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 What do you think of this book? We want to hear from you! Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit:
 
 microsoft.com/learning/booksurvey
 
 Introducing Microsoft Outlook 2010 Bill Gates’s dream of “a computer on every desktop” is becoming more and more of a reality—many people today work (and play) on computers both in the office and at home. But desktop computers are even becoming a thing of the past. Laptops, netbooks, and other portable computers, as well as Windows Mobile devices, smartphones, Windows Phones, BlackBerries, and iPhones are becoming standard communication platforms. Electronic messaging—whether by e-mail, instant messaging, or text messaging—keeps many of us in contact with colleagues, clients, friends, and family members for a dizzying portion of each day. For people who are dependent on electronic messages as a means of communicating, Microsoft Outlook 2010 offers an ideal solution. Outlook 2010 includes not only e-mail functionality, but also integrates with instant messaging programs and SMS text messaging service providers. Outlook enables you to manage messaging and information—address books, calendars, task lists, note pads, and more—in one attractive interface. More importantly, Outlook makes this information immediately available to you when and where you need it. From one place, you can quickly store, organize, manage, and retrieve many types of information. You can use Outlook to: ● Send, receive, organize, and archive e-mail messages. ● Create attractive business graphics and incorporate and edit external images in
 
 your communications. ● Send documents, spreadsheets, graphics, and other files as message attachments,
 
 and preview attachments you receive from other people. ● Schedule events, appointments, and meetings, invite attendees, and reserve
 
 conference rooms, projectors, and other managed resources. ● View upcoming appointments and tasks, and receive reminders for them. ● Store contact information in a transferable and easily accessible format. ● Track tasks for yourself or for someone else, and schedule time to complete
 
 your tasks. ● Store random bits of information as notes.
 
    xi
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 ● Share schedule information with other people, inside and outside your organization. ● Track the interactions you have with other people. ● Organize and easily locate information in messages, attachments, calendars, contacts,
 
 and tasks. ● Filter out unwanted and annoying junk messages. ● Have information from favorite Web sites delivered directly to you.
 
 In an enterprise environment, Outlook 2010 interacts with Microsoft server products to provide unified communications services including real-time presence and status information, specialized functionality for internal messaging, access to facsimile messages and voicemail messages, offline access to SharePoint site content, and many other useful features. Significant changes have been made from previous versions of Outlook. If you’re upgrading from Outlook 2007 or Outlook 2003, you might find that some of the changes take a bit of getting used to—particularly the global incorporation of Office 2010 interface elements such as the ribbon and the Quick Access Toolbar, and the new Backstage view. These elements have been carefully designed to provide intuitive access to tools and commands. In Outlook 2010 you can control the content displayed on the ribbon tabs and personalize your working environment in more ways than in previous versions of Outlook.
 
 Let’s Get Started! To put it simply, Outlook 2010 is a truly excellent one-stop information management system. Managing messages, schedules, and information is easier than ever before. After using this program for only a short time, you might wonder how you ever did without it. Join us now for a close look at all the features and functions of Outlook 2010.
 
 Modifying the Display of the Ribbon The goal of the Microsoft Office 2010 working environment is to make working with Office files—including Microsoft Word documents, Excel workbooks, PowerPoint presentations, Outlook e-mail messages, and Access databases—as intuitive as possible. You work with an Office file and its contents by giving commands to the program in which the document is open. All Office 2010 programs organize commands on a horizontal bar called the ribbon, which appears across the top of each program window whether or not there is an active document. Ribbon tabs
 
 Ribbon groups
 
 A typical program window ribbon.
 
 Commands are organized on task-specific tabs of the ribbon, and in feature-specific groups on each tab. Commands generally take the form of buttons and lists. Some appear in galleries. Some groups have related dialog boxes or task panes that contain additional commands. Throughout this book, we discuss the commands and ribbon elements associated with the program feature being discussed. In this topic, we discuss the general appearance of the ribbon, things that affect its appearance, and ways of locating commands that aren’t visible on compact views of the ribbon. See Also  For detailed information about the ribbon in Microsoft PowerPoint, see “Working in the Outlook Program Window” in Chapter 2, “Explore the Outlook Windows.” Tip  Some older commands no longer appear on the ribbon, but are still available in the program. You can make these commands available by adding them to the Quick Access Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 13, “Customize Outlook.”
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 Dynamic Ribbon Elements The ribbon is dynamic, meaning that the appearance of commands on the ribbon changes as the width of the ribbon changes. A command might be displayed on the ribbon in the form of a large button, a small button, a small labeled button, or a list entry. As the width of the ribbon decreases, the size, shape, and presence of buttons on the ribbon adapt to the available space. For example, when sufficient horizontal space is available, the buttons on the Home tab of the Outlook program window are spread out and you’re able to see more of the commands available in each group. Drop-down lists
 
 Large button
 
 Gallery
 
 Small labeled buttons
 
 The Home tab of the Outlook program window at 1024 pixels wide.
 
 If you decrease the width of the ribbon, small button labels disappear and entire groups of buttons are hidden under one button that represents the group. Click the group button to display a list of the commands available in that group. Small unlabeled button
 
 Group button
 
 The Home tab of the Outlook program window at 675 pixels wide.
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 When the window becomes too narrow to display all the groups, a scroll arrow appears at its right end. Click the scroll arrow to display hidden groups. Gallery list
 
 Scroll arrow
 
 The Home tab of the Outlook program window at 340 pixels wide.
 
 Changing the Width of the Ribbon The width of the ribbon is dependent on the horizontal space available to it, which depends on these three factors: ● The width of the program window  Maximizing the program window provides
 
 the most space for ribbon elements. You can resize the program window by clicking the button in its upper-right corner or by dragging the border of a non-maximized window. Tip  On a computer running Windows 7, you can maximize the program window by dragging its title bar to the top of the screen. ● Your screen resolution  Screen resolution is the size of your screen display expressed
 
 as pixels wide × pixels high. The greater the screen resolution, the greater the amount of information that will fit on one screen. Your screen resolution options are dependent on your monitor. At the time of writing, possible screen resolutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the number of pixels wide (the first number), the greater the number of buttons that can be shown on the ribbon, and the larger those buttons can be.
 
 xvi    Modifying the Display of the Ribbon
 
 On a computer running Windows 7, you can change your screen resolution from the Screen Resolution window of Control Panel.
 
 You set the resolution by dragging the pointer on the slider. ● The density of your screen display  You might not be aware that you can change
 
 the magnification of everything that appears on your screen by changing the screen magnification setting in Windows. Setting your screen magnification to 125% makes text and user interface elements larger on screen. This increases the legibility of information, but means that less fits onto each screen. On a computer running Windows 7, you can change the screen magnification from the Display window of Control Panel. See Also  For more information about display settings, refer to Windows 7 Step by Step (Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.
 
 
 
 Modifying the Display of the Ribbon   xvii
 
 You can choose one of the standard display magnification options, or create another by setting a custom text size.
 
 The screen magnification is directly related to the density of the text elements on screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms are interchangeable, and in fact are both used in the Windows dialog box in which you change the setting.) The greater the dpi, the larger the text and user interface elements appear on screen. By default, Windows displays text and screen elements at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and screen elements to 120 dpi. You can choose a custom setting of up to 500% magnification, or 480 dpi, in the Custom DPI Setting dialog box.
 
 You can choose a magnification of up to 200% from the lists, or choose a greater magnification by dragging across the ruler from left to right.
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 Adapting Exercise Steps The full-screen images shown in the exercises in this book were captured at a screen resolution of 1024 x 768, at 100% magnification, and the default text size (96 dpi). If any of your settings are different, the ribbon on your screen might not look the same as the one shown in the book. For example, you might see more or fewer buttons in each of the groups, the buttons you see might be represented by larger or smaller icons than those shown, or the group might be represented by a button that you click to display the group’s commands. When we instruct you to give a command from the ribbon in an exercise, we do it in this format: ● On the Insert tab, in the Illustrations group, click the Chart button.
 
 If the command is in a list, we give the instruction in this format: ● On the Page Layout tab, in the Page Setup group, click the Breaks button and
 
 then, in the list, click Page. The first time we instruct you to click a specific button in each exercise, we display an image of the button in the page margin to the left of the exercise step. If differences between your display settings and ours cause a button on your screen to look different from the one shown in the book, you can easily adapt the steps to locate the command. First, click the specified tab. Then locate the specified group. If a group has been collapsed into a group list or group button, click the list or button to display the group’s commands. Finally, look for a button that features the same icon in a larger or smaller size than that shown in the book. If necessary, point to buttons in the group to display their names in ScreenTips. If you prefer not to have to adapt the steps, set up your screen to match ours while you read and work through the exercises in the book.
 
 Features and Conventions of This Book This book has been designed to lead you step by step through all the tasks you’re most likely to want to perform in Microsoft Outlook 2010. If you start at the beginning and work your way through all the exercises, you will gain enough proficiency to be able to manage information by using Outlook and to create and work with e-mail messages, calendar items, and contact records. However, each topic is self contained. If you have worked with a previous version of Outlook, or if you completed all the exercises and later need help remembering how to perform a procedure, the following features of this book will help you locate specific information: ● Detailed table of contents  Scan the listing of the topics and sidebars within
 
 each chapter. ● Chapter thumb tabs  Easily locate the beginning of the chapter by looking at the
 
 colored blocks on the odd-numbered pages. ● Topic-specific running heads  Within a chapter, quickly locate a topic by looking
 
 at the running heads at the top of odd-numbered pages. ● Glossary  Look up the meaning of a word or the definition of a concept. ● Keyboard Shortcuts  If you prefer to work from the keyboard rather than with
 
 a mouse, find all the shortcuts in one place. ● Detailed index  Look up specific tasks and features in the index, which has been
 
 carefully crafted with the reader in mind. You can save time when reading this book by understanding how the Step by Step series shows exercise instructions, keys to press, buttons to click, and other information. The following table lists these conventions.
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 Convention
 
 Meaning
 
 SET UP
 
 This paragraph preceding a step-by-step exercise indicates the practice files that you will use when working through the exercise. It also indicates any requirements you should attend to or actions you should take before beginning the exercise.
 
 CLEAN UP
 
 This paragraph following a step-by-step exercise provides instructions for saving and closing open files or programs before moving on to another topic. It also suggests ways to reverse any changes you made to your computer while working through the exercise.
 
 1 2
 
 Blue numbered steps guide you through hands-on exercises in a topic.
 
 1
 
 Black numbered steps guide you through procedures in sidebars and expository text.
 
 2 See Also
 
 This paragraph directs you to more information about a topic in this book or elsewhere.
 
 Troubleshooting
 
 This paragraph alerts you to a common problem and provides guidance for fixing it.
 
 Tip
 
 This paragraph provides a helpful hint or shortcut that makes working through a task easier.
 
 Important
 
 This paragraph points out information that you need to know to complete a procedure.
 
 Keyboard Shortcut This paragraph provides information about an available keyboard
 
 shortcut for the preceding task.
 
 Ctrl+B
 
 A plus sign (+) between two keys means that you must press those keys at the same time. For example, “Press Ctrl+B” means that you should hold down the Ctrl key while you press the B key. Pictures of buttons appear in the margin the first time the button is used in an exercise.
 
 Interface objects
 
 In exercises that begin with SET UP information, the names of program elements, such as buttons, commands, windows, and dialog boxes, as well as files, folders, or text that you interact with in the steps, are shown in bold black type.
 
 User input
 
 In exercises that begin with SET UP information, text that you should type is shown in bold blue type.
 
 Using the Practice Files Before you can complete the exercises in this book, you need to copy the book’s practice files to your computer. These practice files, and other information, can be downloaded from the book’s detail page, located at: go.microsoft.com/fwlink/?LinkId=192151 Display the detail page in your Web browser and follow the instructions for downloading the files. Important  The Microsoft Outlook 2010 software is not available from this Web site. You should purchase and install that software before using this book.
 
 While working through the exercises in this book, you will use some practice files that we provide, and you will create Outlook items to use as practice files in later exercises. The following table lists the practice files you will use and create while working through the exercises in this book. Chapter
 
 Use these files and items
 
 Create these files and items
 
 Chapter 1: Get Started with Outlook 2010
 
 None
 
 None
 
 Chapter 2: Explore the Outlook Windows
 
 None
 
 None
 
 Chapter 3: Send and Receive E-Mail Messages
 
 We provide: Brochure.docx StrategySession.pptx
 
 SBS First Draft message RE: SBS First Draft message FW: SBS First Draft message SBS Tradeshow Schedule message
 
 Chapter 4: Store and Access Contact Information
 
 None
 
 Contact records for Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin
 
 Chapter 5: Manage Scheduling
 
 None
 
 SBS Lunch with Jane appointment SBS Staff Meeting appointment SBS Get Together meeting SBS Pay Day event
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 Chapter
 
 Use these files and items
 
 Create these files and items
 
 Chapter 6: Track Tasks
 
 You provide: SBS First Draft message SBS Tradeshow Schedule message
 
 Flagged SBS First Draft message Flagged SBS Tradeshow Schedule message SBS Dinner Reservations task SBS Order Brochures task SBS Send Dinner Invitations task
 
 Chapter 7: Organize Your Inbox
 
 You provide: SBS Messages folder SBS First Draft message FW: SBS First Draft message RE: SBS First Draft message SBS Tradeshow Schedule message
 
 Chapter 8: Manage Your Calendar
 
 None
 
 Secondary calendar
 
 Chapter 9: Work with Your Contact List
 
 We provide: JoanLambert.jpg SBSContacts.txt
 
 SBS Contacts address book SBS Litware address book Contact records for Joel Lachance, Joan Lambert, Chris Mayo, Heidi Steen, Max Stevens, and Amy Strande Clients contact group Contact records for Eli Bowen, Liberty Munson, and Tjeerd Veninga
 
 You provide: Contact records for Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin Chapter 10: Enhance Message Content
 
 We provide: Lighthouse.jpg
 
 Casual e-mail signature SBS Development Cycle message and embedded SmartArt graphic SBS Picture Tools message and embedded modified image
 
 Chapter 11: Manage E-Mail Settings
 
 You provide: SBS Messages folder
 
 SBS Alert Test 1 message SBS rule
 
 Chapter 12: Work Remotely
 
 None
 
 None
 
 Chapter 13: Customize Outlook
 
 None
 
 None
 
 Getting Help Every effort has been made to ensure the accuracy of this book. If you do run into problems, please contact the sources listed in the following sections.
 
 Getting Help with This Book If your question or issue concerns the content of this book or its practice files, please first consult the book’s errata page, which can be accessed at: go.microsoft.com/fwlink/?LinkId=192151 This page provides information about known errors and corrections to the book. If you do not find your answer on the errata page, send your question or comment to Microsoft Press Technical Support at: [email protected]
 
 Getting Help with Outlook 2010 If your question is about Microsoft Outlook 2010, and not about the content of this book, your first recourse is the Outlook Help system. This system is a combination of tools and files stored on your computer when you installed Outlook and, if your computer is connected to the Internet, information available from the Microsoft Office Online Web site. You can find general or specific Help information in the following ways: ● To find out about an item on the screen, you can display a ScreenTip. For example, to
 
 display a ScreenTip for a button, point to the button without clicking it. The ScreenTip gives the button’s name, the associated keyboard shortcut if there is one, and unless you specify otherwise, a description of what the button does when you click it. ● In the Outlook program window, you can click the Microsoft Outlook Help but-
 
 ton (a question mark in a blue circle) at the right end of the ribbon to display the Outlook Help window. ● After opening a dialog box, you can click the Help button (also a question mark)
 
 at the right end of the dialog box title bar to display the Outlook Help window. Sometimes, topics related to the functions of that dialog box are already identified in the window.    xxiii
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 To practice getting help, you can work through the following exercise. SET UP  You don’t need any practice files to complete this exercise. Start Outlook, and then follow the steps.
 
 
 
 1. At the right end of the ribbon, click the Microsoft Outlook Help button. The Outlook Help window opens.
 
 Your Help window might look different from this one because the material on the Office Online Web site is constantly being updated. Tip  You can maximize the window or adjust its size by dragging the handle in the lowerright corner. You can change the size of the font by clicking the Change Font Size button on the toolbar.
 
 
 
 2. Below the bulleted list under Browse Outlook 2010 support, click see all. The window changes to display a list of Outlook 2010 help and how-to topics.
 
 Getting Help   xxv
 
 
 
 
 
 3. In the list of topics, click Activating Outlook. Outlook Help displays a list of topics related to activating Microsoft Office programs. You can click any topic to display the corresponding information.
 
 
 
 4. On the toolbar, click the Show Table of Contents button, and then scroll down the pane that appears on the left. Like the table of contents in a book, the Help table of contents is organized in sections. If you’re connected to the Internet, Outlook displays sections, topics, and training available from the Office Online Web site as well as those stored on your computer.
 
 Clicking any section (represented by a book icon) displays that section’s topics (represented by help icons).
 
 
 
 5. In the Table of Contents pane, click a few sections and topics. Then click the Back and Forward buttons to move among the topics you have already viewed.
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 6. At the right end of the Table of Contents pane title bar, click the Close button. 7. At the top of the Outlook Help window, click the Search box, type saving, and then press the Enter key. The Outlook Help window displays topics related to the word you typed.
 
 Next and Back buttons appear to make it easier to search for the topic you want. Tip  If you enter a term in the Search box and then click the adjacent Search arrow, you specify the type of help you are looking for or where you want to look for it.
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 8. In the results list, click the Save or don’t save drafts of unsent e-mail messages topic. The selected topic appears in the Outlook Help window.
 
 
 
 9. Below the title at the top of the topic, click Show All. Outlook displays any hidden auxiliary information available in the topic and changes the Show All button to Hide All. You can jump to related information by clicking hyperlinks identified by blue text. Tip  You can click the Print button on the toolbar to print a topic. Only the displayed information is printed.
 
 CLEAN UP  Click the Close button in the upper-right corner of the Outlook Help window.
 
 More Information If your question is about Outlook 2010 or another Microsoft software product and you cannot find the answer in the product’s Help system, please search the appropriate product solution center or the Microsoft Knowledge Base at: support.microsoft.com In the United States, Microsoft software product support issues not covered by the Microsoft Knowledge Base are addressed by Microsoft Product Support Services. Location-specific software support options are available from: support.microsoft.com/gp/selfoverview/
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 Chapter at a Glance
 
 Connect to e-mail accounts, page 4
 
 Troubleshoot connection problems, page 17
 
 1 Get Started with Outlook 2010 In this chapter, you will learn how to ✔ Connect to e-mail accounts. ✔ Troubleshoot connection problems.
 
 Welcome to the wonderful world of Microsoft Outlook 2010! Using Outlook 2010, you can easily manage one or more e-mail accounts. If your e-mail account includes additional information, such as calendar items and contact records, you can also manage that information from Outlook. Before you can begin using Outlook, you need to provide Outlook with the information necessary to connect to your e-mail account. After you configure Outlook to connect to an account, you can easily manage the information stored with that account by using the Outlook features specifically designed for each type of information. You can configure Outlook to connect to many different types of business and personal e-mail accounts. If your organization uses Microsoft Exchange Server, you can use Outlook to work with all the features of your Exchange account including e-mail, calendaring, contact tracking, task tracking, and notes. If your organization also uses Microsoft Office Communications Server features such as Microsoft Office Communicator, and Microsoft Office Live Meeting, you can initiate telephone calls, instant messaging sessions, online meetings, and more from Outlook 2010. In this chapter, you’ll configure Outlook to connect to one or more e-mail accounts. Practice Files  You won’t need any practice files to complete the exercises in this chapter. For more information about practice file requirements, see “Using the Practice Files” at the beginning of this book.
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 Connecting to E-Mail Accounts A default installation of Outlook 2010 supports the following types of e-mail accounts: ● Exchange  You can configure Outlook 2010 to connect to an Exchange account
 
 hosted on Microsoft Exchange Server 2010, Exchange Server 2007, or Exchange Server 2003. If your organization runs any of these versions of Exchange Server, you can send mail within or outside of your organization’s network. Messages are stored centrally on the Exchange server. They are also stored locally in a data file on your computer. Outlook synchronizes with the server when you’re connected to it either over a corporate network or over the Internet, so you can work with existing Outlook items and create new items while working offline. If your computer is connected directly to the corporate network, Outlook handles the connection to your corporate Exchange account for you. If your computer is not connected directly to the corporate network—for example, if you’re configuring your home computer or portable computer to connect to your corporate Exchange account—you can connect to your corporate Exchange account in one of two ways: ❍ You can create a virtual private network (VPN) connection from your com-
 
 puter to the corporate network and then configure Outlook to connect to the corporate Exchange server through the VPN connection. ❍ You can configure Outlook to connect to the Exchange server over the Internet
 
 by using Outlook Anywhere (a vaguely friendly name for a service otherwise known as HTTP over RPC). The Exchange server must be specifically configured to allow this type of connection. Tip  Some Outlook features are dependent on the functionality of the specific version of Exchange hosting your e-mail account. The functionality described in this book is specific to Exchange Server 2010 accounts. Outlook provides additional functionality in enterprise environments that include Microsoft Office Communications Server (OCS).
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 ● Post Office Protocol (POP)  When connected to a POP account, Outlook down-
 
 loads (copies) messages from your e-mail server to your computer, and then removes the original messages from the server after a specified length of time. You read and manage messages on your computer (or locally), and Outlook synchronizes with the server when connected. ● Internet Message Access Protocol (IMAP)  When connected to an IMAP account,
 
 Outlook stores copies of messages on your computer, but leaves the originals on the e-mail server. You read and manage messages locally, and Outlook synchronizes with the server when connected. Tip  Outlook 2010 can also support Windows Live Hotmail accounts. For more information, see the sidebar “Connecting to Hotmail Accounts” later in this chapter.
 
 Before you can use Outlook, you need to configure the program to connect to your e-mail account(s). When you first start the program, the Microsoft Outlook 2010 Startup wizard guides you through an automated process. This process is a significant improvement over the manual account setup process of Outlook 2003 and earlier versions of Outlook, which required you to provide much more information. For most accounts, you need to supply only three pieces of information—your name, your e-mail address, and your e-mail account password—and the Startup wizard will handle the rest of the connection process for you. If the Startup wizard isn’t able to configure Outlook to connect to your account, you can provide additional information to complete the process manually. Configuring Outlook creates an Outlook profile, which stores information about your e-mail accounts. You can work with your profile from within Outlook or from the Mail control available in the Windows Control Panel. Your profile includes information about your e-mail account such as the user name, display name, server name, password, and where your Outlook data is stored. You can connect to more than one e-mail account per profile, to manage all your e-mail communications through Outlook. You can also create multiple profiles that link to different e-mail accounts or to different sets of e-mail accounts. You can add multiple e-mail accounts of any type to your Outlook profile, either during setup or at any time thereafter.
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 In this exercise, you’ll configure Outlook to automatically connect to an e-mail account and you’ll manually configure Exchange account settings. Although we demonstrate connecting to an Exchange account, you can follow the same basic process to connect to another type of e-mail server. SET UP  You need your e-mail account user name and password to complete this exercise. If you are connecting to a POP account, an IMAP account, or an Exchange account that is hosted by an external service provider, you might also need to know the names and authentication requirements of your incoming and outgoing servers. These will be available from your e-mail service provider.
 
 
 
 1. On the Start menu, click All Programs, click Microsoft Office, and then click Microsoft Outlook 2010.
 
 Tip  If the E-mail link at the top of the Start menu specifies Microsoft Outlook as your default e-mail program, you can click that link instead.
 
 
 
 2. The next step depends on whether Outlook is already configured to connect to an e-mail account.
 
 
 
 a. If you haven’t yet configured Outlook to connect to an e-mail account, the Microsoft Outlook 2010 Startup wizard begins.
 
 The Outlook 2010 Startup wizard.
 
 On the Startup wizard’s Welcome page, and again on the E-mail Accounts page, click Next.
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 b. If Outlook is already configured to connect to one or more e-mail accounts, Outlook starts and displays the Inbox of an existing account. You need to manually start the account configuration process. Click the File tab at the left end of the ribbon to display the Backstage view. Then on the Info page of the Backstage view, under the current account information, click Add Account.
 
 You add an account to Outlook from the Backstage view of the program window. Tip  You control Outlook program settings and e-mail account settings from the Backstage view. For detailed information about this new Office 2010 feature, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 Whether you followed step 2a or step 2b, the Auto Account Setup page of the Add New Account wizard is now displayed.
 
 The Add New Account wizard, which you open from the Startup wizard or from the Info page of the Backstage view.
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 3. On the Auto Account Setup page of the Add New Account wizard, enter your name, e-mail address, and e-mail account password in the text boxes provided. Note that you must enter your password two times.
 
 The password characters you enter are hidden, so ensure that the Caps Lock key is not inadvertently active when you enter the password.
 
 
 
 4. On the Auto Account Setup page, click Next. The Add New Account wizard searches your available networks and the Internet for the specified domain.
 
 The wizard searches for the domain that hosts your account and attempts to log on to it by using the credentials you provided in step 3.
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 If the wizard locates an account matching the e-mail address you entered, it attempts to log on by using the password you entered. If the connection is successful, a confirmation appears, along with additional account configuration options. You can click Finish on the wizard’s final page to begin using your account, or you can configure additional settings.
 
 After successfully configuring a connection to an e-mail account, you can modify the account’s server settings, add another account, or click Finish to begin using the account. Tip  If this is the first time you have started a 2010 Microsoft Office system program, Office prompts you to enter your full name and initials. The programs in the 2010 Office system use this information when tracking changes, responding to messages, and so on. Next, Office prompts you to select the type of information you want to share over the Internet, and finally, offers the option of signing up for automatic program updates from the Microsoft Update service.
 
 
 
 5. If the wizard successfully connects to your account, select the Manually configure server settings check box, click Next, and then skip to step 12 to practice configuring additional settings.
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 If the wizard is unable to connect to your account by using the credentials you provided, an informational message appears.
 
 The specific message you see might differ from the one shown here.
 
 
 
 6. If the wizard doesn’t connect to your account, click Back to return to the Auto Account Setup page (shown in step 3 of this exercise). Then click Manually configure server settings or additional server types, and click Next. The Choose Service page opens.
 
 Depending on the information entered on the Auto Account Setup page, the Other option might or might not appear on the Choose Service page.
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 7. On the Choose Service page, click Microsoft Exchange, and then click Next. Important  The screen that appears next varies based on the selected account type. For the purpose of this exercise, we’ll connect to an Exchange account. Tip  It’s more likely that you need to perform manual configuration when connecting to an Internet e-mail account than to an Exchange account. For information about manually configuring a connection to an Internet e-mail account, see “Troubleshooting Connection Problems” later in this chapter.
 
 
 
 8. On the Microsoft Exchange Settings page, enter the name or address of your Exchange server (provided by your Exchange server administrator) and your user name (usually your e-mail address) in the boxes provided, and then click Check Name. If you didn’t provide your password on the Auto Account Setup page, Outlook prompts you for it now.
 
 
 
 9. If the Connect to dialog box appears, enter your logon information, and then click OK.
 
 The wizard contacts the specified server. If the user name and password you provided match the information stored on the server, the wizard replaces your user name with your display name (as recorded in your organization’s Global Address List) and underlines it. (This is known as resolving the address.) If the wizard is unable to validate the information, a Microsoft Exchange dialog box opens. This might occur if you’re connecting to a corporate Exchange server over the Internet, and Outlook requires additional information to establish the connection.
 
 Possible results of attempting to validate Exchange account credentials.
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 10. If the Microsoft Exchange dialog box opens, click Cancel and then wait for the
 
 
 
 11. If the wizard successfully resolves your server name and user name, you can click
 
 wizard to return to the Microsoft Exchange Settings page.
 
 Next and then Finish to begin using your account, or you can manually configure additional account settings. For the purpose of this exercise, we’ll look at the manual configuration options.
 
 
 
 12. On the Microsoft Exchange Settings page, click More Settings. A Microsoft Exchange account settings dialog box opens, displaying the General page. On this page, you can specify the name that identifies the account within Outlook (for example, on the program window title bar and in the Navigation Pane). This action does not affect the name that appears to message recipients.
 
 The General page of the Microsoft Exchange account settings dialog box.
 
 
 
 13. Click each of the dialog box page tabs to review the available settings. On the Advanced page, you can specify additional mailboxes on the same Exchange server that you want to open in Outlook. For example, if you monitor a departmental mailbox, you can specify it here.
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 The Advanced page of the Microsoft Exchange account settings dialog box.
 
 On the Security page, you can choose to secure your locally stored account data by requiring logon credentials each time you start Outlook.
 
 The Security page of the Microsoft Exchange account settings dialog box. See Also  For information about Cached Exchange Mode, see “Working with Outlook Items While Offline” in Chapter 12, “Work Remotely.”
 
 14    Chapter 1  Get Started with Outlook 2010
 
 Tip  Clicking Outlook Data File Settings on the Advanced page of the Microsoft Exchange dialog box displays the path to and name of the data file on your computer in which a local copy of your e-mail account information is stored.
 
 From the Outlook Data File Settings dialog box, you can reduce the data file size by compacting its contents or disable offline use of the local data file so that account information is available only when Outlook is connected to the Exchange server.
 
 On the Connection page, you can select the way you want Outlook to connect to the Exchange server. The default connection option, Connect Using My Local Area Network, is appropriate for any wired or wireless broadband network connection.
 
 The Connection page of the Microsoft Exchange account settings dialog box.
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 If you connect to the network through an analog modem and need to dial in over a phone line, you need to select one of the other options and provide the necessary dial-up network connection information. Tip  You create network connections from Windows. For information about creating a network connection from the version of Windows running on your computer, refer to Windows 7 Step by Step (Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2007), or Windows XP Step by Step (Microsoft Press, 2004) by Joan Lambert Preppernau and Joyce Cox.
 
 
 
 14. In the Microsoft Exchange dialog box, enter any additional connection information
 
 
 
 15. On the Microsoft Exchange Settings page, click Next. Then on the wizard’s final
 
 provided to you by your Exchange server administrator, and then click OK. page, click Finish.
 
 The E-mail page of the Account Settings dialog box might appear and display the new e-mail account.
 
 Your account is ready to use.
 
 
 
 16. If the Account Settings dialog box opens, close it to display your e-mail account Inbox. A test message from Outlook appears at the top of the Inbox, with your other e-mail messages below the test message. CLEAN UP  You’re now ready to begin using your e-mail account!
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 Connecting to Hotmail Accounts Windows Live Hotmail accounts are Hypertext Transfer Protocol (HTTP) accounts. Messages sent through an HTTP account are in the form of Web pages that your e-mail program copies from the HTTP mail server and displays within the message window. The free Microsoft Outlook Hotmail Connector add-on provides a way to configure Outlook to connect to Windows Live Hotmail accounts, Windows Live Calendar, and Windows Live Contacts. The Outlook Connector add-on is available from the Microsoft Download Center (www.microsoft.com/downloads/). However, you can also install it directly from Outlook. Simply enter your Hotmail e-mail address on the Auto Account Setup page of the Add New Account wizard, and click Next. Outlook prompts you to install the Outlook Connector and provides a link to the installation file. After you install the Outlook Connector, restart Outlook. The Outlook Connector then gives you the opportunity to configure Outlook to connect to a Hotmail account. You need to enter only your basic account information. You have the option to specify a friendly name by which you identify the account in Outlook, and an alternate reply address, just as you can with an Internet e-mail account.
 
 To connect to a Hotmail account, you must first install the Outlook Connector.
 
 After you complete the Outlook Connector process, you can use your Hotmail account within Outlook exactly as you do any other type of account.
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 Troubleshooting Connection Problems The automatic account setup feature is very handy, but might not work every time. It is most successful when connecting over a corporate network to a corporate Exchange account. When connecting to a remote Exchange server or to an Exchange account hosted by an external hosting company, or when connecting to a POP or IMAP account, manual troubleshooting might be necessary.
 
 Connecting to Exchange Accounts Here are some common error messages and problems you could encounter when connecting to an Exchange account, and how to address them: ● Server certificate does not match site  If Outlook encounters security issues
 
 associated with the electronic file (digital certificate) that validates the mail server’s identity—for example, if the digital certificate does not match the name of your domain—Outlook notifies you of this problem and lets you choose whether to proceed. If a Security Alert message box appears, you can click the View Certificate button to see the digital certificate of the mail server and verify that you know and trust the company that issued the certificate. If you want, you can install the certificate on your computer by clicking the Install Certificate button and following the steps in the Certificate Import wizard. See Also  For more information about digital certificates, see “Securing Your E-Mail” in Chapter 11, “Manage E-Mail Settings.” ● Encrypted connection not available  Outlook first tries to establish an encrypted
 
 connection with the server. If this attempt is not successful, Outlook notifies you of this problem and asks whether you want to try to establish an unencrypted connection. If you select this option, Outlook might inadvertently configure your Exchange account as an IMAP or POP account instead of as an Exchange account. This configuration results in a loss of functionality—for example, the To-Do Bar will not display your calendar and task information.
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 If you encounter either of these errors when connecting to your Exchange account, verify that your computer is connected to your network domain (locally, over a VPN connection, or by using the HTTP option) and using the correct internal server address method. For example, if your e-mail address is [email protected], you might address your e-mail server as mail.adatum.com or by an internal address, such as ADATUMExchange.adatum.local. To successfully troubleshoot your connection issues, you will likely need to manually configure your server settings. This requires that you have additional information from your server administrator about your e-mail account, including the names of the incoming and outgoing servers, and whether either of the servers requires additional authentication.
 
 Connecting to Internet E-Mail Accounts If the Add New Account wizard is unable to automatically configure Outlook to connect to your POP or IMAP account, you can manually configure the connection.
 
 The basic information required to connect to a POP or IMAP account.
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 You need to provide the following information, which you can obtain from your e-mail service provider: ● Name ● E-mail address ● Account type ● Incoming mail server ● Outgoing mail server ● Account user name ● Account password ● Logon authentication requirements
 
 You can supply additional information, such as the name by which you want to identify the account, the e-mail address you want to appear when you reply to a message, and additional outgoing server authentication information.
 
 It might be necessary to supply additional server authentication information.
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 Most important, when connecting to a POP account, you can control the retention of messages on the e-mail server. By default, messages downloaded from a POP server to your computer are removed from the server after 14 days. You can, however, choose to leave the messages on the server permanently, leave them there for a specified amount of time, or leave them there until you delete them from Outlook. If you access your e-mail account from multiple computers, you probably want to leave messages on the server to ensure that they’re available to you from all your computers.
 
 The Advanced page of the Internet E-mail Settings dialog box, from which you can control how messages are retained on the e-mail server.
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 After supplying the connection information for your Internet e-mail account, you can click Test Account Settings on the Internet E-mail Settings page of the Add New Account wizard to ensure that Outlook successfully connects to your incoming and outgoing servers.
 
 Validating the successful configuration of an Internet e-mail account.
 
 Key Points ● You can configure Outlook to connect to Exchange, POP, and IMAP accounts. You can
 
 also connect to Windows Live Hotmail accounts by installing the Outlook Connector. ● You can configure multiple e-mail accounts within one Outlook profile. ● The Add New Account wizard can connect to most e-mail accounts automatically.
 
 You need to provide only your e-mail address and account password.
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 2 Explore the
 
 Outlook Windows In this chapter, you will learn how to ✔ Work in the Outlook program window. ✔ Work with the ribbon and the Backstage view. ✔ Work in the Mail module. ✔ Work in the Calendar module. ✔ Work in the Contacts module. ✔ Work in the Tasks module.
 
 The Microsoft Outlook 2010 user interface includes many features and tools, organized so that you can easily store, find, and display information. As with other Microsoft Office 2010 programs, Outlook commands are available on the ribbon at the top of the Outlook program window. In addition, a separate version of the ribbon appears at the top of each message window, appointment window, contact record window, and other type of item window. The ribbon in each Outlook module displays commands specific to working with the Outlook items created and stored in that module. Similarly, the ribbon in each type of Outlook item window has a unique tab that displays commands specific to creating that type of item. In this chapter, you’ll first learn about the features and tools available in the Outlook program window. You’ll learn how to use commands on the ribbon and the Quick Access Toolbar. Finally, you’ll explore item window features in message windows, contact record windows, calendar item windows, and task windows. Practice Files  You don’t need any practice files to complete the exercises in this chapter. For more information about practice file requirements, see “Using the Practice Files” at the beginning of this book.
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 Working in the Outlook Program Window Unlike other Office 2010 programs, Outlook doesn’t function for a single purpose or create a single category of files. You use it to create, organize, and track several types of information that are critical to keeping your daily life functioning smoothly. To minimize the work of dealing with such diverse items of information as e-mail messages, contacts, appointments, tasks, and notes, Outlook provides a module for each type and presents each module in a similar interface, allowing you to work with different items of information in consistent ways.
 
 The Program Window The Outlook program window includes eight areas in which you work with Outlook and your Outlook items. Quick Access Toolbar (default location)
 
 Navigation Pane
 
 Content pane
 
 The Outlook program window.
 
 Title bar
 
 Ribbon
 
 Status bar
 
 Reading Pane
 
 To-Do Bar
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 Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book. ● Title bar  The title bar displays the name of the active account. At the left end of
 
 the title bar is the Outlook icon. Clicking the icon displays a menu of commands for moving, sizing, and closing the program window. The three buttons at the right end of the title bar serve the same functions in all Windows programs: You can temporarily hide the program window by clicking the Minimize button, adjust the size of the window by clicking the Restore Down/Maximize button, and close the active document or exit Outlook by clicking the Close button. Tip  Windows 7 introduced many fun and efficient new window-management techniques. For information about ways to work with the Outlook program window on a Windows 7 computer, refer to our book Windows 7 Step by Step by Joan Lambert Preppernau and Joyce Cox (Microsoft Press, 2009). ● Quick Access Toolbar  By default, the Quick Access Toolbar appears to the right
 
 of the Outlook icon at the left end of the title bar. It displays the Send/Receive All Folders button and the Undo/ Redo button. You can change the location of the Quick Access Toolbar and customize it to include any commands to which you want to have one-click access. The program window and the windows in which you work with each type of Outlook item have individually configurable Quick Access Toolbars. So, for example, you can display commands specific to creating and formatting message content only in message item windows and commands specific to creating and managing tasks only in task item windows. Tip  If you create and work with complicated Outlook items, you might increase your efficiency if you add all the commands you use frequently to the Quick Access Toolbar and display it below the ribbon, directly above the workspace. For information, see “Customizing the Quick Access Toolbar” in Chapter 13, “Customize Outlook.” ● Ribbon  Below the title bar is the ribbon. Commands for working with Outlook
 
 items and item content are available from this central location so that you can work efficiently with the program. The program window and each of the Outlook item windows have individually configurable ribbons. See Also  For information about ribbon elements, see “Working with the Ribbon and the Backstage View” later in this chapter.
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 ● Navigation Pane  This collapsible pane appears on the left side of the Outlook win-
 
 dow. Its contents change depending on the module you’re viewing—it might display links to folders, links to external content or Help topics, view options, and so on. See Also  For information about the available Outlook modules, see “Outlook Modules” later in this topic. ● Content pane  This pane appears in the center of the window. It displays the content
 
 of the selected module—your e-mail messages, calendar, contacts, and so on. ● Reading Pane  When this pane is displayed, you can preview the content of a selected
 
 item or attachment (including fully formatted Microsoft Word documents, Microsoft Excel worksheets, and Microsoft PowerPoint presentations) in this pane. The Reading Pane can be displayed in any Outlook module but is displayed by default only in the Mail and Tasks modules. See Also  For information about using the Reading Pane, see “Viewing Messages and Message Attachments” in Chapter 3, “Send and Receive E-Mail Messages.” ● To-Do Bar  On the right side of the Outlook window, this collapsible pane displays
 
 a monthly calendar, your upcoming appointments, and your task list. The To-Do Bar can be displayed in any Outlook module but is displayed by default only in the Mail, Contacts, Tasks, and Notes modules. Keyboard Shortcut  Press Alt+F2 to display or hide the To-Do Bar. See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at the end of this book. For information about working with tasks on the To-Do Bar, see “Displaying Different Views of Tasks” in Chapter 6, “Track Tasks.” ● Status bar  Across the bottom of the program window, the status bar displays informa-
 
 tion about the current document and provides access to certain program features. You can control the contents of the status bar by right-clicking it to display the Customize Status Bar menu, on which you can click any item to display or hide it.
 
 You can specify which items you want to display on the status bar.
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 At the right end of the status bar are the View Shortcuts toolbar, the Zoom button, and the Zoom Slider. These tools provide you with convenient methods for adjusting the display of information in the content pane, the Reading Pane, item windows, and so on. View Shortcuts toolbar Zoom button Zoom Slider The buttons on the View Shortcuts toolbar change to reflect the available views of the active module. See Also  We discuss the module-specific views in Chapter 4, “Store and Access Contact Information,” Chapter 5, “Manage Scheduling,” Chapter 6, “Track Tasks,” and Chapter 7, “Organize Your Inbox.” Tip  You might find that the default Outlook window layout isn’t perfectly suited for the way you work on a day-to-day basis. Or perhaps you’d just like to try a different layout. There are many ways in which you can personalize the way Outlook appears and functions. For more information, see “Personalizing the Outlook Program Window” in Chapter 13, “Customize Outlook.”
 
 Outlook Modules Outlook functionality is divided among several modules that are specific to the content you work with in them, including Mail, Calendar, Contacts, Tasks, and Notes. You display and work with one module at a time in the program window. The program window elements of each module present content-specific functionality. Tip  When you first start Outlook, the program window displays the Mail module.
 
 You can display any of the primary modules—Mail, Calendar, Contacts, Tasks, or Notes— by clicking the corresponding button at the bottom of the Navigation Pane. Or you can hold down the Ctrl key and then press the function key representing the module you want to display. Module 
 
 Keyboard shortcut
 
 Mail 
 
 Ctrl+1
 
 Calendar 
 
 Ctrl+2
 
 Contacts 
 
 Ctrl+3
 
 Tasks 
 
 Ctrl+4
 
 Notes 
 
 Ctrl+5
 
 28    Chapter 2  Explore the Outlook Windows
 
 Module buttons may be large, medium, or small, depending on the size and arrangement of the Navigation Pane at that specific point in time. Each module button is labeled with an icon that represents the type of content you manage in that module. Module icons Resize bar Large module button
 
 Small module button Navigation Pane content commands The module button area at the bottom of the Navigation Pane.
 
 The Navigation Pane contents differ depending on the displayed module. We discuss each module’s Navigation Pane in module-specific topics later in this chapter.
 
 Working with the Ribbon and the Backstage View The ribbon, first introduced in some of the Office 2007 programs, is common to all Office 2010 programs. The ribbon extends across the top of the program window, directly under the title bar, and consists of a set of tabs that change depending on the currently active module, item, or content. Clicking a tab name displays the associated set of commands.
 
 The Mail module tabs. The active tab is white.
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 The Backstage View The leftmost ribbon tab, labeled File and identified in Outlook by an orange tab (the File tab color in each Outlook 2010 program window matches that of the program icon) isn’t actually a tab at all. Clicking the File tab displays the Backstage view, a new feature that is common to all Office 2010 programs.
 
 The Backstage view of the Outlook 2010 program window. Tip  The contents of the Backstage view when opened from the program window are identical regardless of which module you’re working in.
 
 You access commands in the Backstage view from the left pane. Simple file-management commands that interact with the Windows operating system are available at the top of the left pane. These commands change depending on the active module or item and include Save, Save As, Save Attachments, and Close.
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 Categories of commands related to managing Outlook and Outlook accounts (rather than items and item content) are organized on pages, which you display by clicking the page tabs in the left pane. The Outlook 2010 Backstage view includes the following pages: ● Info  From this page, you can manage account settings, automatic replies, mailbox
 
 size, rules, and alerts. ● Open  From this page, you can open an external calendar file, Outlook data file, or
 
 other Outlook user’s folder in Outlook, and you can import files, settings, and RSS feeds into Outlook. ● Print  From this page, you can select a printer, set print options, preview the effect
 
 of the applied options, and print the selected item. ● Help  From this page, you can access information about your Outlook or Office
 
 installation, manage product activation and product keys, and access support resources, program options, and program updates. See Also  For information about managing Outlook and Outlook accounts from the Backstage view, see “Connecting to E-Mail Accounts” in Chapter 1, “Get Started with Outlook 2010,” and “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 Module and Item Tabs Commands related to working with the content of Outlook items are represented in function-specific groups on separate feature-specific tabs of the ribbon. ● The ribbon in each module includes four standard tabs: Home, Send/Receive, Folder,
 
 and View. The Home tab changes to reflect the commands necessary to manage items within the current module. ● The ribbon in each new Outlook item window includes an item-specific tab such
 
 as Message, Appointment, Contact, or Task. It also includes the Insert, Format Text, and Review tabs. The ribbon might also contain additional tabs specific to an item type, to a program installed on your computer, or to customizations you’ve made in the Outlook Options dialog box. See Also  For information about adding standard tabs, removing standard tabs and groups, and creating custom tabs and groups, see “Customizing the Ribbon” in Chapter 13, “Customize Outlook.” ● When certain types of item content (such as tables, charts, and graphics) are active
 
 (selected), additional contextual tabs appear at the right end of the ribbon. These contextual tabs are indicated by colored headers and a colored bottom border, and they contain commands that are specific to working with the selected content.
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 For example, when the cursor is in a table, two Table Tools contextual tabs—Design and Layout—appear to the right of the Review tab. When a chart or chart element is selected, three Chart Tools contextual tabs—Design, Layout, and Format—appear to the right of the Review tab. Each of the available contextual tab groups has a unique color so you can easily differentiate between them. Backstage view Standard tabs
 
 Contextual tabs
 
 Minimize The Ribbon
 
 Groups Tabs and groups on the ribbon. Tip  Don’t be alarmed if your ribbon has tabs not shown in our graphics. Office 2010 allows other programs to add their own tabs to the ribbon. ● To the right of the ribbon tab names, below the Minimize/Maximize/Close buttons,
 
 is the Minimize The Ribbon button. Clicking this button hides the commands but leaves the tab names visible. You can then click any tab name to temporarily display its commands. Clicking anywhere other than the ribbon hides the commands again. When the full ribbon is temporarily visible, you can click the button at its right end, shaped like a pushpin, to make the display permanent. When the full ribbon is hidden, you can click the Expand The Ribbon button to redisplay it. Keyboard Shortcut  Press Ctrl+F1 to minimize or expand the ribbon. ● Clicking the Microsoft Outlook Help button at the right end of the ribbon displays the
 
 Outlook Help window, in which you can use standard techniques to find information. Keyboard Shortcut  Press F1 to display the Outlook Help window. See Also  For information about the Outlook Help system, see “Getting Help” at the beginning of this book.
 
 On each tab, buttons representing commands are organized into named groups. The groups that appear on each tab, and the buttons that appear in each group, vary based on the active module or item. ● Depending on your screen resolution and the size of the program window, the
 
 commands in a group might be displayed as labeled buttons, as unlabeled icons, or as one or more large buttons that you click to display the commands within the group.
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 If a button label isn’t visible, you can display the command, a description of its function, and its keyboard shortcut (if it has one) in a ScreenTip by pointing to the button.
 
 ScreenTips provide helpful information about unlabeled buttons. Tip  In the Outlook Options dialog box, you can control the display and content of ScreenTips from the User Interface Options area of the General page, and change the language of ScreenTip content from the Language page. For more information, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.” ● Related but less common commands are not represented as buttons in a group.
 
 Instead, they are available in a dialog box or task pane, which you display by clicking the dialog box launcher located in the lower-right corner of the group. ● Some buttons include an integrated or separate arrow. To determine whether a but-
 
 ton and arrow are integrated, point to the button or arrow to display its border. If a button and its arrow are integrated within one border, clicking the button displays a list of related actions or options. If the button and arrow have separate borders, clicking the button carries out the default action indicated by the button’s current icon. You can change the default action of the button by clicking the arrow and then clicking the action you want.
 
 The arrow of the Themes button is integrated, and the arrow of the Font Color button is separate.
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 The goal of the entire ribbon is to make working with Outlook items and item content as intuitive as possible. Commands for tasks you perform often are readily available, and even those you might use infrequently are easy to find. For example, when a formatting option has several choices available, they are often displayed in a gallery of thumbnails. These galleries give you an at-a-glance picture of each choice. If you point to a thumbnail in a gallery, Live Preview shows you what that choice looks like if you apply it to your document.
 
 Live Preview shows the effect on the selected element of clicking the thumbnail to which you are pointing. Tip  You might find that obscure commands you used in previous versions of Outlook are not available from the ribbon. However, these legacy commands are still available. You can make legacy commands accessible by adding them to the Quick Access Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 13, “Customize Outlook.”
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 Working in the Mail Module The Mail module is displayed by default when you start Outlook or when you click Mail in the Navigation Pane.
 
 View buttons The Outlook program window displaying the Mail module in Normal view.
 
 Navigation Pane Content In the Mail module, the Navigation Pane displays the Favorites list and the folder structure of your mailbox (or mailboxes, if you have set up multiple e-mail accounts). When you connect to any type of e-mail account, these four folders are visible in your mailbox: ● Inbox  Outlook delivers new messages to this folder. ● Sent Items  When you send a message, Outlook stores a copy of it in this folder. ● Deleted Items  Outlook items that you delete from other folders are held in this
 
 folder. They are not deleted permanently until you empty the folder. See Also  For information about deleting and restoring items, see “Deleting Messages” in Chapter 7, “Organize Your Inbox.” ● Junk E-mail  Outlook delivers messages blocked by the spam filter to this folder.
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 Tip  You can add any mailbox folder to the Favorites list by right-clicking the folder and then clicking Add To Favorites. If you’re managing several e-mail accounts in Outlook, you might find it convenient and efficient to add the Inbox folders of each account to the Favorites list so that you can work with them all in one place.
 
 In Exchange account mailboxes, these five folders are also visible: ● Drafts  Outlook stores temporary copies of in-progress messages in this folder. See Also  For information about creating and working with message drafts, see “Creating and Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.” ● News Feed  News feeds you subscribe to are available from this folder. ● Outbox  Outlook holds outgoing messages in this folder while establishing a
 
 connection to your mail server. ● RSS Feeds  Web site information feeds you subscribe to are available from this folder.
 
 When you first start Outlook, you might find information feeds recommended by Microsoft here. ● Search Folders  These folders contain up-to-date results of searches you’ve conducted
 
 for messages that match specific search criteria. In every module, the area at the bottom of the Navigation Pane displays module buttons and Navigation Pane management commands. You can change the size of the buttons in this area by dragging the resize bar that appears above the Mail button. If you click the Folder List button at the bottom of the Navigation Pane, these seven additional folders appear in Exchange account mailboxes: ● Calendar  The Outlook Calendar module ● Contacts  The Outlook Contacts module ● Journal  The Outlook Journal module ● Notes  The Outlook Notes module ● Suggested Contacts  A list of e-mail addresses with which you’ve recently corre-
 
 sponded that are not in your primary address book ● Sync Issues  A list of conflicts and communication failures on your mail server or in
 
 your mailbox ● Tasks  The Outlook Tasks module Keyboard Shortcut  Press Ctrl+6 to display the expanded folder list in the Navigation Pane.
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 Mail Module Views We refer to the center pane that displays content in the Mail module as the Mail pane. The Mail pane displays the messages in your Inbox or other selected mail folder as well as the Reading Pane, which displays the content of the selected message. There are two standard Mail module views: ● Normal  In this view, the Navigation Pane and To-Do Bar are maximized. ● Reading  In this view, the Navigation Pane, To-Do Bar, and ribbon are minimized.
 
 You switch between views by clicking the View button you want on the status bar.
 
 The Ribbon The ribbon in the Mail module includes the File tab and four tabs that appear in all modules: ● Home  This tab includes commands you need to create and manage e-mail messages
 
 (but not message content).
 
 The Home tab of the Mail module ribbon. ● Send/Receive  This tab includes commands for synchronizing data in Outlook with
 
 data on your mail server. You can control the sending and receiving of messages, whether Outlook automatically downloads full messages or only message headers, and manual download processes. You can also choose to disconnect Outlook from the active Internet connection if you want to work offline; for example, to halt incoming and outgoing messages for a period of time.
 
 The Send/Receive tab of the Mail module ribbon.
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 ● Folder  This tab includes commands for creating and managing folders in which you
 
 can store messages, calendar items, contact records, notes, tasks, and other Outlook items, as well as Search Folders in which you can display up-to-date collections of messages that meet specific criteria. You can manage the contents of the folder and recover inadvertently deleted items; add a folder to the Favorites list; and control archive settings, folder access permissions, and the folder properties.
 
 The Folder tab of the Mail module ribbon. ● View  This tab includes commands for changing the way items are displayed in
 
 the content pane; displaying, hiding or changing the location of program window panes; and opening or closing secondary program windows.
 
 The View tab of the Mail module ribbon.
 
 Message Windows Outlook displays e-mail messages (as well as meeting requests and task assignments received from other Outlook users) in the Mail module. When you start Outlook, it displays the Inbox of your default e-mail account in the Mail module. When you create a new message or open an existing message, it opens in a message window. The message window has its own ribbon and Quick Access Toolbar separate from those in the Outlook program window. You can create, insert, and format message content, modify the settings of outgoing e-mail messages, and take action with received messages by using the commands on the message window ribbon. The layout of all message windows is similar. However, depending on whether you’re working in a message composition window or a message reading window, the content of the message window and the commands on the message window ribbon differ.
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 Message Composition Windows When you’re composing an original message or a message response, you work in a message composition window. Ribbon
 
 Quick Access Toolbar
 
 People Pane
 
 Message header
 
 Message body
 
 A message composition window.
 
 The message composition window interface includes the following elements: ● Quick Access Toolbar  Provides access to the window-management menu (rep-
 
 resented by a New Message icon) and the Save, Undo, Redo/ Repeat, Previous Item, and Next Item buttons. The Save command is available in the Backstage view, but the other commands are not available either in the Backstage view or on the ribbon; they are available only from the Quick Access Toolbar. Previous Item Next Item The Previous Item and Next Item buttons on the Quick Access Toolbar are inactive in a message composition window; they’re active in a message reading window.
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 Tip  You can add commands to the Quick Access Toolbar so that they are available regardless of which tab is currently active in the message composition window. Adding a command to the Quick Access Toolbar in a message composition window does not add it to the Quick Access Toolbar of any other Outlook item window (including the message reading window) or any other Microsoft Office 2010 program window. ● Ribbon  Includes the File tab (your link to the Backstage view) and the Message,
 
 Insert, Options, Format Text, and Review tabs. ● Message header  Includes the To and Cc address fields and the Subject field, by
 
 default. You can also display the From field (if you manage multiple accounts in one Outlook installation) and the Bcc field. See Also  For information about the From field, see the sidebar “Managing Multiple Accounts” in Chapter 3, “Send and Receive E-Mail Messages.” For information about the Bcc field, see “Creating and Sending Messages” in the same chapter. Tip  You save information in a field by entering it into the corresponding text box. Outlook saves the information you enter as data attached to the message, and uses it in various ways. Some types of fields have special rules attached that affect the appearance of the data in the field. For example, telephone number fields in contact records automatically format the numbers you enter to match a standard (123) 456-7890 format. ● Message body  Is the area in which you create message content. The message
 
 body can include text, images, tables, charts, screen clippings, hyperlinks, and other types of content. An e-mail message created in Outlook 2010 can include virtually any element that you can insert into a standard electronic document, such as a Microsoft Word document. ● People Pane  Displays information about the intended message recipients. Clicking
 
 a person’s icon displays information in the expanded People Pane about previous communications with that person. See Also  For more information about the message header, message body, and People Pane, see “Creating and Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 When opened from a message composition window, the Backstage view, which you access by clicking the File tab, includes commands related to message management tasks, such as saving message and message attachments and closing, restricting permissions to, moving, resending, recalling, and printing messages.
 
 40    Chapter 2  Explore the Outlook Windows
 
 The Backstage view of a message composition window.
 
 Commands on the ribbon of a message composition window are organized on five tabs: ● Message  This tab includes a selection of the commands you are most likely to use
 
 when creating a new message, some of which are also available on other ribbon tabs. Specific to the Message tab are commands for inserting and validating e-mail addresses, marking an outgoing message for follow-up, indicating the importance of an outgoing message to the message recipient, and magnifying the message content.
 
 The Message tab of the message composition window ribbon. ● Insert  This tab includes commands that are standard to all item-creation windows,
 
 for attaching items such as files and contact cards to the message, and for inserting specialized content such as e-mail signatures, tables, images, links, and artistic text into the body of the message. In addition to the standard commands, the Insert Calendar command is available in the Include group on the Insert tab of the message composition window ribbon.
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 The Insert tab of the message composition window ribbon. ● Options  This tab includes commands that are specific to the message composition
 
 window, for applying thematic formatting to message content, displaying lessfrequently used address fields in the message header, and setting specialized message delivery options.
 
 The Options tab of the message composition window ribbon. ● Format Text  This tab includes commands that are standard to all item-creation
 
 windows, for manipulating and formatting characters and paragraphs; applying and working with Quick Styles and style sets; and finding, replacing, and selecting text and objects within a text box. In addition to the standard commands, commands for changing the message format are available in the Format group on the Format Text tab of the message composition window ribbon.
 
 The Format Text tab of the message composition window ribbon. See Also  For information about inserting various types of illustrations, see Chapter 10, “Enhance Message Content.” For information about setting permissions, tracking messages, and other options, see “Changing Message Settings and Delivery Options” in that same chapter. For information about formatting fonts and using styles, see “Personalizing the Appearance of Message Text” in the same chapter. ● Review  This tab includes commands that are standard to all item-creation windows,
 
 for working with the language of the message body, including checking spelling and grammar; researching word choices; tracking message content statistics (pages, words, characters, paragraphs, and lines); and translating content either directly or through an online service.
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 The Review tab of the message composition window ribbon. Tip  Depending on the programs you have installed on your computer, tabs and groups other than those described here might also appear on the ribbon.
 
 Message Reading Windows When you’re working with a sent or received message, you work in a message reading window. Message header
 
 Message body
 
 People Pane
 
 A message reading window.
 
 The message reading window interface includes the following elements: ● Quick Access Toolbar  Provides access to the window-management menu (repre-
 
 sented by a Received Message icon) and the same commands as it does in the message composition window. The Previous Item and Next Item buttons are active. ● Ribbon  Includes the File tab and a Message tab that contains a set of commands
 
 different from the commands on the Message tab in a message composition window.
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 ● Message header  Displays the name and online status (if available) of the message
 
 sender and message recipients (those entered in the To and Cc boxes), along with the message subject and any message notifications, categories, or flags. ● Message body  Displays the content of the message. You cannot edit message
 
 content in a message reading window (but you can copy content from the message reading window to paste into another Office document). ● People Pane  Displays information about the message sender and the message
 
 recipients, including you. When opened from a message reading window, the Backstage view includes the Set Permissions, Move To Folder, and Properties commands that are available from the message composition window, as well as commands related to viewing delivery reports and recalling and resending the message.
 
 The Backstage view of a message reading window.
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 See Also  For information about the Print commands and options, see “Printing Messages” in Chapter 7, “Organize Your Inbox.” For information about moving Outlook items, see “Organizing Messages in Folders” in the same chapter. For information about setting advanced options and properties for a message, see “Changing Message Settings and Delivery Options” in Chapter 10, “Enhance Message Content.” For information about restricting recipients from forwarding, copying, or printing messages you send, see “Securing Your E-Mail” in Chapter 11, “Manage E-Mail Settings.”
 
 Commands on the ribbon of a message reading window are organized on one tab: the Message tab. This tab includes commands for working with the active message, including deleting, responding to, moving, tagging, editing, and viewing it. The Message tab also includes the Quick Steps gallery of command combinations that enable you to accomplish multiple tasks with one click.
 
 The Message tab of the message reading window ribbon. See Also  For information about Quick Steps, see “Managing Messages by Using Quick Steps” in Chapter 7, “Organize Your Inbox.” For information about the elements of the ribbon in Outlook item windows, see “Working in the Calendar Module,” “Working in the Contacts Module,” and “Working in the Tasks Module,” later in this chapter.
 
 In this exercise, you’ll take a tour of the window-management tools and contentmanagement tools in a message composition window. Along the way, you’ll learn to work with commands on the ribbon, on the Quick Access Toolbar, and in the Backstage view. SET UP  You don’t need any practice files to complete this exercise. Display your Outlook Inbox, and then follow the steps.
 
 
 
 1. On the Home tab, in the New group, click the New E-mail button. Keyboard Shortcut  Press Ctrl+Shift+M to create a message.
 
 An untitled message window opens, with the cursor in the To box.
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 You can compose and send any standard e-mail message by using only the commands available on the Message tab. Tip  Only the buttons for commands that can be performed on the currently selected message element are active.
 
 
 
 2. Click to insert the cursor in the message body. Additional commands on the ribbon become active.
 
 
 
 3. On the Message tab, review the available commands. Commands are organized into six groups: Clipboard, Basic Text, Names, Include, Tags, and Zoom.
 
 
 
 4. In the lower-right corner of the Clipboard group, click the dialog box launcher. The Microsoft Office Clipboard task pane display cut and copied content.
 
 The Clipboard task pane displays content cut or copied from any Office application.
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 The Clipboard is shared by the Office 2010 applications installed on your computer and might display content cut or copied from Outlook or from programs such as Word, Excel, or PowerPoint. The content source is indicated by the program icon preceding the content clip. Tip  You can control when and where Clipboard elements are displayed by selecting from the list that appears when you click Options at the bottom of the task pane.
 
 
 
 5. If the Clipboard contains clippings that you don’t need, click Clear All. You can remove all clippings from the Clipboard by using this command.
 
 
 
 6. In the message body, type Please respond to me as soon as possible by e-mail, phone, or fax. Select the text you entered, and then on the Message tab, in the Clipboard group, click the Cut button. The text moves from the message body to the Clipboard and is now available to paste into a text field of any Outlook item or into any other type of Office document.
 
 
 
 7. Point to the clipped text, and then click the arrow that appears. A short menu of actions you can take with the selected clipping appears.
 
 You can insert and remove all clippings by clicking Paste All or Clear All, or individual clippings by pointing to the item, clicking the arrow, and then clicking a command.
 
 
 
 8. On the clipping menu, click Paste. The text reappears in the message body but remains available on the Clipboard for later reuse. Tip  When you paste text into a message, the Paste Options button appears at the lower-right corner of the pasted text. Clicking this button displays the Paste Options menu, from which you can choose to keep the original formatting of the pasted text, match the format of the text into which you pasted, and set other paste options.
 
 
 
 9. In the upper-right corner of the Clipboard task pane, click the Close button. 10. In the message body, select the inserted text.
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 11. On the Message tab, in the Basic Text group, click the Font arrow, and then in the Font list, click Arial Rounded MT Bold. The text changes to the selected font.
 
 
 
 12. In the Basic Text group, click the Grow Font button, and then click the Center button. The font size increases from 11 points to 12 points, and the paragraph containing the sentence moves to the horizontal center of the message content pane.
 
 
 
 13. Point to the other buttons in the Basic Text group, and note their functionality
 
 as described in the ScreenTips that appear. Then click the Basic Text dialog box launcher. The Font dialog box opens, displaying the Font page, which contains many additional font-formatting commands.
 
 The Font dialog box includes settings that aren’t available from the Basic Text group on the Message tab. Tip  You can’t format the content of the message header fields.
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 14. In the Font dialog box, click the Advanced tab. The second page of the dialog box appears. From the Advanced page, you can control character spacing and specific font characteristics.
 
 The preview box demonstrates the effect of the currently selected font-formatting options.
 
 
 
 15. In the lower-left corner of the dialog box, click Text Effects. The Format Text Effects dialog box opens.
 
 
 
 16. In the left pane of the Format Text Effects dialog box, click Shadow. The Shadow page of the Format Text Effects dialog box includes many options for adding standard and custom shadows to characters.
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 The Text Effects settings include many advanced options that add dimension to characters.
 
 
 
 17. Click the Presets button, and then click the first shadow setting in the Outer
 
 
 
 18. Click the Color button, and then in the Standard Colors section, click the Red
 
 section (Offset Diagonal Bottom Right).
 
 square. Then in the Format Text Effects dialog box, click Close.
 
 The Preview box displays the effects of the selected Text Effects options on the current text.
 
 
 
 19. Click the Font tab of the Font dialog box, and in the Effects section, select the Small caps check box. Then click OK.
 
 The message text changes to reflect your selected text formatting options.
 
 
 
 20. With the newly formatted text still selected, click the Clipboard dialog box launcher. The Clipboard task pane opens. It now contains both the original, unformatted text and the newly formatted version.
 
 50    Chapter 2  Explore the Outlook Windows
 
 You can store multiple versions of the same text on the Clipboard.
 
 
 
 21. Close the Clipboard task pane. Then explore the other commands on the Message tab and on the Insert, Options, Format Text, and Review tabs.
 
 Many of the commands available on these tabs are also available from the Message tab. We work with these commands later in this chapter and throughout this book.
 
 
 
 22. At the right end of the ribbon, click the Minimize the Ribbon button. The ribbon collapses so that only the tabs are visible.
 
 
 
 23. On the Quick Access Toolbar, click the Undo button. The formatting you applied from the Text Effects dialog box is reverted.
 
 
 
 24. Click the Format Text tab one time, and then in the Font group, click the Clear Formatting button.
 
 The text reverts to its original font and size, and the Format Text tab returns to its minimized state. Tip  Clicking a tab on the minimized ribbon temporarily expands it so that you can perform a single command. You can collapse the ribbon without performing a command by clicking anywhere away from it or by pressing Esc. Either doubleclicking a tab or clicking the Expand The Ribbon button permanently restores the ribbon to its maximized state.
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 25. On the minimized ribbon, click the File tab. The Backstage view opens and displays the Info page, which contains information about the current message, such as its location (the Drafts folder) and size.
 
 
 
 26. In the left pane, click Close. Outlook prompts you to save or discard the draft message. See Also   For information about message drafts, see “Creating and Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 
 
 27. In the Microsoft Outlook message box, click No. The message window closes. CLEAN UP  Open a new message window, click the Expand The Ribbon button, and then close the message window to reset the ribbon to its default state before continuing to the next exercise.
 
 Working in the Calendar Module The Calendar module is displayed when you click Calendar in the Navigation Pane.
 
 Calendar Module Content In the Calendar module, the Navigation Pane displays the Date Navigator and a list of calendars that you can use. The list might include only the default Outlook Calendar, or it might include custom calendars you create, calendars that are shared with you by other Outlook users, and Internet Calendars or SharePoint Calendars that you connect to. Tip  If only the standard Outlook calendar is available, the Calendar icon appears next to it in the Navigation Pane rather than a check box. This ensures that at least one calendar is always selected for display in the Calendars module.
 
 We refer to the center pane that displays content in the Calendar module as the Calendar pane. The Calendar pane displays your calendar for a period of time that you select. The default time period is one day; however, you might find it more useful to have an overview of a longer period of time such as a week or a month.
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 There are four standard Calendar module views: ● Normal  In this view, the Navigation Pane is maximized, the To-Do Bar is turned off,
 
 and the Daily Task List is displayed below the calendar. ● Calendar And Tasks  In this view, the Navigation Pane is minimized, the To-Do Bar
 
 is turned off, and the Daily Task List is displayed below the calendar. ● Calendar Only  In this view, the Navigation Pane is minimized and the To-Do Bar
 
 and Daily Task List are turned off. ● Classic  In this view, the Navigation Pane and To-Do Bar are maximized and the
 
 Daily Task List is turned off. The ribbon in the Calendar module includes the File tab and the four standard module tabs: ● Home  This tab includes the commands you need to create calendar items, display
 
 specific views of the calendar, manage other calendars and calendar groups, and share the calendar with other people.
 
 The Home tab of the Calendar module ribbon. See Also  For information about calendar views, see “Displaying Different Views of a Calendar” in Chapter 5, “Manage Scheduling.” ● Send/Receive  This tab includes commands for synchronizing Outlook with your
 
 e-mail accounts. This set of commands is common to the Send/Receive tab in all modules.
 
 The Send/Receive tab of the Calendar module ribbon. ● Folder  This tab includes commands for creating and working with calendars. From
 
 this tab, you can create a new calendar, manipulate an existing calendar, share a calendar with other Outlook users and specify what each user can do with the shared calendar, open a calendar that you’re not currently connected to, and control the behind-the-scenes behavior of a calendar.
 
 Working in the Calendar Module   53
 
 
 
 The Folder tab of the Calendar module ribbon. See Also  For information about creating calendars, see “Working with Multiple Calendars” in Chapter 8, “Manage Your Calendar.” ● View  This tab includes commands for viewing and arranging calendar items,
 
 changing the layout and appearance of the Calendar module, displaying missed reminders, opening multiple calendars in separate windows, and closing all open calendar item windows.
 
 The View tab of the Calendar module ribbon.
 
 Calendar Item Windows We refer to the window in which you create or respond to an appointment as the appointment window, to a meeting as the meeting window, and to an event as the event window; collectively we refer to these windows as the calendar item windows. Like the message windows, the calendar item windows contain their own commands arranged on the ribbon. The calendar item window interface includes the Quick Access Toolbar, the ribbon, and the content area that displays the appointment, message, or event information. When opened from a calendar item window, the Backstage view includes commands related to managing tasks, such as saving tasks and task attachments and closing, moving, and printing tasks. Tip  The commands available in the Backstage view of a calendar item window are identical to those in the Backstage view of a contact record window. For more information, see “Working in the Contacts Module” later in this chapter.
 
 Commands on the ribbon of a calendar item window are organized on four tabs: a main tab specific to the type of calendar item and the Insert, Format Text, and Review tabs. The latter three tabs are identical to those of other item windows.
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 The commands you use to create and manage appointments are available on the main tab. The tab name changes depending on the type of item you’re creating and whether you invite other people to attend. Regardless of the tab name, commands are organized on the main tab in six groups: Actions, Show, Attendees, Options, Tags, and Zoom. You can create a calendar item by using only the commands available on this tab. In this exercise, you’ll take a tour of the calendar item window elements that differ from the message windows discussed earlier in this chapter. You’ll also learn about the differences between the types of calendar items. SET UP  You don’t need any practice files to complete this exercise; just follow the steps.
 
 
 
 1. In the Navigation Pane, click the Calendar button. Keyboard Shortcut  Press Ctrl+2 to display the Calendar module.
 
 The Calendar module opens. The Calendar pane displays the calendar associated with your default e-mail account. Date Navigator
 
 Available calendars
 
 30-minute time scale
 
 Daily Task List
 
 The Outlook program window displaying the Calendar module in Normal view.
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 2. On the Home tab, in the New group, click the New Appointment button. Keyboard Shortcut  Press Ctrl+N to create an appointment from within the Calendar module. Press Ctrl+Shift+A to create an appointment from any Outlook module.
 
 An untitled appointment window opens with the Appointment tab active. Content pages
 
 The Appointment page of an appointment window.
 
 
 
 3. On the Appointment tab, in the Attendees group, click the Invite Attendees button. The appointment window changes to a meeting window, and the Appointment tab is replaced by the Meeting tab.
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 The Appointment page of a meeting window. Tip  The Insert, Format Text, and Review tabs of the calendar item windows contain the same commands as they do in other types of item windows.
 
 The meeting request header includes a To field in addition to the Subject and Location fields present in the Appointment and Event windows. You can invite attendees by entering them in the To field, by clicking the To button and selecting them from an address list, or by entering them in the All Attendees list of the Scheduling Assistant.
 
 
 
 4. Enter one or more contact names or e-mail addresses in the To box. Then on the Meeting tab, in the Show group, click the Scheduling Assistant button.
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 The meeting window displays information about the available time of the requested meeting attendees.
 
 The Scheduling Assistant page of a meeting window.
 
 
 
 5. Familiarize yourself with the information in the Scheduling Assistant. Then close the meeting window.
 
 
 
 6. On the Home tab of the Calendar module, in the New group, click New Items, and then click All Day Event.
 
 An untitled event window opens with the Event tab active.
 
 58    Chapter 2  Explore the Outlook Windows
 
 The Appointment page of an event window. Tip  You can also open an Event window by selecting the All Day Event check box in the header of an appointment window.
 
 The Event tab contents are nearly identical to the Appointment tab contents—the only change is that on the Event tab, in the Options group, your time is shown as Free by default rather than Busy, and the reminder is set to display 18 hours prior to the event rather than 15 minutes. Tip  You can invite people to an event in the same way you do to a meeting, by clicking the Invite Attendees button from within an event window.
 
 
 
 7. In the Start time area, clear the All day event check box to change the event to an appointment.
 
 
 
 8. On the Appointment tab, in the Options group, click the Time Zones button.
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 A new field displaying the time zone for each of the start and end times appears. With this useful Outlook 2010 feature, you can schedule an appointment that crosses time zones—for example, a flight from Los Angeles to New York. See Also  For more information about displaying more than one time zone in your calendar, see “Configuring Time Zones” in Chapter 8, “Manage Your Calendar.”
 
 
 
 9. Display the Backstage view, and then click Options. The Outlook Options dialog box opens, displaying the Calendar page.
 
 The top half of the Calendar page of the Outlook Options dialog box.
 
 
 
 10. Note the types of customizations you can make in the Work time and Calendar options areas. Then scroll to the bottom of the page.
 
 Additional Calendar module features that you can customize are displayed.
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 The bottom half of the Calendar page of the Outlook Options dialog box.
 
 
 
 11. Note the types of customizations you can make in the Display options, Time
 
 zones, Scheduling assistant, and Resource scheduling areas. Then click Cancel to return to the appointment window.
 
 CLEAN UP  Click the Time Zones button to hide the time zone settings, if you don’t want to display them. Then close the appointment window without saving your changes.
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 Working in the Contacts Module The Contacts module is displayed when you click Contacts in the Navigation Pane.
 
 Contacts Module Content In the Contacts module, the Navigation Pane displays your available address books. The Contacts and Suggested Contacts address books appear by default, along with any custom address books you create and address books shared with you by co-workers. We refer to the center pane that displays content in the Contacts module as the Contacts pane. The Contacts pane displays the contact records saved in the selected address book. By default, the contact records are displayed as business cards, but you can choose among several standard views, including text-only cards and various lists. There are three standard Contacts module views: ● Normal  In this view, the Navigation Pane and To-Do Bar are maximized. ● Cards Only  In this view, the Navigation Pane and To-Do Bar are minimized. ● No To-Do Bar  In this view, the Navigation Pane is maximized and the To-Do Bar
 
 is minimized. The ribbon in the Contacts module includes the File tab and the four standard module tabs: ● Home  This tab includes the commands you need to create, manage, and view con-
 
 tact records, and to initiate communication with contacts. You can select contacts for a mail-merge process, send contact information to Microsoft OneNote, share contacts with other Outlook users, and tag contact records in ways that enable you to better locate or manage them.
 
 The Home tab of the Contacts module ribbon.
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 ● Send/Receive  This tab is identical to that in the Calendar and Tasks modules.
 
 The Send/Receive tab of the Contacts module ribbon. ● Folder  This tab provides the same functionality as it does in the Calendar and
 
 Tasks modules, but is specific to contact records.
 
 The Folder tab of the Contacts module ribbon. ● View  This tab provides the same functionality as it does in the Mail and Tasks
 
 modules. The content of the Arrangement gallery is specific to contact records.
 
 The View tab of the Contacts module ribbon. Tip  The Arrangement commands are available only when you display contact records in a list view.
 
 Contact Record Windows When you create a contact record or display the contact record for a person or group of people, it opens in a contact record window. The contact record window has its own ribbon and Quick Access Toolbar, separate from those in the Outlook program window and other types of item windows. You can insert, format, and work with information in a contact record or contact group record by using the commands on the contact record window ribbon.
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 Content pages
 
 Category lists
 
 Business card preview
 
 Formattable notes
 
 A new contact record window.
 
 The contact record window interface includes the Quick Access Toolbar, the ribbon, and the People Pane, as well as the content area that displays the contact record information. Tip  Throughout this book, we frequently refer to people whose contact information you have stored in Outlook as contacts.
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 When opened from a contact record window, the Backstage view includes commands related to managing contact records, such as saving contact records and contact record attachments and closing, moving, and printing contact records. Record-specific management commands
 
 Record-specific Backstage view pages
 
 The Backstage view of a contact record window.
 
 Commands on the ribbon of a contact record window are organized on four tabs: ● Contact  This tab includes commands that are specific to managing and working
 
 with contact records. Commands include those for managing the contact record, switching among the contact record pages, communicating with the contact, accessing and verifying saved contact information, and personalizing a contact’s electronic business card. This tab also includes commands for assigning a category or follow-up flag to a contact record, preventing other Outlook users from viewing the contact record when connected to your account, and changing the magnification level of the Notes pane (not of the contact record window).
 
 The Contact tab of the contact record window ribbon.
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 Tip  The contact record–management commands are available on only the Contact tab. ● Insert  This tab includes the same standard commands as the Insert tab of a
 
 message composition window ribbon. The commands on the Insert tab of the contact record window ribbon, other than those in the Include group, apply only to the content of the Notes pane.
 
 The Insert tab of the contact record window ribbon. See Also  For information about inserting various graphic elements, see Chapter 10, “Enhance Message Content.” ● Format Text  This tab includes the same standard commands as the Format Text
 
 tab of a message composition window ribbon. The commands on the Format Text tab of the contact record window ribbon, other than the Paste commands and the Select command, apply only to the content of the Notes pane.
 
 The Format Text tab of the contact record window ribbon. ● Review  This tab includes the same standard commands as the Review tab of a mes-
 
 sage composition window ribbon. The commands on the Review tab of the contact record window ribbon, other than the Research and Thesaurus commands, apply only to the content of the Notes pane.
 
 The Review tab of the contact record window ribbon.
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 In this exercise, you’ll familiarize yourself with the types of information you can store in a contact record and the customizations you can make to the way Outlook manages contact records. SET UP  You don’t need any practice files to complete this exercise; just follow the steps.
 
 
 
 1. In the Navigation Pane, click the Contacts button. Keyboard Shortcut  Press Ctrl+3 to display the Contacts module. Tip  If you want to work in two modules at the same time, you can open a module in a second instance of Outlook by right-clicking the module button in the Navigation Pane and then clicking Open In New Window.
 
 The Contacts module opens. The content pane, which in the Contacts module is called the Contacts pane, displays your main address book, with any contact records it contains displayed as business cards. Alphabet bar
 
 International alphabets
 
 The Outlook program window displaying the Contacts module in Normal view. Troubleshooting  If the contact records in your Contacts module aren’t presented like those shown here, click Business Card in the Current View gallery on the Home tab.
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 Tip  Clicking a letter or letter pairing on the alphabet bar scrolls the Contacts pane to display contact records beginning with that letter. You can add a second alphabet bar that displays the Arabic, Cyrillic, Greek, Thai, or Vietnamese alphabet by clicking the International Contacts button and then clicking the language you want.
 
 
 
 2. On the Home tab, in the New group, click the New Contact button. Keyboard Shortcut  Press Ctrl+N to create a contact record from within the Contacts module. Press Ctrl+Shift+C to create a contact record from any Outlook module.
 
 A new, blank contact record window opens, displaying the General page of the contact record. The cursor is automatically active in the Full Name box, so you can immediately begin entering a contact’s information.
 
 The General page of a contact record window. Tip  An arrow to the right of a field name indicates that the displayed field is one of a group of related fields that you can display in that location, one at a time. For example, the arrow next to the e-mail name indicates that there are multiple e-mail address fields; clicking the arrow displays a list. Clicking a field in the list displays it in place of the previous related field.
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 The Contact tab is active by default. Buttons that represent commands related to creating and working with contact records are organized on this tab in seven groups: Actions, Show, Communicate, Names, Options, Tags, and Zoom. We work with most of these commands in the exercises in Chapter 4, “Store and Access Contact Information.”
 
 
 
 3. On the Contact tab, in the Show group, click Details. The Details page appears in the content pane of the contact record window.
 
 The Details page of a contact record window.
 
 
 
 4. In the Show group, click Activities. Then on the Activities page, click the Show arrow. Outlook displays the types of activities it tracks for each contact.
 
 The Activities page of a contact record window.
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 5. In the Show group, click Certificates. The Certificates page appears. This page displays digital IDs that are installed on your computer, and commands for managing digital IDs.
 
 The Certificates page of a contact record window. See Also  For information about digital IDs, see “Securing Your E-Mail” in Chapter 11, “Manage E-Mail Settings.”
 
 
 
 6. In the Show group, click All Fields. The All Fields page of the contact record window appears. The default view displays custom fields that you define yourself, none of which are present in the default contact record window. See Also  For information about defining custom fields, see the sidebar “User-Defined Fields” in Chapter 4, “Store and Access Contact Information.”
 
 
 
 7. Click the Select from arrow, and scroll the list to note the many categories on which you can filter the information displayed on the All Fields page. Then in the Select from list, click Phone number fields. The All Fields page is filtered to display all the phone numbers that might be included in this contact record.
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 The All Fields page of a new contact record, displaying all available fields that are formatted to contain phone numbers.
 
 You can enter information into fields directly on the All Fields page of a contact record by clicking in the Value cell for the field, and then typing the associated entry.
 
 
 
 8. In the Show group, click General to return to the primary page of the contact record window.
 
 
 
 9. In the Communicate group, click More. The More list expands to display types of communication you can initiate with a contact from his or her contact record.
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 From a contact record, you can initiate many types of electronic communication. Keyboard Shortcut  Press Ctrl+F to create a message with the selected contact as the subject. Press Ctrl+Shift+X to send a fax to the selected contact. Tip  Many of these communication options are available from the Contact Card that appears when you point to a contact in a message recipient box, or on the context menu that appears when you right-click a contact record in an address book.
 
 
 
 10. Click to position the cursor in the Notes box of the contact record. Then click the Insert, Format Text, and Review tabs in turn to see the available commands. Tip  Many commands on the Insert, Format Text, and Review tabs of a contact record window are unavailable when the cursor is located anywhere other than in the notes pane.
 
 The commands on these tabs are identical to those in the message window.
 
 
 
 11. Display the Backstage view, and then click Options. The Outlook Options dialog box opens, displaying the Contacts page.
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 The Contacts page of the Outlook Options dialog box.
 
 
 
 12. Note the types of changes you can make to the functionality of the Contacts module. Then in the Outlook Options dialog box, click Cancel.
 
 The dialog box closes and Outlook returns to the contact record window. See Also  For information about changing the default settings for the Contacts module, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 
 
 13. Display the Backstage view, and click Close. Then in the Microsoft Outlook message box that asks whether you want to save changes, click No.
 
 By clicking Close in the Backstage view or on the Outlook menu that opens when you click the Outlook icon at the left end of the title bar, or by clicking the Close button at the right end of the title bar, you have the option to not save changes to the contact record. Clicking the Save & Close button in the Actions group on the Contact tab saves the contact record without further prompting. CLEAN UP  If you created a contact record while experimenting in the contact record window that you don’t want to keep, right-click the contact record in the Contacts pane, and then click Delete.
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 Working in the Tasks Module The Tasks module is displayed when you click Tasks in the Navigation Pane.
 
 Tasks Module Content The Navigation Pane in the Tasks module displays the task list variations you can display in the content pane, including the To-Do List and Tasks folder created by Outlook, as well as any custom folders you create to contain task items. We refer to the center pane that displays content in the Tasks module as the Tasks pane. The Tasks pane displays either the To-Do List or a Tasks List. ● The To-Do List is displayed by default. This list of tasks is organized by default in
 
 groups by due date. When the To-Do List is displayed, by default the Reading Pane is also displayed. ● A Tasks List is displayed in multiple columns with each task preceded by a check box
 
 so that you can indicate when the task is complete. When a Tasks List is displayed, by default the Reading Pane is hidden. There are two standard Tasks module views: ● Normal  In this view, the Navigation Pane and To-Do Bar are maximized. ● Reading  In this view, the Navigation Pane, To-Do Bar, and ribbon are minimized.
 
 The ribbon in the Tasks module includes the File tab and the four standard module tabs: ● Home  This tab includes the commands you need to create, manage, and view tasks,
 
 and to initiate communication with contacts. You can assign tasks to coworkers and work with tasks assigned to you, send task information to a OneNote notebook, and tag tasks in ways that enable you to better locate or manage them.
 
 The Home tab of the Tasks module ribbon.
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 ● Send/Receive  This tab is identical to that of the Calendar and Contacts modules.
 
 The Send/Receive tab of the Tasks module ribbon. ● Folder  This tab provides the same functionality as it does in the Calendar and
 
 Contacts modules, but is specific to task items.
 
 The Folder tab of the Tasks module ribbon. Tip  The Actions commands are available only when you select a custom folder (a folder that you create, rather than the To-Do List or Tasks folders created by Outlook). ● View  This tab provides the same functionality as it does in the Mail and Contacts
 
 modules. The content of the Arrangement gallery is specific to tasks.
 
 The View tab of the Tasks module ribbon.
 
 Task Windows The window in which you create or manage a task is a task window. Like the message, contact record, and calendar item windows, the task window includes the Quick Access Toolbar, a unique set of commands arranged on the ribbon, and the content area that displays the task information.
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 Content pages
 
 A new task window.
 
 When opened from a task window, the Backstage view includes commands related to managing tasks, such as saving tasks and task attachments and closing, moving, and printing tasks. Tip  The commands available in the Backstage view of a task window are identical to those in the Backstage view of a contact record window. For more information, see “Working in the Contacts Module” earlier in this chapter.
 
 Commands on the ribbon of a task window are organized on four tabs: The Task tab and the Insert, Format Text, and Review tabs. The latter three tabs are identical to those of other item windows. The commands you use to create and manage most tasks are available on the Task tab. Commands include those for managing the task, sending the task to a OneNote notebook, switching among the task pages, and managing task assignments and frequency. This tab also includes commands for assigning a category or follow-up flag to a task, preventing other Outlook users from viewing the task details when connected to your account, and changing the magnification level of the Notes pane (not of the task window).
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 In this exercise, you’ll take a tour of the Tasks module and look at features in the task window that differ from those in the message, contact record, and calendar item windows. SET UP  You don’t need any practice files to complete this exercise; just follow the steps.
 
 
 
 1. In the Navigation Pane, click the Tasks button. The Tasks module opens, displaying the To-Do List view of your task list. To-Do Bar Task List
 
 The Outlook program window displaying the Tasks module in Normal view.
 
 If the To-Do Bar is expanded, you can see the contents of your task list in the To-Do Bar Task List as well as in the Tasks pane. If the To-Do Bar is minimized, the number of active tasks due today appears on the minimized To-Do Bar.
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 2. On the Home tab, in the New group, click the New Task button. An untitled task window opens. Keyboard Shortcut  Press Ctrl+N to create a task from within the Tasks module. Press Ctrl+Shift+K to create a task from any Outlook module.
 
 
 
 3. Familiarize yourself with the fields in the task window. The Subject field is the only field in which you must enter text to create a task. If you enter an end date, Outlook adds the task to the appropriate Due Date category (Today, Tomorrow, This Week, Next Week, or a custom category based on the date). Leaving the Due Date set to None adds the task to the No Date category. Tip  You can easily move a task to a different Due Date category by clicking the task in the To-Do List, tasks list, or To-Do Bar, and then clicking the timeframe you want in the Follow Up group on the Home tab of the Tasks module.
 
 
 
 4. On the Task tab, in the Show group, click the Details button. The Details page appears in the content pane of the task window.
 
 The Details page of a task window.
 
 Notice the type of information you can track on the Details page. This could be useful when tracking billable tasks for clients.
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 5. Display the Backstage view, and then click the Options button. The Outlook Options dialog box opens, displaying the Tasks page.
 
 The Tasks page of the Outlook Options dialog box. See Also  For information about the commands available in the Outlook Options dialog box, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 
 
 6. Familiarize yourself with the customizations you can make to the way Outlook manages tasks. Then click Cancel to return to the task window.
 
 CLEAN UP  Close the task window.
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 Key Points ● The Outlook program window includes eight areas in which you work with Outlook
 
 or with your Outlook items: the title bar, the ribbon, the Navigation Pane, the content pane, the Reading Pane, the To-Do Bar, and the status bar. ● You give commands from the ribbon and from the Quick Access Toolbar. ● The program window and each type of item window have individually configurable
 
 ribbons and Quick Access Toolbars, so you can make the commands you want available specifically where you want them. ● The different item windows share certain common tabs, but each has a main tab
 
 containing all the commands you need when creating or working with a basic Outlook item of that type.
 
 Chapter at a Glance Create and send messages, page 82 Attach files to messages, page 99
 
 View messages and message attachments, page 102
 
 View message participant information, page 114
 
 3 Send and Receive E-Mail Messages In this chapter, you will learn how to ✔ Create and send messages. ✔ Attach files to messages. ✔ View messages and message attachments. ✔ Configure Reading Pane behavior. ✔ View message participant information. ✔ Respond to messages.
 
 Although Microsoft Outlook 2010 helps you manage your calendar, contacts, tasks, and notes, the primary reason most people use Outlook is to send and receive e-mail messages. Over the past decade, e-mail (short for electronic mail) has become an accepted and even required form of business communication. And of course, many people use e-mail to keep in touch with friends and family, either from work or from home. Outlook makes it easy to connect to multiple e-mail accounts, either on a business network or over the Internet, and provides all the tools you need to send, respond to, organize, filter, sort, find, and otherwise manage e-mail messages. Tip  In this chapter and throughout this book, for expediency’s sake, we sometimes refer to e-mail messages simply as messages. When referring to other types of messages we use full descriptions such as instant messages or text messages.
 
 When sending messages from Outlook, you can format the text to suit your preferences, and include attachments such as documents, workbooks, and images. You can also personalize your message in these ways: ● Embed images, business graphics, and automatic signatures. ● Set message options such as voting buttons, importance, sensitivity, and reminders. ● Request electronic receipts when a message is delivered or opened. See Also  For information about personalizing messages and setting message options, see Chapter 10, “Enhance Message Content.”    81
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 Outlook 2010 has several fancy new features that make it easy to display and track information about the people you correspond with. These features include presence icons that indicate whether a person is currently online, contact cards that appear when you point to a name in an e-mail message, and the People Pane at the bottom of the message window. In this chapter, you’ll create, send, and view messages, with and without attachments. You’ll view information about message participants. Then you’ll reply to and forward messages. Practice Files  Before you can complete the exercises in this chapter, you need to copy the book’s practice files to your computer. The practice files you’ll use to complete the exercises in this chapter are in the Chapter03 practice file folder. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book. Important  You’ll use the messages you create in this chapter as practice files for exercises in later chapters of this book.
 
 Creating and Sending Messages Creating an e-mail message is a relatively simple process. The only information that is absolutely required is the recipient’s e-mail address; however, you will usually provide information in the following fields: ● To  Enter the e-mail address of the primary message recipient(s) in this field.
 
 This is the only field that is absolutely required to send a message. ● Subject  Enter a brief description of the message contents or purpose in this field.
 
 The subject is not required, but it is important to provide information in this field, both so that you and the recipient can identify the message and so that the message isn’t blocked as suspected junk mail by a recipient’s e-mail program. Outlook will warn you if you try to send a message with no subject. ● Message body  Enter your message to the recipient in this field, which is a large
 
 text box. You can include many types of information including formatted text, hyperlinks, and graphics in the message body.
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 Addressing Messages Addressing an e-mail message is as simple as inserting the intended recipient’s e-mail address into an address box in the message header of a message composition window. You can enter e-mail recipients into any of three address boxes: ● To  This address box is for primary message recipients. Usually, these are the people
 
 you want to respond to the message. Each message must have at least one address in the To box. ● Cc  This address box is for “courtesy copy” recipients. These are usually people you
 
 want to keep informed about the subject of the e-mail message but from whom you don’t require a response. ● Bcc  This address box is for “blind courtesy copy” recipients. These are people you
 
 want to keep informed but whom you want to keep hidden from other message recipients. Bcc recipients are not visible to any other message recipients and therefore aren’t included in message responses unless specifically added to one of the address boxes in the response message. Tip  The Bcc address box is not displayed by default. You can display it in the message header by clicking the Bcc button, located in the Show Fields group on the Options tab of the message composition window.
 
 You can insert an e-mail address into an address box in the following ways: ● Type the entire address. ● Type part of a previously used address and then select the address from a list. ● Click the address box label to display an address book from which you can select
 
 one or more addresses. See Also  For information about address books, see “Saving and Updating Contact Information” in Chapter 4, “Store and Access Contact Information.” Tip  Responding to a received message automatically fills in one or more of the address boxes in the new message window. For information, see “Responding to Messages” later in this chapter.
 
 If your e-mail account is part of an Exchange network, you can send messages to another person on the same network by typing only his or her e-mail alias—for example, joan; the at symbol (@) and domain name aren’t required. If you type only the name of a person whose e-mail address is in your address book, Outlook associates the name with the corresponding e-mail address, a process called validating, before sending the message. Keyboard Shortcut  Press Ctrl+K to force Outlook to validate addresses. See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at the end of this book.
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 If you type only a name and Outlook cannot find that person’s e-mail address in your address book, when you send the message, Outlook prompts you to select an address book entry or provide a full e-mail address. Depending on how you enter a message recipient’s name or e-mail address into an address box, Outlook either validates the name or address immediately (if you chose it from a list of known names) or validates it when you send the message. The validation process (also known as resolving) for each name or address has one of two results: ● If Outlook successfully resolves the name or address, an underline appears below
 
 it. If the name or address matches one stored in an address book, Outlook replaces your original entry with the content of the Display As field in the contact record, and then underlines it. See Also  For information about contact record fields, see “Saving and Updating Contact Information” in Chapter 4, “Store and Access Contact Information.” ● If Outlook is unable to resolve the name or address, the Check Names dialog box
 
 opens, asking you to provide additional information.
 
 The Check Names dialog box might display No Suggestions, names that match the entry, or contact options saved in the contact record for the entered name.
 
 In the Check Names dialog box, you can do one of the following: ❍ Select from the suggested options. ❍ Click Properties to learn more about the selected option. ❍ Click Show More Names to display your address book. ❍ Click New Contact to create a new contact record in your default address
 
 book, directly from the dialog box.
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 Troubleshooting Message Addressing Outlook 2010 includes many features intended to simplify the process of addressing messages to recipients. As with any tool, these features can sometimes be more difficult to use than you’d like. In this section, we discuss troubleshooting tips for some common problems.
 
 Troubleshooting the AutoComplete Address List As you type a name or an e-mail address into the To, Cc, or Bcc box, Outlook displays matching addresses in a list below the box. You can insert a name or address from the list into the address box by clicking it or by pressing the arrow keys to select it and then pressing Tab or Enter. From time to time, you might find that the address list contains incorrect e-mail addresses— for example, if you have previously sent a message to an incorrect e-mail address, or if a person changes his or her e-mail address. If you don’t remove the incorrect address from the list, it can be easy to mistakenly accept Outlook’s suggestion and send your message to the wrong address. To clean up the AutoComplete Address list: 1. In the list, point to the name or address you want to remove. 2. Click the Delete button (the X) that appears to the right of the name or address.
 
 Troubleshooting Multiple Recipients By default, Outlook requires that you separate multiple e-mail addresses with semicolons. If you separate multiple addresses with another character such as a space or comma, or by pressing Enter, Outlook treats the addresses as one address and displays an error message when you attempt to send the message. You can instruct Outlook to accept commas as address separators, in addition to semicolons. To do this, follow these steps: 1. In the Outlook program window or any item window, display the Backstage view, and then click Options. 2. In the left pane of the Outlook Options dialog box, click Mail. 3. On the Mail page, scroll to the Send Messages section. 4. Select the Commas Can Be Used To Separate Multiple Message Recipients check box, and then click OK.
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 Troubleshooting the Address Book By default, Outlook first searches your Global Address List (the corporate directory provided with an Exchange account, if you’re working with one), then searches the contact records stored in the Contacts module of your default account and then searches the Suggested Contacts list. If an e-mail address isn’t located in one of those locations, Outlook may search other address books such as those containing contact records stored with secondary e-mail accounts or custom address books that you create. If you have multiple address books, particularly multiple address books associated with multiple accounts, Outlook does not, by default, search all of the address books and therefore might not locate an e-mail address you have saved. To change the order in which Outlook searches the address books, or to add address books to the search list, follow these steps: 1. On the Home tab of the Outlook program window, in the Find group, click Address Book. 2. In the Address Book window, on the Tools menu, click Options. The Addressing dialog box opens.
 
 From the Addressing dialog box, you can designate the order in which Outlook searches for contacts in existing address books.
 
 Creating and Sending Messages   87
 
 
 
 3. In the Addressing dialog box, click Custom. Then do any of the following: ❍ To search additional address books, click Add. Then in the Add Address List
 
 dialog box, click the address list you want to add, click Add, and click Close. ❍ To change the order in which Outlook searches the address books in the list,
 
 click an address book and then click the Move Up or Move Down button. ❍ If you’re uncertain which address book is represented by a list entry, click
 
 the address book and then click Properties to display the account name and folder name of the address book. 4. In the Addressing dialog box, click OK, and then close the Address Book window.
 
 Entering Content As long as you have an Internet connection, you can send e-mail messages to people within your organization and around the world by using Outlook, regardless of the type of e-mail account you have. Outlook can send and receive e-mail messages in three message formats: ● Hypertext Markup Language (HTML)  Supports paragraph styles (including num-
 
 bered and bulleted lists), character styles (such as fonts, sizes, colors, weight), and backgrounds (such as colors and pictures). Most (but not all) e-mail programs support the HTML format—those that don’t display HTML messages as Plain Text. ● Rich Text Format (RTF)  Supports more paragraph formatting options than HTML,
 
 including borders and shading, but is compatible only with Outlook and Microsoft Exchange Server. Outlook converts RTF messages to HTML when sending them outside of an Exchange network. ● Plain Text  Does not support the formatting features available in HTML and RTF
 
 messages but is supported by all e-mail programs. E-mail message content isn’t limited to simple text. You can create almost any type of content in an e-mail message that you can in a Word document. Because Outlook 2010 and Word 2010 share similar commands, you might already be familiar with processes for creating content such as lists and tables. You can personalize your messages by using an individual font style or color and by inserting your contact information in the form of an e-mail signature or business card. (You can apply other formatting, such as themes and page backgrounds, but these won’t always appear to e-mail recipients as you intend them to, and they can make your communications appear less professional.)
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 You can format the text of your message to make it more readable by including headings, lists, or tables, and you can represent information graphically by including charts, pictures, clip art, and other types of graphics. You can attach files to your message and link to other information, such as files or Web pages. For the purposes of this book, we assume that you know how to enter, edit, and format content by using standard Microsoft Word techniques, so we don’t discuss all of them in this book. We demonstrate many of these techniques within the step-by-step exercises, though, so keep an eye out for any new features that you aren’t yet familiar with. See Also  For extensive information about entering and editing content and about formatting content by using character and paragraph styles, Quick Styles, and Themes, refer to Microsoft Word 2010 Step by Step, by Joyce Cox and Joan Lambert (Microsoft Press, 2010). Tip  You can also personalize a message by having Outlook add a predefined e-mail signature. You can specify different signatures for new messages and for replies and forwarded messages. For example, you might want to include your full name and contact information in the signature that appears in new messages, but only your first name in the signature that appears in replies and forwarded messages. For more information about e-mail signatures, see “Personalizing the Appearance of Message Text” in Chapter 10, “Enhance Message Content.”
 
 Saving and Sending Messages At regular intervals while you’re composing a message, Outlook saves a copy of the message in the Drafts folder. This is intended to protect you from losing messages that are in progress.
 
 If you close a message composition window before sending the message, Outlook prompts you to save a draft or to save or discard the existing draft.
 
 You can save a message draft at any time by clicking the Save button on the Quick Access Toolbar in the message window.
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 To resume working on a message that’s been saved as a draft and closed, display the Mail module, click the Drafts folder in the Navigation Pane, and then double-click the message you want to work on. After you finish composing a message, you can send it by clicking the Send button located in the message header or by pressing Ctrl+Enter. The first time you press this key combination, Outlook asks you to confirm that you want to designate this as the keyboard shortcut for sending messages. When you send the message, Outlook deletes the message draft, if one exists, and stores a copy of the sent message in the Sent Items folder. Tip  Each account you access from Outlook has its own Drafts folder and its own Sent Items folder. Outlook automatically saves draft messages and sent messages in the folder affiliated with the e-mail account in which you compose or send the message. You can change the location in which Outlook saves message drafts and sent messages from the Advanced E-mail Options dialog box. For more information about this dialog box, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 In this exercise, you’ll compose an e-mail message, save an interim message draft, and then send the message. SET UP  You don’t need any practice files to complete this exercise. Display your Inbox, and then follow the steps.
 
 
 
 1. On the Home tab, in the New group, click the New E-mail button. A new message window opens. Tip  By clicking the New Items button, you can choose to create any type of Outlook item such as an appointment, contact, fax, message, note, or task, or an organizational item such as a contact group or data file, without leaving the module you’re working in.
 
 
 
 2. In the To box, type your own e-mail address. 3. In the Subject box, type SBS Tradeshow Schedule. Important  The subject of this message begins with SBS (for Step by Step) so that you can easily differentiate it from other messages in your Inbox and Sent Items folders and can delete it later.
 
 
 
 4. At the right end of the message window title bar, click the Close button. Outlook prompts you to save a message draft.
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 You can save a message that’s in progress and return to it later. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 
 
 5. In the Microsoft Outlook message box, click Yes. The message window closes. In the Navigation Pane, the number in the unread message counter to the right of the Drafts folder increases.
 
 
 
 6. In the Navigation Pane, click the Drafts folder. Your message and its current content are in this folder.
 
 A bold folder name indicates that the folder contains unread messages; the number of unread messages appears in parentheses to the right of the folder name.
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 7. In the Mail pane, double-click the message to open it for editing. 8. In the content pane, type The following people will be working at the tradeshow: and press the Enter key twice. Then type Amanda, Barry, Cory, and Doyle, pressing Enter once after each of the first three names, and twice after the fourth one. The list of names is currently unformatted.
 
 You enter text in a message the same way you do in a document.
 
 
 
 9. Select the list of names. Then on the Message tab, in the Basic Text group, click the Bullets button (not its arrow).
 
 Tip  The Bullets button and other paragraph-formatting commands are also available in the Paragraph group on the Format Text tab.
 
 Outlook converts the list of names to a simple bulleted list. Tip  In this book, when we give instructions to implement a command, we tell you on what tab and in which group the command button appears. When directing you to use multiple command buttons on the same tab, we might omit the tab name to avoid needless repetition.
 
 
 
 10. With the bulleted list still selected, in the Basic Text group, click the Bullets arrow. The Bullets gallery opens.
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 The Bullets gallery.
 
 Notice the types of bullets available in the Bullet Library section of the gallery. You can change the list to use any of these bullets by clicking the bullet you want.
 
 
 
 11. In the Bullets gallery, point to Change List Level. A menu illustrating bullets used by a multilevel list opens.
 
 The menu illustrates the appearance of a multilevel bulleted list with the current settings.
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 You can demote (or promote) a list item to any of nine levels, differentiated by the bullet character and indent level.
 
 
 
 12. Press Esc twice to close the Bullets gallery without making changes. 13. Press Ctrl+End to move the cursor to the end of the message. Type Giveaways
 
 
 
 14. On the Insert tab, in the Tables group, click the Table button.
 
 are: and then press Enter twice. The Table gallery opens.
 
 
 
 15. In the Table gallery, point to the third cell in the second row. A live preview of a three-column by two-row table appears at the cursor location in the message window.
 
 Outlook displays a preview of the effect of inserting a table with the current settings.
 
 
 
 16. Click the selected cell to insert a three-column by two-row table in the message. The Table Tools contextual tabs, Design and Layout, appear on the Ribbon.
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 17. Enter the following information in the table, pressing Tab to move between table cells: 9:00-11:00 
 
 12:00-2:00 
 
 3:00-5:00
 
 Mouse pads 
 
 T-shirts 
 
 Pens
 
 The table and table content are currently unformatted. Contextual tabs
 
 The current message content.
 
 
 
 18. With the cursor still active in the lower-right table cell, click the More button in the Table Styles gallery on the Design contextual tab.
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 The Table Styles gallery opens. A box around the Plain Tables thumbnail indicates the formatting of the active table.
 
 The Table Styles gallery.
 
 
 
 19. In the Built-In section of the Table Styles gallery, point to the third thumbnail in the second row (the table with a red header row, identified by the ScreenTip Light List – Accent 2), and then click it. Outlook displays a preview when you point to the thumbnail, and then applies the selected table style.
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 Applying a built-in table style.
 
 Notice that the default table style formats the first column as bold.
 
 
 
 20. On the Design tab, in the Table Style Options group, clear the First Column check box. The content in the first row of the table is now bold, and the content of the second row is not.
 
 
 
 21. In the message header, click the Send button. Keyboard Shortcut  Press Ctrl+Enter to send a message.
 
 Outlook closes the message window and sends the message. The message draft disappears from the Drafts folder.
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 22. In the Navigation Pane, click the Inbox folder. The received message is in this folder.
 
 The formatted message content is shown in the Reading Pane. Tip  We’re working with the To-Do Bar closed, so you can see more of the message content. To close the To-Do Bar in your Outlook program window, click the Minimize The To-Do Bar button in its upper-left corner. For more information about working with the To-Do Bar, see “Personalizing the Outlook Program Window” in Chapter 13, “Customize Outlook.”
 
 
 
 23. In the Navigation Pane, click the Sent Items folder. The sent message is in this folder. CLEAN UP  Display your Inbox. Retain the SBS Tradeshow Schedule message in your Inbox and Sent Items folders for use in later exercises.
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 Managing Multiple Accounts If you have configured Outlook to connect to multiple e-mail accounts, you need to ensure that the message is being sent from the correct account. By default, Outlook assumes that you intend to send a message from the account you’re currently working in. If you begin composing a message while viewing the Inbox of your Work account, for example, Outlook selects the Work account as the message-sending account. If you reply to a message received by your Personal account, Outlook selects the Personal account as the message-sending account. You can easily change the message-sending account. When Outlook is configured to use multiple accounts, a From button appears in the message header. Tip  If Outlook is configured to connect to only one account, you can display the From button by clicking From in the Show Fields group on the Options tab of a message composition window.
 
 Clicking the From button displays a list of active accounts from which you can choose. If the account from which you want to send the message doesn’t appear in the list, you can specify another account; however, you must have permission to send messages from that account.
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 Attaching Files to Messages A convenient way to distribute a file (such as a Microsoft Word document, Excel workbook, PowerPoint presentation, or picture) is by attaching the file to an e-mail message. Message recipients can preview or open the file from the Reading Pane, open it from the message window, forward it to other people, or save it to their computers. Tip  You can also e-mail Microsoft Office files from within the Office program you’re working in, by using commands in the Backstage view. For example, to send a Word document, open the document, display the Backstage view, click the Save & Send tab, and then click Send Using E-mail. Word offers the options of sending the document as an attached Word document, PDF file, or XPS file (Word converts the file for you before sending it), sending a link to the document (if it’s saved in a shared location), or sending the document to a fax machine.
 
 In this exercise, you’ll send a Word document and a PowerPoint presentation as attachments to an e-mail message. SET UP  You need the Brochure document and the StrategySession presentation located in the Chapter03 practice file folder to complete this exercise. Display your Inbox, and then follow the steps.
 
 
 
 1. On the Home tab, in the New group, click the New E-mail button. 2. In the To box of the new message window, type your own e-mail address. Tip  If you completed the previous exercise, Outlook displays your e-mail address in a list as you begin typing. You can insert the address by clicking it or by pressing the Down Arrow key to select it (if necessary) and then pressing Enter.
 
 
 
 3. In the Subject box, type SBS First Draft. 4. In the content pane, type Here is some information for your review. Then press Enter to move to the next line.
 
 
 
 5. On the Message tab, in the Include group, click the Attach File button. Tip  The Attach File button is also available in the Include group on the Insert tab.
 
 The Insert File dialog box opens, displaying the contents of your Documents library.
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 The Documents library displays top-level folders and files stored in your Documents folder and in the Public Documents folder. Tip  Your Insert File dialog box will reflect the contents of your own Documents library.
 
 
 
 6. Navigate to your Chapter03 practice file folder. In the Chapter03 folder, click the
 
 Brochure document, hold down the Ctrl key, click the StrategySession presentation, and then click Insert. The files appear in the Attached box in the message header.
 
 Information about file attachments is visible to the sender and to the recipient.
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 7. In the message header, click the Send button. Outlook closes the message window and sends the message. CLEAN UP  When you receive the SBS First Draft message in your Inbox, retain it for use in later exercises. Tip  If you want to send personalized copies of the same e-mail message to several people, you can use the mail merge feature of Word 2010. For more information, refer to Microsoft Word 2010 Step by Step by Joyce Cox and Joan Lambert (Microsoft Press, 2010).
 
 Troubleshooting File Types and Extensions By default, Windows does not display file extensions in Explorer windows or dialog boxes such as the Insert File dialog box. You can usually differentiate file types by their icons—for example, the blue Word icon precedes the Brochure document name, and the red PowerPoint icon precedes the StrategySession presentation name. You can display the file type as a field in specific views or as part of all file names. ● In a dialog box or Windows Explorer window, you can display the file type by
 
 clicking the Change Your View arrow on the toolbar and then clicking either Details or Tiles; each of these views includes the Type field. ● To display file extensions as part of all file names, click Organize on the
 
 toolbar of any Windows Explorer window, and then click Folder And Search Options. On the View tab of the Folder Options dialog box, clear the Hide Extensions For Known File Types check box, and then click Apply or OK.
 
 Tip  Many picture files are large, requiring a lot of bandwidth to send and a lot of storage space to receive. Instead of opening a message and then attaching a full-size picture file to it, you can send and simultaneously resize a picture by right-clicking the picture file in Windows Explorer, clicking Send To, and then clicking Mail Recipient. In the Attach Files dialog box that appears, choose from among five picture size options; the corresponding file size appears when you select a picture size. Then click Attach to open a message window in your default e-mail program.
 
 102    Chapter 3  Send and Receive E-Mail Messages
 
 Viewing Messages and Message Attachments Each time you start Outlook and connect to your e-mail server, any new messages received since the last time you connected appear in your Inbox. Depending on your settings, Outlook downloads either the entire message to your computer or only the message header, which provides basic information about the message, such as: ● The item type (message, meeting request, task assignment, and so on) ● Who sent it ● When you received it ● The subject
 
 Icons displayed in the message header indicate optional information such as: ● The most recent response action taken ● Whether files are attached ● If it has been digitally signed or encrypted ● If the sender marked it as being of high or low importance Read Unread
 
 Message attachment
 
 Replied to The message header and icons provide information about the message.
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 There are three standard views of the message list: ● Compact  The default view, which displays two lines of message properties, including
 
 the read status, subject, sender, time received, whether files are attached to the message, and any color categories or follow-up flags associated with the message. ● Single  This one-line view displays the importance, reminder, item type or read
 
 status, whether files are attached to the message, sender, subject, received, size, category, and follow-up flags. The Reading Pane is open by default in this view. ● Preview  This view displays from one to four lines of information about each mes-
 
 sage. For every message, Preview view displays the same information as Single view. For each unread message, Preview view also displays a part of the message content—specifically, the first 255 characters (including spaces). If a message contains fewer than 255 characters, <end> appears in the preview text. The Reading Pane is closed by default in this view. These three standard views are available from the Change View gallery on the View tab. Messages that you haven’t yet read are indicated by closed envelope icons and bold headers. When you open a message, Outlook indicates that you have read it by changing the message icon from a closed envelope to an open envelope and changing the header font in the message list from bold to normal. See Also  For more information, see the sidebar “Marking Messages as Read or Unread” in Chapter 7, “Organize Your Inbox.”
 
 You can view the text of a message in several ways: ● You can open a message in its own window by double-clicking its header in the
 
 message list. ● You can read a message without opening it by clicking its header once in the
 
 message list to display the message in the Reading Pane. ● You can display the first three lines of each unread message under the message header
 
 by using the Preview feature. Scanning the first three lines of a message frequently gives you enough information to make basic decisions about how to manage it. The only drawback is that in Preview view, each unread message takes up five lines rather than the two lines in the default Messages view, so fewer messages are visible on your screen at one time. See Also  For information about turning on specific view features, see “Arranging Messages in Different Ways” in Chapter 7, “Organize Your Inbox.”
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 You can view message attachments in several ways: ● You can preview certain types of attachments (including Excel spreadsheets,
 
 PowerPoint slideshows, Word documents, and Portable Document Format (PDF) files) directly in the Reading Pane by clicking the attachment in the message header. When you click the attachment, the message text is replaced by a preview of the attachment contents, and the Attachments contextual tab appears on the ribbon.
 
 Selected attachment From the Attachments tab, you can work with the attachment or toggle between the message content and attachment preview. Tip  You can turn off the Attachment Preview feature from the Attachment Handling page of the Trust Center window, which you open from the Outlook Options dialog box. For information about Trust Center settings, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.” ● You can open the attachment from the Reading Pane or from an open message
 
 window by double-clicking the attachment in the message header. ● You can save the attachment to your hard disk and open it from there. This strategy
 
 is recommended if you suspect an attachment might contain a virus because you can scan the file for viruses before opening it (provided that you have a virus scanning program installed). See Also  For information about protecting your computer from viruses, refer to Windows 7 Step by Step (Microsoft Press, 2009) or Windows Vista Step by Step, (Microsoft Press, 2007), both by Joan Lambert Preppernau and Joyce Cox.
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 If you receive a contact record or business card as a message attachment, you can add it to your primary address book by dragging the attachment from the e-mail message to the Contacts button in the Navigation Pane. To add the contact record to a secondary address book, expand the folder structure in the Navigation Pane and drag the attachment to that folder. If you want to concentrate on reading messages without the distraction of other information typically presented in the Outlook program window, you can quickly reconfigure the program window to optimize message reading by clicking the Reading View button on the status bar, to the left of the zoom controls. Minimized ribbon
 
 Minimized Navigation Pane
 
 Minimized To-Do Bar
 
 Reading View
 
 In Reading view, the Navigation Pane, To-Do Bar, and ribbon are hidden to maximize the size of the Reading Pane.
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 In this exercise, you’ll preview and open a message and two types of attachments. SET UP  You need the SBS First Draft message you created earlier in this chapter to complete this exercise. If you did not create that message, you can do so now, or you can substitute any received message with an attachment in your Inbox. Display your Inbox, and then follow the steps.
 
 
 
 1. On the View tab, in the Current View group, click the Change View button, and then click Preview.
 
 Troubleshooting  If the Preview icon on the Change View menu is shaded, this feature is already turned on.
 
 The Reading Pane closes, and the first 255 characters of each message appear in the Inbox below the message header.
 
 Preview view displays the first 255 characters of each unread message.
 
 
 
 2. On the View tab, in the Change View list, click Single. The preview text disappears, and the Reading Pane reopens.
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 3. Locate the SBS First Draft message in your Inbox, and then click the message. Outlook displays the message in the Reading Pane. Below the message header area, the Reading Pane displays a Message button (which looks rather more like just the word Message than it does like a button) and the names of the attached files (Brochure.docx and StrategySession.pptx).
 
 
 
 4. In the Reading Pane, point to (don’t click) the Message button below the message header. Troubleshooting  If you are working through this exercise with a message that does not have an attachment, the header does not include a Message button.
 
 A ScreenTip displays the total number of attachments. Message button
 
 Pointing to the Message button displays information about attached files. Tip  If more files are attached than can be seen in the message header, you can use the scroll bar at the right end of the Attachments box to see them all.
 
 
 
 5. Point to the Brochure.docx attachment. A ScreenTip displays the name, type, and size of the attached file.
 
 Pointing to an attached file displays information about the file.
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 6. Click the Brochure.docx attachment once. The Attachments contextual tab appears on the ribbon, and the fully formatted Word 2010 document appears in the Reading Pane.
 
 The message header changes to display properties of the attached file.
 
 You can scroll through the entire document within this pane, without starting Word. Tip  Clicking certain types of attachments displays an interim warning message in the Reading Pane, rather than immediately displaying the attached file’s content. After reading the message, you can click Preview File to display the usual file preview.
 
 You can give Outlook permission to display previews of a specific type of file by clearing the Always Warn Before Previewing This Type Of File check box before clicking Preview File.
 
 
 
 7. Click the StrategySession.pptx attachment. Word starts the PowerPoint previewer and displays the title slide of the presentation in the Reading Pane. You can move among the presentation’s slides by clicking the Previous Slide and Next Slide buttons in the lower-right corner of the pane.
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 8. In the lower-right corner of the Reading Pane, click the Next Slide button. The presentation transitions to the second slide, exactly as it would if you were displaying the slide show in PowerPoint. The slide currently displays only a title.
 
 
 
 9. At the bottom of the vertical scroll bar, click the Next button once. An animated graphic appears on the slide. The animation works in the Reading Pane the same way it would within the PowerPoint program window.
 
 When previewing a PowerPoint presentation, you can navigate through the presentation by using the scroll bar and the controls in the lower-right corner of the Reading Pane or by using the scroll wheel on the mouse.
 
 
 
 10. In the Reading Pane, click the Message button (or, in the Message group on the Attachments tab, click Show Message).
 
 The message text reappears in the Reading Pane.
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 11. In the Reading Pane, double-click the StrategySession.pptx attachment (or, in the Actions group on the Attachments tab, click Open).
 
 PowerPoint 2010 starts and opens the presentation, which is titled The Master Plan. See Also  For an introduction to the features of PowerPoint 2010, refer to Microsoft PowerPoint 2010 Step by Step by Joyce Cox and Joan Lambert (Microsoft Press, 2010).
 
 
 
 12. Close the presentation to return to your Inbox. 13. In the message list, double-click the SBS First Draft message. The message opens in its own window. The Message button and attachments are shown below the message header in the message window, as they are in the Reading Pane.
 
 
 
 14. In the Attachments area below the message header, click the Brochure.docx attachment once. The Attachments contextual tab appears on the ribbon, and a preview of the document appears in the message content pane exactly as it did in the Reading Pane.
 
 You use the same techniques to preview and open attachments from the message window that you do from the Reading Pane.
 
 CLEAN UP  Close the SBS First Draft message window, and retain it in your Inbox for use in later exercises. Then reset the program window to its default view by clicking Compact in the Change View gallery.
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 Viewing Conversations Conversation view was first introduced in Outlook 2007 as a way of viewing in one place a series of received messages that stem from the same original message. This feature made it easy to locate various responses to a message and to identify separate branches of a conversation (referred to as message threads). In Outlook 2010, the original Conversation view has been expanded to present an even clearer method of tracking message threads and to include not only received messages but also sent messages. Conversation view is considered such a useful organizational tool that it is designated as the default view of the Inbox and other message folders. Except when discussing alternative views of messages, the graphics in this book depict messages arranged in Conversation view. A conversation of multiple messages is indicated by an arrow to the left of the conversation message header. See Also  For more information about Conversation view, see “Working with Conversation View” in Chapter 7, “Organize Your Inbox.”
 
 Configuring Reading Pane Behavior You will frequently read and work with messages and other Outlook items in the Reading Pane. You can display the Reading Pane to the right of or below the module content pane.
 
 Viewing Reading Pane Content You might find it difficult to read the text in the Reading Pane at its default size, particularly if your display is set to a high screen resolution, as is becoming more and more common. You can change the size of the content displayed in the Reading Pane by using the Zoom controls located at the right end of the program window status bar to change the pane’s magnification level. Zoom level
 
 Zoom Out
 
 Zoom slider
 
 Zoom In
 
 In the program window, the Zoom controls change the size of the content in the Reading Pane.
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 You can change the magnification of the Reading Pane contents in the following ways: ● To set a specific magnification level, click the Zoom Level button to open the Zoom
 
 dialog box.
 
 Select one of the three predefined magnification levels, or select or type a specific magnification level in the Percent box. ● To change the zoom level in 10 percent increments, click the Zoom Out and Zoom
 
 In buttons. ● To quickly change the zoom level to any setting between 10 percent and 500
 
 percent, move the Zoom slider to the left or right.
 
 Marking Messages as Read By default, Outlook does not change the read status of a message when you preview it in the Reading Pane. If you commonly read your messages in the Reading Pane rather than opening them in message windows, you can keep better track of read and unread messages by changing the default setting. To instruct Outlook to mark a message as read after you have previewed it in the Reading Pane: 1. Display the Backstage view, and then click Options. 2. On the Mail page of the Outlook Options dialog box, in the Outlook Panes area, click Reading Pane.
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 The Reading Pane dialog box opens.
 
 You can configure the way Outlook handles messages displayed in the Reading Pane.
 
 3. In the Reading Pane dialog box, select the check box corresponding to the way you want Outlook to handle messages you view in the Reading Pane. ❍ Mark items as read when viewed in the Reading Pane  Outlook will
 
 mark the item as read after it has been displayed in the Reading Pane for five seconds or an alternative amount of time (up to 999 seconds) that you specify. ❍ Mark item as read when selection changes  Outlook will mark the item as
 
 read when you select another item. 4. Click OK in the Reading Pane dialog box and in the Outlook Options dialog box.
 
 Single Key Reading You can scroll through a long message in the Reading Pane in the following ways: ● Scroll at your own pace by dragging the vertical scroll bar that appears at the right
 
 side of the Reading Pane. ● Move up or down one line at a time by clicking the scroll arrows. ● Move up or down one page at time by clicking above or below the scroll box. ● Move up or down one page at a time by pressing the Spacebar. When you reach
 
 the end of a message by using this feature, called Single Key Reading, pressing the Spacebar again displays the first page of the next message. This option is very convenient if you want to read through several consecutive messages in the Reading Pane, or if you find it easier to press the Spacebar than to use the mouse. Tip  Single Key Reading is turned on by default. If you find it distracting, you can turn it off by clearing the Single Key Reading Using Space Bar check box in the Reading Pane dialog box.
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 Viewing Message Participant Information After you receive a message (or after Outlook validates a recipient’s name in a message that you’re sending), you can easily display contact information and a history of your communications with that person.
 
 Presence Icons If presence information is available, a square presence icon appears to the left of each message participant’s name. The presence icon (more casually referred to as a jelly bean) is color-coded to indicate the availability or online status of the message participant, as follows: ● Green indicates that the message recipient is available. ● Red indicates that the message recipient is busy. ● Orange indicates that the message recipient is away. ● White indicates that the message recipient is offline. Tip  This set of presence icons is used in Outlook, Windows Live Messenger, and Microsoft Office Communicator to provide a consistent user experience.
 
 Depending on the environment, Outlook uses presence information from Office Communications Server or from Windows Live Messenger.
 
 Contact Cards Pointing to a presence icon displays an interactive contact card of information that includes options for contacting the person by e-mail, instant message, or telephone; for scheduling a meeting; and for working with the person’s contact record. Communications options
 
 Presence icons
 
 Pin Contact Card
 
 Expand Contact Card
 
 Pinning the contact card keeps it open even if you send or close the e-mail message.
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 Clicking the Expand Contact Card button displays a more extensive range of information and interaction options. Place a telephone call
 
 Send an e-mail message From the expanded contact card, you can view the contact’s position within the organization and which distribution lists he or she is a member of. Tip  A distribution list is a membership group created through Exchange and available from an organization’s Global Address List. You can’t create distribution lists, but you can create contact groups, which are membership groups saved in the Outlook Contacts module. For more information, see “Creating Contact Groups” in Chapter 9, “Work with Your Contact List.”
 
 Clicking any of the blue links initiates contact with the person through the stored telephone number or e-mail address, initiates a meeting request, or, if the person is in your address book, opens his or her contact record. When available, the Organization tab displays information about the contact’s manager and direct reports. The Member Of tab displays information about distribution lists the contact is a member of. This information is available only for Exchange accounts.
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 The People Pane The People Pane at the bottom of the message window displays extensive information about your previous communications with each message participant. In its collapsed state, the People Pane displays small thumbnails representing each message participant. If a person’s contact record includes a photograph, the photo appears in the People Pane. If no photograph is available, a silhouette of one person represents an individual message participant, and a silhouette of three people represents a distribution list. Resizing bar
 
 Distribution group
 
 Contact without associated picture The collapsed People Pane.
 
 You can expand the People Pane either by clicking the Expand button at the right end of the pane or by dragging the horizontal bar that appears at the top of the pane. The People Pane can occupy only a certain percentage of the message window, so the amount you can manually adjust the height of the People Pane is dependent on the height of the message window. In its expanded state, the People Pane displays either large thumbnails or a tabbed breakdown of communications for each message participant. Toggle button
 
 Scroll to view additional message participants The simple view of the expanded People Pane.
 
 You can switch between the simple view and the detailed view by clicking the Toggle button located near the right end of the expanded People Pane header.
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 The detailed view of the expanded People Pane for messages in an Exchange account. Click Add to set up a connection from Outlook to an online social network.
 
 The All Items tab of the detailed view displays all your recent communications with the selected person. If you’re looking for a specific item, such as a meeting request or a document attached to a message, you can filter the item list by clicking any of the tabs to the left of the list. Tip  The detailed People Pane is available for all types of e-mail accounts. The images in this book depict the People Pane for an Exchange account. The People Pane for a POP3 account is identical except that the tabs are labeled with icons only rather than icons and words.
 
 Troubleshooting the People Pane When working with an Exchange account, you can display the People Pane in detailed view only if the Cached Exchange Mode feature is enabled. If the Toggle button isn’t visible in the expanded People Pane when you’re viewing an Exchange account message, the likely problem is that Cached Exchange Mode is not enabled. To enable Cached Exchange Mode, follow these steps: 1. In the Backstage view of the Outlook program window, click Account Settings, and then in the list that appears, click Account Settings. 2. On the E-mail page of the Account Settings dialog box, click your Exchange account, and then click Change. 3. On the Server Settings page of the Change Account wizard, select the Use Cached Exchange Mode check box, click Next, and then on the wizard’s final page, click Finish. The Toggle button should now be visible in the header of the expanded People Pane.
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 Responding to Messages You can respond to most e-mail messages that you receive by clicking a response button either within the message window or in the Respond group on the Message tab. The most standard response to a message is a reply. When you reply to a message, Outlook fills in one or more of the address boxes for you, as follows: ● Reply  Creates an e-mail message, addressed to only the original message sender,
 
 that contains the original message text. ● Reply All  Creates an e-mail message, addressed to the message sender and all
 
 recipients listed in the To and Cc boxes, that contains the original message text. The message is not addressed to recipients of blind courtesy copies (Bcc recipients). ● Reply with Meeting  Creates a meeting invitation addressed to all message recipi-
 
 ents. The message text is included in the meeting window content pane. Outlook suggests the current date and an upcoming half-hour time slot for the meeting.
 
 A meeting invitation created from a message.
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 Message replies include the original message header and text, preceded by a space in which you can respond. Replies do not include any attachments from the original message. You can add, change, and delete recipients from any reply before sending it. You can forward a received message to any e-mail address (regardless of whether the recipient uses Outlook) provided the message was not sent with restricted permissions. Outlook 2010 has the following message-forwarding options: ● Forward  Creates a new message that contains the text of the original message
 
 and retains any attachments from the original message. ● Forward As Attachment  Creates a blank message that contains no text but
 
 includes the original message as an attachment. The original message text and any attachments are available to the new recipient when he or she opens the attached message. ● Forward As Text Message  Creates a text message to be sent by an SMS text
 
 messaging account to a mobile device, such as a mobile phone or a Windows Phone. Troubleshooting  The Forward As Text Message response option works only if you have access to an SMS account.
 
 Forwarded messages include the original message header and text, preceded by a space in which you can add information. Forwarded messages include attachments from the original message. When you forward a message, Outlook does not fill in the recipient boxes for you (the assumption being that you want to forward the message to someone who wasn’t included on the original message). See Also  For information about restricting recipients from copying, printing, or forwarding messages, see “Securing Your E-Mail” in Chapter 11, “Manage E-Mail Settings.”
 
 If you reply to or forward a received message from within the message window, the original message remains open after you send your response. You can instruct Outlook to close original messages after you respond to them—you’ll probably be finished working with the message at that point. To do so, display the Mail page of the Outlook Options dialog box, select the Close Original Message Window When Replying Or Forwarding check box in the Replies And Forwards area, and then click OK. Tip  When responding to an e-mail message, take care to use good e-mail etiquette. For example, if your response is not pertinent to all the original recipients of a message, don’t reply to the entire recipient list, especially if the message was addressed to a distribution list that might include hundreds of members.
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 You can prevent other people from replying to all recipients of a message you send by addressing the message to yourself and entering other recipients in the Bcc box. Then the recipient list will not be visible to anyone.
 
 If your organization runs Office Communications Server, you may also have these additional response options: ● Call  Uses the telephone calling functionality of Office Communicator to place Voice
 
 Over IP (VOIP) calls from your computer, over the Internet, to the telephone number of the original message sender. ● Call All  Uses the telephone calling functionality of Office Communicator to initiate
 
 a VOIP conference call to the telephone numbers of the original message sender and other message recipients. ● Reply With IM or Reply All With IM  Opens an Office Communicator chat window
 
 with the original message subject as its title and the message sender or sender and recipients as the chat participants.
 
 An Office Communicator IM session created from a message. Troubleshooting  The response options available in your Outlook installation might vary from those described here. The available response options always feature prominently on the main ribbon tab in the item window.
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 Nonstandard messages have alternative response options, such as the following: ● A meeting request includes options for responding to the request.
 
 Responding to a meeting request from the Reading Pane. See Also  For information about meeting requests, see “Scheduling Meetings” in Chapter 5, “Manage Scheduling.” ● A task assignment includes options for accepting or declining the assignment.
 
 Responding to a task assignment from the Reading Pane. See Also  For information about task assignments, see “Managing Task Assignments” in Chapter 6, “Track Tasks.” ● If a message contains voting buttons, you can respond by opening the message,
 
 clicking the Vote button in the Respond group on the Message tab, and then clicking the response you want to send. Or you can click the Info bar (labeled Click here to vote) in the Reading Pane and then click the response you want.
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 Voting from the Reading Pane. See Also  For information about polling other Outlook users in your organization, see “Changing Message Settings and Delivery Options” in Chapter 10, “Enhance Message Content.”
 
 In this exercise, you’ll reply to and forward a message that has an attachment. SET UP  You need the SBS First Draft message you created earlier in this chapter to complete this exercise. If you did not create that message, you can do so now, or you can substitute any received message with an attachment in your Inbox. Display your Inbox, and then follow the steps.
 
 
 
 1. Open the SBS First Draft message in a message window. The message includes two attachments. The message window ribbon displays only the Message tab containing all the commands you use with a received message.
 
 
 
 2. On the Message tab, in the Respond group, click the Reply button. Outlook creates a response, already addressed to you (the original sender). If the message had been sent to any other people, the reply would not include them.
 
 Replying to a message generates a new message addressed to the original sender.
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 The RE: prefix appears at the beginning of the message subject to indicate that this is a response to an earlier message. Note that the response does not include the original attachments (and in fact there is no indication that the original message had any). The original message, including its header information, appears in the content pane separated from the new content by a horizontal line.
 
 
 
 3. With the cursor at the top of the content pane, type the following sentence: We’ll need to get approval from the Marketing team before proceeding.
 
 
 
 4. In the response header, click the Send button. Outlook sends your reply, which appears in your Inbox as the active message in the SBS First Draft conversation. The original message remains open on your screen.
 
 
 
 5. In the original message, in the Respond group, click the Forward button. Troubleshooting  If the original message closes, select the message in your Inbox and then click the Forward button in the Respond group on the Home tab.
 
 Outlook creates a new version of the message that is not addressed to any recipient. The FW: prefix at the beginning of the message subject indicates that this is a forwarded message. The files that were attached to the original message appear in the Attached box. The message is otherwise identical to the earlier response.
 
 The MailTip at the top of the message header indicates that another message (your response) has been added to the conversation, so the message you’re forwarding isn’t technically the most current.
 
 You address and send a forwarded message as you would any other.
 
 
 
 6. In the To box, enter your e-mail address.
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 7. Click to position the cursor at the top of the content pane, and then type the following sentence: Don’t forget to review these!
 
 
 
 8. Send the message, and then close the original message window. 9. When the second message appears in your Inbox, compare the two messages and note the similarities and differences. For example, the Subject prefixes are different, and the forwarded message includes the original message attachments. CLEAN UP  Close any open message windows. Retain the SBS First Draft conversation for use in later exercises.
 
 Key Points ● You can easily create e-mail messages that include attachments. ● By default, messages you receive appear in your Inbox. ● You can see the first few lines of each message in Preview view, open a message
 
 in its own window, or preview messages in the Reading Pane. You can preview message attachments in the Reading Pane. ● You can reply to the message sender only or to the sender and all other recipients.
 
 You can also forward a message and its attachments to other people.
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 Resending and Recalling Messages If you want to send a new version of a message you’ve already sent—for example, a status report in which you update details each week—you can resend the message. Resending a message creates a new version of the message with none of the extra information that might be attached to a forwarded message. To resend a message, follow these steps: 1. From your Sent Items folder, open the message you want to resend. (Or, if you copied yourself on the message, you can open it from your Inbox.) 2. On the Message tab, in the Actions group, click the Other Actions button, and then in the list, click Resend This Message. Outlook creates a new message form identical to the original. If you want, you can change the message recipients, subject, attachments, or content before sending the new message. If, after sending a message, you realize that you shouldn’t have sent it—for example, if the message contained an error or was sent to the wrong people—you can recall it by instructing Outlook to delete or replace any unread copies of the message. To recall a message, follow these steps: 1. From your Sent Items folder, open the message you want to recall. 2. On the Message tab, in the Actions group, click the Other Actions button, and then click Recall This Message. 3. In the Recall This Message dialog box, click the option to delete unread copies of the message or the option to replace unread copies with a new message, and then click OK. Message recall is available only for Exchange Server accounts. Troubleshooting  You may want to test the message recall functionality within your organization before you have occasion to need it for an important recall. Quite frequently, the message recall feature can result in a received message being flagged as Recalled, but remaining in the recipient’s Inbox.
 
 Chapter at a Glance Save and update contact information, page 128
 
 Display different views of contact records, page 143
 
 Print contact records, page 151
 
 4 Store and Access
 
 Contact Information In this chapter, you will learn how to ✔ Save and update contact information. ✔ Communicate with contacts. ✔ Display different views of contact records. ✔ Print contact records.
 
 Having immediate access to current, accurate contact information for the people you need to interact with—by e-mail, telephone, mail, or otherwise—is important for timely and effective communication. You can easily build and maintain a detailed contact list, or address book, in the Microsoft Outlook 2010 Contacts module. From your address book, you can look up information, create messages, and share contact information with other people. You can also keep track of your interactions with a person whose contact information is stored in Outlook. If you need to take contact information with you in a non-electronic format, you can print an address book or selected contact records, in many different formats. In this chapter, you’ll create and edit contact records and view them in different ways. Then you’ll print a contact record and a list of contact information. Practice Files  You don’t need any practice files to complete the exercises in this chapter. For more information about practice file requirements, see “Using the Practice Files” at the beginning of this book.
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 Saving and Updating Contact Information You save contact information for people and companies by creating a contact record in an address book.
 
 A typical contact record for a business contact. Tip  You can create a personalized electronic business card for yourself or for any of your contacts. For information, see “Personalizing Electronic Business Cards” in Chapter 9, “Work with Your Contact List.”
 
 You can store the following types of contact information in a contact record: ● Name, company name, and job title ● Business, home, and alternate addresses ● Business, home, mobile, pager, and other telephone numbers ● Business, home, and alternate fax numbers ● Web page address (URL), instant messaging (IM) address, and up to three e-mail
 
 addresses
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 ● Photo or other identifying image ● General notes, which can include text and illustrations such as photos, clip art
 
 images, SmartArt diagrams, charts, and shapes You can also store personal and organization-specific details for each contact, such as the following: ● Professional information, including department, office location, profession,
 
 manager’s name, and assistant’s name ● Personal information, including nickname, spouse or partner’s name, birthday,
 
 anniversary, and the title (such as Miss, Mrs., or Ms.) and suffix (such as Jr. or Sr.) for use in correspondence
 
 Creating Contact Records You typically create a contact record by displaying the Contacts module and then clicking the New Contact button in the New group on the Home tab. In the contact record window that opens, you insert the information you want to save. After you save the contact record, it is displayed in the Contacts pane. You can create a contact record containing only one piece of information (for example, a name or company name), or as much information as you want to include. You can quickly create contact records for several people who work for the same company by cloning the company information from an existing record to a new one. And of course, you can add to or change the information stored in a contact record at any time. The order in which Outlook displays contact records in the Contacts pane is controlled by the File As setting. By default, Outlook files contacts by last name (Last, First order). If you prefer, you can change the order for new contacts to any of the following: ● First, Last ● Company ● Last, First (Company) ● Company (Last, First)
 
 To set the filing order for all your contacts, display the Backstage view, click Options, and then on the Contacts page of the Outlook Options dialog box, click the Default “File As” Order arrow and select an order from the list. You can change the filing order for an individual contact by selecting the order you want in the File As list in the contact record. Tip  In addition to individual contact records, you can create groups of contacts so that you can manage messaging to multiple people through one e-mail address. For information, see “Creating Contact Groups” in Chapter 9, “Work with Your Contact List.”
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 Address Books Outlook stores contact information from different sources in separate address books. Some are created by Outlook, some by your e-mail server administrator, and others by you.
 
 Contacts and Suggested Contacts Address Books Outlook automatically creates a Contacts address book and a Suggested Contacts address book for each account you connect to. These address books are available from the My Contacts list in the Navigation Pane of the Contacts module.
 
 The default Navigation Pane of the Contacts module.
 
 The Contacts address book of your default e-mail account is your main address book, and it is the address book that appears by default in the Contacts module. The Contacts address book is empty until you add contact records to it. If you correspond with someone who isn’t already in your Contacts address book, Outlook automatically adds that person to the Suggested Contacts address book. You can work with the contact information saved in this address book, or you can move the information from the Suggested Contacts address book to create an official contact record for that person in a different address book. Tip  If you have an Outlook Mobile Service account, Outlook automatically creates a Mobile Address Book containing all the contacts in your Contacts address book for whom mobile phone numbers are listed. For more information, refer to Microsoft Outlook 2010 and Office Communications Server Inside Out by Jim Boyce (Microsoft Press, 2010).
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 Custom Address Books You can create additional address books; for example, you might want to keep contact information for family and friends in an address book separate from client contact information, or you might maintain an address book for team members working on a specific project. You create an address book by creating a folder and specifying that the folder will contain contact items.
 
 An address book is a folder designed specifically to contain contact records and contact groups.
 
 When you display the Folder List in the Navigation Pane, your custom address books appear along with other folders you create, and you can organize them in the same manner—for example, at the same level as your Inbox, as a subfolder of the Contacts address book, or inside a project folder. All address books are available from the My Contacts list in the Navigation Pane of the Contacts module. See Also  For information about creating address books, see “Organizing Messages in Folders” in Chapter 7, “Organize Your Inbox.” Tip  If your organization stores contact information in a SharePoint Contacts List, you can import the list contents from SharePoint into Outlook as an address book. For more information, see “Working with SharePoint Site Content” in Chapter 12, “Work Remotely.”
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 Global Address Lists If you have an Exchange account, you also have access to an official address book called the Global Address List (or GAL). The GAL is maintained by your organization’s Exchange administrator and may include information about individuals within your organization, distribution lists, and resources (such as conference rooms and media equipment) that you can reserve when you schedule meetings. It can also include organizational information (each person’s manager and direct subordinates) and group membership information (the distribution lists each person belongs to). The GAL doesn’t appear in the My Contacts list shown in the Navigation Pane of the Contacts module. To display the GAL, click the Address Book button located in the Find group on the Home tab of the Contacts module or the Address Book button located in the Names group on the Message tab of a message composition window. Outlook users can view the GAL but not change its contents.
 
 Dialing Rules The first time you enter a phone number for a contact, the Location Information dialog box opens, prompting you to enter your own country, area code, and any necessary dialing information, such as a carrier code.
 
 The Location Information and Phone And Modem dialog boxes collect information required by phone and fax programs.
 
 Outlook sets up dialing rules based on the information you enter. You must enter at least your country and area code in the dialog box and then click OK; you can’t close the dialog box without entering the requested information.
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 In this exercise, you’ll create and edit a contact record in your main address book. SET UP  You don’t need any practice files to complete this exercise. Display the Contacts module, and then follow the steps.
 
 
 
 1. On the Home tab, in the New group, click the New Contact button. A new contact record window opens. See Also  For information about the features and functions of the contact record window, see “Working in the Contacts Module” in Chapter 2, “Explore the Outlook Windows.”
 
 
 
 2. In the Full Name box, type Sara Davis, and then press the Tab key to move to the Company box.
 
 Outlook transfers the name to the File As box and displays it in the default order (Last, First). The name also appears on the contact record window title bar and in the business card representation.
 
 Entering a contact’s name in the Full Name box distributes it to multiple areas of the contact record. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 
 
 3. In the Company box, type Wingtip Toys. 4. In the Job title box, type Assembly Plant Manager. 5. In the Internet area, type [email protected] in the E-mail box, and press Tab. Outlook automatically formats the e-mail address as a hyperlink and then enters the contact’s name, followed by the e-mail address in parentheses, in the Display As box. This box indicates the way the contact will appear in the headers of e-mail messages you exchange with this contact.
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 6. In the Display as box, select the e-mail address inside the parentheses and then
 
 
 
 7. Click the E-mail arrow (not the button).
 
 type Work.
 
 A list displays the e-mail address fields available in the contact record.
 
 Groups of related contact information fields are indicated by an arrow button to the right of the field name.
 
 
 
 8. In the E-mail list, click E-mail 2. The E-mail 2 field replaces the E-mail field. The e-mail address you entered in the E-mail field, and its associated Display As text, disappears.
 
 
 
 9. In the E-mail 2 field, enter [email protected], and then press Tab. Outlook enters the original name and the second e-mail address in the Display As field. Although the field name doesn’t change to indicate it, this information is specific to the E-mail 2 field.
 
 
 
 10. In the Display as box, select the e-mail address inside the parentheses and then type Personal.
 
 The business card representation displays both e-mail addresses.
 
 
 
 11. In the Web page address box, type www.wingtiptoys.com. Outlook automatically formats the text as a hyperlink.
 
 
 
 12. In the Phone numbers area, type 9725550101 in the Business box, and then press Tab. If the Location Information dialog box opens, enter your country and area code, and click OK. Then in the Phone and Modem dialog box, with the location associated with your area code selected, click OK.
 
 See Also  For information about the Location Information dialog box, see the sidebar “Dialing Rules” earlier in this topic.
 
 Outlook formats the series of numbers you entered as a telephone number, using the regional settings governed by Windows.
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 13. In the Addresses area, click in the text box to the right of Business, type 4567 Main Street, press the Enter key, and then type Dallas, TX 98052.
 
 Tip  In a new contact record, a selected check box to the left of the Business address field indicates that it is the default mailing address for the contact.
 
 
 
 14. Click the Business arrow to display the Addresses list and then, in the list, click Home.
 
 The button label changes to indicate that you are displaying Sara’s home address information.
 
 
 
 15. In the text box, type 111 Magnolia Lane, press Enter, and then type Flower Mound, TX 98053.
 
 The contact record now contains both business and personal contact information. Tip  If you record multiple addresses for a contact and want to specify one as the default mailing address, display that address and then select the This Is The Mailing Address check box.
 
 The completed contact record.
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 16. On the Contact tab, in the Actions group, click the Save & Close button. The contact record window closes. The Contacts pane now includes the new contact record for Sara Davis.
 
 A business card view of the new contact record is visible in the Contacts pane.
 
 
 
 17. In the Contacts pane, double-click the contact record for Sara Davis.
 
 
 
 18. On the Contact tab, in the Show group (or in the Show list, if the Show group is compacted), click the Details button.
 
 Outlook displays the Details page of the contact record. Tip  You can assign follow-up flags to contact entries, and link contact entries to e-mail messages, appointments, tasks, and other Outlook items. For more information, see “Creating Tasks from Outlook Items” in Chapter 6, “Track Tasks.” You can view all items linked to a contact on the Activities page of the contact record.
 
 
 
 19. In the Spouse/Partner box, type Andrew.
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 20. Click the Birthday arrow, scroll the calendar to July, and then click 31. The Birthday box displays the day and date information for July 31 of the current year.
 
 The Details page of the contact record provides space for recording business and personal information. Tip  The birthday or anniversary date you select in the calendar defaults to the current calendar year. You can change the year by selecting it in the text box and then typing the year you want.
 
 
 
 21. In the Actions group, click the Save & New arrow (not the button), and then in the list, click Contact from the Same Company.
 
 Troubleshooting  Clicking the Save & New button rather than the Save & New arrow opens a new, blank contact record. If this occurs, close the new contact record window to return to Sara Davis’s contact record, and repeat step 21.
 
 Outlook creates a new contact record that already contains the company name, Web page address, business phone number, and business address from Sara Davis’s contact record.
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 Without any changes, the new contact record could be saved as a contact record for the company rather than for a specific person.
 
 Because no person’s name has been provided, the File As name is currently set to the company name.
 
 
 
 22. In the Full Name box, type Andrea Dunker, and in the Job title box, type Sales
 
 
 
 23. In the E-mail box, type [email protected]. Leave the default Display
 
 
 
 24. Save and close the open contact records.
 
 Associate.
 
 As text.
 
 Saving and Updating Contact Information   139
 
 
 
 
 
 25. Use the techniques described in this exercise to create contact records for the following people: Full name
 
 Company
 
 Job title
 
 E-mail address
 
 Andrew Davis
 
 Trey Research
 
 Account Manager
 
 [email protected]
 
 Idan Rubin
 
 Trey Research
 
 Research Associate
 
 [email protected]
 
 Nancy Anderson
 
 Trey Research
 
 Research Associate
 
 [email protected]
 
 The Contacts pane now includes the five records you’ve created.
 
 The completed contact records.
 
 CLEAN UP  Save and close any open contact records to return to the Contacts pane. Retain the Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin contact records for use in later exercises. Tip  You can create a contact record for the sender of a message you have received by rightclicking the sender’s name in the message header—either in the Reading pane or the open message item—and then clicking Add To Outlook Contacts. Outlook creates a contact record with the name and e-mail address already filled in. Add any other information you want to record, and then save the contact record.
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 Conforming to Address Standards When you finish entering information in the Addresses area, Outlook verifies that the address conforms to a standard pattern. If Outlook detects irregularities in the address you enter, the Check Address dialog box opens, prompting you to enter the street address, city, state or province, postal code, and country in separate fields from which it reassembles the address.
 
 The Check Address dialog box validates the address against standard patterns.
 
 The intention of this feature is to verify that you have the information necessary to send mail to the contact. If you determine that the information in the Check Address dialog box is correct, you can click Cancel to close the dialog box without making changes.
 
 Communicating with Contacts Saving contact information for people in a physical or electronic address book is useful because it centralizes the information in one place so that you no longer have to remember the information or where to find it. The added benefit of saving contact information in an Outlook address book is that it makes the process of initiating communication with a contact much more efficient.
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 Initiating Communication from Contact Records Contact records aren’t useful only for storing information; you can also initiate a number of actions that are specific to a selected contact. Commands for initiating communication are available in the Communicate group on the Contact tab of an open contact record.
 
 The commands available in the Communicate group may vary based on your specific Outlook configuration.
 
 You can perform many actions from within a contact record by using the commands in the Communicate group on the Contact tab, including the following: ● Create an e-mail message addressed to the contact by clicking the E-mail button. ● Create a meeting request that includes the contact by clicking the Meeting
 
 button. ● Initiate a chat session with the contact by clicking the Reply With IM button.
 
 (Requires Office Communicator.) ● Place a call to the contact by clicking the Call arrow and then, in the list, clicking
 
 the telephone number you would like Outlook to dial. (Requires Internet telephone capabilities.) ● Display the contact’s Web site by clicking the Web Page button. ● Create a task assigned to the contact by clicking the Assign Task button. ● Create a journal entry assigned to the contact by clicking the Journal Entry button. ● Display a map of the contact’s address by clicking the Map It button in the
 
 Addresses area. If Microsoft OneNote 2010 is installed on your computer, you can create a OneNote notebook entry linked to the contact record by clicking the OneNote button in the Actions group on the Contact tab.
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 Selecting Message Recipients from Address Books When you send an e-mail message to a person whose contact information is stored in one of your address books, you can quickly address the message to that person by entering his or her name exactly as it appears in the address book and letting Outlook validate the address. If you don’t know the exact spelling of the name, follow these steps: 1. In the message composition window, click the Address Book button in the Names group on the Message tab. The Select Names dialog box opens.
 
 To insert names from an address book, you must open the address book from the message composition window.
 
 2. In the Address Book list, click the arrow, and then click the address book you want to search. 3. Scroll through the Name list, and locate the person’s name. Tip  You can enter the first few letters of the person’s name to scroll to entries beginning with those letters.
 
 4. To add the person in the To box as a primary message recipient, double-click the name, or click it and then press Enter. To add the person as a secondary or private recipient, click in the Cc or Bcc box at the bottom of the dialog box and then doubleclick the name, or click it and press Enter.
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 Tip  If you click the To, Cc, or Bcc box in the message header before clicking the Address Book button, double-clicking the name adds the person to that box. You can also click the Cc or Bcc box and then click the adjacent button to open the Select Names dialog box with that box active.
 
 5. After selecting all message recipients from the address book, click OK to close the Select Names dialog box and return to the message composition window. See Also  For information about creating e-mail messages, see “Creating and Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 Displaying Different Views of Contact Records You can view all your address books in the Contacts module. You can also display a list of the contacts in an address book in one of these ways: ● Click the Address Book button in the Find group on the Home tab of the program
 
 window in any module to open the Address Book window. ● Click the Address Book button in the Names group on the Contact tab of a contact
 
 record window to open the Select Name dialog box. In either case, you can expand the Address Book list and then click the name of the address book you want to display.
 
 You can display any of the available address books from the Select Name dialog box.
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 You can view an address book in many different formats. You can choose any standard view from the Current View gallery on the Home tab of the Contacts module.
 
 The Current View gallery of the Contacts module.
 
 Each view presents information from your contact records either as cards or in a list: ● Business Card  This view displays the business card associated with each contact
 
 record—either the default card created by Outlook or a custom card if you have one. Business cards are displayed in alphabetical order by first or last name, depending on the File As selection. ● Card  This view displays contact information as truncated business cards that include
 
 limited information, such as job title and company name. ● Phone  This view displays a columnar list including each contact’s name, company,
 
 and contact numbers. ● List  This view displays a columnar list with contact records arranged in groups.
 
 You can choose the grouping you want from the Arrangements gallery on the View tab.
 
 Buttons in the Arrangements gallery of the Contacts module are available only while contact records are displayed in a list view.
 
 In any list view, you can expand and collapse the groups or select and take action on an entire group of contacts. You can also enter information directly into any contact record field displayed in the list.
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 You can search and filter your contact records in any view by using the Instant Search feature. You can sort contact records by any displayed column in a list view by clicking the column header. You can change the fields displayed in each view; the way records are grouped, sorted, and filtered; the display font; the size of business cards; and other settings to suit your preferences. You can personalize a view from the Advanced View Settings dialog box, which you open by clicking View Settings in the Current View group on the View tab.
 
 The options available in the Advanced View Settings dialog box vary depending on the currently displayed view.
 
 In this exercise, you’ll look at different views of contact records within the Contacts pane, add and remove columns in a list view, and reset a customized view. SET UP  This exercise uses the Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin contact records you created in the exercise “Saving and Updating Contact Information,” earlier in this chapter. If you didn’t complete that exercise, you can do so at this time or use contact records of your own. Display the Contacts module, and then follow the steps.
 
 
 
 1. On the Home tab, in the Current View gallery, click the Business Card button if that view isn’t already selected. In Outlook 2010, this default Contacts module view displays standard business cards for each contact, as well as any personalized business cards you have saved. The cards are organized by File As name, which by default is alphabetically by last name.
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 2. On the alphabet bar located on the right side of the Contacts pane, click the letter r.
 
 The Contacts pane scrolls as necessary to display the business card for Idan Rubin (or the first contact record in your Contacts module that is filed under R).
 
 Alphabet bar
 
 Scroll to the first record filed under a letter
 
 Language Settings In Business Card view or Card view, you can scroll contact records by using the alphabet bar. Tip  You can display an additional alphabet in the alphabet bar. Options include Arabic, Cyrillic, Greek, Thai, and Vietnamese—other alphabets might be available depending on the version of Outlook and any language packs you have installed. To get started, click the Language Settings button at the bottom of the alphabet bar.
 
 
 
 3. In the Current View gallery, click the Card button. 4. If the card columns are not wide enough to display the information saved with the contact records, click the Zoom In button at the right end of the status bar until the information is visible.
 
 Outlook displays your contact records in a card-like format that includes only text and no additional graphic elements.
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 Card view displays the available primary contact information, including name, telephone and fax numbers, postal and e-mail addresses, and notes.
 
 
 
 5. In the Current View gallery, click the Phone button. Outlook displays your contact records in a grid of columns and rows organized in ascending order based on the File As column.
 
 
 
 6. Click the Full Name column heading. Outlook sorts the contact records in ascending order based on the Full Name field, as indicated by the upward-pointing sort arrow to the right of the column heading. You can reverse the sort order by clicking the active heading again. Sort order
 
 Click any column header to sort by that column or to reverse the sort order.
 
 148    Chapter 4  Store and Access Contact Information
 
 
 
 7. Click the Company column heading. Outlook sorts the contact records in ascending order based on the Company field. Tip  You can add a contact to your address book in any list view by clicking the box under the Full Name header (labeled Click Here To Add A New Contact) and entering the contact’s information.
 
 
 
 8. Right-click the Company column header, and then click Field Chooser. The Field Chooser window opens.
 
 
 
 9. Scroll down the Field Chooser list until the Job Title field is visible. Drag the Job Title field from the Field Chooser dialog box to the column heading area, and when the red arrows indicate that it will be inserted between the Company and File As fields, release the mouse button. The list view now includes a column displaying the Job Title for each contact.
 
 Drop location
 
 Field Chooser
 
 You can add any field to a list view from the Field Chooser.
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 10. Point to the column separator between Job Title and File As. When the cursor changes to a double-headed arrow, double-click. Double-click to resize column
 
 Double-clicking a column separator resizes the column to the left of the separator.
 
 The column width changes to accommodate its contents.
 
 
 
 11. Drag the Country/Region column header down from the column heading row until a black X appears. Then release the mouse button.
 
 You can remove a column from a list view by dragging its column header away from the column header row.
 
 The Country/Region column is removed from the list view.
 
 
 
 12. On the View tab, in the Current View group, click the Reset View button. Then in the Microsoft Outlook dialog box that asks whether you want to reset the view to its original settings, click Yes.
 
 The view returns to its original settings. CLEAN UP  Return the Contacts module to the default Business Card view. Retain the Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin contact records for use in later exercises.
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 User-Defined Fields If you’d like to save information that doesn’t fit into the default contact record fields, you can create a custom field. A custom field can contain information such as text, numbers, percentages, currency, Yes/No answers, dates, times, durations, keywords, and formulas. You can create a custom information field from any view of the All Fields page by clicking the New button in the lower-left corner of the page and then specifying the name, type, and format of the field in the New Column dialog box that opens.
 
 Custom fields can be formatted to contain many specific types of information.
 
 Custom fields appear when you filter the All Fields page on User-Defined Fields In This Folder. When you enter information in the custom field for a specific contact, it also appears in the User-Defined Fields In This Item list within that contact record.
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 Printing Contact Records You can print an address book or individual contact records, either on paper or to an electronic file (such as a PDF file or an XPS file), from any address book view. Depending on the view, Outlook offers a variety of print styles, such as those described in the following table. Style
 
 Description
 
 Available in these views
 
 Card
 
 Contact information displayed alphabetically in two columns. Business Card, Letter graphics appear at the top of each page and the Card beginning of each letter group
 
 Small Booklet
 
 Contact information displayed alphabetically in one column. Formatted to print eight numbered pages per sheet. Letter graphics appear at the top of each page and the beginning of each letter group, and a contact index at the side of each page indicates the position of that page’s entries in the alphabet. Print double-sided if possible.
 
 Business Card, Card
 
 Medium Booklet
 
 Contact information displayed alphabetically in one column. Formatted to print four numbered pages per sheet. Letter graphics appear at the top of each page and the beginning of each letter group, and a contact index at the side of each page indicates the position of that page’s entries in the alphabet. Print double-sided if possible.
 
 Business Card, Card
 
 Memo
 
 Contact information displayed under a memo-like header containing your name. One record per sheet.
 
 Business Card, Card
 
 Phone Directory
 
 Contact names and telephone numbers displayed in two columns. Letter graphics appear at the top of each page and the beginning of each letter group.
 
 Business Card, Card
 
 Table
 
 Contact information displayed in a table that matches the on-screen layout.
 
 Phone, List
 
 You can customize the layout of most of the default print styles, as well as save custom print styles.
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 In this exercise, you’ll set up Outlook to print a phone list and then to print individual address cards. SET UP  This exercise uses the Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin contact records you created in the exercise “Saving and Updating Contact Information,” earlier in this chapter. If you didn’t complete that exercise, you can do so at this time or use contact records of your own. Display the Contacts module in Card view, and then follow the steps.
 
 
 
 1. Display the Backstage view, and then click Print. The Backstage view displays the current Print settings.
 
 In Card view, many print styles are available in the Settings list. Tip  The Backstage view on your computer reflects your individual printer settings and might display more print options than shown here.
 
 The preview pane displays the way the cards will appear if printed in the default Card Style, with the current settings. The page indicators at the bottom of the preview pane indicate that the cards will be printed on two pages.
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 Important  To fully complete this exercise, you must have a printer installed. If you don’t have a printer installed, you can perform all the steps of the exercise other than printing. To install a printer, click the Start button, click Devices And Printers, and then on the toolbar, click Add A Printer. Follow the wizard’s instructions to install a local or network printer. If you are working on a corporate network, your administrator can provide the information you need to install a printer.
 
 
 
 2. In the lower-right corner of the preview pane, click the Multiple Pages button. The preview pane displays both pages. The second page contains a series of lines and illegible text.
 
 You can display all pages of a document as they will be printed, to peruse the overall document layout.
 
 
 
 3. In the lower-right corner of the preview pane, click the Actual Size button. The preview pane displays a full-size version of the document. The magnified text is large enough to read.
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 4. At the bottom of the preview pane, to the right of the number of pages, click the right arrow. The preview pane displays the second page, which provides an area for you to record information about an additional contact. Outlook refers to this page of the print style as a blank page.
 
 Certain print layouts include blank pages on which you can record information about new contacts.
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 5. In the middle pane, click Print Options. The Print dialog box opens, displaying the options for the Card Style print style.
 
 When printing contact records in the Card Style print style, you can select specific contact records (items) to be printed.
 
 
 
 6. In the Print dialog box, click Page Setup. The Page Setup: Card Style dialog box opens, displaying the Format page.
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 The Page Setup dialog box contents vary depending on the selected print style.
 
 
 
 7. Look at the settings available on each of the dialog box pages. For all print styles, you can change the fonts, paper size, page orientation and margins, header and footer, and other basic settings. For this print style you can also change the layout of cards on the page, the number of blank forms to be printed, and how the alphabetical division of the cards is indicated.
 
 
 
 8. In the Page Setup dialog box, in the Options area of the Format page, click
 
 
 
 9. Click OK in the Page Setup dialog box, and then click Preview in the Print
 
 None in the Blank forms at end list. Select the Contact index on side check box, and then clear the Headings for each letter check box.
 
 dialog box. The preview pane displays the previously selected Actual Size view of the card list, which is now only one page.
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 Alphabetical headings no longer precede the contact record cards.
 
 
 
 10. In the lower-right corner of the preview pane, click the One Page button. The preview pane displays the entire card list as it will appear when printed.
 
 
 
 11. If you want to print the card list, click the Print button. After printing the card list, Outlook returns to the Contacts module.
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 12. On the Home tab, in the Current View gallery, click the List button.
 
 
 
 13. In the Contacts pane, click the Sara Davis contact record to select it, press and
 
 
 
 14. Display the Print page of the Backstage view.
 
 hold the Ctrl key, and then click the Andrea Dunker contact record to add it to the selection. The Settings list displays only two options—Table Style and Memo Style. Memo Style is selected by default.
 
 If the preview pane can’t automatically display the multiple selected records, a Preview button appears in the preview pane instead.
 
 
 
 15. If the Preview button appears in the preview pane, click it to display the previews of the two selected contact records.
 
 
 
 16. In the Settings list, click Table Style. The preview of Table Style indicates that all contact records will be printed rather than only the two you selected.
 
 
 
 17. In the middle pane, click Print Options. The Print dialog box opens, displaying the options for the Table Style.
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 When printing contact records in Table Style, you can select specific items to be printed.
 
 
 
 18. In the Print range area, click Only selected rows. Then click Preview. The preview pane changes to display only the two contact records you selected.
 
 
 
 19. If you want to print the two records, click the Print button. Outlook prints a page displaying only the selected contacts.
 
 
 
 20. Experiment with the other ways in which you can print your contact records and your address book. CLEAN UP  Return to the default Business Card view or your preferred view of the Contacts module before continuing to the next chapter. Retain the Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin contact records for use in later exercises.
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 Key Points ● You can create and access different types of address books including the Global
 
 Address List provided by your Exchange Server account, your main address book, and any custom address books that you create. ● Contact records can include names, e-mail and IM addresses, phone numbers,
 
 mailing addresses, birthdays, and other information. ● You can display contact records in many different views. In card views, you can
 
 move among records by clicking the alphabet bar. In list views, you can sort records by any field. ● You can print your address book or individual contact records in several formats.
 
 Chapter at a Glance Schedule and change appointments, page 164
 
 Schedule and change events, page 173
 
 Display different views of a calendar, page 185
 
 5 Manage Scheduling In this chapter, you will learn how to ✔ Schedule and change appointments. ✔ Schedule and change events. ✔ Schedule meetings. ✔ Respond to meeting requests. ✔ Display different views of a calendar.
 
 You can use the Microsoft Outlook 2010 calendar to organize your daily activities and to remind you of important tasks and events. If you’re a busy person and use the Outlook calendar to its fullest potential, it might at times seem as though the calendar runs your life—but that isn’t necessarily a bad thing! Using the calendar effectively can help you stay organized, on task, and on time. You can schedule and track appointments, meetings, and events, and block time as a reminder to yourself to take care of tasks. If you have a Microsoft Exchange Server account, an Outlook calendar has already been created for you. If you have configured Outlook to connect to a different type of account, you can manually create a calendar within that account. You can easily create appointments, events, and meetings on your Outlook calendar. In this chapter, you’ll schedule an appointment and an event on your own calendar and work with appointment options including recurrence, reminders, and availability. You’ll schedule a meeting with another person, and learn about responding to, updating, and canceling meeting requests. Then you’ll experiment with different ways of looking at your calendar to find the view that is most effective for your daily working style. Practice Files  You don’t need any practice files to complete the exercises in this chapter. For more information about practice file requirements, see “Using the Practice Files” at the beginning of this book. Important  The exercises in this chapter assume that you’re working with an Exchange account. Some functionality may be unavailable if you’re working with a calendar that’s part of another type of account.
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 Scheduling and Changing Appointments Appointments are blocks of time you schedule for only yourself (as opposed to meetings, to which you invite other Outlook users). An appointment has a specific start time and a specific end time (as opposed to an event, which occurs for one or more full 24-hour periods). To schedule an appointment, you enter, at the minimum, a subject and time in an appointment window. The basic appointment window also includes a field for the appointment location and a free form notes area in which you can store general information, including formatted text, Web site links, and even file attachments so that they are easily available to you at the time of the appointment. When creating an appointment, you indicate your availability (referred to as Free/Busy time) by marking it as Free, Tentative, Busy, or Out Of Office. The appointment time is color-coded on your calendar to match the availability you indicate. Your availability is visible to other Outlook users on your network, and is also displayed when you share your calendar or send calendar information to other people. Tip  When viewing your calendar in Day, Work Week, or Week view, each item on your Outlook task list appears in the Tasks section below its due date. You can schedule specific time to complete a task by dragging it from the Tasks area to your calendar. See Also  For information about adding the contents of a received message to your calendar, see the sidebar “Creating an Appointment from a Message” later in this chapter. For information about assigning appointments to categories, see “Organizing Outlook Items by Using Color Categories” in Chapter 7, “Organize Your Inbox.” For information about sharing your calendar with other Outlook users on your network and about sending your schedule information in an e-mail message, see “Sharing Calendar Information” in Chapter 8, “Manage Your Calendar.”
 
 By default, Outlook displays a reminder message 15 minutes before the start time of an appointment—you can change the reminder to occur as far as two weeks in advance, or you can turn it off completely if you want to. If you synchronize your Outlook installation with a mobile device, reminders also appear on your mobile device. This is very convenient when you are away from your computer. If you have the same appointment on a regular basis—for example, a bimonthly haircut or a weekly exercise class—you can set it up in your Outlook calendar as a recurring appointment. A recurring appointment can happen at almost any regular interval, such as every Tuesday and Thursday, every other week, or the last day of every month. Configuring an appointment recurrence creates multiple instances of the appointment in your calendar at the time interval you specify. The individual appointments are linked. When making changes to a recurring appointment, you can choose to update all occurrences or only an individual occurrence of the appointment.
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 You can specify the time zone in which an appointment starts and ends. You might want to have different time zones if, for example, your “appointment” is an airplane flight that starts and ends in different time zones, and you want the flight to show up correctly wherever you’re currently located. In this exercise, you’ll schedule an appointment and a recurring appointment, and you’ll update appointments by using commands in the appointment window. SET UP  You don’t need any practice files to complete this exercise. Display the Calendar module in the default Day view, minimize the To-Do Bar, and then follow the steps.
 
 
 
 1. In the Date Navigator at the top of the Navigation Pane, click tomorrow’s date. See Also  For information about the default Calendar module view and the Date Navigator, see “Displaying Different Views of a Calendar” later in this chapter.
 
 Outlook displays tomorrow’s schedule.
 
 
 
 2. In the Calendar pane, point to the 12:00 P.M. time slot (or, if you already have an appointment scheduled at 12:00 P.M., to another time when you have 30 minutes available). Click to add appointment appears in the time slot.
 
 
 
 3. Click once to activate the time slot. In this default mode, you can enter basic appointment details directly in the Calendar pane.
 
 
 
 4. Type SBS Lunch with Jane, and then press Enter. Important  The subject of each appointment, meeting, or event you create while working through the exercises in this book begins with SBS so that you can easily differentiate the practice items you create from other items on your calendar.
 
 Outlook creates a half-hour appointment beginning at 12:00 P.M.
 
 
 
 5. Drag the appointment from the 12:00 P.M. time slot to the 1:00 P.M. time slot (or, if you already have an appointment scheduled at 1:00 P.M., to another time when you have an hour available). Outlook changes the appointment start time.
 
 
 
 6. Point to the bottom border of the appointment, and when the pointer changes to a double-headed arrow, drag down one time slot so that the appointment ends at 2:00 P.M. While the appointment is selected in the calendar, the Appointment contextual tab is available.
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 Date Navigator
 
 Active appointment
 
 The most common appointment settings are available on the Appointment contextual tab. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 You can add more details to the appointment and change the default settings from within the appointment window.
 
 
 
 7. Double-click the SBS Lunch with Jane appointment. The appointment window opens. The subject, start time, and end time are set according to the information you entered in the Calendar pane.
 
 
 
 8. In the Location box, type Fourth Coffee. 9. On the Appointment tab of the appointment window (not the Appointment
 
 
 
 10. In the Options group, click the Reminder arrow, and then in the list, click 1 hour. 11. In the Tags group, click the Private button.
 
 contextual tab in the Calendar module), in the Options group, click the Show As arrow, and then in the list, click Out of Office.
 
 Marking an appointment, event, or meeting as Private hides the details from anyone you share your calendar with.
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 All of these settings other than the location are available from the Appointment contextual tab in the Calendar module.
 
 
 
 12. In the Actions group, click the Save & Close button. When the appointment window closes, Outlook applies your changes to the appointment shown on the calendar. Your availability is indicated by the colored bar on the left side of the appointment.
 
 Availability
 
 Location
 
 Private appointment
 
 Outlook might display messages about the appointment based on other calendar information.
 
 The settings on the Appointment contextual tab also reflect the changes you made to the appointment.
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 13. Double-click the 2:00 P.M. time slot. Outlook opens an appointment window with the appointment start time set to 2:00 P.M. and the end time set 30 minutes later. Because this immediately follows the lunch appointment you just created, the information bar at the top of the meeting window indicates that the meeting is adjacent to another on your calendar.
 
 
 
 14. In the Subject box, type SBS Staff Meeting. In the Location box, type
 
 Conference Room. Then in the notes area, type the following sentence: Bring status reports.
 
 
 
 15. On the Appointment tab, in the Options group, click the Recurrence button. The Appointment Recurrence dialog box opens.
 
 When configuring a weekly recurrence, you can change the time, day, frequency, and duration from the Appointment Recurrence dialog box.
 
 The default appointment recurrence is weekly on the currently selected day of the week. You can set the appointment to recur until further notice, to end after a certain number of occurrences, or to end by a certain date.
 
 
 
 16. In the End list, click 4:00 PM (2 hours). In the Range of recurrence area, click
 
 
 
 17. To indicate that you want to create a 2-hour appointment beginning at 2:00 P.M.
 
 End after, and then in the box, replace 10 with 2.
 
 on the selected day of the week, this week and next week only, click OK in the Appointment Recurrence dialog box.
 
 Scheduling and Changing Appointments   169
 
 
 
 In the appointment window, the Start Time and End Time fields disappear and are replaced by the recurrence details. Recurrence-related solutions
 
 Recurrence details Several aspects of the appointment window change to reflect that this is now a series of recurring appointments.
 
 
 
 18. On the Appointment Series tab, in the Actions group, click the Save & Close button. The new appointment appears on your calendar.
 
 
 
 19. If necessary, scroll the Calendar pane to display the entire appointment. The circling arrow icon at the right end of the time slot indicates the recurrence. Recurring appointment
 
 The completed appointments.
 
 
 
 20. In the Date Navigator, click the weekday of the appointment in each of the next two weeks, to verify that the appointment appears on your calendar next week, but not the following week. CLEAN UP  Retain the SBS Lunch with Jane and SBS Staff Meeting appointments in your calendar for use as practice files later in this chapter.
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 Adding National Holidays to Your Calendar You can easily add the local holidays of any of over 80 countries to your Outlook calendar. To add national holidays to your Outlook calendar, follow these steps: 1. Open the Outlook Options dialog box. 2. On the Calendar page of the Outlook Options dialog box, under Calendar Options, click Add Holidays. The Add Holidays to Calendar dialog box opens.
 
 More than 80 countries are available in the Add Holidays To Calendar dialog box.
 
 3. Select the check boxes of the countries whose holidays you want to add to your calendar, and then click OK. Tip  If you’ve already added the holidays for a selected country to your calendar, Outlook prompts you to verify that you want to install a second instance of each holiday. Assuming that you do not want to do this, click No.
 
 4. After Outlook adds the selected country’s holidays to your calendar, click OK in the confirmation message box and in the Outlook Options dialog box.
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 Outlook 2010 assigns a color category named Holiday to all the local holidays it adds to your calendar. To view all the holidays on your calendar, enter category:holiday in the Search box. Note that Outlook adds each holiday for the next 20 years to the calendar, so the entire list of results might not be displayed immediately (only the first 200 results). If the search returns more than 200 results, add search criteria to narrow down the field (for example, start:2012 to view all holidays in 2012) or click the information bar at the top of the search results list to display the entire list. You can narrow your search by using any of the displayed column headers followed by a colon and a search specification.
 
 A basic search returns only the first 200 results; click the information bar to display all the results. See Also  For information about categories, see “Organizing Outlook Items by Using Color Categories” in Chapter 7, “Organize Your Inbox.” For information about Outlook search functionality, see “Quickly Locating Messages” in the same chapter.
 
 To remove national holidays from your calendar, follow these steps: 1. Use the Search function to locate the holidays you want to remove. 2. Select individual holidays you want to remove; or click any holiday in the list to activate the list, and then press Ctrl+A to select all the holidays in the search results. 3. Press the Delete key. Tip  If you inadvertently add two sets of holidays from one country to the calendar, the easiest way to rectify the situation is to remove all of that country’s holidays and then add them again.
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 Creating an Appointment from a Message Many e-mail messages that you receive result in your wanting or needing to schedule an appointment on your calendar based on the information in the message—for example, a friend or co-worker might send you a message containing the details of the grand opening for a local art gallery that you want to add to your calendar. Outlook provides a convenient method of creating a Calendar item (an appointment, event, or meeting request) based on an e-mail message; you simply drag the message to the Calendar button in the Navigation Pane. When you release the mouse button, an appointment window opens, already filled in with the message subject as the appointment subject, the message text in the content pane, and any message attachments attached to the appointment. The start and end times are set to the next half-hour increment following the current time. You can convert the appointment to an event or meeting in the same way that you would create an event or meeting from within the Calendar module. You can retain any or all of the message information as part of the Calendar item so that you (or other meeting participants) have the information on hand when you need it. After creating the Calendar item, you can delete the actual message from your Inbox. To create an appointment from an e-mail message: 1. Drag the message from the Mail pane to the Calendar button in the Navigation Pane, but don’t release the mouse button. As you hold the dragged message over the Calendar button, the Navigation Pane changes to display the Calendar module information instead of the Mail module information. 2. After the Navigation Pane content changes, release the mouse button to create an appointment based on the message. You can convert the appointment to an event by selecting the All Day Event check box, or convert it to a meeting by inviting other people to attend. You can edit the information in the content pane without affecting the content of the original message, and you can move or delete the original message without affecting the appointment. 3. In the appointment window, click the Save & Close button to save the appointment to your calendar. See Also  For information about adding message content to your To-Do List, see “Creating Tasks” in Chapter 6, “Track Tasks.”
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 Scheduling and Changing Events Events are day-long blocks of time that you schedule on your Outlook calendar—for example, a birthday, a payroll day, or anything else occurring on a particular day but not at a specific time. In all other respects, creating an event is identical to creating an appointment, in that you can specify a location, indicate recurrence, indicate your availability, and attach additional information to the event item. You can create an event directly on the calendar when viewing your calendar in Day, Work Week, Week, or Month view. In this exercise, you’ll schedule an event and convert it to a recurring event by using the commands in the Calendar module. SET UP  You don’t need any practice files to complete this exercise. Display the Calendar module in Day view, and then follow the steps.
 
 
 
 1. In the Date Navigator at the top of the Navigation Pane, click the first day of next month. The Date Navigator changes to display the next month.
 
 
 
 2. In the Calendar pane, point to the blank space below the day header and above the time slots. Click to add event appears in the space.
 
 
 
 3. Click once to activate the event slot. The event space changes to display a darker background color, and an event placeholder becomes active. In this mode, you can enter basic event details directly in the Calendar pane.
 
 
 
 4. Type SBS Pay Day, and then press Enter. 5. On the Appointment contextual tab, in the Options group, click the Recurrence button. The Appointment Recurrence dialog box opens. The default recurrence for events is the same as for appointments—weekly on the currently selected day of the week. Note that the Start and End times are set to 12:00 AM and the Duration to 1 day, indicating that this is an all-day event.
 
 
 
 6. In the Recurrence pattern area, click Monthly. Tip  If you have an Exchange account and a mobile device that supports connections to Exchange accounts (such as a Windows 7 Phone, BlackBerry, or iPhone), it’s easy to keep your calendar and reminders at your fingertips wherever you are by configuring your mobile device to connect to your Exchange account.
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 You can schedule a monthly event to recur on a specific date of the month or on a selected (first, second, third, fourth, or last) day of the month. Monthly events can recur every month or less often (for example, every third month).
 
 When configuring a monthly recurrence, you can change the day or date of the month, frequency, and duration from the Appointment Recurrence dialog box.
 
 
 
 7. To create a recurring appointment on the first day of each month, with no specific end date, click OK.
 
 The contextual tab changes to reflect that this is now a recurring event, and the recurrence icon appears to the right of the event subject.
 
 In Day view, events appear above the schedule for the day.
 
 CLEAN UP  Retain the SBS Pay Day event in your calendar for use as a practice file later in this chapter.
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 Scheduling Meetings A primary difficulty when scheduling a meeting is finding a time that works for all the people who need to attend it. Scheduling meetings through Outlook is significantly simpler than scheduling meetings by discussing times and locations with the participants, particularly when you need to accommodate the schedules of several people. Outlook displays the individual and collective schedules of people within your own organization, and of people outside of your organization who have published their calendars to the Internet. You can review attendees’ schedules to locate a time when everyone is available, or have Outlook find a convenient time for you. You can send an Outlook meeting invitation (referred to as a meeting request) to any person who has an e-mail account—even to a person who doesn’t use Outlook. You can send a meeting request from any type of e-mail account (such as an Exchange account or an Internet e-mail account). The meeting window has two pages: the Appointment page and the Scheduling Assistant (or Scheduling) page. The Appointment page is visible by default. You can enter all the required information directly on the Appointment page, or use the additional features available on the Scheduling Assistant page to find the best time for the meeting.
 
 The Appointment page of a meeting window.
 
 People you invite to meetings are referred to as attendees. By default, the attendance of each attendee is indicated as Required. You can inform non-critical attendees of the meeting by marking their attendance as Optional. You can invite entire groups of people by using a contact group or distribution list. You can also invite managed resources, such as conference rooms and audio/visual equipment, that have been set up by your organization’s Exchange administrator.
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 A meeting request must have at least one attendee other than you, a start time, and an end time. It should also include a subject and a location, but Outlook will send the meeting request without this information if you specifically allow it. The body of a meeting request can include text and Web links, as well as file attachments. This is a convenient way to distribute meeting information to attendees ahead of time. The secondary page of the meeting window is the Scheduling Assistant page, if your e-mail account is part of an Exchange Server 2010 or Exchange Server 2007 network. Otherwise, the secondary page is the Scheduling page, which doesn’t include the Room Finder feature we discuss below. If you’re organizing a meeting for a large number of people and want to view collective information about their schedules, you do so on the Scheduling or Scheduling Assistant page.
 
 The Scheduling Assistant page of a meeting window.
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 The Scheduling and Scheduling Assistant pages include a group schedule that shows the status of each attendee’s time throughout your working day. Outlook indicates your suggested meeting time on the group schedule with green (start time) and red (end time) vertical bars. If free/busy information is available for meeting attendees, their time is shown as white (Available), blue (Busy), or purple (Out of Office). Their Tentative bookings are indicated by light-blue diagonal stripes. If no information is available (either because Outlook can’t connect to an attendee’s calendar or because the proposed meeting is further out than the scheduling information stored on the server), Outlook shows the time with gray diagonal stripes. The row at the top of the schedule, to the right of the All Attendees heading, indicates the collective schedule of all the attendees. Tip  You can enter additional attendees in the To box on the Appointment page or in the All Attendees list on the Scheduling or Scheduling Assistant page.
 
 You can change the time and duration of the meeting to work with the displayed schedules by selecting a different time in the Start Time and End Time lists, by dragging the green and red vertical bars (the start time and end time bars) in the group schedule, or by clicking the time you want in the Suggested Times list. On the right side of the Scheduling Assistant page, the Room Finder task pane is open by default. The monthly calendar at the top of the Room Finder task pane indicates the collective availability of the group on each day, as follows: ● Dates that occur in the past and non-working days are gray. ● Days when all attendees are available are white (Good). ● Days when most attendees are available are light blue (Fair). ● Days when most attendees are not available are medium blue (Poor). Tip  The Room Finder task pane is available only for Exchange accounts. You can display or hide the Room Finder task pane on the Appointment page or on the Scheduling Assistant page by clicking the Room Finder button in the Options group on the Meeting tab.
 
 Managed conference rooms that are available at the indicated meeting time are shown in the center of the Room Finder task pane. At the bottom of the Room Finder task pane, the Suggested Times list displays attendee availability for appointments of the length of time you have specified for the meeting. Selecting a date in the calendar displays the suggested meeting times for just that day. (Scheduling suggestions are not provided for past or nonworking days.) Clicking a meeting time in the Suggested Times list updates the calendar and the meeting request. See Also  For information about creating a meeting request from an e-mail message, see the sidebar “Creating an Appointment from a Message” earlier in this chapter.
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 Outlook tracks responses from attendees and those responsible for scheduling the resources you requested, so you always have an up-to-date report of how many people will attend your meeting. The number of attendees who have accepted, tentatively accepted, and declined the meeting request appears in the meeting header section when you open a meeting in its own window. In this exercise, you’ll create and send a meeting request. SET UP  You don’t need any practice files to complete this exercise. Display your default calendar and inform two co-workers or friends that you are going to practice inviting them as attendees to a meeting. Ask the attendees not to respond to the meeting request that they receive. Then follow the steps.
 
 
 
 1. In the Date Navigator, click tomorrow’s date. Then in the Calendar pane, click the
 
 
 
 2. On the Home tab, in the New group, click the New Meeting button.
 
 3:00 P.M. time slot (or if you have a conflicting appointment, click a time when you have 30 minutes available). An untitled meeting window opens. The selected date and times are shown in the Start Time and End Time boxes above the notes pane.
 
 
 
 3. In the To box, type the e-mail address of the first co-worker or friend with whom you arranged to practice.
 
 
 
 4. In the Subject box, type SBS Get-Together. 5. In the Location box, type Test meeting to indicate that the meeting request is for testing purposes only. You have provided all the standard information for a meeting request.
 
 A basic meeting request.
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 6. On the Meeting tab, in the Show group, click the Scheduling Assistant button. The All Attendees list on the Scheduling Assistant page includes you and the attendee you entered in the To box (showing the attendee’s e-mail address or, if the attendee has an entry in your Address Book, the associated name). The icon next to your name, a magnifying glass in a black circle, indicates that you are the meeting organizer. The icon next to the attendee’s name, an upward-pointing arrow in a red circle, indicates that he or she is a required attendee. Attendance options
 
 Start time and end time bars
 
 When you are the meeting organizer, the Scheduling Assistant displays the subject of each appointment on your schedule that is not marked as Private.
 
 
 
 7. If necessary, scroll to the bottom of the Room Finder task pane to display the Suggested times list.
 
 The times shown are based on your schedule and the schedule information that is available for the first attendee.
 
 
 
 8. In the All Attendees list, click Click here to add a name, enter the e-mail address of the second person with whom you arranged to practice, and then press Tab. The Suggested Times list in the Room Finder task pane is updated to reflect any schedule conflicts for the second attendee.
 
 
 
 9. Click the Required Attendee icon to the left of the second attendee’s name. A list of attendance options expands.
 
 180    Chapter 5  Manage Scheduling
 
 You can extend a courtesy invitation to optional attendees.
 
 
 
 10. In the list, click Optional Attendee. The second attendee’s icon changes to the letter i (for information) in a blue circle to indicate that you’re sending the meeting request for his or her information, but he or she does not need to attend.
 
 
 
 11. In the group schedule, experiment with changing the meeting time and duration by dragging the green start time bar and the red end time bar. Then in the Suggested times list, select a meeting time that works for all three attendees. The start time and end time bars move to the selected time slot. You can change the Show As and Reminder settings, create recurrences, assign color categories, and make any other changes you want. The availability specified in the Show As list will apply to all attendees who accept your meeting request.
 
 
 
 12. After you select the meeting time you want, click the Appointment button in the Show group.
 
 On the Appointment page, the second attendee has been added to the To box, and the Start Time and End Time boxes display the meeting time you selected.
 
 
 
 13. Verify the meeting details, and then click the Send button. The meeting appears in your calendar, and your co-workers or friends receive the meeting request. CLEAN UP  Remind your attendees not to respond to the meeting request. Retain the SBS Get-Together meeting in your calendar for use in later exercises.
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 Updating and Canceling Meetings You might find it necessary to change the date, time, or location of a meeting after you send the meeting request. As the meeting organizer, you can change any information in a meeting request at any time, including adding or deleting invited attendees, or canceling the meeting. To edit a meeting request, double-click the meeting on your calendar. If the meeting is one of a series (a recurring meeting), Outlook prompts you to indicate whether you want to edit the meeting series or only the selected instance of the meeting. Make the changes you want, and then save and close the meeting window.
 
 Changes to meeting details are tracked so that attendees can quickly identify them.
 
 To cancel a meeting, click the meeting on your calendar and then click the Delete button in the Actions group on the Meeting or Meeting Series tab, or open the meeting window and then click the Delete button in the Delete group on the Meeting tab. After you edit or cancel a meeting, Outlook sends an updated meeting request to the invited attendees to keep them informed. If the only change you make is to the attendee list, Outlook gives you the option of sending an update only to the affected attendees.
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 Responding to Meeting Requests When you receive a meeting request from another Outlook user, the meeting appears on your calendar with your time scheduled as Tentative. Until you respond to the meeting request, the organizer doesn’t know whether you plan to attend.
 
 Unaccepted meeting requests in the Reading Pane.
 
 You can respond to a meeting request in one of these four ways: ● You can accept the request. Outlook deletes the meeting request and adds the
 
 meeting to your calendar. ● You can tentatively accept the request, which indicates that you might be able to
 
 attend the meeting but are undecided. Outlook deletes the meeting request and shows the meeting on your calendar as tentatively scheduled. ● You can propose a new meeting time. Outlook sends your request to the meeting
 
 organizer for confirmation and shows the meeting with the original time on your calendar as tentatively scheduled. ● You can decline the request. Outlook deletes the meeting request and removes
 
 the meeting from your calendar. If you don’t respond to a meeting request, the meeting remains on your calendar with your time shown as tentatively scheduled.
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 Tentatively scheduled time is indicated by diagonal striping.
 
 If you’re unsure whether a meeting time works for you, you can click the Calendar button within the meeting window. Your Outlook calendar for the suggested meeting day opens in a separate window so that you can view any conflicting appointments. When accepting or declining a meeting, you can choose whether to send a response to the meeting organizer. If you don’t send a response, your acceptance will not be tallied, and the organizer will not know whether you are planning to attend the meeting. If you do send a response, you can add a message to the meeting organizer before sending it.
 
 You can add a note to the meeting organizer or attach a document that pertains to the meeting subject.
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 To respond to a meeting request: 1. In the meeting window, in the Reading Pane, or on the shortcut menu that appears when you right-click the meeting request, click Accept, Tentative, or Decline. 2. Choose whether to send a standard response, a personalized response, or no response at all. To propose a new time for a meeting: 1. In the meeting window, in the Reading Pane, or on the shortcut menu that appears when you right-click the meeting request, click Propose New Time, and then click Tentative And Propose New Time or Decline And Propose New Time. The Propose New Time dialog box opens.
 
 You can respond to a meeting request by proposing a different meeting time.
 
 2. In the schedule area of the Propose New Time dialog box, change the meeting start and end times to the times you want to propose, and then click the Propose Time button. 3. In the meeting response window that opens, enter a message to the meeting organizer if you want to, and then click Send. Outlook sends your response and adds the meeting to your calendar as tentatively scheduled for the original meeting time. If the meeting organizer approves the meeting time change, you and other attendees will receive updated meeting requests showing the new meeting time.
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 Displaying Different Views of a Calendar You can select a view and an arrangement for the display of your calendar. The default view is Calendar, and the default arrangement is Day. Most exercises in this chapter have shown the calendar in this default view and arrangement, which we refer to simply as Day view. Tip  Because Outlook 2010 coordinates your scheduled tasks to your calendar, you can look at your calendar in Day view or Week view to see the tasks that need to be completed that day or that week, and you can track your progress by marking tasks as complete when you finish them.
 
 Views The Calendar module offers four distinct views of content, which are available from the Change View list in the Current View group on the View tab. These views are: ● Calendar  This is the standard view in which you display your Outlook calendar. In
 
 the Day, Work Week, or Week arrangement, Calendar view displays the subject, location, and organizer (if space allows) of each appointment, meeting, or event, as well as the availability bar and any special icons, such as Private or Recurrence. ● Preview  In the Day, Work Week, or Week arrangement, Preview view displays
 
 additional information, including information from the notes area of the appointment window, as space allows. ● List  This list view displays all appointments, meetings, and events on your calendar. ● Active  This list view displays only future appointments, meetings, and events.
 
 When working in a list view, you can group calendar items by selecting a field from the Arrangement gallery on the View tab. Important  In this book, we assume you are working in Calendar view, and refer to the standard Calendar view arrangements as Day view, Work Week view, Week view, and Schedule view. For information about changing and resetting views, see “Displaying Different Views of Contact Records” in Chapter 4, “Store and Access Contact Information.”
 
 Arrangements By default, your calendar is shown in the Day arrangement of Calendar view. However, this arrangement displays your schedule only for the current day and doesn’t keep you apprised of upcoming appointments later in the week or month. To help you stay on top of your schedule, you can display several different arrangements of your calendar: ● Day  Displays one day at a time separated into half-hour increments.
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 ● Work Week  Displays only the days of your work week. The default work week is
 
 Monday through Friday from 8:00 A.M. to 5:00 P.M. Time slots that fall within the work week are white on the calendar; time slots outside of the work week are colored. See Also  For information about modifying the days and hours of the work week shown in Outlook, see “Defining Your Available Time” in Chapter 8, “Manage Your Calendar.” ● Week  Displays one calendar week (Sunday through Saturday) at a time. ● Month  Displays one calendar month at a time, as well as the preceding and following
 
 weeks (for a total of six weeks, the same as the Date Navigator). When displaying Month view, you can choose one of three detail levels: ❍ Low Detail  Displays a calendar that is blank except for events. ❍ Medium Detail  Displays events and shaded, unlabeled bars to indicate
 
 appointments and meetings. ❍ High Detail  Displays events and labeled bars to indicate appointments and
 
 meetings. ● Schedule view  Displays a horizontal view of the calendar for the selected time
 
 period. Schedule view, which is new in Outlook 2010, is very useful for comparing multiple calendars such as those of the members of a calendar group. See Also  For information about calendar groups, see “Sharing Calendar Information” in Chapter 8, “Manage Your Calendar.”
 
 You switch among arrangements by clicking the buttons in the Arrangement group on the View tab of the Calendar module ribbon. Tip  If you’ve made changes to any view (such as the order in which information appears) and want to return to the default settings, click the Reset View button in the Current View group on the View tab. If the Reset View button is unavailable, the view already displays the default settings.
 
 You can display a specific day, week, or month in the Calendar pane by using these techniques: ● In Month view, you can click the week tab at the left edge of a week to display only
 
 that week. ● In Month, Week, or Work Week view, you can display a specific day in Day view by
 
 double-clicking the header for that day. ● You can display the previous or next time periods by clicking the Back button or
 
 the Forward button next to the date or date range. ● You can display the current day by clicking the Today button in the Go To group on
 
 the Home tab.
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 Using the Date Navigator You can use the Date Navigator to change the day or range of days shown on the calendar. Scheduled appointments Scroll to next month
 
 Current date Dates of next month The default Date Navigator.
 
 By default, the Date Navigator displays six weeks at a time. The current date is indicated by a red border. The days of the selected month are black. Days of the previous month and the next month are gray, but you can still select them in the Date Navigator. Bold dates indicate days with scheduled appointments, meetings, or events. You can display a specific day, week, or month in the Calendar pane by selecting it in the Date Navigator. Use these techniques to work with the Date Navigator: ● To display a day, click that day.
 
 If you’re displaying the calendar in Day, Work Week, or Week view, the day appears and is highlighted in the current view. If you’re displaying the calendar in Month view, the display changes to Day view. ● To display a week, click the margin to the left of that week. Or, if you display
 
 week numbers in the Date Navigator and Calendar, click the week number to display that week. In any calendar view, selecting a week in the Date Navigator changes the display to Week view. Tip  Specific weeks are referred to in some countries by number to simplify the communication of dates. (For example, you can say you’ll be out of the office “Week 24” rather than “June 7-11.”) Week 1 is the calendar week in which January 1 falls, Week 2 is the following week, and so on through to the end of the year. Because of the way the weeks are numbered, a year can end in Week 52 or (more commonly) in Week 53. To display week numbers in the Date Navigator and in the Month view of the calendar, select the Show Week Numbers... check box on the Calendar page of the Outlook Options dialog box.
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 ● To display a month, click the Previous or Next button to scroll one month back or
 
 forward, or click the current month name and hold down the mouse button to display a range of months, point to the month you want to display, and then release the mouse button. To scroll beyond the seven-month range displayed by default, point to the top or bottom of the month list. In Month view, scrolling the month displays the entire month; in Day view it displays the same date of the selected month, and in Week or Work Week view it displays the same week of the selected month. In every Outlook module, the Date Navigator is located at the top of the To-Do Bar. In the Calendar module, if you close the To-Do Bar, the Date Navigator moves to the top of the Navigation Pane. In either location, you can display additional months by increasing the width or height of the area allocated to the Date Navigator. You can allocate up to 50 percent of the program window to the Navigation Pane or To-Do Bar. Click to minimize
 
 Drag to resize
 
 Click to expand
 
 Expanding the Date Navigator in the Navigation Pane.
 
 When the Date Navigator displays more than one month, each month shows either five or six weeks at a time—whichever is necessary to show all the days of the currently selected month in a Sunday through Saturday calendar format and to match the height of any other month displayed next to it. Only the first and last months include the days of the preceding or following month (in gray). See Also  For more information about modifying the display of the Date Navigator, see “Personalizing the Outlook Program Window” in Chapter 13, “Customize Outlook.”
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 In this exercise, you’ll first display different periods of time in your calendar and reset a customized view to its default settings. Then you’ll change the display of the Daily Task List and of the To-Do Bar. Finally, you’ll navigate through your calendar by using the Date Navigator, and display different levels of information about scheduled appointments and events. SET UP  You need the SBS Lunch with Jane and SBS Staff Meeting appointments and the SBS Pay Day event you created in the previous exercises in this chapter. If you did not complete those exercises, you can do so now, or use any appointments, meetings, or events on your own calendar. Display the Calendar module in any Calendar view, and then follow the steps.
 
 
 
 1. On the Home tab, in the Arrange group, click the Work Week button. Keyboard Shortcut  Press Ctrl+Alt+2 to display your calendar in the Work Week arrangement. See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at the end of this book.
 
 The Calendar pane displays your currently configured work week and highlights the corresponding days in the Date Navigator. The Daily Task List is open at the bottom of the pane. The first time slot of your work day appears at the top of the pane.
 
 
 
 2. Scroll the Calendar pane to display one hour prior to the start of your work day. Time slots within your work day are white; time slots outside of your work day are shaded.
 
 
 
 3. In the Go To group, click the Today button. If the Calendar pane wasn’t previously displaying the current week, it does so now. The times displayed remain the same. The current day and the current time slot are highlighted.
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 Work week time slots
 
 Current time
 
 Current day
 
 Non–work week time slots
 
 Daily Task List
 
 When the To-Do Bar is open, the Date Navigator appears at the top of the To-Do Bar and not in the Navigation Pane.
 
 
 
 4. On the View tab, in the Current View group, click the Reset View button. A message box prompts you to confirm that you want to reset the view.
 
 The Reset View command resets only the current view.
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 5. In the Microsoft Outlook message box, click Yes. The Calendar pane changes to display today’s schedule in the default Day arrangement, with the Daily Task List open at the bottom of the pane.
 
 
 
 6. On the View tab, in the Layout group, click the Daily Task List button, and then in the list, click Minimized.
 
 The Daily Task List changes to a single row at the bottom of the Calendar pane. The minimized Daily Task List displays a count of your total, active, and completed tasks for the day.
 
 
 
 7. In the Layout group, click the To-Do Bar button, and then in the list, click Minimized. The To-Do Bar changes to a single column at the right side of the program window. The minimized To-Do Bar displays your next appointment and the number of tasks due today (from the To-Do Bar Task List).
 
 Minimized Daily Task List
 
 Minimized To-Do Bar
 
 When the To-Do Bar is minimized, the Date Navigator moves to the Navigation Pane.
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 8. In the Date Navigator, which now appears at the top of the Navigation Pane, click a bold date to display your calendar for a day on which you have scheduled appointments or meetings.
 
 
 
 9. In the Date Navigator, point to the left edge of a calendar row that contains one or more bold dates. When the cursor changes to point toward the calendar, click once. The Calendar pane displays the selected seven-day week.
 
 The days shown in the Calendar pane are shaded in the Date Navigator.
 
 
 
 10. On the Home tab, in the Arrange group, click the Month button (not its arrow). Keyboard Shortcut  Press Ctrl+Alt+4 to display your calendar in the Month arrangement.
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 Outlook displays your calendar for the month. Alternating months are shaded to provide an obvious visual indicator of the change. The Daily Task List is not available in Month view.
 
 You can display a different month by scrolling the Calendar pane, or by clicking the month you want to view, in the Date Navigator.
 
 
 
 11. In the Arrange group, click the Month arrow, and then click Show Medium Detail.
 
 The calendar changes to display only events as readable items; appointments and meetings appear as horizontal lines, with the width of the line indicating the amount of time scheduled for that item.
 
 194    Chapter 5  Manage Scheduling
 
 Week label
 
 Hidden appointment
 
 In Medium Detail view, items assigned to color categories are represented by lines in the category color.
 
 
 
 12. In the Month list, click Show Low Detail to hide appointments and meetings entirely. The calendar changes to display only events; appointments and meetings are hidden entirely.
 
 
 
 13. Click one of the week labels that appear along the left edge of the Calendar pane. Outlook displays the selected week in Week view. (If you had more recently displayed a Work Week view, the week would be shown in that view.) The calendar item details are no longer hidden.
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 14. To the left of the date range in the calendar header, click the Forward button. The calendar moves forward one week.
 
 
 
 15. Use any of the available navigation methods to display the week containing one of
 
 
 
 16. On the View tab, in the Current View group, click the Change View button and
 
 the SBS Staff Meeting appointments.
 
 then in the gallery, click Preview.
 
 The notes saved with the recurring appointment appear on the calendar.
 
 
 
 17. Click the day label at the top of the day on which the SBS Staff Meeting appointment occurs. Outlook returns to Day arrangement, but still displays the Preview view.
 
 In Preview view, the calendar displays any notes saved with the appointment.
 
 
 
 18. In the Change View gallery, click Calendar. The Calendar pane returns to its default settings. CLEAN UP  Retain the SBS Lunch With Jane and SBS Staff Meeting appointments and the SBS Pay Day event on your calendar for use in later exercises.
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 Key Points ● You can create and manage appointments and all-day events in your calendar. ● Other people in your organization can see whether you are free, busy, or out-of-
 
 office as a result of the appointments, events, and meetings scheduled in your calendar. ● You can personalize the display of your available working hours, and mark
 
 appointments as private to hide the details from other people. ● You can use Outlook to set up meetings, invite participants, and track their
 
 responses. ● Outlook can identify a meeting time based on participants’ schedules. ● If your organization is running Exchange Server 2010 or Exchange Server 2007,
 
 you can use the Scheduling Assistant features to quickly identify meeting times of a specific duration during which your planned attendees are available. ● You can display many different views of your calendar. You can change the dates
 
 and date ranges displayed in the Calendar pane by using the Date Navigator, by using navigational buttons within the Calendar pane, or by using commands on the ribbon.
 
 Chapter at a Glance Create tasks, page 200
 
 Update tasks, page 210
 
 Remove tasks and items from task lists, page 213
 
 Manage task assignments, page 214 Display different views of tasks, page 219
 
 6 Track Tasks In this chapter, you will learn how to ✔ Create tasks. ✔ Update tasks. ✔ Remove tasks and items from task lists. ✔ Manage task assignments. ✔ Display different views of tasks.
 
 Many people keep one or more task lists going at all times, listing things to do, things to buy, people to call, and so on. You might cross off tasks as you complete them, transfer unfinished tasks to other lists, create multiple lists for multiple purposes, or follow a specialized system designed by an efficiency expert. You probably write these task lists on pieces of paper, even though you’ve undoubtedly experienced the pitfalls of that age-old system. Paper crumples, tears, and frequently ends up in the lint tray of the clothes dryer (even when you are sure you checked all the pockets before you put your pants in the laundry). If you use Microsoft Outlook 2010 on a daily basis, you might find it far easier to use its built-in task list, called the To-Do List. You can add tasks, assign due dates, receive reminders, and mark tasks as complete when you finish them. You can even assign tasks to other people, and if those people use Outlook, you can view their progress on assigned tasks as they track progress milestones. You can view the task list associated with your default e-mail account in several locations within Outlook, including the Tasks module, the To-Do Bar Task List, the Daily Task List that appears in selected calendar views, and the Outlook Today page. You can view other Outlook task lists in the Tasks module. In this chapter, you’ll create tasks from scratch and learn how to delegate tasks to other people and manage task assignments. You’ll also review different ways of arranging, organizing, and locating tasks, and you’ll remove tasks from your list by marking them as complete or deleting them.
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 Practice Files  The exercises in this chapter use Outlook items you created in exercises in previous chapters. If an exercise requires an item that you don’t have, you can complete the exercise in which you create the item before beginning the exercise, or you can substitute a similar item of your own. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book. See Also  For information about the Daily Task List, see “Displaying Different Views of a Calendar” in Chapter 5, “Manage Scheduling.” For information about the To-Do Bar and the To-Do Bar Task List, see “Displaying Different Views of Tasks” later in this chapter.
 
 Creating Tasks If you use your Outlook task list to its fullest potential, you’ll frequently add tasks to it. You can create one-time or recurring tasks from scratch in different ways, or you can add an existing Outlook item (such as a message) to your task list. Regardless of how or where you create a task, all tasks are available in the Tasks module and in the To-Do Bar Task List. Only individual tasks are available in the Tasks List. Tip  Another way to add a task to your list is by accepting an assigned task. For more information, see “Managing Task Assignments” later in this chapter.
 
 You can attach files to task items, and you can include text, tables, charts, illustrations, hyperlinks, and other content in the task window content pane by using the same commands you use in other Outlook item windows and in other Microsoft Office 2010 programs, such as Microsoft Word. You can also set standard Outlook item options such as recurrence, color categories, reminders, and privacy. Tip  You can maintain multiple task lists by creating folders to contain task items. For information about creating task folders, see the sidebar “Finding and Organizing Tasks” later in this chapter.
 
 Creating Tasks from Scratch You can create a task item from scratch by using one of several methods. In the Tasks module: ● Click the New Task button on the Home tab, enter the task details in the task
 
 window that opens, and then save and close the task. ● When you display your To-Do List, enter the task description in the Type A New
 
 Task box at the top of the list, and then press Enter to create a task with the default settings.
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 ● When you display your Tasks List, enter the task description in the Click Here To Add
 
 A New Task box, press Tab to move to subsequent fields, fill in other information, and then press Enter. Tip  The fields available in the Tasks List vary based on the list view you’re displaying. For information about the available views, see “Displaying Different Views of Tasks” later in this chapter.
 
 In any module: ● Click the New Items button on the Home tab and then, in the list, click Task. ● In the To-Do Bar, enter the task description in the Type A New Task box at the top
 
 of the To-Do Bar Task List. From any view of the task list, you can assign the task to a category, change the due date, add a reminder, mark the task as complete, or delete the task entirely. To access these commands, right-click the task name, category, or flag, and then click the option you want. Tip  By default, Outlook doesn’t automatically set a reminder for tasks as it does for calendar items. You can turn on reminders from the Outlook Options dialog box. For more information, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 Task Options When you create a task item, the only information you must include is the subject. As with many other types of Outlook items, you can set several options for tasks to make it easier to organize and identify tasks. ● Start date and due date  You can display tasks on the various Outlook task lists on
 
 either the start date or the due date. The color of the task flag indicates the due date. ● Status  You can track the status of a task to remind yourself of your progress. Specific
 
 status options include Not Started, In Progress, Completed, Waiting On Someone, or Deferred. You also have the option of indicating what percentage of the task is complete. Setting the percentage complete to 25%, 50%, or 75% sets the task status to In Progress. Setting it to 100% sets the task status to Complete. ● Priority  Unless you indicate otherwise, a task is created with a Normal priority
 
 level. You can set the priority to add a visual indicator of a task’s importance. Low priority displays a blue downward pointing arrow and High priority displays a red exclamation point. You can sort and filter tasks based on their priority. ● Recurrence  You can set a task to recur on a regular basis; for example, you might
 
 create a Payroll task that recurs every month. Only the current instance of a recurring task appears in your task list. When you mark the current task as complete, Outlook creates the next instance of the task.
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 ● Category  Tasks use the same category list as other Outlook items. You can
 
 assign a task to a category to associate it with related items such as messages and appointments. ● Reminder  You can set a reminder for a task in the same way you do for an
 
 appointment. The reminder appears until you dismiss it or mark the task as complete. ● Privacy  Marking a task as private ensures that other Outlook users to whom you
 
 delegate account access can’t see the task details. None of the options are required, but they can be helpful to you when sorting, filtering, and prioritizing your tasks.
 
 Creating Tasks from Outlook Items You frequently need to take action based on information you receive in Outlook—for example, information in a message or in a meeting request. You might want to add information from another Outlook item to your task list, to ensure that you complete any necessary follow-up work. Depending on the method you use, you can either create a new task from an existing item or simply transfer the existing item to your task list by flagging it. To create a new task from a message, contact, or note: ● Drag the message to the Tasks button at the bottom of the Navigation Pane, pause
 
 until the Navigation Pane changes to display the Tasks module content, and then release the mouse button. This method opens a task window that already has information filled in from the original item. You can change settings, add information and attachments, assign the task to other people, and so on. To transfer an existing e-mail message to your task list without creating an individual task: ● Click the flag icon to the right of a message in the Mail pane. This method, referred
 
 to as flagging a message for follow-up, adds the message to your task lists with the default due date specified in the Quick Click settings, and adds an information bar to the message. However, it does not create a separate task item, so to retain the task, you must retain the message—you can move the message between mail folders, but deleting the message deletes the task as well.
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 ● Right-click the flag icon to the right of a message in the Mail pane, and then specify
 
 a due date: Today, Tomorrow, This Week, Next Week, No Date, or Custom (which allows you to set specific start and end dates). Tip  Flagged messages appear on your task list under the default due date header. You can change the default due date either by setting the Quick Click flag in the Outlook Options dialog box or by right-clicking the flag and then clicking Set Quick Click. In the Set Quick Click dialog box, click the due date you want to appear by default, and then click OK. ● Drag the message to the To-Do Bar Task List and drop it under the heading for
 
 the due date you want to assign it to. (If the desired due date doesn’t already have a heading in the To-Do Bar Task List, you need to drop the message under another heading and then assign the due date you want.) This method also adds the message to your task list but doesn’t create a separate task item. You can flag a contact record for follow-up by clicking the contact record in the Contacts pane and then clicking the Follow-Up button in the Tags group on the Home tab. If you frequently want to create message-based tasks with special settings, such as a task with the original message attached to it, with specific follow-up settings or categories, and with specific assignments, you can create a Quick Step to accomplish all of these steps with one click. See Also  For information about using standard Quick Steps, see “Managing Messages by Using Quick Steps” in Chapter 7, “Organize Your Inbox.” For information about creating custom Quick Steps, see “Creating and Managing Quick Steps” in Chapter 13, “Customize Outlook.”
 
 In this exercise, you’ll flag a message for follow-up and create tasks from the To-Do Bar Task List and from the Tasks pane. SET UP  This exercise uses the SBS Tradeshow Schedule and SBS First Draft messages you created in Chapter 3, “Send and Receive E-Mail Messages.” If you didn’t create those messages, you can do so now, or you can substitute any messages in your Inbox. Display your Inbox, and expand the To-Do Bar if it is minimized. Locate the SBS Tradeshow Schedule message, and then follow the steps.
 
 
 
 1. In the message list, to the right of the SBS Tradeshow Schedule message, click the transparent Quick Click flag.
 
 The Quick Click flag changes from transparent to red, and a task named SBS Tradeshow Schedule appears in the Today category on your To-Do Bar Task List. Tip  For the purposes of this exercise, we assume that you haven’t yet created other tasks and Today is the only due date heading in the To-Do Bar Task List at this time.
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 2. In the To-Do Bar Task List, point to the SBS Tradeshow Schedule task. A ScreenTip appears displaying the start date, reminder time, due date, the folder in which the message appears, and any categories assigned to the message.
 
 The flagged message appears in the To-Do Bar Task List. Pointing to the message displays additional information. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 
 
 3. In the To-Do Bar Task List, double-click the SBS Tradeshow Schedule task. The flagged message opens in a message window. The message header indicates that you need to follow up on this message. The start and due dates given are today’s date.
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 Follow-up information
 
 The ribbon of the flagged message includes only message commands; it does not have additional task-related tabs or commands.
 
 
 
 4. Close the message window. 5. In the message list, locate the SBS First Draft message. Drag the message from the message list to the To-Do Bar Task List, and drop it under the Today heading.
 
 In the message list, the Quick Click flag in the right margin of the SBS First Draft message changes from transparent to red. Tip  If you can’t see all of your tasks, you can increase the height of the To-Do Bar Task List by dragging the horizontal divider between the calendar information and the task information upward.
 
 
 
 6. In the To-Do Bar Task List, right-click (don’t click) the red flag to the right of the SBS First Draft message.
 
 Troubleshooting  Clicking an active flag marks the item as complete in the Inbox, and removes it from the To-Do Bar Task List. For more information, see “Removing Tasks and Items from Task Lists” later in this chapter.
 
 A list of due date options appears and, because a task has been activated, the Task List contextual tab appears on the ribbon.
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 It’s easy to change the due date of a task or the follow-up date for a flagged message in the To-Do Bar Task List.
 
 
 
 7. In the list, click This Week. Tip  Flagging a task for completion This Week or Next Week sets the start date to the first working day of the specified week and the due date to the last working day of the week. The default work week is Monday through Friday but the start and due dates reflect your own work week configuration. For information about changing the days and times of your work week, see “Defining Your Available Time” in Chapter 8, “Manage Your Calendar.”
 
 A new This Week due date heading appears in the To-Do Bar Task List with the message under the heading. In the message list and in the To-Do Bar Task List, the Quick Click flag to the right of the SBS First Draft message changes from red to light pink. Troubleshooting  If the This Week heading doesn’t automatically appear, click the Today heading to refresh the list.
 
 
 
 8. At the top of the To-Do Bar Task List, click Type a new task, enter SBS Order Brochures, and then press Enter.
 
 Tip  The tasks you create while working through the exercises in this book begin with SBS so that you can differentiate them from any real tasks you create.
 
 The new task appears in the Today section of the To-Do Bar Task List.
 
 
 
 9. In the Navigation Pane, click the Tasks button.
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 The Tasks module opens, displaying your active tasks in the To-Do List. The icon preceding each item in the list indicates whether it is a standard task, a flagged e-mail message, and so on. Message icons match those shown in the Inbox, indicating whether the message is read or unread and whether you’ve replied to or forwarded the message.
 
 
 
 10. In the To-Do List, click the SBS Tradeshow Schedule message. The Reading Pane displays the flagged message contents. Follow-up information
 
 The To-Do List and Reading Pane of the Tasks module, displaying a flagged message.
 
 
 
 11. In the To-Do List, click SBS Order Brochures. The Reading Pane displays the task item contents. You can’t edit the task settings directly in the Reading Pane. Task item header information
 
 The To-Do List and Reading Pane, displaying a task item.
 
 
 
 12. At the top of the To-Do List, click Type a new task, enter SBS Dinner Reservations, and then press Enter.
 
 The task appears in the Today section of both the To-Do List and the To-Do Bar Task List.
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 13. In the To-Do List, click the SBS Dinner Reservations task. Then on the Home tab, in the Follow Up group, click Next Week.
 
 In both task lists, the task appears under the Next Week heading. In the Reading Pane, the due date changes to Friday of the next week.
 
 Setting the due date to Next Week puts the task under the Next Week heading but assigns an actual due date of the last working day of the next week.
 
 
 
 14. Double-click the SBS Dinner Reservations task to open it in a task window. 15. In the notes pane, enter the following sentence: Confirm that the restaurant has a private dining room available for the Board Meeting. As with other Outlook items, you can add many types of content to the notes pane and format the text in the notes pane.
 
 You can add notes, links, and attachments in the notes pane.
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 16. On the Task tab, in the Actions group, click the Save & Close button. The task window closes.
 
 
 
 17. On the Home tab, in the New group, click the New Task button. An untitled task window opens.
 
 
 
 18. In the Subject box, enter the following sentence: SBS Send Dinner Invitations.
 
 
 
 19. Click the Due date arrow. A calendar appears.
 
 On the calendar, a red outline indicates the current date.
 
 
 
 20. On the calendar, click the Tuesday of the next week (not of the current week). Tip  You can’t assign to a task a due date that has already passed.
 
 
 
 21. Select the Reminder check box, click the Reminder arrow, and then in the calendar,
 
 
 
 22. In the notes pane, enter the following sentence:
 
 click the Monday of the next week.
 
 Invite all Board members and their spouses.
 
 
 
 23. In the Actions group, click the Save & Close button. Outlook adds the task to your task list, and it appears in the Next Week group in both the To-Do Bar Task List and the To-Do List.
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 A bell next to a task name indicates that a reminder is set for the task.
 
 CLEAN UP  Retain the SBS Order Brochures, SBS Dinner Reservations, and SBS Send Dinner Invitations tasks, and the flagged SBS Tradeshow Schedule and SBS First Draft messages, for use in later exercises.
 
 Updating Tasks Tasks generally appear on the Outlook task lists by start date or due date. You can change the details or dates of a task, or track the progress you’ve made on it. To update the status of a task: 1. Open the task window. 2. In the % Complete list, type or select (by clicking the arrows) the percentage of the project you estimate as complete. Outlook changes the status to reflect your selection. Tasks that are 0% complete are Not Started, tasks that are 1% to 99% complete are In Progress, and tasks that are 100% complete are Completed.
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 3. If you want to manually change the task status—for example, to Waiting on someone else or Deferred—click that option in the Status list. 4. Save and close the task. Outlook updates the task both in your own task list and in the task originator’s task list. You can’t track the status of a flagged message. In this exercise, you’ll update the status and due date of a task on your task list. SET UP  You need the SBS Dinner Reservations task you created earlier in this chapter to complete this exercise. If you didn’t create that task, you can do so now, or you can substitute any task in your default task list. Display your To-Do List in the Tasks module, and then follow the steps.
 
 
 
 1. In the Tasks pane, double-click the SBS Dinner Reservations task. For the purposes of this exercise, assume that you are waiting for the banquet manager to confirm whether a private dining room is available. You want to update the task to reflect your progress, change the task due date, and also remind yourself to call again if you don’t hear from her by the end of the day.
 
 
 
 2. Click the Start date arrow, and then on the calendar, click Today. 3. Click the Status arrow, and then in the list, click Waiting on someone else. 4. In the % Complete box, type or select (by clicking the arrows) 25%. 5. In the notes pane, on a new line, type the following sentence: Left message for banquet manager—will call back tomorrow.
 
 
 
 6. Click the Due date arrow, and then on the calendar, click the next day. The information bar at the top of the task header changes to reflect the new due date.
 
 
 
 7. Select the Reminder check box. Click the first Reminder arrow, and then on the calendar, click the due date.
 
 
 
 8. Click the second Reminder arrow, and then in the list, click 3:00 PM. Outlook is set to display a reminder on the afternoon of the new due date.
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 You can easily update a task to reflect its current completion status.
 
 
 
 9. On the Task tab, in the Actions group, click the Save & Close button. In the To-Do List, the SBS Dinner Reservations task moves under the Tomorrow heading.
 
 The changes you made in the task window are reflected in the Reading Pane.
 
 CLEAN UP  Retain the SBS Dinner Reservations task for use in later exercises.
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 Removing Tasks and Items from Task Lists When you complete a task or follow up on a flagged item, you have three options for managing its presence on your task list: marking the task or flagged item as complete, removing the flag from a flagged item, or deleting the task or flagged item entirely. Marking a task or flagged item as complete retains a record of the item on your task list. Completed tasks are visible only in certain task list views. To mark a task as complete: ● In the Tasks module, click the task to make it active, and then on the Home tab, in
 
 the Manage Task group, click the Mark Complete button. ● In views that include a check box preceding the task subject (most list views), select
 
 the check box to delete the task. ● In views that include a colored flag, click the flag once. ● In any view, right-click the task, and then click Mark Complete. ● In the task window, change the Status to Completed or the % Complete setting
 
 to 100%. Whichever method you use, in your task list, the completed task is crossed through, the Complete check box is selected, and the flag changes to a check mark. In the task window for the completed task, Status is set to Completed and % Complete is set to 100%. (In other words, doing any one thing accomplishes all the others.)
 
 Completed tasks appear in certain views of your Tasks List but not in your To-Do List.
 
 After you mark an instance of a recurring task as complete, Outlook generates a new instance of the task at whatever interval you specified when creating the task. Removing the flag from a flagged item such as a message or contact record retains the item in its original location but removes it from your task list entirely.
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 To remove the flag from an item: ● Display the Tasks module, click the flagged item to select it, and then click the
 
 Remove From List button in the Manage Tasks group on the Home tab. ● Click the flagged item in the To-Do Bar Task List and then click the Remove From
 
 List button in the Manage Tasks group on the Task List contextual tab. ● Right-click the flagged item, click Follow-up, and then click Clear Flag.
 
 Deleting a task or flagged item moves the task or the original item to the Deleted Items folder; it is permanently deleted when you empty that folder. No record of it remains on your task list or in its original location (such as your Inbox). To delete a task or flagged item: ● In the Tasks module, click the task to make it active and then on the Home tab, in
 
 the Delete group, click the Delete button. ● In any view, right-click the task, and then click Delete.
 
 Managing Task Assignments You can assign tasks from your Outlook task list to other people within your organization and outside of your organization (and other people can assign tasks to you). Outlook indicates assigned tasks in your task list by adding blue arrow pointing to a person on the task icon, similar to that of a shared folder in Windows Explorer.
 
 Tasks You Assign to Others You can assign tasks to people on your Microsoft Exchange Server network, to people on other Exchange Server networks, and to people running e-mail programs other than Outlook. ● When you assign a task to a person on your Exchange Server network, Outlook
 
 sends a task request, similar to a meeting request, to the person you designated. The assignee can accept or decline the task assignment by clicking the corresponding button in the Reading Pane or in the task window header. Outlook indicates the status of the task in your task list as Assigned. ● When you assign a task to a person who is on another Exchange Server network or
 
 is using an e-mail program other than Outlook, Outlook sends a message that the assignee can respond to manually. Until you change the task status, it is Waiting For Response From Recipient, rather than Assigned.
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 When you assign a task, you can choose whether to keep a copy of the task on your own task list or transfer it entirely to the assignee’s task list. Either way, the task remains on your own task list until accepted, so you won’t lose track of it. (If the recipient declines the task, you can return it to your task list or reassign it.) Tip  You can assign only actual task items; you can’t assign flagged messages that appear in your task list.
 
 After you assign a task to someone else, ownership of the task transfers to that person, and you can no longer update the information in the task window. (The assignee becomes the task owner and you become the task originator.) If you keep a copy of the task on your task list, you can follow the progress as the assignee updates the task status and details, and you can communicate information about the task to the owner by sending status reports. Unless you choose otherwise, Outlook automatically sends you a status report on an assigned task when the assignee marks the task as complete. To delegate a task to another Outlook user: 1. In the task window, on the Task tab, in the Manage Task group, click the Assign Task button. 2. In the To box that appears in the task header, enter the e-mail address of the person you want to assign the task to. 3. In the task header, click the Send button. If a message box notifies you that the task reminder has been turned off, click OK. Outlook sends the task request, and notifies you when the assignee accepts or declines the task. You can view the status of tasks you have assigned to other people by displaying your task list in Assignment view. See Also  For information about task list views, see “Displaying Different Views of Tasks” later in this chapter.
 
 If you assign a task and the assignee declines the assignment, the task doesn’t automatically return to your task list; you need to either reclaim it (return it to your own task list) or reassign it. To reclaim or reassign a declined task: 1. Open the declined task assignment (indicated in your Inbox by a task icon with a red X). The Manage Task group on the Task tab of the ribbon includes commands specific to managing the declined task.
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 Declined task
 
 Task management options
 
 When an assignee declines a task, you can reclaim or reassign it.
 
 2. In the Manage Task group, click the Return To Task List button to reclaim the task, or the Assign Task button to reassign it.
 
 Tasks Other People Assign to You When another person assigns a task to you, you receive a task assignment request. To accept, decline, respond to, or reassign a task assignment request: 1. Open the task assignment request (indicated in your Inbox by a task icon with an outstretched hand). The Task tab of the ribbon includes commands specific to managing the task assignment request. Assigned task
 
 Task response options
 
 You can respond in several ways to a task assignment.
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 2. Take one of the following actions: ❍ In the Respond group, click the Accept button to accept the task or the
 
 Decline button to decline the task, and send the associated response to the task owner. ❍ In the Respond group, click Reply to send a message to the task owner
 
 without accepting or declining the task, or the Forward button to forward the task content to another person without reassigning the task. ❍ In the Manage Task group, click the Assign Task button, and follow the process
 
 described earlier in this topic to assign the task to another person. You can update the details of a task assigned to you by someone else in the same way that you do tasks that you create. To send a status report about a task assigned to you by someone else: 1. Open the task window. 2. On the Task tab, in the Manage Task group, click the Send Status Report button. Outlook generates an e-mail message with the task information in the Subject field and message body. 3. Address the message to the people you want to send the report to, and then send the message. In this exercise, you’ll assign a task to another person. SET UP  You need the SBS Send Dinner Invitations task you created earlier in this chapter to complete this exercise. If you didn’t create that task, you can do so now, or you can substitute any task in your default task list. Choose a co-worker or other e-mail contact to practice assigning tasks to, and let him or her know to expect a task assignment. Then display your To-Do List in the Tasks module, and follow the steps.
 
 
 
 1. In the Tasks pane, double-click the SBS Send Dinner Invitations task. The task opens in a task window.
 
 
 
 2. In the Manage Task group, click the Assign Task button. A To box and Send button appear in the task header, and the Manage Task group changes to display only the Cancel Assignment button.
 
 
 
 3. In the To box, enter the e-mail address of the person to whom you want to assign the task.
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 Note that the Keep An Updated Copy Of This Task On My Task List and Send Me A Status Report When This Task Is Complete check boxes are selected by default.
 
 When you assign a task, you have the option of keeping it on your task list or removing it.
 
 
 
 4. In the task header, click the Send button. A message box notifies you that the task reminder previously set for this task will be turned off when you assign it to another person.
 
 You don’t receive reminders when tasks you assigned to others are overdue.
 
 
 
 5. In the Microsoft Outlook message box, click OK. Outlook sends the task request. Your co-worker or contact receives a task assignment request.
 
 
 
 6. Ask your co-worker or contact to accept the task. Outlook notifies you when the assignee accepts or declines the task. CLEAN UP  Retain the SBS Send Dinner Invitations task for use in later exercises.
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 Displaying Different Views of Tasks Outlook 2010 makes it simple to keep your task list at your fingertips. You can view tasks in several different locations, including the following: ● In the Tasks module, you can display either the To-Do List, which includes both tasks
 
 and flagged messages, or the Tasks List, which includes only tasks. There are many options for viewing and arranging each list. ● In any module, the expanded To-Do Bar displays the To-Do Bar Task List, where
 
 tasks are grouped and sorted under due date headings. (You can also sort this list by category, start date, folder, type, or importance, or you can create a custom arrangement.) You can scroll through the list to display all your tasks or collapse the groups you don’t want to view. To increase the space available for your task list, you can close the Date Navigator or show fewer or no appointments. The minimized To-Do Bar displays only your next appointment (if you choose to display appointments) and the number of incomplete tasks due today (if you choose to display tasks). You switch between views of the To-Do Bar by clicking the Minimize or Expand button on its header. See Also  For information about the To-Do Bar, including changing the type and amount of content displayed, see “Personalizing the Outlook Program Window” in Chapter 13, “Customize Outlook.” ● In the Calendar module, the Daily Task List appears at the bottom of the Calendar
 
 pane in Day, Work Week, or Week view. When expanded, the Daily Task List at displays the tasks due, including the category and task type, during the displayed time period. In Day view, the start date, due date, and reminder time also appear. Tip  If you don’t see the Daily Task List in Day, Work Week, or Week view, click the Daily Task List button in the Layout group on the View tab, and then click Normal.
 
 Like the Navigation Pane and the To-Do Bar, you can minimize the Daily Task List so that it displays only the number of active and completed tasks and provides more space for you to work. You can switch between views of the Daily Task List by clicking the Minimize or Expand button on its header. You can schedule a specific block of time to complete a task by dragging it from the Daily Task List to your calendar. When you mark the task complete, Outlook removes it from your calendar. ● On the Outlook Today page, the tasks due today are listed in the Tasks area. (This page
 
 was previously the “home page” of Outlook. You display the Outlook Today page by clicking your top-level account in the Navigation Pane.)
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 The Outlook Today page summarizes your activities for the current day.
 
 So far in this chapter, we’ve been working in your To-Do List, which is the default Tasks module view and displays both tasks and flagged messages. You can display more comprehensive information about the tasks on a task list by clicking the Tasks entry for that account in the Tasks module Navigation Pane. As you can with your calendar, you can display different views of your Tasks List and within each view, different arrangements of the tasks. You can change the view from the Change View gallery in the Current View group on the Home tab, or from the Change View gallery in the Current View group on the View tab. Tasks List views include: ● Active ● Assigned ● Completed ● Detailed ● Next 7 Days ● Overdue ● Prioritized ● Server Tasks ● Simple List ● Today ● To-Do List
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 The default view for the Tasks List is Simple List view, with tasks arranged by due date. Not surprisingly, the default view for the To-Do List is To-Do List. From the Arrangements gallery in the Arrangement group on the View tab, you can select from the following standard arrangements of items within the To-Do List or a Tasks List view: ● Assignment ● Categories ● Due Date ● Folder (Available in the To-Do List only, this view separates tasks and flagged
 
 messages that are stored in different folders.) See Also  For information about organizing tasks in custom folders, see the sidebar “Finding and Organizing Tasks” later in this chapter. ● Importance ● Modified Date ● Start Date ● Type
 
 You can reorder the tasks in any list view by clicking the heading of the field you want to sort on. You can add and remove fields from the list view by using the Field Chooser, in the same way that you would from the list view of contact records. See Also  For information about adding and removing fields in a list view, see “Displaying Different Views of Contact Records” in Chapter 4, “Store and Access Contact Information.”
 
 Completed tasks remain in the Tasks List until you actually delete them, so they are available there if you want to view them. Tip  The Tasks List views don’t by default display the Reading Pane. If you want, you can display it at the bottom of the Tasks pane so that you don’t lose horizontal screen space and obscure task details. Click the Reading Pane button in the Layout group on the View tab, and then click Bottom.
 
 In this exercise, you’ll look at different views of tasks and flagged messages within the Tasks module. SET UP  This exercise uses the SBS Order Brochures, SBS Dinner Reservations, and SBS Send Dinner Invitations tasks, and the SBS First Draft and SBS Tradeshow Schedule flagged messages you created and assigned earlier in this chapter. If you didn’t create those tasks and messages, you can do so now, or you can substitute any tasks and flagged messages in your task list. Display the To-Do List in the Tasks module, in the default To-Do List view, and then follow the steps.
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 1. With the To-Do List displayed in the Tasks pane, click the Change View button in the Current View group on the Home tab.
 
 The Change View gallery expands. The To-Do List button is selected to indicate the current view.
 
 The Change View gallery.
 
 
 
 2. In the Change View gallery, click Detailed. The To-Do List changes to a list view displaying many different task fields. The Reading Pane, which by default is open to the right of the Tasks pane in To-Do List view, closes.
 
 The To-Do List displayed in the Detailed view.
 
 In this view, the To-Do List resembles the Tasks List.
 
 
 
 3. In the Navigation Pane, click Tasks. The Tasks List appears in the Tasks pane. Only the tasks appear in the list; the flagged messages are absent.
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 The Tasks List, displayed in Simple List view and arranged by due date.
 
 The Tasks List displays its default Simple List view rather than the Detailed view you chose for the To-Do List. The arrow in the Due Date header indicates the current arrangement.
 
 
 
 4. On the View tab, in the Arrangement gallery, click the More button. The gallery expands to display additional arrangements.
 
 The Arrangement gallery.
 
 
 
 5. In the Arrangement gallery, click Assignment. The order of the tasks changes slightly, although it’s not entirely obvious how or why.
 
 
 
 6. In the Arrangement gallery, click Show in Groups. The list changes to clearly distinguish tasks that you’ve assigned to other people from tasks that you own. If you have assigned tasks to multiple people, each assignee has a group.
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 You can group tasks by the current arrangement.
 
 
 
 7. In the Current View group, in the Change View gallery, click Assigned. The list changes to display only the task that you assigned in a previous exercise. Although only one task is visible in the Tasks List, the To-Do Bar Task List still displays all the tasks and flagged messages, so you can feel confident that you’re looking at a filtered view and haven’t accidentally deleted the other tasks.
 
 You can filter a task list to display tasks that meet very specific criteria.
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 8. In the Change View gallery, click To-Do List. The Tasks pane displays all the active tasks in the same format as the default To-Do List. The arrangement changes to Due Date.
 
 The Reading Pane is open by default in the To-Do List view of the Tasks pane.
 
 Note, however, that this is not the real To-Do List—it doesn’t include the flagged messages.
 
 
 
 9. In the Navigation Pane, click To-Do List. The flagged messages reappear in the Tasks pane. CLEAN UP  Return to the Tasks List, and change the view back to the default Simple List view. Retain the SBS Order Brochures, SBS Dinner Reservations, and SBS Send Dinner Invitations tasks, and the flagged SBS Tradeshow Schedule and SBS First Draft messages, for use in later exercises.
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 Finding and Organizing Tasks You can use the Outlook 2010 Search feature to quickly locate tasks by searching on any text in the task or in a file attached to the task. Type the word or other information you want to find in the Search box at the top of the Tasks pane header, in any view. Outlook filters the tasks as you type, displaying only those containing the search criteria you enter, and highlighting the matching criteria in the tasks.
 
 You can modify your search by using the tools on the contextual Search tab.
 
 To help you organize your tasks, you can assign them to color categories in the same way that you do any other Outlook item. See Also  For more information about Instant Search, see “Quickly Locating Messages” in Chapter 7, “Organize Your Inbox.” For more information about Color Categories, see “Organizing Outlook Items by Using Color Categories” in the same chapter.
 
 If your task list gets too big, or if you want to maintain separate task lists for different purposes, you can organize tasks into separate folders. To create a task folder: 1. On the Folder tab, in the New group, click the New Folder button. 2. In the Create New Folder dialog box, enter the name and select the location of the folder. 3. In the Folder Contains list, click Task Items, and then click OK. You can then drag existing tasks into the folder. Tip  If you drag a task into a Mail, Calendar, Contact, or Note Items folder, a message, meeting, contact, or note window opens with the task’s subject entered in the Subject field and details of the task in the message body or notes pane.
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 Key Points ● You can create tasks for yourself and assign tasks to other people. ● Outlook displays tasks in the Tasks pane, in the Daily Task List in the Calendar
 
 pane, and on the To-Do Bar, which is available from any Outlook pane. ● You can organize tasks by grouping them in additional task folders or by
 
 categorizing them. ● When you assign tasks, Outlook sends a task request to the designated person,
 
 who can accept or decline the task. If you keep a copy of the assigned task, it is automatically updated when the person you assigned the task to updates the original. ● You can update tasks assigned to you and send status reports to the person who
 
 assigned the task. ● A task can have a status of Not Started, Deferred, Waiting, Complete, or the
 
 percentage completed. ● You can create one-time or recurring tasks. Outlook creates a new occurrence of a
 
 recurring task every time you complete the current occurrence. ● You can set a reminder to display a message at a designated time before a task
 
 is due. ● When you complete a task you can mark it as complete, remove it from your task
 
 list, or delete it.
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 7 Organize Your Inbox In this chapter, you will learn how to ✔ Work with Conversation view. ✔ Arrange messages in different ways. ✔ Organize Outlook items by using color categories. ✔ Organize messages in folders. ✔ Manage messages by using Quick Steps. ✔ Quickly locate messages. ✔ Print messages. ✔ Delete messages.
 
 You can use Microsoft Outlook 2010 to manage multiple e-mail accounts, including multiple Microsoft Exchange Server accounts with their associated contacts, calendars, and so on. Even if you use Outlook only for sending and receiving e-mail messages, you can rapidly build up a mass of messages that make it difficult to locate information. Fortunately, Outlook is designed to act as a complete information-management system; it provides many simple yet useful features that enable you to organize messages and other Outlook items and to quickly find information that you need. Outlook 2010 automatically handles certain types of organization for you. In your Inbox, Outlook makes it easy to follow related messages (message threads) from multiple people by displaying the messages in Conversation view. Outlook Search almost instantly locates items that contain specific content, and it allows you to save search results as Search Folders in which you can view up-to-date search results at any time. You can organize items in Outlook by storing related items in folders and by assigning color categories to related items. In this chapter, you’ll work with Conversation view to locate different levels of messages in a series. You’ll display the messages in your Inbox in a variety of arrangements and organize messages by assigning color categories and by moving them to folders within your Inbox. You’ll filter and find messages by using the Search feature, and use Search Folders. You’ll work with the built-in Quick Steps. Finally, you’ll preview, print, and delete messages.    231
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 Practice Files  The exercises in this chapter use Outlook items you created in exercises in previous chapters. If an exercise requires an item that you don’t have, you can complete the exercise in which you create the item before beginning the exercise, or you can substitute a similar item of your own. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book.
 
 Working with Conversation View Conversation view is an arrangement of messages grouped by subject. All the messages with the same subject appear together in your Inbox (or other message list) under one conversation header. Collapsed conversation headers
 
 Unread messages
 
 Message senders
 
 Until you expand the conversation header, the entire conversation takes up only as much space in your Inbox as a single message would.
 
 The conversation header provides information about the messages within the conversation, including the number of unread messages and whether one or more messages includes an attachment, is categorized, or is flagged for follow up. When you receive a message that is part of a conversation, the entire conversation moves to the top of your Inbox and the new message appears when you click the conversation header. When a conversation includes unread messages, the conversation header is bold. When there are multiple unread messages, the number is indicated in parentheses following the subject. The senders of the unread messages are listed below the subject.
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 Split Conversations When an e-mail conversation involves more than two people, it frequently happens that more than one person responds to the same message, and other people respond to each of those messages. Multiple conversations emerge from the primary conversation in a process that you might think of as branches growing out from a tree—each can split into additional branches that are farther and farther from the trunk (the original message). A conversation that contains multiple branches is called a split conversation. Within a split conversation, individual conversation branches are marked by orange and gray dots. Larger orange dots indicate the most current message in each branch. Small orange dots indicate older messages. Small gray dots indicate messages that may be considered redundant. Messages within each conversation branch are connected by orange and gray lines (referred to as visual threads). Tip  Conversation view isn’t new in Outlook 2010—it was first introduced in Outlook 2007—but it’s greatly improved and is now the default view for your Inbox and other message folders.
 
 Viewing Conversations You can display differing levels of messages within a conversation, as follows: ● Click the conversation header or the Expand Conversation button to the left of the
 
 conversation header once to display the most recent message in the Reading Pane and to display the most recent message in each branch of a split conversation in the message list. These messages are indicated by orange dots.
 
 Click the conversation header once to display only the most recent messages.
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 ● Click the conversation header again to expand the conversation to display all
 
 messages in the conversation. Expanded conversation
 
 Sent message
 
 Current split conversation message Click the conversation header twice to display all messages. ● Click the most recent message in a split conversation to display the visual thread
 
 of that message branch.
 
 Click a message to display its visual thread.
 
 Conversation View Settings By default, Conversation view displays messages stored in any folder, including sent messages that are stored in the Sent Items folder. (Within the expanded conversation, sent messages are indicated by italic font.) If you prefer to display only messages from the current folder, you can clear this setting on the Conversation Settings menu in the Conversation group on the View tab.
 
 Working with Conversation View   235
 
 
 
 Other settings that you can turn on include: ● Show Senders Above the Subject  This setting reverses the order of the information
 
 in the conversation header; you see the names of the conversation participants above the conversation subject. In some cases, such as when Outlook displays a message on the second line, the subject might not be visible at all.
 
 The effect of the Show Senders Above The Subject setting in a split conversation. ● Always Expand Conversations  This setting causes Outlook to display all messages
 
 in a conversation when you click the conversation header once, rather than twice. ● Use Classic Indented View  This setting causes Outlook to indent older messages
 
 within individual message threads to show the progression of the thread. This setting is not as effective as the default for displaying split conversations because a message might be at the root of multiple branches but can appear only once in the message list.
 
 The effect of the Use Classic Indented View setting.
 
 Managing Conversations Although the most apparent function of Conversation view is the grouping of related messages, its greatest usefulness is as a message-management tool. It can be especially handy for Outlook users within large organizations that use distribution lists to disseminate information to a large group of people. When hundreds of message recipients use the Reply All function to respond to a message, your Inbox can quickly become cluttered.
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 Troubleshooting Conversation View As with many “new and improved” features, Conversation view has its fans and its detractors. Many Outlook users appreciate the efficiency of the automatically grouped messages and not having to wade through as many messages in their Inboxes; others rue the fact that this new feature can cause messages to vanish, apparently, from their Inboxes before they’ve even seen them. Conversation view can present a very efficient means of viewing messages within a multi-threaded conversation; however, it also has its drawbacks. Because Conversation view displays only certain messages within a conversation, a specific message that you’re looking for might not be visible within a conversation. If this happens, you can turn off Conversation view (by clearing the Show In Conversations check box in the Conversation group on the View tab) and then use one of these methods to locate the message you want to find: ● Sort the messages by subject, and then type the first few letters of the con-
 
 versation subject to scroll those messages to the top of the Message pane. ● Enter the subject into the Search box at the top of the Message pane and then
 
 specify any other criteria (such as the sender or date) of the message that you’re looking for to narrow the results. After using either of these methods to display a set of messages, visually scan the messages to locate the one you’re looking for. Conversation view enables you to manage all the messages within a conversation as a group. You can do this by clicking the conversation header to effectively select all the messages in the conversation (they won’t appear selected, but any action you apply to the conversation header applies to all the individual messages in the conversation) and then applying your action. Or you can use these new conversation-management tools: ● Ignore Conversation  This command moves the selected conversation and any
 
 related messages you receive in the future directly to the Deleted Items folder. Keyboard Shortcut  Press Ctrl+Del to ignore the currently active conversation. See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at the end of this book. Tip  Be cautious when using the Ignore Conversation command. Outlook identifies “conversations” based on message subjects. If you receive unrelated messages in the future that have the same message subject as a conversation that you’ve chosen to ignore, you won’t receive those messages.
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 ● Clean Up Conversation  This command deletes redundant messages—messages
 
 whose text is wholly contained within later messages—from a conversation. By default, Outlook doesn’t clean up categorized, flagged, or digitally signed messages. You can modify conversation clean-up settings on the Mail page of the Outlook Options dialog box. See Also  For information about modifying mail settings, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 Arranging Messages in Different Ways As the number of messages in your Inbox increases, it can be challenging to keep track of them. You can arrange, group, and sort messages in Outlook to help you quickly determine which are the most important, decide which can be deleted, and locate any that need an immediate response. See Also  For information about the available message folder views, see “Viewing Messages and Message Attachments” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 You can view a message list in Compact view, Single view, or Preview view. Regardless of the view you’re displaying, you can arrange messages and conversations within the message list by choosing a standard arrangement from the Arrangement gallery on the View tab.
 
 The Arrangement gallery.
 
 Alternatively, you can click the Arrange By bar at the top of the message list and then click an option in the Arrange By list.
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 Message list header Sort order
 
 The Arrange By list.
 
 Two options that affect the way messages appear within an arrangement are conversations and grouping. Both of these organizational options are turned on by default; you can turn either or both off. See Also  For information about conversations, see “Working with Conversation View” earlier in this chapter.
 
 Grouping gathers messages that fit within specific arrangement categories under arrangement-specific headings so that you can manage common messages as one. For example, when messages are arranged by date, they are grouped by date: groups include each day of the current week, Last Week, Two Weeks Ago, Three Weeks Ago, Last Month, and Older. Each group has a header. You can expand or collapse an individual group by clicking the arrow to the left of the group name in the header. You can collapse the group containing the currently selected item by pressing the Left Arrow key, and you can expand a selected group by pressing the Right Arrow key. You can expand or collapse all groups by choosing a command from the Expand/Collapse list in the Arrangement group on the View tab.
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 By default, Outlook displays messages arranged by date, from newest to oldest. Alternatively, you can arrange items by any of the following attributes: ● Account  Messages are grouped by the e-mail account to which they were sent.
 
 This is useful if you receive messages for more than one e-mail account in your Inbox (for example, if you receive messages sent to your POP3 account within your Exchange account mailbox). ● Attachments  Messages are grouped by whether they have attachments and
 
 secondarily by date received. ● Categories  Messages are arranged by the category you assign them to. Messages
 
 without a category appear first. Messages assigned to multiple categories appear in each of those category groups. ● Flag: Start Date or Due Date  Unflagged messages and messages without specific
 
 schedules appear first. Messages that you’ve added to your task list with specific start or due dates are grouped by date. ● From  Messages appear in alphabetical order by the message sender’s display name.
 
 If you receive messages from a person who uses two different e-mail accounts, or who sends messages from two different e-mail clients (for example, from Outlook and from Windows Mail), the messages will not necessarily be grouped together. ● Importance  Messages are grouped by priority: High (indicated by a red exclamation
 
 point), Normal (the default), or Low (indicated by a blue downward-pointing arrow). ● To  Messages are grouped alphabetically by the primary recipients (the addresses
 
 or names on the To line). The group name exactly reflects the order in which addresses appear on the To line. Therefore, a message addressed to Bart Duncan; Lukas Keller is not grouped with a message addressed to Lukas Keller; Bart Duncan. ● Size  Messages are grouped by the size of the message, including any attachment.
 
 Groups include Huge (1–5 MB), Very Large (500 KB–1 MB), Large (100–500 KB), Medium (25–100 KB), Small (10–25 KB), and Tiny (less than 10 KB). This feature is useful if you work for an organization that limits the size of your Inbox because you can easily locate large messages and delete them or move them to a personal folder. ● Subject  Messages are arranged alphabetically by their subjects and then by date.
 
 This is similar to arranging by conversation except that the messages aren’t threaded. ● Type  Items in your Inbox (or other folder) are grouped by the type of item—for
 
 example, messages, encrypted messages, message receipts, meeting requests and meeting request responses, tasks, Microsoft InfoPath forms, and server notifications.
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 After arranging the items in your message list, you can change the sort order of the arrangement by clicking the sort order indicator that appears on the right side of the message list header. Regardless of the view and arrangement you choose, you can sort messages by any visible column simply by clicking its column heading (and reverse the sort order by clicking the column heading a second time). You can change the displayed columns from the Show Columns dialog box, which you display by clicking the Add Columns button in the Arrangement group on the View tab.
 
 The Show Columns dialog box.
 
 Outlook displays the selected columns in the order shown in the list on the right side of the Show Columns dialog box. If displaying all the columns requires more space than is available, only some of the columns will be visible. If necessary, you can change the number of lines shown to accommodate more columns. However, you are likely to find that one of the standard views fits your needs. In a list view, you can control the message arrangement, sorting, grouping, visible columns, and other settings from the shortcut menu that appears when you right-click any column header.
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 In this exercise, you’ll change the arrangement, sort order, and grouping of messages in your Inbox, and filter the Inbox content to display only specific messages. Then you’ll restore the default settings. SET UP  You don’t need any specific practice files to complete this exercise; just use the messages in your Inbox. Display your Inbox in Messages view, and then follow the steps.
 
 
 
 1. In the Arrangement gallery, click From. Outlook rearranges and groups the messages in your Inbox alphabetically by sender.
 
 The Sort Order indicator changes to match the selected arrangement.
 
 
 
 2. In the message list header, click A on top. Outlook reverses the order of the messages and changes the sort order in the message header to Z On Top.
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 3. In the message list header, click the Arrange By bar, and then click Subject. Outlook rearranges and groups the messages by subject, in alphabetical order.
 
 
 
 4. In the Arrangement group, click the Expand/Collapse button and then, in the list, click Collapse All Groups.
 
 Only the group headers are visible. There is a group header for each message or set of messages with the same subject.
 
 Collapsing groups of messages displays only the group headers.
 
 Notice that the number of unread items in each group (if there are any) is indicated in parentheses following the conversation subject.
 
 
 
 5. On the Home tab, in the Find group, click the Filter E-mail button. The Filter E-mail list expands. The list contains the same options that are present on the Search contextual tab.
 
 In the Filter E-mail list, you can specify one or more criteria for the messages that are shown in the message list.
 
 Arranging Messages in Different Ways   243
 
 
 
 
 
 6. In the Filter E-mail list, click Unread. Outlook enters the specified filter in the Search box at the top of the message list and filters your Inbox to display only unread messages. (If you have no unread messages in your Inbox, it appears to be empty.)
 
 The Search box and Search contextual tab indicate the applied filter. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 
 
 7. On the Search tab, in the Close group, click the Close Search button. Outlook removes the filter and returns to the previous arrangement.
 
 
 
 8. Experiment with the available arrangement, sorting, and grouping options. 9. On the View tab, in the Current View group, click the Reset View button. Then in the Microsoft Outlook dialog box that asks whether to reset the view, click Yes.
 
 The message list returns to its original arrangement: grouped, by date, in conversations. CLEAN UP  Arrange your Inbox content in the way that works best for you. Retain the default view settings before continuing, if you want them to match those shown in the rest of this book.
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 Marking Messages as Read or Unread When a new message arrives in your Inbox, its header is bold and its icon depicts a closed envelope to indicate that you haven’t yet opened the message—its status is unread. When you open a message in a message window or preview it for a certain length of time in the Reading Pane, its status changes to read. The message header is no longer bold, and its icon depicts an open envelope. You might want to change the status of a message from read to unread, to remind you to revisit it, or from unread to read, if you know from the message subject that you don’t need to take action on it. You can manually change the status of a message by using these methods: ● Click a message in the message list or select multiple messages, and then on
 
 the Home tab, in the Tags group, click the Unread/Read button. ● Right-click a message or one of a group of selected messages in the message
 
 list, and then click Mark As Read or Mark As Unread. Tip  The shortcut menu that appears when you right-click an item shows only the available option. ● Right-click a folder in the Navigation Pane, and then click Mark All As Read. Keyboard Shortcuts  Press Ctrl+Q to mark a message as read. Press Ctrl+U to mark a message as unread.
 
 Organizing Outlook Items by Using Color Categories To help you more easily locate Outlook items associated with a specific subject, project, person, or other condition, you can create a category specific to that condition and assign the category to any related items. You can assign a category to any type of Outlook item— a message, an appointment, a contact record, a note, and so on. For example, you might assign contact records for customers to a Customers category. Outlook uses color categories, which combine named categories with color bars to provide an immediate visual cue when you view messages in your Inbox, appointments on your calendar, and so on. Depending on the view of the Outlook items, the category may be indicated by a simple colored block or a large colored bar.
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 Category blocks
 
 Category bars
 
 Category bars include the category name. Tip  You can locate, sort, and filter Outlook items by category. For information, see “Quickly Locating Messages” later in this chapter.
 
 Outlook 2010 comes with six pre-configured color categories that are associated only with the color names. You can rename the six starting categories and create new categories. Each category can have the following elements: ● Name  The category name can be one simple word or a long, descriptive phrase.
 
 The first 32 characters of the category name are visible in the color categories dialog box, but pointing to a truncated name displays a ScreenTip containing the entire name. ● Shortcut key  You can assign any of the 11 available keyboard shortcut combinations
 
 (CTRL+F2 through CTRL+F12) to a color category. (You can assign only these 11 keyboard shortcuts within the dialog box.) By using a keyboard shortcut, you can assign a frequently used category in one step. ● Color  You can assign any of the 25 available colors to a category, or you can
 
 choose not to assign a color. (You can’t choose colors other than the 25 shown.) When you assign a category that doesn’t have an associated color to an Outlook item, the color block or color bar is shown as white. You can assign one color to multiple categories.
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 You can assign any of 25 colors to a category.
 
 One category is designated as the Quick Click category. Outlook assigns the Quick Click category by default when you simply click the Category box or column associated with an item. You can change the Quick Click category by clicking Set Quick Click on any one of the Categorize menus and then making your selection in the Set Quick Click dialog box that appears.
 
 The Quick Click category is applied by default when you click a Category bar. Tip  You can also set the Quick Click category on the Advanced page of the Outlook Options dialog box. For more information, see “Personalizing Your Office and Outlook Settings” in Chapter 13, “Customize Outlook.”
 
 You can apply a color category to a selected item or items by using any of these methods: ● In any mail or contacts folder, click the Categorize button in the Tags group on the
 
 Home tab, and then in the list, click the category you want. ● In any message list, click in the Categories column to assign the Quick Click category. ● In any calendar, click the Categorize button in the Tags group on the contextual tab
 
 (Appointment, Meeting, and so on) that appears for the selected item, and then click the category you want. ● In any folder, right-click an item or a selection of items, point to Categorize, and
 
 then click the category you want.
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 To quickly view the messages belonging to a category, you can group messages by category or include the category in a search. In a list view of any module, you can sort and filter by category. On the To-Do Bar, you can arrange your flagged messages and tasks by category. Tip  You can instruct Outlook to automatically assign a category to an incoming message that meets specific criteria by creating a rule. For more information, see “Creating Rules to Process Messages” in Chapter 11, “Manage E-Mail Settings.”
 
 In this exercise, you’ll change the name and color of an existing category, assign a shortcut key to a category, and create categories. Then you’ll categorize a message, and experiment with organizing your Inbox contents by using categories. SET UP  You need the SBS Tradeshow Schedule, SBS First Draft, RE: SBS First Draft, and FW: SBS First Draft messages you created in Chapter 3, “Send and Receive E-Mail Messages.” If you have not already created these messages, you can do so now, or you can substitute any messages in your Inbox. Display your Inbox, and then follow the steps.
 
 
 
 1. In the message list, click the SBS Tradeshow Schedule message. 2. On the Home tab, in the Tags group, click the Categorize button. The Categorize list displays the available categories. Notice that you can remove all categories from a selected message or group of messages by clicking Clear All Categories.
 
 If you haven’t yet worked with categories, the Categorize list includes only the six standard categories named for their colors.
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 3. In the Categorize list, click All Categories. The Color Categories dialog box opens, displaying the currently available categories.
 
 You can rename any of the standard color categories or create new color categories.
 
 
 
 4. In the Color Categories dialog box, click the Blue Category name (not the check box), and then click Rename.
 
 Troubleshooting  If you have already renamed the standard categories, you can either create or rename a different category.
 
 
 
 5. With the category name selected for editing, type Management, and then press Enter. Troubleshooting  Don’t click OK—doing so closes the dialog box.
 
 The category name changes. The category order doesn’t immediately change, but the next time you display the categories in a list or dialog box, they are reordered alphabetically. Tip  If you don’t rename a standard color category before assigning it for the first time, Outlook gives you the option of renaming the category the first time you use it.
 
 
 
 6. With the Management category still selected, click the Color arrow, and then in the lower-right corner of the color palette, click the Dark Maroon square.
 
 The color associated with the Management category changes from Blue to Dark Maroon.
 
 
 
 7. Repeat steps 4 and 5 to rename the Orange Category as Travel Required.
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 8. In the Color Categories dialog box, click New. The Add New Category dialog box opens.
 
 
 
 9. In the Name box, type Marketing. Click the Color arrow and then, in the color palette, click the Dark Green square. Then click the Shortcut Key list.
 
 The list expands to display the keyboard shortcuts available to color categories.
 
 Assign keyboard shortcuts to categories that you use frequently, to save time.
 
 
 
 10. In the Shortcut Key list, click CTRL+F2. Then in the Add New Category dialog box, click OK.
 
 The new category appears at the bottom of the color categories list. Its selected check box indicates that it has been assigned to the currently selected message.
 
 
 
 11. In the Color Categories dialog box, click the Green Category name (not the check box), and then click Delete. In the Microsoft Outlook dialog box confirming that you want to delete the category, click Yes.
 
 Keyboard Shortcut  Press Alt+D to delete the selected category from the color categories dialog box.
 
 The Green Category disappears from the list.
 
 
 
 12. In the Color Categories dialog box, click OK. In the message list and in the To-Do Bar Task List, the Category box of the selected message changes to a dark green square. In the Reading Pane, a dark green bar with the category name Marketing appears at the top of the message.
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 13. In the SBS Tradeshow Schedule message header, right-click the Category box. The shortcut menu displays the color category options in alphabetical order.
 
 Right-clicking any Category box displays the Categorize list content.
 
 
 
 14. On the shortcut menu, click Travel Required. The second category box appears in the message header and in the To-Do Bar Task List. Tip  You can assign an unlimited number of categories to a message, but only the three most recently assigned appear in the message header.
 
 The Reading Pane displays two colored category bars. If you assign more than three categories to a message, Outlook displays additional rows of category bars.
 
 Category bars Assigned categories are visible in the message list, Reading Pane, and To-Do Bar.
 
 
 
 15. In the message list, expand the SBS First Draft conversation twice to display its messages. Click any message in the conversation, and then press Ctrl+F2.
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 The Marketing category is assigned to the selected message and also appears in the conversation header.
 
 
 
 16. Click another message in the SBS First Draft conversation. On the Home tab, in the Tags group, click the Categorize button and then, in the list, click Management.
 
 The Management category is assigned to the selected message, and also appears as a second category in the conversation header.
 
 
 
 17. In the message list header, click the Arranged By bar and then, in the list, click Categories.
 
 The messages are arranged by category, beginning with the uncategorized messages (None), followed by the categorized messages in alphabetical order by category.
 
 
 
 18. To the right of the Arranged By bar, click A on top. The sort order reverses to display the categorized messages (in reverse alphabetical order) at the top of the list.
 
 You can quickly locate categorized messages by changing the message list arrangement.
 
 CLEAN UP  Return the message list to its default Date arrangement before continuing to the next exercise. Retain the SBS Tradeshow Schedule, SBS First Draft, RE: SBS First Draft, and FW: SBS First Draft messages for use in later exercises.
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 Recording Information by Using Outlook Notes You can store miscellaneous information such as reminders, passwords, account numbers, and processes by recording them as electronic notes. Because your notes are available to you from wherever you access Outlook, this can be a very convenient way of retaining information you might need later. And because you’re less likely to accidentally delete a note than a message, it is safer than sending information to yourself in an e-mail message. Although notes are a type of Outlook item, they don’t appear in the same type of windows as messages, appointments, contact records, and tasks. Instead, they appear in the form of “sticky notes” resembling the popular 3M-brand Post-It notes. You can view, sort, and organize notes in the same way you do other Outlook items. The standard views include: ● Icons ● Notes List ● Last Seven Days
 
 You switch the view by clicking the View you want in the Current View gallery on the Home tab. If you’re looking for a specific piece of information in a note, you can quickly locate it by typing a search word or phrase in the Search Notes box above the content pane. By default, the Reading Pane is hidden in the Notes pane, but if you prefer, you can display the Reading Pane and view the content of notes without opening them. To do so, click the Reading Pane button on the View tab, in the Layout group, and then click Right or Bottom to display the Reading Pane in that location. You can enter only text into a note; you can’t format the text. If you paste formatted text into a note, it will change to the default font.
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 Tip  Notes do support hyperlinks; if you enter a Web site address and then press Enter, the Web site address will change to blue, underlined text to indicate that it is a hyperlink. You can click the hyperlink to open the Web site or page in your default Web browser.
 
 By default, note icons and sticky note representations are a pale yellow color, like the color of standard paper sticky notes. When you assign a category to a note, the note color changes to the category color. You can change the default note color (you have the choice of white or a pastel shade of blue, green, pink, or yellow), size (small, medium or large), or font (any font installed on your computer) from the Notes and Journal page of the Outlook Options dialog box. To store information in a note: 1. In the Navigation Pane, click the Notes button. Outlook displays the Notes pane. 2. On the Home tab, in the New group, click the New Note button. Outlook displays a new note. The current date and time appear at the bottom. 3. Enter the subject or title of the note, press Enter, and then enter the information you want to store into the note. The first line of the note becomes its subject or title. 4. To save and close the note, click the Close button in the upper-right corner. The note appears in the Notes pane. Only the subject is visible. You can access the stored information by opening the note (or by displaying the Reading Pane).
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 Organizing Messages in Folders After you’ve read and responded to messages, you might want to keep some for future reference. You can certainly choose to retain them all in your Inbox if you want, but as the number of messages in your Inbox increases to the hundreds and even into the thousands, it might quickly become overwhelming. To keep your Inbox content low and avoid an accumulation of unrelated messages, you can organize messages into folders. For example, you can keep messages that require action on your part in your Inbox and move messages that you want to retain for future reference into other folders. Tip  Because the Outlook Search function provides the option of searching within all folders containing items of a particular type, you can easily locate a message that’s been moved to a folder without having to remember exactly which folder it’s in. For more information, see “Quickly Locating Messages” later in this chapter.
 
 Popular personal-organization experts advocate various folder structures (for paper folders as well as for e-mail message folders) as an important part of an organizational system. You can apply any of these ideas when you create electronic folders in Outlook, or you can use any other structure that works for you. For example, you might create a folder for each project you’re working on and store all messages regarding a particular project in its own folder. Or you might create a folder to store all messages from a particular person, such as your manager, regardless of the message subject. When you create a folder, you specify the location of the folder within your existing Outlook folder structure and the type of items you want the folder to contain. You can create folders to contain the following types of items: ● Calendar items ● Contact items ● InfoPath Form items ● Journal items ● Mail and Post items ● Note items ● Task items
 
 The selection you make governs the folder icon that precedes its name in the folder list, the folder window layout, the ribbon tabs and commands available in the folder, and the content of the Navigation Pane in the folder.
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 You can move messages to folders manually, or if your organization is running Exchange, you can have Outlook move them for you. You can automatically move messages to another folder by creating a rule—for example, you can instruct Outlook to automatically move all messages received from your manager to a separate folder. You can set up different rules that go into effect when you’re away from the office. See Also  For information about automatically moving messages, see “Creating Rules to Process Messages” in Chapter 11, “Manage E-Mail Settings.”
 
 In this exercise, you’ll create a folder and then use different methods to move messages to the folder. SET UP  You need the SBS First Draft, RE: SBS First Draft, and FW: SBS First Draft messages you worked with in the previous exercise. If you have not already created these messages, you can do so now, or you can substitute any messages in your Inbox. Display your Inbox, and then follow the steps.
 
 
 
 1. On the Folder tab, in the New group, click the New Folder button. Keyboard Shortcut  Press Ctrl+Shift+E to create a new folder.
 
 The Create New Folder dialog box opens.
 
 The default settings in the Create New Folder dialog box match the active module at the time you create the folder.
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 Troubleshooting  If your default data file (the file in which your messages are stored) is a personal folder on your hard disk, the first item in the Select Where To Place The Folder box is Personal Folders.
 
 
 
 2. In the Name box, type SBS Messages. In the Select where to place the folder
 
 box, click Inbox. Then, with Mail and Post Items selected in the Folder contains list, click OK. Tip  The name of this folder begins with SBS so that you can easily differentiate it from other folders in your mailbox.
 
 Because you created this folder from the Inbox, Outlook creates the new folder as a subfolder of the Inbox, and formats it to contain mail items.
 
 The new folder will display the ribbon tabs of the Mail module because you designated that it will contain Mail items.
 
 
 
 3. In the message list, locate the SBS First Draft, RE: SBS First Draft, and FW: SBS
 
 
 
 4. Drag the SBS First Draft message from the message list to the SBS Messages
 
 First Draft messages.
 
 folder in the Navigation Pane.
 
 The message moves from the Inbox to the SBS Messages folder.
 
 
 
 5. Click the RE: SBS First Draft message to select it. Then on the Home tab, in the Move group, click the Move button.
 
 The Move list expands, displaying a list of folders and other move options.
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 The Move list automatically includes folders that you create.
 
 
 
 6. In the Move list, click SBS Messages. The selected message moves from the Inbox to the SBS Messages folder.
 
 
 
 7. Right-click the FW: SBS First Draft message, click Move, and then click SBS Messages. The conversation disappears from the Inbox. Tip  When you move the last message of a conversation from the Inbox, related messages stored in other folders disappear.
 
 
 
 8. In the Navigation Pane, under the Inbox folder, click the SBS Messages folder. The messages are visible in the new folder as part of a conversation.
 
 
 
 9. Expand the conversation header once. All the messages in the conversation are visible in the list.
 
 Messages that aren’t in the current folder are shown in italics.
 
 CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.
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 Managing Messages by Using Quick Steps A convenient new feature of Outlook 2010 is Quick Steps, which allow you to perform multiple tasks on messages by clicking only one button. Quick Steps are available from the Quick Steps gallery on the Home tab of any mail folder.
 
 The default Quick Steps gallery.
 
 You can use the built-in Quick Steps or create your own to accomplish as many as 12 tasks at once. A default Outlook installation includes these five Quick Steps: ● Move To  Moves the selected message to a folder that you specify the first time you
 
 use the Quick Step and marks the message as read. After you specify the folder, the Quick Step name changes to include the folder name. ● Team E-mail  Creates a message to a person or people you specify the first time you
 
 use the Quick Step. You can edit the Quick Step to include Cc and Bcc recipients, a specific message subject, a follow-up flag, a level of importance, and specific message text, and to automatically send the message one minute after you click the Quick Step command. ● Reply & Delete  Creates a response to the original message sender and immediately
 
 deletes the original message. Troubleshooting  The Reply & Delete Quick Step deletes the original message before you send the reply. If you close the response message composition window without sending it, the original message will no longer be in your Inbox. If you want to respond to the original message, you first need to retrieve it from your Deleted Items folder. ● To Manager  Forwards the selected message to a person or people you specify the
 
 first time you use the Quick Step. You can edit the Quick Step to include Cc and Bcc recipients, a specific message subject, a follow-up flag, a level of importance, and specific message text, and to automatically send the message one minute after you click the Quick Step command. ● Done  Moves the selected message to a folder that you specify the first time you use
 
 the Quick Step, marks the message as read, and marks the message as complete so that a check mark is displayed in the follow-up flag location.
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 For each of the built-in Quick Steps, you can change its name; edit, add, and remove actions; and specify tooltip text that appears when you point to the Quick Step in the Quick Steps gallery. You can assign shortcut keys (Ctrl+Shift+1 through Ctrl+Shift+9) to up to nine Quick Steps. Tip  You can create new Quick Steps to simplify the performance of many types of messagemanagement actions. For more information, see “Creating and Managing Quick Steps” in Chapter 13, “Customize Outlook.”
 
 In this exercise, you will set up and use a built-in Quick Step. SET UP  Use the SBS Tradeshow Schedule message you worked with earlier in this chapter and the SBS Messages folder you created in the previous exercise. If you did not create these practice files, you can do so now or substitute any message and folder in your Inbox. Display your Inbox, locate the SBS Tradeshow Schedule message, and then follow the steps.
 
 
 
 1. On the Home tab, in the Quick Steps gallery, click Move to: ?. The First Time Setup dialog box for the selected command opens.
 
 Some generic Quick Steps require that you supply information the first time you use them.
 
 
 
 2. Click the Move to folder arrow and then, in the list, click SBS Messages. In the Name box, the name of the Quick Step changes from Move To: ? to SBS Messages.
 
 
 
 3. In the First Time Setup dialog box, click Options. The Edit Quick Step dialog box opens.
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 The Move To command doesn’t include many standard options.
 
 Notice that you can change the existing actions (Move To Folder and Mark As Read) and add actions to the standard Quick Step.
 
 
 
 4. In the Tooltip text box, select the existing text and then type Move and mark
 
 
 
 5. In the Edit Quick Step dialog box, click Save.
 
 as read.
 
 In the Quick Step gallery, the Quick Step name changes from Move To: ? to SBS Messages.
 
 
 
 6. In the message list, click the SBS Tradeshow Schedule message to select it. 7. In the Quick Steps gallery, point to SBS Messages. Your custom tooltip appears below the ribbon.
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 You can supply custom tooltip text for any Quick Step.
 
 
 
 8. In the Quick Steps gallery, click SBS Messages. The selected message disappears from the message list.
 
 
 
 9. In the Navigation Pane, under the Inbox folder, click the SBS Messages folder. The message has been moved to the designated folder.
 
 The categories and follow-up flag of the moved message are intact.
 
 CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.
 
 Quickly Locating Messages The Outlook Search feature is based on the Windows Search technology that is built into Windows 7 and Windows Vista Service Pack 2. Using the Windows Search technology, you can find any file on your computer that contains a specified search term—whether in a file or folder name, in document or workbook content, in an e-mail message within Outlook, in a message attachment, in a picture, music, or video file, and so on. (As a matter of fact, if you prefer to do so, you can conduct all of your Outlook searches from the Windows Start menu.)
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 You can use the Search feature to locate specific terms in any Outlook item. Although you can search for items in the Calendar, Contacts, Tasks, and Notes modules, you most often use it to locate messages in your Inbox and other mail folders. The Search feature can locate search terms in a message or in a file attached to a message. As you enter a search term in the Search box located at the top of the content pane in any module, Outlook filters the items to show only those items in the module that contain the search term and highlights the search term in the list of results. If the search term you enter produces more than 200 results, only the first 200 are displayed, and an information bar appears in the Search Results pane.
 
 Search displays only the first 200 available results unless you request more.
 
 You can display all the results for the current search term by clicking the message bar, or you can narrow the results by expanding the search term or by specifying other search criteria, such as the sender, the recipient (whether the message was addressed or only copied to you), a category assigned to the item, whether the message contains attachments, and so on. Outlook 2010 features the Search contextual tab. This ribbon tab appears when you activate the Search box in any Outlook module. You can enter search terms into the Search box and refine your search by using the commands on the Search contextual tab.
 
 The Search tab appears when you click in a Search box or filter the contents of a message folder.
 
 When searching any folder, you can use the commands on the Search tab to set the scope of the search and to more closely define the search specifications. You can also return to the results of previous searches. See Also  For information about Windows 7 search features, refer to Windows 7 Step by Step by Joan Lambert Preppernau and Joyce Cox (Microsoft Press, 2009).
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 The buttons available in the Scope and Refine groups vary based on the type of folder you’re searching. The Scope group always offers the options of the current folder, all subfolders, all folders of the current type, and all Outlook items. The commands in the Refine group change to reflect common properties of items stored in the current folder type. The most common properties are shown as buttons in the Refine group; additional properties are available for selection from the More list.
 
 You can search for an item based on any property.
 
 When you click a button in the Refine group or a property in the More list, that property appears in the Search box with a placeholder for you to specify the value you’re looking for. As you define the criteria for a search, Outlook filters out all messages that don’t match, which makes it easy to find exactly what you’re looking for. And here’s the neat thing: Outlook searches not only the content of the e-mail message header and the message itself, but also the content of message attachments. So if the search term you’re looking for is in a Microsoft Word document attached to a message, the message is included in the search results. Tip  If your organization uses Public Folders (a feature of Exchange) you can use these same tools to search a Public Folder, but the content isn’t filtered instantly; you must press Enter or click the Search button to get the same results as you would in a standard account folder.
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 Using Search Folders A Search Folder displays all the messages in your mailbox that match a specific set of search criteria, no matter which folders the messages are actually stored in. When you create a Search Folder, it becomes part of your mailbox and is kept up to date. The Search Folder module is located in the Navigation Pane under your toplevel mailbox, at the same level as the Inbox. Outlook 2010 doesn’t include any standard Search Folders. If you want quick access to messages that fit a specific set of criteria, you can create a custom Search Folder. To do so, follow these steps: 1. Display any mail folder. 2. On the Folder tab, in the New group, click New Search Folder. Keyboard Shortcut  Press Ctrl+Shift+P to create a Search Folder.
 
 The New Search Folder dialog box opens.
 
 Search Folder categories include Reading Mail, Mail From People And Lists, Organizing Mail, and Custom.
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 3. In the New Search Folder dialog box, select the type of Search Folder you want to create, and then click OK. You can choose from the standard options presented or click Create A Custom Search Folder to specify other search options. You can make changes to the contents of an existing Search Folder by right-clicking the folder and then clicking Customize This Search Folder. Outlook automatically keeps Search Folder contents up to date. The names of folders containing unread items are bold, followed by the number of unread items in parentheses. The names of folders containing items flagged for follow up are bold, followed by the number of flagged items in square brackets. The names of folders whose contents are not up to date are italic. To update a Search Folder, click the folder name. Each message in your mailbox is stored in only one folder (such as your Inbox), but it might appear in multiple Search Folders. Changing or deleting a message in a Search Folder changes or deletes the message in the folder in which it is stored. In this exercise, you’ll use the Search feature to locate a specific message in your Inbox. SET UP  Use the SBS First Draft, RE: SBS First Draft, FW: SBS First Draft, and SBS Tradeshow Schedule messages, and the SBS Messages folder, you worked with earlier in this chapter. If you didn’t create those practice files, you can do so at this time or substitute messages and a folder of your own. Display your Inbox and the Reading Pane, and then follow the steps.
 
 
 
 1. In the Search box at the top of the message list, type the. Keyboard Shortcut  Press F3 or Ctrl+E to move the cursor to the Search box.
 
 As you type, the Search contextual tab appears on the ribbon, and options for refining your search appear below the Search box.
 
 Selecting an option other than Keyword enters the alternative search criterion (and term) in the Search box.
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 Outlook filters the messages in your Inbox to include only those that contain the word the, and highlights all occurrences of the word in the message list and in the active message.
 
 Initial search results include only messages contained in the Inbox folder and not in any of its subfolders or any other mailbox folders.
 
 In the lower-left corner of the program window, the status bar displays the number of messages included in the search results.
 
 
 
 2. On the Search tab, in the Refine group, click the Subject button. Outlook adds the subject criterion to the Search box and prompts you to enter keywords that should appear in the Subject field of all search results.
 
 You replace the placeholder with the words you want to find in the subject field.
 
 
 
 3. With keywords highlighted, type SBS. Outlook instantly updates the search results to display only the messages in your Inbox that contain the word the and have SBS somewhere in the Subject field.
 
 If you’ve followed along with all the exercises in this chapter, it’s likely that the current search returns no results.
 
 
 
 4. On the Search tab, in the Scope group, click the All Subfolders button.
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 Keyboard Shortcut  Press Ctrl+Alt+Z to expand a search to include subfolders. Press Ctrl+Alt+A to expand a search to include all items of the current type.
 
 The SBS First Draft conversation and SBS Tradeshow Schedule message that you moved to the SBS Messages subfolder in previous exercises appear in the search results.
 
 
 
 5. In the message list header, click the Arrange By bar, and then click Folder. The search results change to reflect the new arrangement.
 
 Grouping the results of a search that includes All Subfolders by folder can help you to locate messages.
 
 
 
 6. In the Options group, click the Recent Searches button. Your recent searches are saved so that you can use the same search again at another time.
 
 Clicking a previous set of search criteria reruns that search against your current items.
 
 
 
 7. Experiment with locating information by specifying criteria. When you finish, click
 
 the Close Search button to remove the filter and redisplay the Inbox message list. Keyboard Shortcut  Press Esc to clear the search results.
 
 CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.
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 Printing Messages Although electronic communications certainly have less environmental impact than paper-based communications, you might from time to time want or need to print an e-mail message—for example, if you want to take a hard copy of it to a meeting for reference, or if you keep a physical file of important messages or complimentary feedback. You can print the message exactly as it appears in your Inbox or embellish it with page headers and footers. Outlook prints the message as shown on-screen, including font and paragraph formats. In this exercise, you’ll preview a message as it will appear when printed, add a page header, and then print the message. Important  To fully complete this exercise, you must have a printer installed. If you don’t have a printer installed, you can perform all steps of the exercise other than printing. To install a printer, click the Start button, click Devices And Printers, and then on the toolbar, click Add A Printer. Follow the wizard’s instructions to install a local or network printer. Your network administrator can provide the information you need to install a network printer.
 
 SET UP  You need the SBS Tradeshow Schedule message you worked with earlier in this chapter. If you did not create that message, you can do so now, or you can substitute any message in your Inbox. Open the SBS Tradeshow Schedule message, and then follow the steps.
 
 
 
 1. In the message window, display the Backstage view, and then click Print. The Print page of the Backstage view displays the current print settings.
 
 The Print page of the Backstage view.
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 The right pane displays the message as it will appear when printed, if you click the Print button without changing the settings shown in the center pane. If necessary, you can adjust the following settings: ❍ Printer  Select an installed printer or add a new one. ❍ Print Options  Opens the Print dialog box, where you can change the default
 
 printing options before printing. You can also change an existing print style (the way the message is presented on the printed page) or create a new one. ❍ Print Style  Choose from the existing print styles available for the selected mes-
 
 sage or other Outlook item. The default print style is Memo style, which prints your name, the message header information, and then the message content.
 
 
 
 2. Click the Print Options button. The Print dialog box opens, displaying your default printer settings, which you can change before printing. Clicking OK prints the message with the current settings.
 
 The Print dialog box displaying the basic Memo Style for printing a message.
 
 
 
 3. In the Print dialog box, click Page Setup.
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 The Page Setup: Memo Style dialog box opens. You can change the font, paper size, page margins, header, and footer from this dialog box.
 
 
 
 4. In the Page Setup: Memo Style dialog box, on the Format page, click the Font button. The Font dialog box opens.
 
 
 
 5. In the Font list, click Arial. In the Font style list, click Narrow Bold Italic. Then
 
 
 
 6. In the Page Setup: Memo Style dialog box, click OK, and then click Preview in
 
 
 
 7. In the lower-right corner of the Print page of the Backstage view, click the Actual
 
 click OK.
 
 the Print dialog box.
 
 Size button to display the message at 100 percent of its size.
 
 The right pane of the Print page displays the message as it will appear when printed, with the header text in Arial Narrow Bold Italic.
 
 You can preview the message at its full size. Tip  If a message will be longer than one page when printed with the current settings, you can click the Multiple Pages button to preview all pages of the message at the same time. You might find this useful when, for example, you want to check page breaks or scan a document for a particular element.
 
 
 
 8. Click Print Options, click Page Setup, and then in the Page Setup: Memo Style dialog box, click the Paper tab to see the available options.
 
 In addition to choosing the paper size, you can select the number of pages that will be printed on each sheet of paper, and set the page margins and the orientation.
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 The Paper page of the Page Setup dialog box.
 
 
 
 9. Click the Header/Footer tab. 10. In the Header area, type For Your Information in the center box, and then click the Font button above the box. In the Font dialog box, under Size, click 16, and then click OK.
 
 The text you entered doesn’t reflect the font size change, but the Header box to the left of the Font button indicates the current font selection.
 
 
 
 11. In the Footer section, select the default text (the page number) that appears in the center box. Then in the AutoText box that appears near the bottom of the Page Setup dialog box, click the User Name button.
 
 Outlook will print the specified text at the top of the page and your name (or user name, if different) at the bottom.
 
 
 
 12. In the Page Setup dialog box, click OK, and then in the Print dialog box, click Print. Troubleshooting  If the Save As dialog box opens, you do not have a printer installed.
 
 Outlook prints the message, including your custom header and footer, to the active printer. CLEAN UP  If you don’t want to retain the custom header and footer as part of the standard message printing template, remove them from the Memo Style. Then close the SBS Tradeshow Schedule message.
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 Deleting Messages When you delete a message, contact record, or any other item, Outlook temporarily moves it to the Deleted Items folder of your mailbox. You can open the folder from the Navigation Pane, view items that have been deleted but not purged, and restore items (undelete them) by moving them to other folders. Keyboard Shortcut  Press Shift+Delete to permanently delete a message from a message list without first moving it to the Deleted Items folder.
 
 By default, Outlook does not permanently delete items until you purge them from the Deleted Items folder. You can empty the entire Deleted Items folder manually or automatically, or you can permanently delete individual items from it. To permanently delete an individual item, follow these steps: 1. In the Navigation Pane, click the Deleted Items folder to display its contents. 2. In the Deleted Items list, click the item (or select multiple items) you want to delete. 3. On the Home tab, in the Delete group, click the Delete button (or press the Delete key). 4. In the Microsoft Outlook message box asking you to confirm that you want to permanently delete the selected item(s), click Yes. To manually empty the Deleted Items folder, follow these steps: ● In the Navigation Pane, right-click the Deleted Items folder, and then click
 
 Empty Folder. To automatically empty the Deleted Items folder each time you exit Outlook, follow these steps: 1. Display the Backstage view, and then click Options. 2. On the Advanced page of the Outlook Options dialog box under Outlook Start And Exit, select the Empty Deleted Items Folder When Exiting Outlook check box. Then click OK.
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 Key Points ● You can filter and locate messages in your mailbox by using the Search feature. ● You can group and sort messages by sender, time, subject, size, category, or any
 
 other field. ● You can assign color-coded categories to messages and then group and sort items
 
 by color category. You can use the default Outlook categories or tailor them to fit your needs. ● You can record miscellaneous information in electronic notes. You can categorize,
 
 search, display, and sort notes, and send notes to other people. ● You can create folders to organize your mail, and move items to folders manually
 
 or automatically. ● You can print a message when you need a paper copy. You can select from several
 
 print styles and make modifications to the print styles to suit your needs. ● When you delete a message or other Outlook item, it moves to the Deleted Items
 
 folder and is not permanently deleted until you empty the folder.
 
 Chapter at a Glance
 
 Define your available time, page 276
 
 Configure time zones, page 279 Work with multiple calendars, page 281
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 8 Manage Your Calendar In this chapter, you will learn how to ✔ Define your available time. ✔ Configure time zones. ✔ Work with multiple calendars. ✔ Share calendar information. ✔ Print a calendar.
 
 Using the Microsoft Outlook 2010 Calendar is a big step toward efficient time management. The Outlook calendar differentiates between working time and nonworking time—only working time is available to co-workers when they schedule meetings with you through Outlook. If the default working times set by Outlook don’t match your actual work schedule, you can change the Work Week settings. You can also configure the Outlook calendar to track your schedule in two time zones and smoothly switch between time zones when you travel. In addition to the default Outlook calendar, you can create, import, and manage other calendars within the Calendar module. In the Calendar pane, you can view either discrete or compiled views of information stored in multiple calendars. Other calendars might include Microsoft Exchange Server account calendars that Outlook creates, secondary calendars you create within your Outlook configuration, calendars other people share with you, and online calendars that you download or subscribe to. There are several ways to share your calendar information with other people. You can share an entire calendar or only selected information with people inside or outside of your organization. If you need to access your calendar information when you’re away from your computer, and don’t have access to it from a mobile device, or if you want to share calendar information with other people in a hardcopy form, you can print out the information for specific date ranges. Outlook offers many different formats for printed calendars; you can choose the print style and level of detail that fit your needs.    275
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 In this chapter, you’ll define your work time and learn how to configure Outlook for use in multiple time zones. You’ll learn about different types of secondary calendars, and experiment with the different ways you can display and switch among multiple calendars. You’ll share selected calendar information by embedding it in an e-mail message. Finally, you’ll print daily and monthly calendars. Practice Files  You don’t need any practice files to complete the exercises in this chapter. For more information about practice file requirements, see “Using the Practice Files” at the beginning of this book.
 
 Defining Your Available Time In your Outlook calendar, the time that you indicate you are available for other people to schedule meetings with you is referred to as your work week. The calendar timeslots within your work week are colored differently from those outside of your work week, and are the only timeslots made available to people on your network when they are searching for a time to meet with you. The default work week is defined as from 8:00 A.M. to 5:00 P.M. (in your local time zone) Monday through Friday. You can change this to match your individual work schedule. In Outlook 2010, you can specify a start time and end time for your standard work day, specify the days of the week that you work, and specify the day of the week you’d like to appear first when you display only the work week in your calendar. You define your work week in the Work Time area on the Calendar page of the Outlook Options dialog box. See Also  For more information about locating available meeting times, see “Scheduling Meetings” in Chapter 5, “Manage Scheduling.”
 
 In this exercise, you’ll view and change your work week. SET UP  You don’t need any practice files to complete this exercise. Display your calendar in Week view, turn off the Daily Task List, and then follow the steps.
 
 
 
 1. On the Home tab, in the Arrange group, click the Work Week button. 2. Scroll up and down the calendar page to display the beginning and/or end of the work day. Time slots during working hours are white. Time slots during nonworking hours are colored.
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 Working time (white)
 
 Nonworking time (shaded)
 
 The calendar maintains a visible distinction between work and nonwork time by shading nonwork time. Troubleshooting  If your work week does not match the default days and times described here, work through this exercise using your own settings.
 
 
 
 3. Click the Arrange dialog box launcher. The Outlook Options dialog box opens with the Calendar page displayed.
 
 The default work week settings.
 
 For the purposes of this exercise, assume that you work as a catering manager in a restaurant. You start work at 12:00 P.M. and finish at 8:00 P.M. You work Wednesday through Sunday, and have Monday and Tuesday off.
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 4. In the Work time area, click the Start time arrow and then, in the list, click 12:00 PM. 5. Click the End time arrow and then, in the list, click 8:00 PM. 6. Next to Work week, select the Sun and Sat check boxes, and clear the Mon and
 
 
 
 7. Click the First day of week arrow and then, in the list, click Wednesday.
 
 Tue check boxes.
 
 The days and display of your work week are now defined as Wednesday through Sunday.
 
 You can define the days and times that you are available to meet with co-workers.
 
 
 
 8. In the Outlook Options dialog box, click OK. The Work Week view of the calendar now displays only Wednesday through Sunday. Working time (white)
 
 Nonworking time (shaded)
 
 Your working time now starts at noon on Wednesday through Sunday. Troubleshooting  Outlook doesn’t allow you to define a workday that crosses midnight or to define different start and end times for different days.
 
 CLEAN UP  Set up your work week the way you want it before continuing to the next exercise.
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 Configuring Time Zones When you travel with your portable computer to locations in other time zones, you’ll probably change the time zone on your computer to match the time zone you’re in. You can do this from Windows or from Outlook. When you change the time zone, information, such as the receipt time of e-mail messages and appointment times, changes to match the new time zone; if you display the clock in the Windows Taskbar notification area, the time shown there also changes. To change the time zone of your computer from Outlook: 1. Display the Calendar module. 2. On the Home tab, click the Arrange dialog box launcher. The Outlook Options dialog box opens, displaying the Calendar page. 3. In the Time Zones area, click the Time Zone arrow and then, in the list, click the time zone you want. Then click OK to close the dialog box and return to your calendar. When you prepare to travel, or if you schedule meetings involving participants in different time zones, you might want to configure Outlook to display two time zones in your calendar. Outlook then displays the time zones in Day view, Work Week view, and Week view in two columns to the left of the Calendar pane. Time zones
 
 Displaying two time zones in your calendar.
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 To simultaneously display two time zones in your calendar: 1. On the Home tab, click the Arrange dialog box launcher. 2. In the Time Zone area, select the Show A Second Time Zone check box. Then in the second Time Zone list, click the time zone you want to display. 3. Type a label for each time zone (such as San Diego and Copenhagen) in the corresponding Label box. 4. Click OK. Tip  When you have two time zones displayed in your Outlook calendar, you can quickly change the time zone of your computer by clicking the Swap Time Zones button in the Outlook Options dialog box.
 
 Specifying Appointment Time Zones When you schedule an appointment or meeting, you have the option of specifying the time zone—for both the start time and the end time of the appointment or meeting. If you travel frequently, you might find that it is worth your time to do this. Here’s an example of why you would want to do this: Imagine that you live in Dallas, Texas (in the Central time zone). You have a meeting that occurs every Wednesday at noon. You travel to Seattle, Washington (in the Pacific time zone, two hours earlier than Central time) for one week. When you arrive in Seattle, you change the time zone of your computer to Pacific time. The appointments on your calendar shift to accommodate the time zone change. Your Wednesday meeting now appears on the calendar at 10:00 A.M. You call in to the meeting at the appropriate time. During the meeting, you learn of a client presentation that will occur at 2:00 P.M. the following Tuesday. You enter the presentation as an appointment on your calendar at 2:00 P.M. Tuesday, but you do not specify the time zone of the presentation. When you return to Dallas, you change the time zone of your computer to Central time. On Wednesday morning, you look at your calendar and see that you need to attend the client presentation. The presentation is on your calendar for 4:00 P.M. When you arrive at the client site, the presentation has already ended. Because you didn’t specify the time zone of the appointment, the appointment time shifted by two hours when you returned to Dallas.
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 Working with Multiple Calendars The Calendar button in the Navigation Pane links to the calendar of your default e-mail account. In addition, you can display these other types of calendars in the Calendar module: ● Calendars of other e-mail accounts  These are available automatically when
 
 you configure Outlook to connect to an account. ● Custom calendars  You create a calendar in the same way that you do a folder
 
 that contains mail, contact records, or other items. To create a calendar, click the New Calendar button in the New group on the Folder tab of the Calendar module. ● Shared calendars  Other Outlook users may share their calendars with you. ● Internet calendars  You can subscribe to or import calendars from the Internet. See Also  For information about Internet calendars, see the sidebar “Connecting to Internet Calendars” later in this chapter. For information about SharePoint calendars, see “Working with SharePoint Site Content” in Chapter 12, “Work Remotely.”
 
 All these types of calendars are available to you from the Navigation Pane in the Calendar module or the Folder List in the Mail module. ● In the Calendar module, the Navigation Pane displays a list of the available calendars.
 
 You display or hide a calendar by selecting or clearing its check box.
 
 Available calendars in the Navigation Pane of the Calendar module.
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 ● In the Mail module, calendars are shown in the expanded folder list. You display a
 
 calendar in the Calendar module by clicking it in the folder list.
 
 Default calendar Imported Internet calendar
 
 Internet calendar subscription
 
 Available calendars in the Navigation Pane of the Mail module.
 
 You can display calendars individually, or you can display more than one calendar at a time. For example, you might have separate business and personal calendars and want to view them together. You can view multiple calendars next to each other, or you can overlay them to display a composite view of the separate calendars. When you view and scroll through multiple calendars, they all display the same date or time period. You can copy items from one calendar to another, by dragging with the right mouse button and then clicking Copy on the shortcut menu.
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 Connecting to Internet Calendars A variety of specialized calendars that track professional sports schedules, holidays, entertainment, scientific data, and so on are available online. (For example, your local school district or sports team might offer an Internet calendar on its Web site that you can import or subscribe to.) Internet calendars are files that have the extension .ics. You can locate Internet calendars by searching from a Web browser, by locating links on the Web sites of specific organizations, or by visiting a calendar sharing Web site such as iCalShare (located at www.icalshare.com). You can link to an Internet calendar in one of two ways: ● Subscribe to the calendar  You receive updates from the calendar publisher
 
 as they occur, but you can’t change the calendar data. ● Import the calendar  You can interact with a local copy of the calendar. You
 
 can change the calendar data, but you won’t receive any updates provided by the calendar publisher. Most Internet calendars are accompanied by a link or button that you can click to start the subscription or import process. If the Internet calendar you want to connect to doesn’t provide a simple method, you can manually connect to it. To manually import or subscribe to an Internet calendar, follow these steps: 1. On the Internet, locate the calendar you want to connect to and copy the address of its .ics file. 2. Display the Calendar module. 3. On the Home tab, in the Manage Calendars group, click the Open Calendar button and then, in the list, click From Internet. 4. In the New Internet Calendar Subscription dialog box, enter the address of the .ics file, and click OK. Then in the Microsoft Outlook message box that asks whether you want to add the calendar to Outlook and subscribe to updates, click Yes. Outlook adds the selected Internet calendar to the Other Calendars list in the Navigation Pane and displays it next to your calendar in the Calendar pane. You can display Internet calendars within the Calendar module as you would any other. You can modify aspects of an Internet calendar in Outlook, such as its location, color, or name, and you can share it with another person or delete it. You perform these actions by right-clicking the calendar name in the Navigation Pane or its tab in the Calendar pane and then clicking the applicable command.
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 In this exercise, you’ll create custom calendars and then view multiple calendars in Side-By-Side mode, Overlay mode, and Schedule View. SET UP  You need access to multiple calendars to complete this exercise. Display your calendar in Day view, and then create, import, subscribe to, or share one or more additional calendars. For best results, display a day on which one or more appointments, meetings, or events appear on the calendar.
 
 
 
 1. In the Navigation Pane, under My Calendars, ensure that the check box for your
 
 default calendar (simply titled Calendar) is selected. Then under Other Calendars or Shared Calendars, select the check box for at least one additional calendar.
 
 By default, Outlook displays the calendars side by side and in different colors.
 
 The order of the calendars in the Navigation Pane and the Calendar pane is the same; your default calendar always appears first.
 
 In Side-By-Side mode, each calendar tab has a Close button (an X) near its right edge. The tab of each calendar other than your default calendar has a View In Overlay Mode button (a left-pointing arrow) near its left edge.
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 2. Click the Calendar tab to make your default calendar the active calendar. Then on the tab of each secondary calendar, click the View in Overlay Mode button.
 
 The secondary calendars overlap your default calendar. The Search box indicates the active calendar.
 
 Appointments on overlaid calendars appear in a lighter font and in the color assigned to that calendar.
 
 Each of the overlapping calendar tabs now has a View In Side-By-Side Mode button (a right-pointing arrow) near its left edge.
 
 
 
 3. Click the Calendar tab. Your default calendar now overlaps the secondary calendars.
 
 
 
 4. On each of the secondary calendars, click the View in Side-By-Side Mode button to return to the standard display.
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 5. On the Home tab, in the Arrange group, click the Schedule View button. Keyboard Shortcut  Press Ctrl+Alt+5 to switch to Schedule View. See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at the end of this book.
 
 The calendars change to a horizontal format that displays appointments and meetings, but not events. A timeline at the top of the Calendar pane indicates the date and time being displayed.
 
 
 
 6. If necessary, click the Zoom Out button at the right end of the status bar until the Calendar pane displays several hours of each calendar.
 
 You can click the scroll bar or drag the scroll box at the bottom of the Calendar pane to change the displayed time period.
 
 In Schedule View, you can view and compare appointments on multiple calendars.
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 7. In the Arrange group, click the Work Week button to return to Side-By-Side mode. If you changed the zoom level of the calendar in Schedule View, the side-byside view of the calendar now displays a greater range of timeslots than it did previously.
 
 You can apply any of the standard arrangements to side-by-side calendars.
 
 
 
 8. Close each secondary calendar by clicking the Close Calendar button at the right end of its tab or by clearing its check box in the Navigation Pane.
 
 CLEAN UP  Reset the current view to return to the default calendar display and zoom level.
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 Sharing Calendar Information Co-workers can see your available working time when they schedule meetings with you, and in some instances they can see the details of any appointment that you haven’t marked as private. If you want to share more information with co-workers or with people outside of your organization, you have several options for doing so. ● You can allow selected co-workers to see your entire calendar by sharing the
 
 calendar with them. ● You can allow selected co-workers to see your entire calendar and to make appoint-
 
 ments and respond to meeting requests on your behalf by delegating control of the calendar to them. ● You can publish your calendar to the Office.com Web site or to a corporate Web
 
 server and then share the published calendar with any person who has access to the Internet. ● You can send a professional graphic representation of your appointments during
 
 a selected date range by e-mail to any person who uses an HTML-capable e-mail program (not only people who use Outlook), including colleagues, friends, and family members. The options for sending, sharing, and publishing calendar information are available from the Share group on the Home tab of the Calendar module.
 
 Sharing Calendars with Co-workers If your e-mail address is part of an Exchange network, you can give permission to other people on your network to view, modify, or create items within a calendar or any other type of Outlook folder. The level of access each co-worker has is governed by the permissions you assign to him or her. Using this method, you can share your default calendar or a secondary calendar that you create, import, or subscribe to. To share a calendar with a co-worker: 1. In the Calendar module, display the calendar you want to share. 2. On the Home tab, in the Share group, click the Share Calendar button. An e-mail message opens.
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 If you’re sharing an Exchange calendar, the message is an invitation to share the calendar. If you’re sharing an imported calendar, the message includes the calendar as an attachment. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 3. Address the message to your co-worker. If you’d like to request that your co-worker reciprocate by sharing his or her calendar with you, select the Request Permission To View Recipient’s Calendar check box. Then send the message, and click Yes in the Microsoft Outlook dialog box that asks you to confirm that you want to share the calendar with the default permissions. After you share a calendar, you can specify the actions each person with whom you share the calendar can take. On the Permissions tab of the Calendar Properties dialog box, which you display by clicking the Calendar Permissions button in the Share group on the Home tab, you can select a Permission Level, which includes specific Read, Write, Delete, and Other settings, or you can select individual settings in each category.
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 Write permissions include Create Items, Create Subfolders, Edit Own, and Edit All.
 
 You can delegate control of your calendar so that a co-worker or assistant can create and respond to meeting requests on your behalf. Then meeting requests sent to you are delivered to your delegate rather than to you. You receive copies of the meeting requests and copies of your delegate’s responses, but you don’t have to respond. Your delegate can also create meeting requests on your behalf (that is, they appear to come from you). Tip  You can delegate access of your calendar from Outlook 2010 only to a co-worker who also uses Outlook 2010.
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 To delegate control of your calendar to another Outlook user, follow these steps: 1. On the Info page of the Backstage view, click Account Settings and, in the list, click Delegate Access. The Delegates dialog box opens. 2. In the Delegates dialog box, click Add. The Add Users dialog box opens. 3. In the Add Users dialog box, click the person you want to delegate control to, click Add, and then click OK. The Delegate Permissions dialog box opens.
 
 The default permission level when delegating a calendar is Editor.
 
 4. In the Delegate Permissions dialog box, set the permission level you want the delegate to have, and then click OK. The delegate is now shown in the Delegates dialog box.
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 You can specify who receives meeting requests and responses for a delegated calendar.
 
 5. In the Delegates dialog box, select the delivery option you want for meeting requests and responses, and then click OK.
 
 Sharing Calendar Information Outside of Your Organization You can share calendar information with people who are not on your Exchange network through e-mail or on the Web. When you share a calendar by using one of these methods, you can choose the period of time for which you want to share information (Today, Tomorrow, Next 7 Days, Next 30 Days, or Whole Calendar, or you can specify a custom date range) and the level of detail you want to share, as follows: ● Availability only  Shows only whether time periods are marked as Free, Busy,
 
 Tentative, or Out Of Office during scheduled time periods. ● Limited details  Shows your availability and the subject of each appointment,
 
 meeting, or event scheduled on the calendar. ● Full details  Shows your availability and the full details (such as location and notes)
 
 of each appointment, meeting, or event scheduled on the calendar. The E-mail Calendar feature of Outlook 2010 provides a simple method of sharing specific calendar information with people outside of your organization. For example, if a friend is arranging a get-together and needs to know what days and times you’re free this week, you can send her your free/busy information for the week.
 
 
 
 Sharing Calendar Information   293
 
 If you need to distribute calendar information to a large number of people outside of your organization, you can publish it to a Web site and then give specific people permission to view the calendar. However, this feature works only with your default calendar and not with any secondary calendars that you create, import, or subscribe to, so you can’t use it, for example, to share calendar information for a club or organization for which you keep a secondary calendar. The process for publishing calendar information externally is similar for both methods. In this exercise, you’ll embed information about your schedule in an e-mail message. SET UP  You don’t need any practice files to complete this exercise. Display your calendar, and then follow the steps.
 
 
 
 1. On the Home tab, in the Share group, click the E-mail Calendar button. Outlook opens a new message window and the Send A Calendar Via E-mail dialog box.
 
 
 
 2. In the Advanced area, click Show to display all the options. The options appear, and the Show button changes to a Hide button.
 
 If you have multiple calendars in Outlook, you can choose the calendar from which you want to send information in the Calendar list.
 
 
 
 3. Click the Date Range arrow, and then in the list, click Next 7 days. 4. Click the Detail arrow, and then in the list, click Full details.
 
 294    Chapter 8  Manage Your Calendar
 
 In the Advanced area, you can choose whether to include private appointment details and attachments, and whether to present schedule information as a daily schedule or only a list of events.
 
 
 
 5. With Daily schedule selected in the E-mail Layout list, click OK. Outlook embeds the selected calendar information in the e-mail message window and also attaches the same information as an .ics file. You can send the e-mail message to any recipient. A recipient using an e-mail program that supports .ics files can add your calendar information to his or her calendar list.
 
 The Full Details option provides a monthly calendar overview, a daily summary, and a detailed daily schedule.
 
 
 
 6. Scroll through the content pane to view the embedded calendar information. Then experiment with other time periods, details, and layout options on your own. CLEAN UP  Close or send the e-mail message.
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 Printing a Calendar From time to time, you might find it convenient to print a day, week, month, or other period of your calendar—for instance, if you’re traveling without a laptop or want to have your weekly schedule quickly available in your briefcase. You can easily print any time period of your calendar. The amount of detail that appears depends on the period you print and the print style you choose. Outlook offers several built-in print styles, and you can create others if you want. The available print styles vary based on what view you’re in when you choose the Print command. The default print styles include: ● Daily Style  Prints the selected date range with one day per page. Printed elements
 
 include the date, day, TaskPad, reference calendar for the current month, and an area for notes. ● Weekly Agenda Style  Prints the selected date range with one calendar week per
 
 page, including reference calendars for the selected and following month. ● Weekly Calendar Style  Prints the selected date range with one calendar week per
 
 page. Each page includes date range and time increments, reference calendars for the selected and following month, and TaskPad. ● Monthly Style  Prints a page for each month in the selected date range. Each
 
 page includes the selected month with a few days showing from the previous and subsequent months, along with reference calendars for the selected and following month. ● Tri-fold Style  Prints a page for each day in the selected date range. Each page
 
 includes the daily schedule, weekly schedule, and TaskPad. ● Calendar Details Style  Lists your appointments for the selected date range, as
 
 well as the accompanying appointment details. You can select the date or range of dates to be printed and modify the page setup options to fit your needs.
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 In this exercise, you’ll preview the available print styles, make changes to a standard print style, and print information from your calendar. Important  To fully complete this exercise, you must have a printer installed. If you don’t have a printer installed, you can perform all steps of the exercise other than printing. To install a printer, click the Start button, click Devices And Printers, and then on the toolbar, click Add A Printer. Follow the wizard’s instructions to install a local or network printer. If you are working on a corporate network, your network administrator can provide the information you need to install a printer.
 
 SET UP  You don’t need any practice files to complete this exercise. Display your calendar in Day view before beginning this exercise. For best results, display a day on which one or more appointments, meetings, or events appear on the calendar.
 
 
 
 1. Display the Backstage view. In the left pane, click Print. The Print page of the Backstage view displays the available printing options and a preview of the selected day’s calendar as it would be printed in the Daily Style format.
 
 The Print page of the Backstage view displays print options and an interactive page preview.
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 2. In the right pane, click the Actual Size button. If necessary, scroll up or down the page to display appointment information. The calendar page entries are magnified to a legible size, with the Actual Size view selected.
 
 You can magnify the preview and view all pages of the calendar you’re printing. See Also  For information about applying color categories to appointments, see “Organizing Outlook Items by Using Color Categories” in Chapter 7, “Organize Your Inbox.”
 
 
 
 3. In the left pane of the Print page, click the Print Options button. The Print dialog box opens. You can make many types of changes to the appearance of the printed content.
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 In the Print dialog box, you can change the printer, the calendar being printed, and the print style, in addition to the usual printer options.
 
 
 
 4. In the Print dialog box, click Preview or Cancel. The Print dialog box closes, and you return to the Print page of the Backstage view. Tip  Clicking Print in the Print dialog box sends the calendar data to the active printer and then closes the Backstage view.
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 5. On the Print page, in the Settings list, click Weekly Agenda Style. A preview of the print style appears in the right pane. The time period displayed in the printed calendar has been expanded to include the entire week (from Monday through Sunday) that contains the originally selected day.
 
 Weekly Agenda Style displays a box for each day of the week, beginning on Monday. Saturday and Sunday share a space.
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 6. In the Settings list, click Weekly Calendar Style. A preview of the print style appears in the right pane. The time period displays the week from Sunday through Saturday. A vertical line precedes the day that is designated as the first day of the week. See Also  For information about setting the first day of the week, see “Defining Your Available Time” earlier in this chapter.
 
 Weekly Calendar Style displays a column for each day of the week.
 
 
 
 7. Click the Print Options button and then, in the Print dialog box that opens, click Page Setup.
 
 The Page Setup dialog box for the selected print style opens.
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 The available settings differ depending on the print style.
 
 For the Weekly Calendar Style, you can choose a vertical or horizontal layout, split the week across two pages, include the Daily Task List or To-Do Bar Task List, add an area for handwritten notes, specify the range of hours to print, and print only your designated work week rather than a standard seven-day week.
 
 
 
 8. On the Format page of the Page Setup dialog box, do the following: ❍ Click To-Do Bar in the Tasks list. ❍ Select the Notes area (blank) check box. ❍ In the Print from list, click 8:00 AM. ❍ In the Print to list, click 5:00 PM. ❍ Select the Only Print Workdays check box.
 
 
 
 9. Click the Paper and Header/Footer tabs to display the additional options, and then click OK.
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 10. In the Print dialog box, click Preview. Your changes are reflected in the page preview.
 
 To-Do Bar Task List
 
 Notes pane
 
 After-hours appointments
 
 When the calendar displays fewer hours, the timeslots become larger.
 
 
 
 11. In the Settings list, click Monthly Style. A preview of the print style appears in the right pane. The time period displays the calendar month containing the originally selected day.
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 Printing a calendar in Monthly Style.
 
 
 
 12. In the Settings list, click Tri-fold Style. A preview of the print style appears in the right pane. The left section displays the detailed schedule for the originally selected day, the middle section displays the Daily Task List, and the right section displays the seven-day week.
 
 Printing a calendar in Tri-fold Style. Tip  Note that selecting the Only Print Workdays option for the Weekly Calendar Style did not affect the week shown in the Tri-fold Style.
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 13. Click the Print Options button and then, in the Print dialog box that opens, click Page Setup.
 
 The Page Setup dialog box for the selected print style opens.
 
 
 
 14. In the Options area of the Page Setup dialog box, click the Right section arrow. The Right Section list includes the elements you can choose to display in each section of the printed calendar.
 
 In the Tri-fold Style, you can choose what calendar element appears in each section.
 
 
 
 15. Experiment with various arrangements of information in the Tri-fold Style calendar,
 
 
 
 16. On the Print page of the Backstage view, in the Settings list, click Calendar
 
 clicking OK in the Page Setup dialog box and Preview in the Print dialog box to preview the results. Details Style.
 
 A preview of the print style appears in the right pane, displaying information for only the originally selected day.
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 The appearance of a calendar printed in Calendar Details Style.
 
 
 
 17. Experiment with different print styles and date ranges. If you want to print a calendar page, click the Print button on the Print page of the Backstage view.
 
 CLEAN UP  If you don’t print a calendar page, click the Home tab to close the Backstage view and return to your calendar before continuing to the next exercise.
 
 Key Points ● You can display a traditional calendar view of your schedule by the day, work week,
 
 full week, or month. You can also display multiple list views of calendar items. ● You can display multiple time zones, change your calendar as you travel between
 
 time zones, and schedule appointments or meetings that start and end in different time zones. ● You can import or subscribe to many types of calendars available from the Internet.
 
 Calendars that you subscribe to are automatically updated as new information is made available by the calendar publisher. ● You can view two or more calendars next to each other or as a composite. Outlook
 
 displays each calendar in a different color, so you can easily tell them apart. ● You can display multiple calendars in a horizontal view so that you can more easily
 
 compare schedules by scrolling through the calendars. ● You can share entire calendars or selected calendar information with people inside
 
 or outside of your organization. ● You can print selected schedule information in a number of different layout styles.
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 9 Work with Your Contact List In this chapter, you will learn how to ✔ Create additional address books. ✔ Import and export contact records. ✔ Create contact groups. ✔ Quickly locate contact information. ✔ Personalize electronic business cards.
 
 If you regularly save contact information for business and personal contacts in Microsoft Outlook, you will quickly accumulate a large collection of contact records. Being able to organize and quickly locate specific contact information is important for efficient communications. The more people you deal with on a daily basis, the more important it is to keep your contact list organized. You can simplify communications with specific groups of contacts by creating contact groups to which you can address messages as you would an individual contact. You can also create purpose-specific address books and organize contact records within the address books to make it easier to locate specific contact records. You can add contact records to a custom address book either by moving contact records that are already stored in Outlook, or by importing contact records from another program or file. The Search feature of Outlook 2010 makes it easy to find a specific contact record based on any text within the contact record or any attribute, such as the category assigned to it. Within each contact record, you can make preferred contact information easily discoverable by displaying it on the business card version of the contact record. You can also display images, such as photographs or corporate logos on business cards, to provide additional information when you view contacts in the default Business Card view.
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 In this chapter, you’ll first organize the contact records associated with this book into an individual address book. You’ll import a fresh set of contact records into the custom address book, and then export a subset of the records. Then you’ll create a contact group and learn how to send a message to a subset of the group. You’ll locate specific contact records by using the Search feature and the commands available on the new Search contextual tab. Finally, you’ll personalize the content of an electronic business card. Practice Files  Before you can complete the exercises in this chapter, you need to copy the book’s practice files to your computer. The practice files you’ll use to complete the exercises in this chapter are in the Chapter09 practice file folder. The exercises in this chapter also use Outlook items you created in exercises in previous chapters. If an exercise requires an item that you don’t have, you can complete the exercise in which you create the item before beginning the exercise, or you can substitute a similar item of your own. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book.
 
 Creating Additional Address Books You can track all your contacts—business and personal—within the address book of your default e-mail account. However, you might find it useful to create a separate address book that contains contact records for only a specific group of people. For example, you might want to have an address book that contains only clients, relatives, club members, neighborhood contacts, parents and teachers from your child’s school, or sports teammates. You create an additional address book by creating a folder with a designated purpose of containing contact items (a contacts folder). You can move and copy contact records between address books in your Outlook configuration. As with other folders, you can share the contacts folder with other Outlook users on your network, or you can export it for distribution to other people. Unlike the Calendar module, which allows you to display multiple calendars, the Contacts module can display only one address book at a time. When you have multiple address books, you can switch among them by choosing the address book you want to display from the list in the Navigation Pane of the Contacts module or from the folder list displayed in the Navigation Pane of the Mail module. Tip  When searching for a specific contact record, you can search a single address book or search all address books within your Outlook configuration, including your organization’s Global Address List, if you have one. For more information, see “Quickly Locating Contact Information” later in this chapter.
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 In this exercise, you’ll create an address book and move existing contact records into it. SET UP  You will need the Nancy Anderson, Andrew Davis, Sara Davis, Andrea Dunker, and Idan Rubin contact records you created in Chapter 4, “Store and Access Contact Information,” to complete this exercise. If you didn’t create those contact records, you may do so now or substitute any contact records of your own. Display the Contacts module, and then follow the steps.
 
 
 
 1. On the Folder tab, in the New group, click the New Folder button. The Create New Folder dialog box opens. Because you opened the dialog box from the Contacts module, the default settings are to create the new folder in your default Contacts folder, and for the folder to contain Contact Items.
 
 Creating an address book as a subfolder of your default Contacts folder.
 
 
 
 2. In the Name box, type SBS Contacts. Tip  The name of this folder begins with SBS so that you can easily differentiate it from other folders in your mailbox.
 
 
 
 3. Click the Folder contains arrow, and note the types of folders you can create. Because you are creating this folder from within the Contacts module, Contact Items is selected by default. However, you can create any type of folder from within any module.
 
 
 
 4. In the Folder contains list, click Contact Items to close the list without changing the selected item type.
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 5. In the Select where to place the folder list, click your account name (or Mailbox, depending on your account configuration). The new folder will be at the same level in the folder list structure as your Inbox.
 
 You can create a contacts folder anywhere within the existing folder list structure.
 
 
 
 6. In the Create New Folder dialog box, click OK. The SBS Contacts address book appears in the My Contacts list at the top of the Contacts module Navigation Pane.
 
 The Navigation Pane of the Contacts module lists all the contacts folders available within your Outlook configuration.
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 7. In the Navigation Pane, click the Mail button to display your Inbox. The SBS Contacts folder is not visible in the Navigation Pane, which currently displays the All Mail Items list.
 
 
 
 8. At the bottom of the Navigation Pane, click the Folder List button. The Navigation Pane contents expand to display all folders within your Outlook configuration rather than only those containing mail items. The SBS Contacts folder appears above your Search Folders folder.
 
 A contact card icon next to the folder name indicates that it is a contacts folder, designed to hold contact items.
 
 
 
 9. In the Navigation Pane, click the SBS Contacts folder. The Navigation Pane components don’t change, but the currently empty SBS Contacts address book appears in the content pane and the ribbon changes to display the Contacts module-specific tabs.
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 The same features available within your main address book, such as the alphabet bar, are available within this custom address book.
 
 
 
 10. At the bottom of the Navigation Pane, click the Contacts button. The Contact module opens, still displaying the SBS Contacts address book. The Navigation Pane provides easy access to your other address books.
 
 
 
 11. In the My Contacts list, click Contacts to display your default address book, which currently contains the five contact records you created in Chapter 4, “Store and Access Contact Information.”
 
 
 
 12. In the Contacts pane, click the Nancy Anderson contact record once to select it. 13. Drag the selected contact record from the Contacts pane to the SBS Contacts address book in the Navigation Pane.
 
 The selected contact record disappears from the Contacts pane. Tip  To copy rather than move a contact record, right-click and drag the contact record to the destination address book and then, when you release the mouse button, click Copy on the shortcut menu.
 
 
 
 14. In the Contacts pane, click the Andrew Davis contact record to select it. 15. On the Home tab, in the Actions group, click the Move button. The Move list displays your custom and standard Outlook folders.
 
 You can select and manipulate multiple contact records at one time.
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 16. In the Move list, click SBS Contacts. The selected contact record disappears from the Contacts pane.
 
 
 
 17. In the Contacts pane, click the Sara Davis contact record to select it. Press and
 
 hold the Ctrl key, and then click the Andrea Dunker and Idan Rubin contact records in turn. All the contact records you’ve created for the exercises in this book that remain in your main address book are now selected.
 
 
 
 18. Right-click any one of the selected contact records, click Move, and then click SBS Contacts.
 
 The selected contact records disappear from the Contacts pane.
 
 
 
 19. In the My Contacts list, click SBS Contacts. The content pane displays the custom address book, which now contains the five records you moved there.
 
 The contact records you’ve created for the exercises in this book are now collected in the custom address book.
 
 CLEAN UP  Retain the SBS Contacts folder and its contents for use in later exercises.
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 Importing and Exporting Contact Records In addition to copying and moving contact records between address books within your Outlook configuration, you can import contact records into an existing address book from external files and programs. Outlook accepts data imported from non– application specific files, files created in other Microsoft programs, and files created in third-party programs. You can import data into Outlook from the following types of files: ● Account-specific data files created in Outlook (.pst files), Outlook Express version
 
 4.x, Outlook Express version 5.x, or 6.x, or Windows Mail Tip  Software manufacturers frequently release interim builds containing updates to software programs between major releases. A program version number ending in .x indicates any release of that major version of the software. For example, version 1.x covers all versions of a software product from version 1.0 through version 1.9. ● Databases created in Microsoft Access 97, Access 2000, Access 2002, or Access 2003
 
 (.mdb files) ● Workbooks created in Microsoft Excel 97, Excel 2000, Excel 2002, or Excel 2003
 
 (.xls files) ● Plain-text files containing field values separated by commas (.csv files) or by tabs
 
 (.txt files) ● Data files created in ACT! Contact Manager version 3.x, 4.x, or 2000 (.dbf files) ● Data files created in Lotus Organizer version 4.x or 5.x (.org files) ● Personal address books created in other contact-management programs Tip  To import a file containing contact records into its own separate address book, first create the address book, and then import the contact records.
 
 Similarly, you can export contact records from Outlook as an address book that other people can import into Outlook or another program.
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 In this exercise, you’ll import contact records from a tab-separated (also referred to as tab-delimited) text file into an existing address book. Then you’ll export a selection of records from the updated address book to a file that other Outlook users can import, and you’ll test that you successfully exported only the records you wanted. SET UP  You will need the SBS Contacts address book you created in the previous exercise, and the SBSContacts text file located in the Chapter09 practice file folder to complete this exercise. If you didn’t create the address book, you may do so now or substitute any existing address book. Display the SBS Contacts address book, and then follow the steps.
 
 
 
 1. Display the Backstage view, and then click Open. The Open page of the Backstage view displays options for opening or importing external content.
 
 Opening a file creates a link to the external file from Outlook; importing adds data to your existing Outlook folders.
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 2. On the Open page of the Backstage view, click Import. The Import And Export wizard starts.
 
 You can export data to and import data from many different types of files.
 
 
 
 3. With Import from another program or file selected in the Choose an action to perform list, click Next.
 
 The Import A File section of the wizard displays a list of file types from which you can import content.
 
 Outlook accepts data from third-party file formats as well as Microsoft Office files.
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 4. Scroll down the Select file type to import from list, and click Tab Separated Values (Windows). Then click Next.
 
 The wizard prompts you to specify the file you want to import.
 
 You can choose whether to allow, refuse, or replace duplicate files.
 
 
 
 5. Click the Browse button to the right of the File to import box. The Browse dialog box opens.
 
 
 
 6. In the Browse dialog box, navigate to the Chapter09 practice file folder, click the SBSContacts text file, and then click OK.
 
 The specified folder path and file appear in the File To Import box.
 
 
 
 7. In the Options area, click Replace duplicates with items imported. Then click Next.
 
 The wizard prompts you to select the folder into which you want to import the file content. Because you started the wizard from the SBS Contacts address book, that folder is already selected.
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 You can import content into any type of folder.
 
 
 
 8. With SBS Contacts selected in the Select destination folder list, click Next. The wizard displays the import operation it will perform and buttons you can click to display additional options.
 
 You can choose to map custom fields or change the destination of the imported content.
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 9. On the wizard’s last page, click Map Custom Fields. The Map Custom Fields dialog box opens. In this dialog box, you can match named fields from the import source file to named fields in Outlook. You might need this functionality when you import content from a file that was not originally created in Outlook.
 
 If the structure of the imported records is different from the Outlook contact record structure, you can match incoming data fields to Outlook data fields before you import the content.
 
 
 
 10. Scroll down the From list and note the fields that are present in the source file. Then in the area below the From list, click Next.
 
 The Map Custom Fields dialog box displays the first record in the source file.
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 11. In the To list, click the Expand button to the left of Name to display all the name fields. The Mapped From column displays the value from the current source record that maps to each of the Outlook fields.
 
 You can view the source content before you import it into Outlook.
 
 
 
 12. Click Next a few times to view additional records, and scroll the To list to view the
 
 
 
 13. On the wizard’s last page, click Finish.
 
 way the records map to the Outlook fields. Then click OK.
 
 Outlook imports the contact records into the SBS Contacts address book, which now contains 11 items.
 
 
 
 14. On the Home tab, in the Current View gallery, click Card. In Card view, you can see that the five contact records you created earlier in this book now contain additional information. In fact, new versions of these contact records were imported from the SBSContacts file. Because in step 7 you selected the option to replace duplicate records, the new records, which contain additional business contact information for the two Trey Research employees, replaced the records you created.
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 Imported and replaced contact records.
 
 Now you’ll export selected records from the updated address book for distribution to other Outlook users.
 
 
 
 15. Display the Open page of the Backstage view, and then click Import. The Import And Export wizard starts.
 
 
 
 16. In the Choose an action to perform list, click Export to a file. Then click Next. The Export To A File section of the wizard prompts you to select the type of file you want to create.
 
 The export file type options are limited to Office files and separated text files.
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 17. In the Create a file of type list, click Outlook Data File (.pst). Then click Next. The wizard prompts you to select the folder and records you want to export.
 
 The SBS Contacts folder selected for export.
 
 
 
 18. With SBS Contacts selected in the Select the folder to export from list, click Filter.
 
 The Filter dialog box opens. From this dialog box, you can filter the contents of the selected folder so that only items (in this case, contact records) that meet specific criteria are exported.
 
 
 
 19. On the Contacts page of the Filter dialog box, enter Litware in the Search for the word(s) box. Then click the In arrow.
 
 The In list displays the fields on which you can filter contact records.
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 Contact record filtering options.
 
 
 
 20. In the In list, click company field only. Then in the Filter dialog box, click OK. 21. In the Export Outlook Data File wizard, click Next. Outlook suggests that you save the exported file in the system-created Outlook Files folder as backup.pst.
 
 
 
 22. To the right of the Save exported file as box, click the Browse button. In the
 
 Open Outlook Data Files dialog box, navigate to the Chapter09 practice file folder. In the File name box, enter LitwareInc. Then click OK. The folder path and file name appear in the Save Exported File As box.
 
 
 
 23. On the wizard’s last page, click Finish. The wizard exports the selected records, and then the Create Outlook Data File dialog box opens.
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 You can protect items that you export to an Outlook data file by assigning a password to the file.
 
 
 
 24. In the Create Outlook Data File dialog box, click OK to create the file without assigning a password.
 
 
 
 25. To test that you successfully exported the file, use the techniques you learned
 
 in this chapter to create a contacts folder named SBS Litware. Display the SBS Litware address book and follow the process you learned earlier in this exercise to import the LitwareInc data file into it. During the import process, the Import Outlook Data File wizard prompts you to select the folder you want to import and the import location.
 
 Contact record importing options.
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 26. In the Select the folder to import from list, click SBS Contacts (the folder from which you exported the data file). Click Import items into the current folder. Then click Finish.
 
 The wizard imports the records from the LitwareInc Outlook data file into the SBS Litware address book.
 
 The resulting address book contains only the six contact records of the Litware, Inc. employees.
 
 CLEAN UP  Retain the SBS Litware address book for use in later exercises. Tip  In the preceding exercise, we imported and exported contact records, but you can use the same process to import and export other Outlook items.
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 Creating Contact Groups If you frequently send messages to specific groups of people, such as members of a project team, club, or family, you can create a contact group containing all the e-mail addresses. Then you can send a message to all the group members by addressing it to just the contact group. Contact groups are like personal versions of distribution lists. A distribution list is available to everyone on your Microsoft Exchange Server network; a contact group is available only from the local address book you store it in. You can, however, distribute a contact group to other people for their own use.
 
 A contact group.
 
 You add a member to a contact group either by selecting an existing contact record from an address book or by entering contact information in the Add New Member dialog box. When you add a member by using the latter method, you have the option to simultaneously create a contact record for him or her. When you send a message to a contact group, each member of the contact group receives a copy of the message. If you want to send a message to most, but not all, members of a contact group, you can expand the contact group in the address field to a full list of its members, and remove individual people for the specific message at the time you send it.
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 In this exercise, you’ll create a contact group and add new contacts to your address book. Then you’ll send a message to all but one member of the contact group. SET UP  You need the contact records you imported into the SBS Contacts address book in the previous exercise. If you didn’t import the contact records, you may do so now or substitute contact records of your own. Display the SBS Contacts address book in List view, and then follow the steps.
 
 
 
 1. On the Home tab, in the New group, click the New Contact Group button. The Contact Group window opens.
 
 
 
 2. In the Name box, type Clients. Then on the Contact Group tab, in the Members group, click the Add Members button.
 
 The Add Members list displays the locations from which you can add contacts to the contact group.
 
 You can add members to a group from existing records or by entering e-mail addresses. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 
 
 3. In the Add Members list, click From Outlook Contacts. The Select Members: Contacts dialog box opens, displaying your organization’s Global Address List, your default Contacts address book, or whatever address book you have most recently accessed by using this method.
 
 
 
 4. In the Address Book list, click SBS Contacts. The Select Members dialog box displays the contact records you imported into the SBS Contacts address book in the previous exercise.
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 You can search for contacts in the Select Members dialog box by name or by other criteria.
 
 
 
 5. In the Name list, click Andrea Dunker, and then click the Members button. Andrea Dunker ([email protected]) appears in the Members box at the bottom of the Select Members dialog box. This is the display name stored in Andrea’s contact record.
 
 
 
 6. In the Name list, double-click the first Sara Davis entry. Sara Davis (Work) appears in the Members box. Tip  You can quickly add multiple names to the Members box by double-clicking each name, or by holding down the Ctrl key while selecting multiple names.
 
 
 
 7. In the Select Members: SBS Contacts dialog box, click OK. The Clients contact group now contains the two Wingtip Toys employees.
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 Contact group members added from an address book are listed by the Display As names saved in their contact records.
 
 
 
 8. In the Add Members list, click New E-mail Contact. The Add New Member dialog box opens.
 
 
 
 9. In the Add New Member dialog box, type Tjeerd Veninga in the Display
 
 name box, and then type [email protected] in the E-mail address box. The Add To Contacts check box is selected by default, so Tjeerd will be added to your default address book as well as to the contact group.
 
 In the Add New Member dialog box, you can select the e-mail format for messages to the individual group member.
 
 330    Chapter 9  Work with Your Contact List
 
 
 
 10. In the Add New Member dialog box, click OK. The Clients contact group now includes Andrea, Sara, and Tjeerd.
 
 
 
 11. Repeat steps 8 through 10 to add the following people to the Clients contact group and to your default address book: Display name Eli Bowen Liberty Munson 
 
 E-mail address [email protected] [email protected]
 
 Each new contact group member appears in the contact group in alphabetical order.
 
 The folder in which the contact group is being created is shown in the lower-left corner of the dialog box.
 
 
 
 12. On the Contact Group tab, in the Actions group, click the Save & Close button. The Clients group appears in the SBS Contacts address book.
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 Contact group names are displayed in bold font so that you can easily differentiate them from individual contacts. Tip  The three contact group members you added manually do not appear in this address book; Outlook created their contact records in your default Contacts address book.
 
 
 
 13. In the Contacts pane, click the Clients contact group. Then on the Home tab, in the Communicate group, click the E-mail button.
 
 A message composition window opens. The message is addressed to the Clients contact group.
 
 
 
 14. In the To box, click the Expand button to the left of Clients. Outlook warns you that you can’t collapse a list after you expand it.
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 Contact group
 
 In a message header, the contact group name is bold and is preceded by an Expand button.
 
 
 
 15. In the Expand List message box, click OK. The Clients contact group is replaced by the individual display names of its members. You can remove any group member from the address box before sending the message. MailTip
 
 Contact group members
 
 When you expand the contact group, the contact group name is replaced with its members and is no longer available.
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 The individual message recipient names change to a green font, and a MailTip appears above the To box in the message header, notifying you that the message is addressed to recipients outside of your organization. Troubleshooting  MailTips are a feature of Microsoft Office Communications Server and Exchange Server 2010 that displays information in e-mail messages based on centrally stored information about the organization and its individual members. If you are using an e-mail account that doesn’t have Exchange and Office Communications Server as part of its infrastructure, the font color of the recipients will not change, and the MailTip will not appear.
 
 You can’t actually send this message because the message recipient addresses are fictitious. CLEAN UP  Close the message window without saving or sending the message. Retain the Clients contact group and the Eli Bowen, Liberty Munson, and Tjeerd Veninga contact records for use in later exercises.
 
 Quickly Locating Contact Information You can use the Search feature in any Outlook module to immediately find a specific Outlook item within the current folder, an item of the same type in any folder, or an item of any type in any folder. Finding an item that contains, for example, a specific word is as simple as typing that word in the Search box at the top of the content pane. When you position the cursor in the Search box, the Search contextual tab appears on the ribbon. You can refine your search criteria or expand your search to include additional locations by using the commands available on the Search tab. In this exercise, you’ll locate specific contact records, and work with the contact records from the search results. SET UP  You need the contact records you imported into the SBS Contacts address book earlier in this chapter, and the Eli Bowen, Liberty Munson, and Tjeerd Veninga contact records you created in the previous exercise. If you didn’t create those contact records, you may do so now or substitute contact records of your own. Display the SBS Contacts address book in Card view, and then follow the steps.
 
 
 
 1. At the top of the Contacts pane, click to position the cursor in the Search box. Keyboard Shortcut  Press Ctrl+E to position the cursor in the Search box of the current module.
 
 The Search contextual tab appears and becomes active on the ribbon.
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 Commands available on the Contacts module Search tab.
 
 
 
 2. In the Search box, type and. As you type, Outlook filters the list to display only those contact records that contain the letters you’ve entered, and highlights the matches in the contact records. This highlighting appears in any view other than Business Card view. Troubleshooting  If Outlook doesn’t automatically filter the contact records as you type, press Enter or click the Search button after entering the search term.
 
 Outlook highlights the letters you search for anywhere they appear in the visible contact information.
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 3. On the Search tab, in the Refine group, click the Has Address button and then, in the list, click Has Business Address.
 
 In the Search box, NOT businessaddress:= appears after your original entry, specifying that you want to locate only contact records for which the business address field is not blank. Each of the current search results does include a business address, so the search results don’t change.
 
 
 
 4. In the Refine group, click the More button and then, in the list, click Company. A Company box appears below the Search pane.
 
 
 
 5. In the Company box, enter toys. In the Search box, company:toys appears after the first two criteria. Outlook filters the list to display only the contact record for Andrea Dunker, who works at Wingtip Toys.
 
 A refined search.
 
 
 
 6. On the Search tab, in the Close group, click the Close Search button. The orange Search pane closes, the Search contextual tab disappears, and the Contacts pane displays all 12 records in the SBS Contacts address book. Tip  You can also cancel the current search by clicking the Close Search button (the X) that replaces the Search button at the right end of the Search box while the search feature is active.
 
 
 
 7. Click in the Search box. The orange Search pane reopens, with the Company box still visible. You can add your frequently used search fields to the Search pane so that they are immediately available when you want to use them.
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 8. In the Company box, enter Wide World Importers. As you type, the official syntax for the search criterion appears in the Search box.
 
 When a single search criterion includes multiple words, Outlook encloses the words in parentheses.
 
 The search returns no results; no contact records with Wide World Importers in the Company field exist in this folder. You added the contacts from Wide World Importers to the address book when you created the Clients contact group, so their contact records contain only a first name, last name, and e-mail address.
 
 
 
 9. Click the Remove button to the right of the Company box. The Company box closes, the corresponding criterion disappears from the Search box, and the Contacts pane redisplays the 12 original records.
 
 
 
 10. In the Refine group, click the More button and then, in the list, click E-mail. An E-mail box opens in the Search pane.
 
 
 
 11. In the E-mail box, enter wideworldimporters. The Search box content updates, but the Contacts pane displays no matching contact records.
 
 
 
 12. On the Search tab, in the Scope group, click the All Contact Items button. The three contact records you created in the previous exercise appear in the Contacts pane.
 
 
 
 13. In the Scope group, click the All Outlook Items button. The Contacts pane changes to display the search results listed by folder, and the Reading Pane in which you can see the information available for the selected contact. The text matching the search criterion is highlighted in the Reading Pane.
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 E-mail address is one of the criteria by which you can conduct a search.
 
 In the Contacts pane, the Contacts group heading above the three contact records indicates that the records are currently stored in the Contacts address book.
 
 
 
 14. In the Contacts pane, click the Liberty Munson contact record, and then press Ctrl+A to select all three contact records.
 
 
 
 15. Drag the selected contact records from the Contacts pane to the SBS Contacts folder in the Navigation Pane.
 
 The group heading in the Contacts pane changes to indicate the new location of the contact records.
 
 
 
 16. In the Navigation Pane, click the Contacts address book. The three contact records are not in the Contacts address book.
 
 
 
 17. In the Navigation Pane, click the SBS Contacts address book. Then on the Home tab, in the Current View gallery, click List.
 
 The contact records for Eli Bowen, Liberty Munson, and Tjeerd Veninga are now stored in this address book with the other contact records and the contact group that you have created while working through this book.
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 The final contents of the SBS Contacts address book.
 
 CLEAN UP  Click in the Search box to activate the Search pane, and then click the Remove button to the right of the E-mail box to remove this field from the pane. Tip  You can quickly repeat previous searches by clicking in the Search box to display the Search contextual tab, clicking the Recent Searches button in the Options group of the Search tab, and then clicking the criteria of the previous search you want to repeat.
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 Personalizing Electronic Business Cards Within each contact record window, information appears not only in the fields of the contact record but also in the form of a graphic that resembles a business card. When you enter a person’s contact information in a contact record, basic information appears in the business card shown in the upper-right corner of the contact window. This data includes the person’s name, company, and job title; work, mobile, and home telephone numbers; and e-mail, postal, Web page, and instant messaging addresses. (Only the first 10 lines of information fit on the card.) If the contact record includes an image, the image appears on the left side. You can change the types of information that appear, rearrange the information fields, format the text and background, and add, change, or remove images, such as a logo or photograph. Creating a business card for yourself provides you with an attractive way of presenting your contact information to people you correspond with in e-mail. You can attach your business card to an outgoing e-mail message or include it as part (or all) of your e-mail signature. The recipient of your business card can easily create a contact record for you by saving the business card to his or her Outlook address book. See Also  For information about e-mail signatures, see “Personalizing the Appearance of Message Text” in Chapter 10, “Enhance Message Content.”
 
 In this exercise, you’ll modify the business card associated with a contact record. SET UP  You need the JoanLambert image located in the Chapter09 practice file folder and the SBS Litware address book you created earlier in this chapter to complete this exercise. Display the SBS Litware address book in Business Card view, and then follow the steps.
 
 
 
 1. In the Contacts pane, double-click the Joan Lambert contact record. The contact record window opens. The business card in the upper-right corner is filled in with information stored in the contact record fields. The image to the left of the business card is a placeholder.
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 The default business card displays the information stored in the contact record.
 
 
 
 2. On the Contact tab, in the Options group, click the Picture button. Then click Add Picture.
 
 The Add Contact Picture dialog box opens, displaying the contents of your Pictures library. You can add a business logo, your photograph, or any other identifying image to a business card.
 
 
 
 3. In the Add Contact Picture dialog box, navigate to the Chapter09 practice file folder, click the JoanLambert image, and then click OK.
 
 In the contact record window, the photo of Joan replaces the image placeholder and also appears on the business card.
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 4. In the Options group, click Business Card. The Edit Business Card dialog box opens.
 
 The default placement of an image on an electronic business card.
 
 
 
 5. In the Card Design area, click the Layout setting and then, in the list, click Image Right.
 
 The photo moves from the left side of the card to the right side.
 
 
 
 6. In the Image Area box, type or select (by clicking the arrows) 38%. 7. Click the Image Align setting and then, in the list, click Fit to Edge. The photo expands to the full height of the business card.
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 8. In the Card Design area, click the Background Color button. Then in the Color dialog box, click the brown square that is the second from the bottom and the second from the left of the color gallery. The selected color will be applied to the card background.
 
 You can choose from the 48 standard colors or define your own.
 
 
 
 9. In the Color dialog box, click OK. The card preview reflects the new background color. The text on the card is difficult to read against the dark background.
 
 
 
 10. With Full Name selected in the Fields list, click the Font Color button at the top
 
 of the Edit area (not the button associated with the Label field). Then in the Color dialog box, click the white square (in the lower-right corner of the color gallery), and then click OK. The contact’s name is now easy to read.
 
 
 
 11. In the Fields list, click Company, and then change the color of the company name shown on the business card from black to light gray (the third square from the right in the bottom row of the color gallery).
 
 
 
 12. In the Fields list, click Job Title. Then below the Fields list, click Remove. The job title no longer appears on the business card. It hasn’t been removed from the contact record.
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 13. In the Fields list, click the first instance of Blank Line. Then click the Move Field Up button five times to place a blank line between the Company and Business Phone fields. Each time you click the button, the position of the blank line is reflected on the business card.
 
 
 
 14. In the Fields list, click E-mail. Then click the Move Field Up button two times to position the e-mail address before the telephone numbers.
 
 
 
 15. Use the techniques you learned in this exercise to do the following: ❍ Remove the Business Address field from the business card. ❍ Insert a blank line between the Mobile Phone and Business Home Page
 
 fields. ❍ Change the color of the E-mail, Business Phone, and Mobile Phone information
 
 to light gray and the Business Home Page information to white. After completing these changes, the business card looks very different from the original.
 
 You can easily modify the layout and formatting of an electronic business card.
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 16. In the Edit Business Card dialog box, click OK. Tip  You can undo all the changes you’ve made to a business card by clicking Reset Card in the Edit Business Card dialog box.
 
 The contact window displays the customized business card.
 
 
 
 17. On the Contact tab, in the Actions group, click the Save & Close button. The Contacts pane displays the personalized business card along with the standard business cards of the other Litware, Inc. employees.
 
 A personalized business card stands out from other contact records.
 
 CLEAN UP  Retain the SBS Litware address book and its contents for use in later exercises.
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 Sending Business Cards You can send entire contact records to other Outlook users to add to their address books or, if you prefer to share only the information shown on the associated business card, you can send the business card. To send an Outlook business card: 1. In the Contacts pane, click a business card you want to send. 2. On the Home tab, in the Share group, click the Forward Contact button and then, in the list, click As A Business Card. A new message window opens, with the business card displayed in the content area, and as an attachment to the message. The contact name is displayed in the Subject box in the message header. 3. Address and send the message.
 
 Key Points ● To more specifically organize contact records, you can create separate address
 
 books. ● You can import information into an Outlook address book from many external
 
 sources, and export information to share with other people who are using other programs. ● Creating and making use of contact groups saves time if you frequently send
 
 messages to a specific group of people. ● The Search feature makes short work of locating a specific contact or item of
 
 information in a contact record. ● You can customize the information shown in the electronic business card for
 
 each contact record, including your own.
 
 Chapter at a Glance Personalize the appearance of message text, page 348
 
 Embed and modify images, page 362
 
 Create and format business graphics, page 381
 
 10 Enhance
 
 Message Content In this chapter, you will learn how to ✔ Personalize the appearance of message text. ✔ Embed and modify images. ✔ Create and format business graphics. ✔ Change message settings and delivery options.
 
 Messages composed in and sent from Microsoft Outlook 2010 don’t have to consist only of plain text. They can contain diagrams and graphics and can be visually enhanced by a judicious use of colors, fonts, and backgrounds. For more formal messages, you can attach a signature that includes your contact information as well as graphics such as a photograph or logo. In this chapter, you’ll first review formatting techniques, set default fonts for new messages and message responses, and create an e-mail signature that‘s automatically included in all new messages. Then you’ll insert and modify pictures, Clip Art, and shapes, and use the new Screenshot and Screen Clipping tools to capture images of content displayed on your screen. You’ll create and format graphical representations of business information and data. Finally, you’ll learn about the message settings and delivery options you can set for outgoing messages. Practice Files  Before you can complete the exercises in this chapter, you need to copy the book’s practice files to your computer. The practice files you’ll use to complete the exercises in this chapter are in the Chapter10 practice file folder. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book.
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 Personalizing the Appearance of Message Text By default, the text content of an Outlook message is shown in black, 11-point Calibri (a font chosen for its readability), arranged in left-aligned paragraphs on a white background. You can change the appearance of the text in a message by applying either local formatting (character or paragraph attributes and styles that you apply directly to text) or global formatting (a theme or style set that you apply to the entire document) in the same way that you would when working in a Microsoft Word document or Microsoft PowerPoint presentation. However, if you have a preferred font or theme for the messages you compose, you can save your preferences so that Outlook automatically applies it to new messages and to message responses.
 
 Formatting Message Text You set your default font and theme preferences from the Signatures And Stationery dialog box, which you open by clicking Stationery And Fonts on the Mail page of the Outlook Options dialog box. You have the option of specifying one default font for new messages and another for message responses. You might do this if you need to visually differentiate between original messages and responses. For example, you might compose original messages in a dark blue font, and compose message responses in a medium blue font.
 
 The Signatures And Stationery dialog box.
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 You can also specify a theme—a preselected set of fonts, colors, and graphic elements— to have Outlook create new messages using that theme. For example, if your organization uses a specific theme for corporate communications, you can specify that theme as the default for outgoing messages as well as for Word documents. Tip  If you create different types of Office documents (such as Word documents, PowerPoint presentations, and corporate e-mail messages) for your organization, you can ensure the uniform appearance of all the documents by applying the same theme to all the documents. For example, you might choose a theme that incorporates your company’s corporate fonts and logo colors.
 
 You can manually format text in the content pane to differentiate it from your default font. The local formatting options available in Outlook 2010 are the same as those available in Word and other Microsoft Office 2010 programs, and you might already be familiar with them from working with those programs. Here’s a quick review of the types of formatting changes you can make. ● Font, size, and color  More than 220 fonts in a range of sizes and in a virtually
 
 unlimited selection of colors. ● Font style  Regular, bold, italic, or bold italic. ● Underline style and color  Plain, multiple, dotted, dashed, wavy, and many
 
 combinations thereof, in all colors. ● Effects  Strikethrough, superscript, subscript, shadow, outline, emboss, engrave,
 
 small caps, all caps, or hidden. ● Character spacing  Scale, spacing, position, and kerning. ● Paragraph attributes  Alignment, indentation, and spacing. ● Character and paragraph styles  Titles, headings, and purpose-specific font
 
 formatting (for example, for quotes and book titles). In a message composition window, the local formatting commands are available both from the Message tab and from the Format Text tab. The formatting commands are available only when the cursor is in the content pane. When the cursor is in a message header box (such as To or Subject), the formatting commands are grayed out.
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 You can apply character and paragraph styles from the Quick Styles gallery in the Styles group on the Format Text tab, or from the Styles pane that opens when you click the Styles dialog box launcher on the Format Text tab. Quick Styles gallery
 
 Styles pane
 
 You can specify the styles that you want to appear in the Quick Styles gallery and in the Styles pane. Tip  You can preview the effect of a style on the currently selected text by pointing to the style in the Quick Styles gallery.
 
 The global formatting options—themes and style sets—are sets of local formatting that you can apply with a couple of clicks.
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 A theme applies a preselected combination of colors, fonts, and effects to all the message content. You can apply all the elements of a theme to the message content by selecting any of the 40 available themes in the Themes gallery, which you open from the Themes group of the Options tab.
 
 The Themes gallery.
 
 The default theme for all e-mail messages, Word documents, PowerPoint presentations, Microsoft Excel workbooks, and other Office 2010 documents is the Office theme. If you don’t apply another theme to your message, the colors, fonts, and effects in your message are controlled by the Office theme.
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 You can modify the currently applied theme by selecting a color set from the Colors gallery, a font set from the Fonts gallery, or an effect from the Effects gallery.
 
 The color set, font set, and effect sets that are the defaults for each theme are named to match that theme.
 
 A style set changes the colors, fonts, and paragraph formatting of individual styles. You can change the appearance of all the styles in a message by selecting any of the 14 available style sets (or by creating your own). Selecting a style set changes the appearance of all the text in the current document, as well as the appearance of the icons in the Quick Styles gallery. You can preview or select a style set by clicking the Change Styles button in the Styles group on the Format Text tab, clicking Style Set, and then pointing to or clicking a specific style set.
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 Choosing a style set. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book. See Also  For more information about Quick Styles, style sets, color schemes, and font sets, refer to Microsoft Word 2010 Step by Step by Joyce Cox and Joan Lambert (Microsoft Press, 2010).
 
 Adding Signatures to Messages Automatically When you send an e-mail message to someone, you will most likely “sign” the message by typing your name at the end of the message text. You can automatically insert your signature text in outgoing messages by creating an e-mail signature and assigning it to your e-mail account. Your e-mail signature can include additional information that you want to consistently provide to message recipients.
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 Editing your signature.
 
 Your e-mail signature can include any text or graphics you want; you would commonly include your name and contact information, but depending on your situation, you might also include information such as your company name, job title, a legal disclaimer, a corporate or personal slogan, a photo, and so on. You can even include your electronic business card as part or all of your e-mail signature. See Also  For more information about electronic business cards, see “Personalizing Electronic Business Cards” in Chapter 9, “Work with Your Contact List.”
 
 You can create different signatures for use in different types of messages or for use when you’re sending messages from different e-mail accounts. For example, you might create a formal business signature for client correspondence, a casual business signature for interoffice correspondence, and a personal signature for messages sent from a secondary account. Or you might create a signature containing more information to send with original e-mail messages, and a signature containing less information to send with message replies. You can format the text of your e-mail signature in the same ways that you can format message text. If you want to apply formatting that’s not available from the selections of buttons across the top of the signature content pane, you can create and format your signature either in an e-mail message composition window or in a Word document, copy the signature from its original location, and then paste it into the signature content pane. Using this technique, you can include artistic content such as WordArt and Clip Art in your e-mail signature.
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 Tip  All Office programs share the Microsoft Office Clipboard, so you can easily copy and move content between programs. You don’t need to work from the Clipboard to paste the most recently cut or copied text into another location; it’s stored in the shared Clipboard, so all Office programs have access to it.
 
 You can assign specific e-mail signatures to specific accounts so that they appear automatically in new messages. You can also manually insert any e-mail signature in any message. To manually insert an existing e-mail signature in a message: 1. Position the cursor where you want to insert the e-mail signature. 2. On the Insert tab, in the Include group, click the Signature button. 3. In the Signature list, click the name of the e-mail signature you want to insert. Tip  If you have not previously set up a signature, clicking the Signature button opens the Signatures And Stationery dialog box in which you can create a signature.
 
 To remove an e-mail signature from a message, select and delete the signature content as you would any other text. In this exercise, you’ll first set the default fonts for new messages and for responses. Then you’ll create an e-mail signature and instruct Outlook to insert the signature in all new messages you create. SET UP  You don’t need any practice files to complete this exercise. Display your Inbox, and then follow the steps.
 
 
 
 1. Display the Backstage view and then, in the left pane, click Options. The Outlook Options dialog box opens, displaying the General page.
 
 
 
 2. In the left pane of the Outlook Options dialog box, click Mail. From the Mail page of the Outlook Options dialog box, you can access other dialog boxes that control the settings for specific features.
 
 The Mail page of the Outlook Options dialog box.
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 3. In the Compose messages section, click the Stationery and Fonts button. The Signatures And Stationery dialog box opens, displaying the Personal Stationery page.
 
 The Personal Stationery page.
 
 By default, new messages use the 11-point version of the body font and font color specified by the theme (for the default Office theme, this is 11-point black Calibri), and responses use the same font, but in blue.
 
 
 
 4. Under New mail messages, click the Font button. The Font dialog box opens.
 
 
 
 5. Scroll down the Font list, noting the many fonts you can choose from, and click Garamond.
 
 The sample text in the Preview pane changes to reflect your selection.
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 Choosing a font. Tip  This Font dialog box doesn’t display font previews in the Font list; you have to actually select the font to see what it looks like in the Preview box. You can preview fonts in the font lists that are available in a message composition window, either from the Basic Text group on the Message tab or from the Font group on the Format Text tab.
 
 
 
 6. Scroll down the Font list and click Lucida Sans. The sample text changes, as do the options available in the Font Style list. The available styles are specific to the fonts installed on your computer. Tip  Fonts are installed on your computer in the C:\Windows\Fonts folder. You can view all the installed fonts in that folder.
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 7. In the Font style box, click Demibold Roman, and in the Size box, click 9. 8. Click the Font color arrow and then in the palette, click the second darkest square in the purple column. (When you point to the square, the ScreenTip identifies it as Purple, Accent 4, 25%.) The Preview box reflects your changes.
 
 Choosing a font color.
 
 
 
 9. In the Font dialog box, click OK. The New Mail Messages font preview changes to reflect your selections.
 
 
 
 10. In the Replying or forwarding messages area, click the Font button. Repeat steps 6 through 9 to set the default font for message responses to Purple, 9-point, Demibold Roman, Lucida Sans.
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 In this instance, you aren’t differentiating between the color of the font in your new messages and message responses; instead you will differentiate by including an e-mail signature only in new messages.
 
 Setting identical fonts for new messages and responses.
 
 
 
 11. In the Signatures and Stationery dialog box, click the E-mail Signature tab. 12. Below the Select signatures to edit box, click New. Outlook prompts you to first supply a name for the new signature.
 
 Assign a name that will allow you to easily differentiate when inserting signatures.
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 13. In the Type a name for this signature box, enter Casual. Then click OK. Outlook creates the Casual signature, which is currently blank.
 
 
 
 14. In the Edit signature box, type Thanks! (including the exclamation point), press the Enter key, and then type your name.
 
 
 
 15. Select your name. Click the Font arrow and then, in the list, click Lucida
 
 
 
 16. Click the Font Size arrow and then, in the Font Size list, click 14. 17. Click the Font Color arrow and then, under Standard Colors, click the Purple box.
 
 Handwriting (or any other font you like).
 
 Then click away from your name to see the results of your changes. With the formatting you applied, the name now resembles a signature.
 
 Your signature will appear in e-mail messages exactly as it does here.
 
 
 
 18. Apply any other types of formatting you want; for example, you might want to format the Thanks! to match your default message font.
 
 Tip  If you want to include your electronic business card as part of your signature, click the Business Card button. Then in the Insert Business Card dialog box, locate and click your name, and click OK.
 
 You can manually insert any signature you create in an e-mail message, but it’s a more usual practice to instruct Outlook to insert the signature automatically.
 
 
 
 19. In the Choose default signature area, ensure that your default e-mail account is shown in the E-mail account box. Then click the New messages arrow and, in the list, click Casual.
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 Outlook will now insert your signature into all new e-mail messages you send from this account but not into replies or forwarded messages. Tip  If you have more than one e-mail account set up in Outlook, you can instruct Outlook to insert a different signature in messages sent from each account. To do so, click the account in the E-mail Account list, click the signature you want to use with that account in the New Messages and Replies/Forwards lists, and then click OK.
 
 
 
 20. Make any other changes you want, and then click OK in the Signatures and
 
 
 
 21. On the Home tab, in the New group, click the New E-mail button.
 
 Stationery dialog box and in the Outlook Options dialog box.
 
 A message composition window opens. Your e-mail signature is already present in the content pane.
 
 
 
 22. Click to position the cursor in the blank line at the top of the content pane. Then type I love this book!
 
 The message text is automatically formatted in the default font you set earlier in this exercise.
 
 The inserted Casual signature.
 
 CLEAN UP  Close the message window without saving your changes. Reset the New Messages signature to <none> if you don’t want to use the Casual signature you created in this exercise.
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 Embedding and Modifying Images E-mail is a means of communicating information to other people, and, as the old saying goes, a picture is worth a thousand words. Using Outlook 2010, you can communicate visual information in the following ways: ● Share photographs with other people by attaching them to or embedding them
 
 in messages. ● Share information from Web sites, documents, and other visual presentations
 
 by capturing pictures of things on your screen using a handy tool that is new in Office 2010, and then inserting those screen clippings in your message. ● Explain complicated processes and other business information by creating SmartArt
 
 graphics within messages or by embedding SmartArt graphics that you create in other Office 2010 programs. ● Communicate statistical information by creating a chart within a message. ● Decorate message content by inserting Clip Art images.
 
 You can insert all these types of images from the Illustrations group on the Insert tab into the content pane of an e-mail message, calendar item, or task; or into the Notes pane of a contact record. (You can’t insert an image into a note.) See Also  For information about SmartArt graphics and charts, see “Creating and Formatting Business Graphics” later in this chapter.
 
 Inserting Pictures The process of embedding a picture in a message or other Outlook item is straightforward. Simply follow these steps: 1. Position the cursor in the content pane or notes pane where you want the picture to appear. 2. On the Insert tab, in the Illustrations group, click the Picture button. The Insert Picture dialog box opens, displaying the contents of your Pictures library.
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 3. In the Insert Picture dialog box, browse to the folder containing the picture you want to insert. 4. Click the picture to select it, and then click Insert. Tip  To insert multiple pictures at one time, select the first picture you want to insert. Then either press Shift and click the last picture in a consecutive series, or press Ctrl and click each individual picture.
 
 After inserting a picture, you can modify the picture and control the flow of text around it by using the commands on the Format contextual tab that appears when the picture is selected.
 
 Picture formatting options within an Outlook e-mail message. See Also  For information about applying effects to pictures, see “Modifying Images” later in this topic.
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 Inserting Clip Art and Shapes Clip Art is free media—illustrations, photographs, videos, and audio files—that you can insert into any Office document. A collection of Clip Art is installed on your computer and available whether you are working online or offline. Additional Clip Art is available from the Microsoft Office Web site at office.microsoft.com.
 
 After inserting a Clip Art image, you can modify the image and control the flow of text around it.
 
 To locate and insert a Clip Art image, follow these steps: 1. Position the cursor in the content pane or Notes pane where you want the image to appear. 2. On the Insert tab, in the Illustrations group, click the Clip Art button. The Clip Art task pane opens on the right side of the Outlook item window. 3. In the Search box, enter one or more keywords describing the image you want to locate.
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 4. In the Results Should Be list, clear the check boxes of any media file types you don’t want to search for.
 
 Removing unwanted media types from the search makes it easier to review the results.
 
 5. Click Go. 6. Scroll through the search results until you locate the image you want to insert. Tip  If you don’t find an image that fits your needs, click the Find More At Office.com link to display the Images And More page of the Microsoft Office Web site. From that page, you can browse categories of images and download images you like to your local Clip Art collection.
 
 7. Point to any image to display a ScreenTip with information about the file; click the vertical bar that appears on the right side of the image to display a menu of commands. From the menu, you have several options for working with the selected image.
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 You can display more information about each image by clicking Preview/Properties on the menu.
 
 8. On the menu, click Insert. In addition to Clip Art, you can insert many types of shapes into the content pane of an Outlook item. To insert a shape, follow these steps: 1. On the Insert tab, in the Illustrations group, click the Shapes button. 2. In the Shapes gallery, click the shape you want to insert. 3. In the content pane, drag to draw the shape at the size you want. Available shapes include lines and simple arrows, geometric shapes, common symbols, block arrows, mathematical operators, flowchart symbols, stars and banners, and more. After inserting a shape, you can change its outline and fill colors and modify its appearance in many ways by using the commands available on the Drawing Tools Format contextual tab.
 
 Embedding and Modifying Images   367
 
 
 
 Capturing Screen Images The Screenshot and Screen Clipping tools are new features of Outlook 2010 that you can use to easily capture images of either an entire window that’s open on your screen or a specific area of the screen that you select. To capture and insert a screen image, follow these steps: 1. Ensure that the window you want to capture is not minimized or, if you plan to capture only a portion of a window, that it’s visible on the screen. 2. In the Outlook item window, position the cursor in the content pane or Notes pane where you want the image to appear. 3. On the Insert tab, in the Illustrations group, click the Screenshot button. The Available Windows gallery displays the currently open (non-minimized) windows.
 
 You can capture an image of any open window by clicking it in the Available Windows gallery.
 
 4. To insert an image of an entire open window into the Outlook item, click its icon in the Available Windows gallery.
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 5. To capture an image of a portion of the content that’s visible on your screen, click Screen Clipping. If you click Screen Clipping, the active Outlook item is minimized to the Windows Taskbar so that the content behind it is visible. White shading covers the desktop, and the Screen Clipping tool (which at this point looks like a large plus sign) appears. Screen Clipping tool
 
 The white shading indicates the portion of the desktop that’s not being captured by the Screen Clipping tool.
 
 6. Position the Screen Clipping tool in the upper-left corner of the area you want to capture. Press and hold the mouse button, and then drag to encompass the capture area. The Screen Clipping tool makes a window in the shaded area to indicate the intended capture area. You can change the capture area until you release the mouse button. Tip  You don’t have to be exact with the size of your outline because you can modify the screen clipping after you insert it into the Outlook item.
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 Screen capture area
 
 The area that will be captured is unshaded and boxed.
 
 7. When the entire area you want to capture is encompassed in the Screen Clipping box, release the mouse button. The Outlook item is restored from the taskbar and the captured image appears in the content pane.
 
 You can format and modify screen clippings in the same ways that you can pictures.
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 Modifying Images Using functionality that is new in Office 2010, you can modify and enhance images directly in the item window. From the new Picture Tools contextual tabs that appear when you select an image, you can do things like: ● Crop or remove background elements from an image. ● Sharpen or soften the image content. ● Colorize the image and control color saturation and tone. ● Apply artistic effects to make an image look as though it’s rendered in pencil,
 
 chalk, marker, or paint, or has a pattern applied to it. ● Add shadows, reflections, and glowing or soft edges. ● Apply three-dimensional effects.
 
 Certain effects can be applied to only specific types of files. For example, you can apply artistic effects to a photograph that’s saved in .jpg format (a common format for digital photos) but not to an illustration that’s saved in .wmf format (a common format for Clip Art illustrations). In this exercise, you’ll insert a photograph in an e-mail message and then use some of the new Picture Tools commands to modify the photo before sending it. SET UP  You need the Lighthouse photograph located in the Chapter10 practice file folder to complete this exercise. Open a new message composition window, and then follow the steps.
 
 
 
 1. Maximize the message window. Tip  The graphics in this exercise depict the full-size message window at a width of 1024 pixels.
 
 
 
 2. On the ribbon, click the Insert tab. While the cursor is in the To field, only the commands in the Include group are available.
 
 
 
 3. Click to position the cursor in the content pane. The commands in the Tables, Illustrations, Links, Text, and Symbols groups become available.
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 Commands on the Insert tab are available only when the cursor is located in a text box, such as the content pane or notes pane, into which you can insert content. See Also  For information about inserting and formatting tables, see “Creating and Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 
 
 4. On the Insert tab, in the Illustrations group, click the Picture button. The Insert Picture dialog box opens, displaying the Pictures library or the previous location you browsed to in the current computing session.
 
 
 
 5. Navigate to the Chapter10 practice file folder, click the Lighthouse photo, and then click Insert.
 
 The photo appears in the e-mail message content pane, and the Picture Tools Format contextual tab becomes active. Because the image is so large, only the upper-left corner of the photo is visible in the content pane.
 
 External images are inserted at their original sizes; the dimensions of the selected image are shown in the Size group on the Insert tab.
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 Troubleshooting  If your screen resolution is set higher than 1024 × 768, you will see more of the photo in the message window. Either change the size of your message window to match ours or simply follow along with the steps as written and be aware that your message window will appear different from those shown here.
 
 
 
 6. On the Format tab, in the Size group, click and hold the down arrow in the Shape Height box until the shape height is 4".
 
 The shape’s width decreases proportionally with the shape’s height so that the photo maintains its aspect ratio.
 
 You can change the size of a graphic by setting specific dimensions or by dragging its resizing handles.
 
 
 
 7. In the Adjust group, click the Remove Background button. Purple shading obscures all but selected areas of the photo. Resizing handles surround an area selector in the center of the photo. The Picture Tools Background Removal contextual tab appears on the ribbon.
 
 
 
 Embedding and Modifying Images   373
 
 Resizing handles
 
 The Background Removal tool makes its best attempt at identifying background areas in the photo; you can refine the selection to fit your needs.
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 8. Drag the upper-left resizing handle to the left edge of the photo, keeping it just above the top of the lighthouse. Then drag the lower-right resizing handle to the lower-right corner of the photo. The purple shading now covers only part of the sky.
 
 Resizing the area selector is one way of controlling the area marked for removal.
 
 
 
 9. On the Background Removal tab, in the Refine group, click the Mark Areas to Remove button. Then move the cursor back to the photo. The cursor shape changes from an arrow to a pencil.
 
 
 
 10. Click the area of sky that remains visible just below the purple screen. After a moment, a marker appears in the location you clicked, and the purple screen extends to cover the area defined by your clicks.
 
 
 
 11. Click two more times (or as necessary) to shade the entire sky. If a click results in an unintended effect, click the Undo button on the Quick Access Toolbar to remove the effect, and then try again.
 
 Keyboard Shortcuts  Press Ctrl+Z to undo the most recent action. Press Ctrl+Y to repeat the most recent action. See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at the end of this book.
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 Each click affects the area that resembles the marker location. Removal markers
 
 Removal markers are labeled with minus signs. Tip  You can indicate areas of a picture to keep by clicking the Mark Areas To Keep button in the Refine group on the Background Removal tab and then clicking the picture. Keep markers are labeled with plus signs.
 
 
 
 12. On the Background Removal tab, in the Close group, click the Keep Changes button. The purple-shaded area is removed from the photo, leaving only a white background. The Background Removal contextual tab disappears from the ribbon and the Format contextual tab becomes active again.
 
 
 
 13. Click in the content pane, away from the photo, to see the full effect of removing the background from the photo. The lighthouse and landscape details are clearly outlined as though the photo had been carefully trimmed with scissors.
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 A three-dimensional effect can be achieved by removing the background from a picture.
 
 
 
 14. Click the photo to select it and activate the Format contextual tab. On the
 
 Format tab, in the Size group, click the Crop arrow (not the button), and then click Aspect Ratio. A menu of width-to-height ratios opens.
 
 You can crop a graphic to a precise aspect ratio.
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 15. On the Aspect Ratio menu, click 1:1. A selection area appears on the photo.
 
 
 
 16. Drag the photo to the right within the square selection area so that the left edge of the photo is aligned with the left edge of the square.
 
 
 
 17. Press and hold the Shift key, and then drag the lower-right crop handle up and to the left until the square selection area encompasses the lighthouse, trees, and only a bit of rock. Release the mouse button first, and then the Shift key. Tip  Holding down the Shift key maintains the aspect ratio while you crop or resize a picture.
 
 The resulting selection is approximately three inches square. The area of the photo outside of the selection is depicted in grayscale rather than in color. Crop handles
 
 You can crop a picture to show only the portion you want.
 
 
 
 18. In the Size group, click the Crop button. The photo is cropped to the square shape.
 
 
 
 19. In the Picture Styles gallery, click the More button. The Picture Styles gallery expands.
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 You can apply predefined sets of formatting to pictures to achieve a professional effect.
 
 
 
 20. In the Picture Styles gallery, point to several of the icons to see their names and the effect of applying that style to the selected photo. Then click the Rounded Diagonal Corner, White style (in the fourth column of the third row). A combination of shapes and shadows is applied to the photo.
 
 
 
 21. With the photo still selected, click the Artistic Effects button in the Adjust group. The Artistic Effects gallery expands.
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 You can choose from a wide range of effects.
 
 
 
 22. In the Artistic Effects gallery, point to several of the icons to see their names
 
 and the effect of applying that style to the selected photo. Then click the Mosaic Bubbles effect (in the fourth column of the third row).
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 23. Click in the content pane away from the photo to see the full effect. The artistic effect causes the photo to more closely resemble a painting than a photograph.
 
 An artistic effect.
 
 
 
 24. In the message header, enter your e-mail address in the To box and enter SBS
 
 
 
 25. When the message arrives in your Inbox, note that you can select and copy the
 
 Picture Tools in the Subject box. Then send the message.
 
 embedded picture in the Reading Pane or in the open message window for use in other documents. CLEAN UP  Close any open message windows. Move the SBS Picture Tools message to the SBS Messages folder and retain it for use in later exercises. Tip  When you respond to a message that contains an embedded image, clicking the image activates the Picture Tools Format tab that contains a restricted range of formatting options. (Fewer formatting options are available when you work with the modified image than were available in the original message window.)
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 Creating and Formatting Business Graphics Images can be especially valuable in business communications, when you need to clearly explain facts or concepts, particularly to a global audience. In Outlook 2010 (and other Office 2010 programs), you can depict relationships, processes, cycles, hierarchies, and so on, by creating SmartArt graphics, and you can depict graphical representations of data by creating charts. You can create a SmartArt graphic directly in an e-mail message or you can convert an existing list into a SmartArt graphic. When sending a message, Outlook converts any SmartArt graphics within the message to static graphics. You can create a chart directly in an e-mail message. Charts you create in an Outlook message look exactly like those you would create in an Excel workbook—because they are based on an Excel data source that is created from within Outlook. To create a chart in a message or other Outlook item, follow these steps: 1. Position the cursor in the pane where you want the picture to appear. 2. On the Insert tab, in the Illustrations group, click the Insert Chart button. The Insert Chart dialog box opens.
 
 You can filter the available chart types by choosing a category from the left pane.
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 3. In the Insert Chart dialog box, locate the type of chart you want to create. Click the chart icon, and then click OK. A basic chart appears in the Outlook item, and several Chart Tools contextual tabs become active on the ribbon. An Excel program window opens, containing the mock data from which the basic chart is built.
 
 Changes you make to the data are immediately reflected in the chart.
 
 4. Update the mock data with your own. When you finish, close the Excel window. It’s not necessary to save or name the worksheet that contains the data depicted by the chart. When you want to send a chart depicting important data, it’s safer to store the data in an Excel worksheet, create a chart in the Excel workbook from the data, and then embed that chart in an e-mail message. In this exercise, you’ll create a SmartArt flowchart in an e-mail message. SET UP  You don’t need any practice files to complete this exercise. Open a new message composition window, and then follow the steps.
 
 
 
 1. Maximize the message window, and then click in the content pane.
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 2. On the Insert tab, in the Illustrations group, click the SmartArt button. The Choose A SmartArt Graphic dialog box opens.
 
 You can filter the contents of the dialog box by clicking the categories in the left pane.
 
 
 
 3. Scroll through the center pane of the dialog box for an overview of the available SmartArt graphics. Tip  You can display the name of a SmartArt graphic by pointing to it.
 
 
 
 4. In the left pane, click Process. Scroll to the top of the center pane and click the second icon in the second row (Alternating Flow).
 
 This is a process diagram showing the details of a three-step process.
 
 A preview and description of the selected SmartArt graphic appear in the right pane.
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 5. In the Choose a Smart Art Graphic dialog box, click OK. Outlook inserts a basic version of the selected process diagram in the content pane. It looks similar to the preview graphic, but without the colors and threedimensional aspects. (You select formatting options later.) The Text pane opens and the two SmartArt Tools contextual tabs, Design and Format, appear on the ribbon.
 
 In the Text pane to the right of the graphic, you can build a hierarchical list that transfers content to the graphic. Tip  You can display or hide the Text pane for any SmartArt graphic by clicking the diagram and then clicking the Text Pane button in the Create Graphic group on the Design contextual tab. Or you can click the Text Pane tab on the left side of the diagram drawing area.
 
 You can enter text in the Text pane or directly in the graphic—selecting a graphic element or positioning the insertion point within the bulleted list also selects the corresponding element in the graphic or Text pane. The graphic name is shown at the bottom of the Text pane; pointing to it displays a ScreenTip describing the purpose of the current type of graphic.
 
 
 
 6. In the Text pane, click the [Text] placeholder to the right of the first bullet, and then type Plan.
 
 As you type in the pane, the text appears in the diagram.
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 7. Click the [Text] placeholder to the right of the first second-level (indented) bullet, and type Survey current customers. Press the Down Arrow key to move to the next second-level bullet, and then type Survey potential customers. The font size in the graphic adjusts to fit the text into the available space.
 
 
 
 8. Press Enter to create another second-level bullet in the Text pane and in the
 
 
 
 9. In the diagram, click the second solid blue box to select the placeholder, and then
 
 graphic, and then type Analyze competition. type Define.
 
 As you type, the text also appears in the second first-level bullet in the Text pane.
 
 
 
 10. In the third solid blue box, type Design. 11. On the Design contextual tab, in the Create Graphic group, click the Add Shape arrow (not the button) and then, in the list, click Add Shape After.
 
 An additional item appears at the right end of the diagram and in the Text pane. You can add shapes above, below, before, or after the selected shape, depending on the diagram layout.
 
 
 
 12. In the new solid blue box, type Develop. 13. In the Text pane, click at the end of the word Develop, and then press Enter. A first-level bullet and additional shape appear.
 
 You can easily add to the structure of a SmartArt graphic.
 
 
 
 14. Type Test and then, in the Text pane, click the Close button. At its current size, the text within the diagram is very difficult to read.
 
 
 
 15. Point to the move handle (the vertical line of four dots) on the right side of the diagram. When the pointer becomes a double-headed arrow, drag the move handle to the right so that the diagram fills the width of the message window.
 
 
 
 16. In the Layouts gallery, click the More button.
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 The Layouts gallery expands.
 
 The Layouts gallery.
 
 
 
 17. In the Layouts gallery, point to a few of the icons to preview the effect of the SmartArt graphic layout on your content. Then click the second layout in the second row (Continuous Block Process). The process diagram layout changes, as do the styles available on the Design tab.
 
 The content is reconfigured to fit the new layout.
 
 
 
 18. In the SmartArt Styles gallery, click the More button. The SmartArt Styles gallery expands.
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 The SmartArt Styles gallery.
 
 
 
 19. In the SmartArt Styles gallery, point to a few of the icons to preview the effect of
 
 
 
 20. In the SmartArt Styles group, click the Change Colors button.
 
 the style on your graphic. Then in the 3-D section, click the first icon (Polished).
 
 The Change Colors gallery expands.
 
 The colors shown in the gallery change to match the colors specified by the active theme.
 
 The color schemes displayed in the Change Colors gallery are variations of the current theme colors, and they are organized in groups that reflect the six thematic accent colors. Changing the theme also changes the color schemes in the gallery.
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 21. In the Change Colors gallery, point to a few of the icons to preview the effect
 
 of the color scheme on your graphic. Then under Colorful, click the second icon (Colorful Range – Accent Colors 2 to 3). The color scheme of the graphic changes to match your selection.
 
 
 
 22. In the message header, enter your e-mail address in the To box, and enter SBS Development Cycle in the Subject box. Then send the message.
 
 When you receive the message, the SmartArt graphic is visible in the Reading Pane. Regardless of the size at which you created the graphic, the entire graphic is visible in the Reading Pane.
 
 
 
 23. Open the message, and click the SmartArt graphic. The SmartArt graphic has been converted to a static image. If you open the message from your Sent Items folder, you’ll find that the same is true of the graphic in that message.
 
 The graphic resizes with the message window.
 
 CLEAN UP  Close the message window. Move the SBS Development Cycle message to the SBS Messages folder, and retain it for use in later exercises.
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 Changing Message Settings and Delivery Options When you send a message, you can include visual indicators of the importance, sensitivity, or subject category of a message or other Outlook item, flag a message for follow-up, restrict other people from changing or forwarding message content, provide a simple feedback mechanism in the form of voting buttons, and specify message delivery options to fit your needs. Message settings and delivery options
 
 In the received message, tags are displayed as text in the message header.
 
 Common message settings and delivery options include: ● Flags and reminders  You can place an outgoing message on your task list, add an
 
 informational reminder to it, or set a reminder to appear at a certain time and date, for yourself and for message recipients. ● Importance  You can indicate the urgency of a message by setting its importance
 
 to High or Low. A corresponding banner appears in the message header and, if the Importance field is included in the view, an importance icon appears in the Inbox or other message folder. ● Sensitivity  You can indicate that a message should be kept private by setting
 
 its sensitivity to Confidential, Personal, or Private. No indicator appears in the message folder, but a banner appears in the message header to indicate a sensitivity level other than Normal. You can choose to include the sensitivity as one of the message attributes shown in the Inbox pane, but if you do, it replaces the message subject, which isn’t very helpful. ● Security  If you have a digital ID, you can digitally sign the message; or you can
 
 encrypt the contents of the message.
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 ● Voting options  If you and your message recipients have Microsoft Exchange Server
 
 accounts, you can add voting buttons to your messages to enable recipients to quickly select from multiple-choice response options. ● Tracking options  You can track messages by requesting delivery receipts and read
 
 receipts. These receipts are messages automatically generated by the recipient’s e-mail server when it delivers the message to the recipient and when the recipient opens the message. ● Delivery options  You can have reply messages delivered to an e-mail address
 
 other than yours, specify a date and time for the message to be delivered and to expire, and set advanced attachment format and encoding options. ● Categories  You can assign a message to a color category that will be visible to the
 
 recipient if he or she views the message in Outlook. Tip  You can easily sort and group messages by message settings by choosing the message setting in the Arrange By list.
 
 The most commonly used options are available in the Tags group on the Message tab of the message window. You can access other options from the Properties dialog box, which you open by clicking the Tags dialog box launcher.
 
 The Properties dialog box.
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 You can limit the actions other people can take with messages they receive from you by restricting the message permissions. For example, you can prevent recipients from forwarding or printing the message, copying the message content, or changing the content when they forward or reply to the message. (Restrictions apply also to message attachments.) Within a message window, permission options are available both on the File tab and in the Permission group on the Options tab. See Also  For information about digital signatures and for more information about restricting recipients from forwarding, copying, or printing messages you send, see “Securing Your E-Mail” in Chapter 11, “Manage E-Mail Settings.”
 
 Key Points ● You can format the text and background of your messages, either by choosing
 
 individual formatting options and styles or by applying a theme. ● You can automatically insert contact information in e-mail messages by using an
 
 electronic signature. You can create different signatures for different purposes and instruct Outlook to insert a specific signature for each e-mail account and message type. ● You can insert many types of images including photos, screen clippings, and Clip
 
 Art into an Outlook item and modify the appearance of the inserted image by using commands available from the Picture Tools contextual tab. ● You can create graphical representations of processes, hierarchies, and other
 
 organizational structures by using the SmartArt feature. ● You can create a chart directly in an Outlook item as a graphical representation
 
 of data stored in an associated Excel worksheet. ● You can make outgoing messages more useful by setting their properties to com-
 
 municate information to the message recipient and by setting delivery options so you are informed when the message is received and read.
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 11 Manage E-Mail Settings In this chapter, you will learn how to ✔ Work with new mail notifications. ✔ Create rules to process messages. ✔ Block unwanted messages. ✔ Secure your e-mail.
 
 To more easily manage the information you receive through e-mail, you can specify how Microsoft Outlook 2010 alerts you to and processes incoming messages. You can also take advantage of the many security features built into Outlook 2010 to keep your outgoing communications secure and to protect your computer system from spam, viruses, Web beacons, and other modern electronic threats. In this chapter, you’ll learn how to maintain your information in Outlook in a secure and organized fashion. First you’ll work with new mail notifications. You’ll process incoming messages by using rules, and set up the Junk E-mail Filter to manage unwanted messages. Finally, you’ll learn about ways of ensuring that your e-mail communications are secure. Practice Files  The exercises in this chapter use Outlook items you created in exercises in previous chapters. If an exercise requires an item that you don’t have, you can complete the exercise in which you create the item before beginning the exercise, or you can substitute a similar item of your own. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book.
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 Working with New Mail Notifications When new messages, meeting requests, or task assignments arrive in your Inbox, Outlook alerts you in several ways so that you can be aware of e-mail activity if you are using another application or if you’ve been away from your computer. ● A New Mail Message icon appears in the notification area at the right end of the
 
 Windows Taskbar. ● A semi-transparent desktop alert appears on your screen for a few seconds,
 
 displaying the name of the sender, the subject, and the first few words of the message (approximately 125 characters).
 
 Desktop alert New Mail Message icon Outlook icon
 
 From the desktop alert, you can open a message, mark it as read, flag it for action, respond to it, or delete it.
 
 You can change the location, transparency, and length of time desktop alerts appear, or you can choose not to display them. ❍ You can position the alert inside or outside of the Outlook program window.
 
 For example, if you usually work with the taskbar hidden, you might want to position the alert away from the taskbar to prevent you from accidentally displaying the taskbar each time you point to an alert. ❍ The alert can be a solid color or up to 80 percent transparent. The default is
 
 20 percent transparent. You might find that transparent alerts are less likely to interfere with your view of the work you’re doing. ❍ The alert can stay on the screen for from 3 to 30 seconds. The default is
 
 7 seconds. ● If Outlook is minimized or another application window is active, a chime sounds.
 
 You can change the sound or turn it off. ● The mouse pointer briefly changes shape, from an arrow to an e-mail message,
 
 and back. You can turn off this feature. You can customize and turn off these notifications.
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 In this exercise, you’ll customize your desktop alert settings and process messages by using desktop alerts as you receive them. SET UP  You don’t need any practice files to complete this exercise. Display your Outlook Inbox, and then follow the steps.
 
 
 
 1. Display the Backstage view, and then in the left pane, click Options. The Outlook Options dialog box opens.
 
 
 
 2. In the left pane of the Outlook Options dialog box, click Mail. 3. Scroll down the Mail page of the Outlook Options dialog box to display the Message arrival section.
 
 From this section, you can customize the ways in which Outlook alerts you to the arrival of a new message.
 
 You can stop desktop alerts from appearing by clearing the Display A Desktop Alert check box.
 
 
 
 4. In the Message arrival section, click Desktop Alert Settings. The Desktop Alert Settings dialog box opens.
 
 You can set the duration and transparency for desktop alerts.
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 Tip  To quickly access the Desktop Alert Settings dialog box, when a desktop alert appears, click the Options button in the alert, and then click Desktop Alert Settings. You can turn off desktop alerts by clicking the Options button and then clicking Disable New Mail Desktop Alert.
 
 
 
 5. Drag the Duration slider to the left end of the slider bar to set it to 3 seconds, and then click Preview.
 
 A semi-transparent sample desktop alert appears in the lower-right corner of your desktop and fades away after three seconds.
 
 You can preview the effects of changing the desktop alert settings.
 
 
 
 6. Click Preview again, and when the alert appears, point to it. The semi-transparent alert becomes solid. As long as the mouse pointer is positioned over the alert, it remains visible.
 
 
 
 7. Drag the sample desktop alert to the upper-right corner of your screen. Future desktop alerts will appear wherever you move the sample alert.
 
 
 
 8. In the Desktop Alert Settings dialog box, drag the Transparency slider to the left end of the slider bar to set it to 0% transparent, and then click Preview.
 
 The sample desktop alert appears in the upper-right corner of the screen and its transparency lessens until it is opaque.
 
 
 
 9. Move the desktop alert to the position at which you want it to appear in the future.
 
 Then experiment with the options in the Desktop Alert Settings dialog box and set the duration and transparency as you want, previewing your changes as necessary.
 
 
 
 10. When you’re done, click OK in the Desktop Alert Settings dialog box, and click
 
 
 
 11. On the Home tab, in the New group, click the New E-mail button.
 
 OK in the Outlook Options dialog box. A new message window opens.
 
 
 
 12. Enter your e-mail address in the To box, and then in the Subject box, type SBS Alert Test 1.
 
 Important  The subject of each message we instruct you to send to yourself while working through the exercises in this book begins with SBS so that you can easily differentiate the practice files from other messages in your Inbox and Sent Items folders.
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 13. In the message body, type This is a test. Then send the message. When the message arrives in your Inbox, the New Mail Message icon appears in the notification area at the right end of the taskbar, and a desktop alert appears on your screen.
 
 
 
 14. When the desktop alert appears, point to (but don’t click) its message text. The message sender, subject, and text are underlined.
 
 You can click the underlined text in the desktop alert to open the message in a message window.
 
 
 
 15. In the desktop alert, click the Options button. A menu of options appears.
 
 You can process an incoming message from a desktop alert without switching to Outlook.
 
 
 
 16. On the Options menu, click Mark as Read. The desktop alert closes, and in your Inbox, the message corresponding to the desktop alert is marked as read (whether or not the Inbox is visible).
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 17. On the Home tab, in the New group, click the New Items button, and then in the list, click Meeting.
 
 A new meeting window opens.
 
 
 
 18. Enter your e-mail address in the To box, enter SBS Alert Test 2 in the Subject
 
 box, and enter My Inbox in the Location box. Then send the meeting request. If a meeting reminder window opens, click Dismiss. See Also  For more information about meeting requests, see “Responding to Meeting Requests” in Chapter 5, “Manage Scheduling.”
 
 
 
 19. When the desktop alert appears, point to it, and then click the Delete Item button. The message corresponding to the desktop alert moves from your Inbox to the Deleted Items folder, and the desktop alert closes. Tip  If a meeting reminder window opens, click Dismiss.
 
 CLEAN UP  Retain the SBS Alert Test 1 message in your Inbox for use in later exercises. Tip  When the Outlook icon is active in the notification area of the status bar, you can click it to access commands for controlling the display of various types of alerts: Microsoft Exchange Server messages, network warnings, network connectivity changes, and new mail desktop alerts. The Outlook icon is not shown by default. To display it, click the Show Hidden Icons button at the left end of the notification area, click Customize, and then in the Notification Area Icons window of Control Panel, in the Microsoft Outlook list, click Show Icon And Notifications.
 
 Creating Rules to Process Messages You can have Outlook evaluate your incoming or outgoing e-mail messages and take various actions with them based on sets of instructions you set up, called rules. You can create rules based on different message criteria such as the message sender, message recipients, message content, attachments, and importance. By using rules, you can have Outlook automatically move, copy, delete, forward, redirect, reply to, or otherwise process messages based on the criteria you specify. You can choose from a collection of standard rules or create your own from scratch. If you have an Exchange account, you can set up rules that are applied to messages as they are received or processed by your Exchange server, and you can set up rules that go into effect only when you indicate that you are unavailable, by setting up an Automatic Reply. Whether or not you have an Exchange account, you can set up rules that are applied to messages stored on your computer. Tip  You cannot use Outlook rules to filter messages sent to an Internet e-mail account.
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 See Also  For information about setting up Outlook to automatically respond to and process messages when you are unavailable, see “Automatically Replying to Messages” in Chapter 12, “Work Remotely.”
 
 In this exercise, you’ll create a rule to process incoming messages that meet specific criteria. SET UP  You need the SBS Alert Test 1 message you created in the preceding exercise and the contents of the SBS Messages folder you created in Chapter 7, “Organize Your Inbox.” If you have not already created the message or created and populated the folder, you can you can do so now, or you can substitute any messages in your Inbox and adjust the rule criteria accordingly. Display your Outlook Inbox, and then follow the steps.
 
 
 
 1. On the Info page of the Backstage view, click the Manage Rules & Alerts button. The Rules And Alerts dialog box opens, displaying the E-mail Rules page.
 
 Your organization might have server-based rules that are not displayed in this dialog box.
 
 
 
 2. On the E-mail Rules page, click New Rule. The Rules Wizard starts.
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 The wizard leads you through the steps of creating a rule.
 
 You can base a rule on one of the nine rule templates provided by Outlook, or you can start from a blank rule for incoming or outgoing messages.
 
 
 
 3. In the Select a template box, click each of the rule templates in the Stay Organized and Stay Up to Date lists.
 
 The criteria and actions associated with the selected rule appear in the Edit The Rule Description box. Tip  The name of the large box begins with Step 1. This text remains at the beginning of the name as the wizard leads you through a series of steps. We therefore refer to the box by the descriptive name that follows.
 
 
 
 4. In the Start from a blank rule list, click Apply rule on messages I receive. This basic information appears in the Step 2 box.
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 5. In the Rules Wizard, click Next. The Step 1 box changes to display a list of conditions that you can apply to incoming messages.
 
 
 
 6. In the Select condition(s) box, scroll down the list to see the conditions you can apply. Then select the with specific word(s) in the subject check box.
 
 Outlook adds the selected condition to the Edit The Rule Description box. You can specify as many conditions as you want.
 
 Outlook will apply the finished rule to incoming messages that meet the conditions you select.
 
 
 
 7. In the Edit the rule description box, click the underlined term specific words. The Search Text dialog box opens.
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 8. In the Specify words or phrases to search for in the subject box, enter SBS. Then click Add.
 
 The specified term is enclosed in quotation marks and moves to the Search List box.
 
 The rule will apply to messages with subjects that include any of the specified search terms.
 
 
 
 9. In the Search Text dialog box, click OK. Then in the Rules Wizard, click Next. The Step 1 box changes to display a list of actions that can be performed on incoming messages.
 
 
 
 10. Scroll through the Select action(s) list to review the actions Outlook can perform
 
 on incoming items that meet the criteria you specify. Then select the move a copy to the specified folder check box, and in the Edit the rule description box, click the underlined word specified.
 
 The Rules And Alerts dialog box opens, displaying the folders in your mailbox.
 
 You can choose an existing folder or create a new folder directly from the dialog box.
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 11. In the Rules and Alerts dialog box, click the Expand button to the left of the Inbox, click the SBS Messages folder, and then click OK.
 
 Troubleshooting  If you didn’t create the SBS Messages folder in an earlier exercise, click Inbox in the Choose A Folder list, click New, enter SBS Messages as the folder name in the Create New Folder dialog box, and then click OK.
 
 
 
 12. In the Rules Wizard, click Next. The Step 1 box changes to display a list of exceptions you can specify that will cause Outlook not to apply the rule to messages that meet the selected conditions.
 
 Exceptions you specify on this page overrule the conditions specified previously.
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 13. In the Rules Wizard, without selecting an exception, click Next. The final page of the Rules Wizard summarizes the parameters of the SBS rule.
 
 You can review the specified criteria and actions.
 
 
 
 14. Select the Run this rule now… check box, and then click Finish. Outlook runs the rule on the contents of your Inbox and then saves the rule in the Rules And Alerts dialog box.
 
 All the rules you’ve created appear in this list, whether or not they’re turned on.
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 The selected check box to the left of the rule name indicates that this rule is active and that Outlook will apply it to all incoming messages.
 
 
 
 15. In the Rules and Alerts dialog box, click OK. 16. Click the Home tab. In the Navigation Pane, expand the Inbox if necessary, and then click the SBS Messages folder.
 
 The folder contains practice messages you created in earlier chapters of this book, as well as the SBS Alert Test 1 message you created in the preceding exercise.
 
 The SBS Alert Test 1 message has been moved from your Inbox to the specified folder. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.
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 Blocking Unwanted Messages Outlook offers levels of protection for managing junk e-mail messages (also called spam)— the unsolicited advertisements, sometimes containing dangerous attachments, that can swamp your Inbox if your e-mail address finds its way into the hands of unscrupulous mailing list vendors. When enabled, the Junk E-Mail Filter either moves messages that appear to be junk e-mail to a special folder or deletes them. You can specify a list of e-mail addresses or domains whose messages should always be treated as junk; you can also specify a list of e-mail addresses or domains from whom messages should never be treated as junk. Outlook also offers protection from phishing—a widespread identity theft scam. Phishing messages are e-mail messages that contain links to phishing sites purporting to represent trusted, known entities, such as banks or e-commerce sites that would likely have your personal information on file. The messages request that you update your personal information through the link provided. If you do so, you inadvertently provide the requested information (which might include your social security number, bank account number, passwords, and other confidential information) to scam artists, who might then sell or otherwise use the information for their own financial gain. In the past, you were in danger only if you submitted your information through the phishing site, but these sites are becoming increasingly sophisticated, and many now host malicious keystroke-logging software. You can infect your computer just by visiting such sites, which makes it vital that you protect yourself from these threats. See Also  Windows Internet Explorer 8 provides built-in protection against phishing sites. For more information, refer to Windows 7 Step by Step, by Joan Lambert Preppernau and Joyce Cox (Microsoft Press, 2009).
 
 Working with Junk E-Mail Messages By default, when Outlook receives a message that it deems to be either junk mail or a phishing message, it delivers that message to the Junk E-Mail folder associated with your account rather than to your Inbox. (Each account you configure Outlook to connect to has its own Junk E-Mail folder.) You might not be aware that one or more messages has been redirected to your Junk E-mail folder; if someone tells you that he or she has sent you a message but you haven’t received it, it’s good idea to check whether it’s in your Junk E-Mail folder.
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 You can display the contents of the Junk E-mail folder by clicking Junk E-Mail in the folder list of your account, in the Navigation Pane. When the Junk E-Mail folder contains one or more messages, the folder name is bold, and the number of messages in the folder is shown in parentheses at the end of the folder name. This is similar to the way that your Inbox folder name appears when the Inbox contains unread messages, but in this case, the bold formatting is not linked to the read status of the message.
 
 Bold formatting indicates that the Junk E-Mail folder contains one or more messages.
 
 When you open a message from the Junk E-Mail folder, Outlook converts the message content to plain text and disables any active links or content within the message. The information bar in the message header provides specific information about the message’s status. Suspected junk e-mail messages have orange information bars; suspected phishing messages have pink information bars.
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 Outlook disables functionality in a message that it suspects to be spam.
 
 Any remote graphics (graphics that are displayed from Internet locations rather than embedded in the message—sometimes called Web beacons) that were present in the message are converted to URLs so you can easily see where the graphics originated. See Also  For more information about Web beacons, see “Blocking External Content to Protect Your Privacy” later in this chapter.
 
 Although the response options on the ribbon are active, you can’t reply to a message from the Junk E-Mail folder—you must first move it to the Inbox or another folder. You can forward a message from the Junk E-Mail folder; you might want to forward a message to someone else who can verify for you whether the message is valid. The forwarded message will be in plain-text format rather than the original message format. You can delete messages from the Junk E-Mail folder or indicate to Outlook how you would like the Junk E-mail filter to handle similar messages in the future. To process a message from the Mail pane of the Junk E-Mail folder: 1. In the Mail pane, select the message you want to process. 2. On the Home tab, in the Delete group, click the Junk button. The Junk list displays your options for processing the message.
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 You can configure Outlook to block or allow specific senders.
 
 3. Click one of the first four options to block the sender or to add the sender, the sender’s domain, or the recipient group to your Safe Senders or Safe Recipients list. Clicking an option does not remove the message from the Junk E-Mail folder. 4. To move the message to your Inbox, click Not Junk. The Mark As Not Junk message box opens.
 
 The dialog box might look different, depending on your Outlook e-mail account configuration.
 
 5. If you do not want to move the message to the Inbox, click the Close button. Otherwise, select one or both of the Always Trust check boxes, and then click OK. ❍ Selecting the Always Trust E-mail From check box adds the message sender
 
 to your Safe Senders list. ❍ Selecting a check box in the Always Trust E-mail Sent To The Following
 
 Addresses box adds that message recipient to your Safe Recipients list.
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 To process an open message, click the Junk button in the Delete group on the Message tab of the message reading window, and then click the option you want.
 
 Configuring Junk E-Mail Options You manage junk mail settings from the Junk E-mail Options dialog box, which you open by clicking Junk E-mail Options in the Junk list. You set specific junk e-mail processing options for each account to which Outlook is configured to connect. The account for which you’re configuring options is shown in the title bar of the Junk E-mail Options dialog box. The Junk E-mail Options dialog box has five pages. ● On the Options page, you select a level of protection. If you don’t have additional
 
 filters in place, such as those that might be supplied by your organization, you might prefer to click High. Otherwise, click Low.
 
 The Options page of the Junk E-Mail Options dialog box.
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 If you want Outlook to automatically delete suspected junk e-mail, select the Permanently Delete Suspected Junk E-Mail Instead Of Moving It To The Junk E-Mail Folder check box. Do not select this check box if you set the protection level to High or to Safe Lists Only. With these settings, it is likely that the Junk E-Mail Filter will catch quite a few valid messages that you don’t want deleted. Note that the Disable Links And Other Functionality In Phishing Messages check box is selected by default. Unless you are very confident that you have another protective system in place, leave this option selected. ● On the Safe Senders page, you can add a specific person’s e-mail address to the
 
 Safe Senders list (for example, [email protected]) or specify that e-mail received from any sender at a particular domain is safe by adding only the domain (for example, @contoso.com).
 
 The Safe Senders page of the Junk E-Mail Options dialog box.
 
 To ensure that messages from your legitimate contacts aren’t moved to the Junk E-mail folder by the Junk E-Mail Filter, select the Also Trust E-mail From My Contacts and Automatically Add People I E-mail To The Safe Senders List check boxes.
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 ● On the Safe Recipients page, you can add distribution lists or mailing lists of
 
 which you are a member to your Safe Recipients List to ensure that messages sent to you through the distribution list or mailing list will never be treated as junk e-mail.
 
 The Safe Recipients page of the Junk E-Mail Options dialog box. ● On the Blocked Senders page, you can manually add e-mail addresses and
 
 domain names to the Blocked Senders list, or Outlook will add them for you whenever you identify a received message as junk e-mail.
 
 The Blocked Senders page of the Junk E-Mail Options dialog box. Tip  To add the sender or recipient of a message to one of your Junk E-Mail lists, right-click the message in your Inbox or other mail folder, click Junk, and then click Block Sender, Never Block Sender, Never Block Sender’s Domain, or Not Junk.
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 ● On the International page, you have the option of blocking all messages from a
 
 country-specific, top-level domain, or all messages containing specific non-English text encoding.
 
 The International page of the Junk E-Mail Options dialog box.
 
 Click Blocked Top-Level Domain List to access the list of top-level domains you can block. Click Blocked Encodings List to access the list of languages you can block.
 
 You can block entire country-specific and language-specific groups of messages.
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 Securing Your E-Mail As your e-mail messages travel from server to server en route to you or other message recipients, they are vulnerable to interception by hackers and others who are intent on viewing them. With Outlook 2010, you can safeguard your messages in several ways, including implementing digital signatures, encryption, plain text messages, and Information Rights Management (IRM). In certain corporate environments, particularly those that handle sensitive data such as legal and accounting firms, specific e-mail security procedures might be mandated and enforced. In the absence of such guidance, only you can decide whether any of these additional security measures are appropriate for your situation.
 
 Digital Signatures When sending messages, you can reassure message recipients that they are receiving valid messages from you by using a digital signature—a piece of code that validates the identity of a message sender (not the actual person, but the e-mail account and computer from which the message originates).
 
 Obtaining a Digital ID To send digitally signed or encrypted messages over the Internet, you must obtain a digital ID from an independent certification authority. The first time you try to digitally sign or encrypt a message without having a valid digital ID installed on your computer, Outlook prompts you to obtain one. If you prefer, you can obtain one before you need it. Obtaining some types of digital IDs, such as those used to certify the source of software programs, involves a stringent application process that can take weeks to complete. However, applying for a digital ID to certify documents and e-mail messages is a relatively simple process. You can have more than one digital ID on your computer, and you can select which one to use for each document or message. For example, you might have one digital ID for business use and one for personal use. If you have an Exchange account, your Exchange administrator may be able to issue you a digital ID. Otherwise, you’ll need to get one independently. Many U.S. and international certification companies offer digital IDs to certify e-mail. You’ll probably be most comfortable purchasing a certificate in your native currency. Regardless of where you obtain it, your digital ID is valid worldwide.
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 To obtain a digital ID to sign or encrypt documents and messages: 1. On the Trust Center page of the Outlook Options dialog box, click Trust Center Settings. The Trust Center dialog box opens. 2. In the left pane, click E-mail Security. From this page you can configure many of the settings we discuss in this topic.
 
 The Publish To GAL (Global Address List) button is available only in a centrally administered Exchange environment.
 
 3. In the Digital IDs (Certificates) area of the E-mail Security page, click Get A Digital ID. The Microsoft Office Online Web site opens in your default Web browser, listing providers from whom you can obtain a digital ID to certify documents and e-mail messages.
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 Tip  If you want to use a certification authority other than one of those recommended by Microsoft, search the Web for digital ID or certification authority, and you’ll find a number of options. You can apply for a digital ID from any certification authority through its Web site. Digital IDs from non-recommended providers might have compatibility issues with Windows Internet Explorer, so if you use Internet Explorer and you want to be certain you won’t run into problems, use one of the recommended providers.
 
 4. Click the link at the end of a provider’s description to display the provider’s Web site. 5. Follow the instructions on the Web site to register for a digital ID. Some certifying authorities charge a small fee, but most offer free digital IDs or a free trial period. As part of the process, you’ll likely be required to respond to an e-mail message from your computer. Your digital ID will be installed on the computer on which you complete the application process, but it is associated with your e-mail address; if you need to use it on another computer, you can reinstall it from the provider’s site, or you can export the digital ID files from the original computer and import them on the other computer. To export or import a digital ID: 1. Display the E-mail Security page of the Trust Center dialog box. 2. In the Digital IDs (Certificates) area of the E-mail Security page, click Import/Export. The Import/Export Digital ID dialog box opens.
 
 You can import and use any digital ID that is associated with your e-mail address.
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 3. In the Import/Export Digital ID dialog box, select whether you want to import or export your digital ID, provide the appropriate information, and then click OK. Tip  You can also import a digital ID from the Certificates page of a contact record window. For information, see “Working in the Contacts Module” in Chapter 2, “Explore the Outlook Windows.”
 
 Digitally Signing Messages You can digitally sign individual messages when you compose them, or you can instruct Outlook to digitally sign all outgoing messages. The first time you digitally sign a message, you need to configure your security settings to use your digital certificate. You must do this from the Trust Center dialog box. Troubleshooting  You can follow a similar process to configure security settings from the message window, but there appears to be a bug in the system that results in this not working—so be sure to follow the Trust Center process.
 
 To configure digital certificate settings, follow these steps: 1. Display the E-mail Security page of the Trust Center dialog box. 2. To the right of the Default Setting box, click Settings. The Change Security Settings dialog box opens.
 
 You need to specify digital signing and encryption certificates.
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 3. In the Change Security Settings dialog box, to the right of the Signing Certificate box, click Choose. The Windows Security dialog box opens.
 
 The dialog box displays the digital signing certificates available on your computer.
 
 4. In the Windows Security dialog box, click the digital certificate you want to use to digitally sign outgoing messages, and then click OK. The selected certificate information appears in the Change Security Settings dialog box.
 
 By default, Outlook also assigns the selected certificate for message encryption.
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 5. In the Security Settings Name box, enter a name by which you’ll identify the signing certificate. Then click OK in the Change Security Settings dialog box, in the Trust Center dialog box, and in the Outlook Options dialog box. After you complete this process, the Digital Signature and Encryption buttons appear in the Permission group on the Options tab of the message composition window.
 
 By default, Outlook also assigns the selected certificate for message encryption.
 
 To digitally sign an individual e-mail message: ● On the Options tab, in the Permission group, click the Digitally Sign Message
 
 button. A message with a valid digital signature has a red ribbon on its message icon and a digital signature icon (also a red ribbon) in its message header. When you receive a digitally signed message, you can click the digital signature icon to view information about the signature. To digitally sign all outgoing messages: 1. Display the E-mail Security page of the Trust Center dialog box. 2. In the Encrypted E-mail area of the E-mail Security page, select the Add Digital Signature To Outgoing Messages check box. 3. If all your message recipients don’t have Secure Multipurpose Internet Mail Extensions (S/MIME) security (for instance, if you’re sending messages to people who you know aren’t using Outlook), ensure that the Send Clear Text Signed Message When Sending Signed Messages check box is selected (this is the default setting).
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 Encryption You can secure the contents of outgoing messages by using encryption. Encryption ensures that only the intended recipients can read the messages you send. The message recipient’s e-mail program must have corresponding decryption capabilities in order to read the message. You can encrypt individual messages when you compose them, or you can instruct Outlook to encrypt all outgoing messages. To encrypt an individual message: ● On the Options tab, in the Permission group, click the Encrypt button. Troubleshooting  If you haven't previously used the Encryption feature in Outlook 2010, the Encrypt Message Contents And Attachments button might not be visible. If this is the case, click the More Options dialog box launcher on the Options tab, and then in the Properties dialog box, click Security Settings. In the Security Properties dialog box, select the Encrypt Message Contents And Attachments check box, and click OK. Then close the Properties dialog box.
 
 To encrypt all outgoing messages: 1. Display the E-mail Security page of the Trust Center dialog box. 2. In the Encrypted E-mail area of the E-mail Security page, select the Encrypt Contents And Attachments For Outgoing Messages check box. 3. To receive verification that a message recipient received an encrypted message in its encrypted format, select the Request S/MIME Receipt For All S/MIME Signed Messages check box. An encrypted message has a blue lock on its message icon and an encryption icon (also a blue lock) in its message header. When you receive an encrypted message, you can click the encryption icon to view the message security settings. Tip  If you try to send an encrypted message from Outlook to a recipient whose e-mail configuration doesn’t support encryption, Outlook notifies you and gives you the option of resending the message in an unencrypted format.
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 Plain Text Messages These days, viruses and other harmful programs can easily be spread from computer to computer through active content embedded in or linked to from e-mail messages. To ensure that the e-mail messages you receive won’t harm your computer, you might want to display them in plain text, rather than in Rich Text Format or HTML. Links, scripts, and other active content are disabled in plain text messages. To receive all messages in plain text format: 1. Display the E-mail Security page of the Trust Center dialog box. 2. In the Read As Plain Text area of the E-mail Security page, select the Read All Standard Mail In Plain Text check box, and then click OK.
 
 Information Rights Management If you don’t want a message recipient to forward, copy, or print your message, you can send it with restricted permissions. You use Information Rights Management (IRM) to set these permissions, which control who can read your messages and what they can do with them. If the restricted message includes an attachment, such as a Microsoft Word document, an Excel workbook, or a PowerPoint presentation, the recipient can’t edit, copy, or print the attachment (unless you have set individual permissions to allow those actions within the document). To use IRM, you need access to an IRM server. If your organization has its own IRM server, your administrator can advise you how to set restricted permissions. If you don’t have access to an IRM server, Outlook prompts you to sign up for a free trial on an IRM server provided by Microsoft the first time you try to set permissions for a message.
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 You can use the Microsoft IRM service if your organization doesn’t have an internal IRM server.
 
 To take advantage of this free trial, you click Yes in the Service Sign-Up dialog box and then sign up for a Rights Management (RM) account certificate for your outgoing e-mail address (which must be registered as a Windows Live ID). The certificate is valid for six months. After finishing the sign-up process, you can restrict permissions for outgoing messages sent from the computer on which the certificate is installed. Tip  Registering your e-mail address as a Windows Live ID provides you with the credentials necessary to sign in to many sites and services provided by Microsoft and other companies. To register your e-mail address as a Windows Live ID, visit home.live.com.
 
 To prevent message recipients from forwarding, printing, or copying a message: ● On the Options tab, in the Permission group, click the Permission arrow, and then
 
 in the list, click Do Not Forward. The information bar in the message header of the outgoing and received messages indicates what recipients can and can’t do with the message.
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 You can restrict the ways in which message recipients can share message content with other people.
 
 To read a message sent with restricted permissions, recipients must have Outlook 2010, Outlook 2007, or Outlook 2003.
 
 Blocking External Content to Protect Your Privacy E-mail is increasingly used to deliver marketing information to customers and potential customers. Many companies include pictures in their marketing messages to help explain their product or to make the message more attractive and noticeable, but these pictures can make e-mail messages large. To avoid this problem, some companies include links to pictures that are hosted on their server. When you preview or open the message, you can see the pictures, but they aren’t actually part of the message. Some junk mail senders are using this technology to include Web beacons in their messages. Web beacons are small programs that notify the sender when you read or preview the e-mail message. The notification confirms that your e-mail address is valid, and as a result, you might receive more junk e-mail. To help protect your privacy, Outlook includes features that block external content such as pictures, sounds, and Web beacons. In addition to helping ensure your privacy, this blocking technique can save bandwidth resources, because you choose whether to download images and sounds, rather than downloading them automatically when you open a message. By default, Outlook 2010 blocks external content to and from all sources except those defined in the Safe Senders list and Safe Recipients list. When you open or preview a message that contains blocked content, an information bar in the message header provides options for handling the blocked content.
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 To view the blocked content in an individual e-mail message: ● In the message header, click the information bar, and then click Download
 
 Pictures. To change the way Outlook handles external content: 1. Display the Automatic Download page of the Trust Center dialog box. 2. Select the check boxes for the options you want, which include: ❍ Don’t download pictures automatically in HTML e-mail messages or
 
 RSS items. ❍ Permit downloads in messages from senders and to recipients defined in
 
 the Safe Senders and Safe Recipients Lists used by the Junk E-mail filter. ❍ Permit downloads from Web sites in this security zone: Trusted Zone. ❍ Permit downloads in RSS items. ❍ Permit downloads in SharePoint Discussion Boards. ❍ Warn before downloading content when editing, forwarding, or replying
 
 to e-mail. 3. Click OK to save your settings. Under most circumstances, the security provided by the default settings far outweighs the slight inconvenience of manually downloading content you want to see or hear. You will probably find that many of the messages with blocked pictures are not of interest to you anyway, because they are generally marketing messages.
 
 Key Points   427
 
 
 
 Key Points ● Outlook alerts you to new messages in several ways, all of which are customizable. ● You can set up rules so that Outlook can evaluate and process messages depending
 
 on the criteria you set. ● You can digitally sign your messages, encrypt them, and set permissions for them.
 
 You can also display messages in plain text to disable any active content. ● Built-in filters block annoying or hazardous messages that conform to typical spam
 
 patterns or that contain active content.
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 12 Work Remotely In this chapter, you will learn how to ✔ Work with Outlook items while offline. ✔ Manage download options for slow connections. ✔ Automatically reply to messages. ✔ Work with SharePoint site content.
 
 You don’t need to have an active Internet connection to access the information you have stored in Microsoft Outlook 2010; you can work with messages, appointments, and other Outlook items while your computer is offline, by using the Cached Exchange Mode feature. This feature enables you to compose and read messages on your portable computer, for example, while you’re on an airplane. When you’re working online but have a slow Internet connection, you can configure Cached Exchange Mode settings to restrict the amount of information that is downloaded with each message, so that you can dedicate the available bandwidth to the tasks you most urgently need to complete. When you travel or will be unavailable to respond to incoming e-mail messages for a period of time, you can use the Automatic Replies feature to inform message senders of your status and to set expectations for message response times. It’s increasingly common for people in disparate locations to work together, with a collaboration site providing a central location to store and distribute information and to manage team processes. Microsoft SharePoint products and technologies provide a simple and effective way for team members to share information and collaborate on projects. If your organization uses a SharePoint site to facilitate collaboration among team members, you can connect Outlook to SharePoint document libraries, lists, and calendars. Then you can work with the information stored on the SharePoint site from within Outlook, when you’re online or offline. In this chapter, you’ll first configure Cached Exchange Mode so you can work offline in Outlook with a variety of items. You’ll learn ways of working efficiently with Outlook items while you have a slow Internet connection. Then you’ll set up automatic replies. Finally, you’ll connect SharePoint document libraries, lists, and calendars to Outlook.
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 Practice Files  You don’t need any practice files to complete the exercises in this chapter. For more information about practice file requirements, see “Using the Practice Files” at the beginning of this book.
 
 Working with Outlook Items While Offline Wireless Internet connections are now available at many airports, coffee shops, and restaurants, and even on airplanes, either for free or for a small fee. But even though it’s easier than ever to connect to the Internet, there will still be times that you use your computer offline. Not having a connection to your mail server doesn’t prevent you from using Outlook. You can read and create messages and other Outlook items while your computer is offline exactly as you do when it is online, by using the Cached Exchange Mode feature. Cached Exchange Mode was introduced as an option with Outlook 2003 and is turned on by default in Outlook 2010. It generally works in the background without any interaction from you. Cached Exchange Mode creates a local copy (a copy that resides on your computer) of the contents of your Microsoft Exchange Server account mailbox. When you are working online (connected to Exchange), messages, appointments, meetings, tasks, and other Outlook items are synchronized between the server and the local cache. As a result, when you go offline (disconnect from Exchange, either voluntarily or involuntarily), you can still open and work with all your existing Outlook items—including attachments— as usual. You can’t receive messages while you’re offline, but you can send them—at least as far as your Outbox, where they are held until the next time Outlook connects to Exchange. Cached Exchange Mode has greatly streamlined the offline working process, making it simple, for example, to catch up on e-mail on your laptop when you’re in an airplane—of the old-fashioned sort, without onboard Internet. Using Cached Exchange Mode in Outlook 2010, you can have offline access not only to the contents of your Exchange mailbox, but also to the contents of shared folders and public folders (if your organization uses them).
 
 Public Folders Public Folders are shared storage folders in an Exchange environment. Exchange doesn’t automatically create public folders; your Exchange administrator must specifically enable this feature.
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 If your organization uses public folders, they are available from the expanded folders list in the Navigation Pane of the Mail module.
 
 Exchange account folders
 
 Public folders
 
 Folders List button
 
 To expand the folders list and display public folders, click the Folders List button.
 
 You can store Outlook items in a public folder by manually copying or moving the items, or by creating a rule to automatically move or copy items that meet specific criteria. If you have the necessary permissions, you can create public folders and make them available to the entire organization or to selected individuals or groups.
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 To create and configure a public folder: 1. On the Folder tab in any Outlook module, in the New group, click the New Folder button; or in the Navigation Pane, right-click the All Public Folders folder and then click New Folder. 2. In the Create New Folder dialog box, enter a name for the public folder and select the type of items it will contain. In the Select Where To Place The Folder list, expand Public Folders, and click All Public Folders. Then click OK. 3. In the Navigation Pane, display the public folders and expand the All Public Folders folder. Right-click the new folder, and then click Properties. 4. On the Permissions page of the Properties dialog box, specify the people and permissions you want to assign to the folder. Then click OK. You can choose a predefined permission level or individually set read, write, delete, and other options.
 
 You can set the permissions of public folders for which you have administrative access.
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 Using Cached Exchange Mode, you can make the contents of specific public folders available to you when you’re working offline. To add a public folder to your Public Folder Favorites: 1. In the Navigation Pane, display the public folders and expand the All Public Folders folder. 2. Right-click the folder you want to make available offline, and then click Add To Favorites. The Add To Favorites dialog box opens. 3. Click the Options button to display the subfolder and location options. You can include or exclude subfolders of the selected public folder.
 
 You can label a folder in the Favorites list with a different name.
 
 4. In the Add To Favorites dialog box, specify the name of the public folder as you want it to appear in the Favorites folder, select the subfolder and location options you want, and then click Add.
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 Setting Cached Exchange Mode Options When configuring Outlook to connect to an account, or anytime thereafter, you can configure Cached Exchange mode to keep shared folders and public folders, as well standard Exchange account folders, in your local cache. To manage the Cached Exchange Mode settings for your Exchange account: 1. Display the Backstage view. With your Exchange account active at the top of the Info page, click the Account Settings button, and then click Account Settings. The Account Settings dialog box opens.
 
 All the accounts Outlook is configured to connect to are listed on the E-mail tab.
 
 2. With your Exchange account selected in the list, click the Change button. The Change Account dialog box opens. 3. In the Change Account dialog box, click the More Settings button. The Microsoft Exchange dialog box opens.
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 4. In the Microsoft Exchange dialog box, click the Advanced tab. The check boxes available under Cached Exchange Mode Settings depend on your organization’s Exchange settings.
 
 If public folders aren’t available in your Exchange environment, the Download Public Folder Favorites check box doesn’t appear in the dialog box.
 
 5. To turn off Cached Exchange Mode, clear the Use Cached Exchange Mode check box. 6. To turn on Cached Exchange Mode, select the Use Cached Exchange Mode check box. Then select the optional folders you want to cache: ❍ Select the Download Shared Folders check box to cache the contents
 
 of SharePoint document libraries and calendars and of shared Outlook calendars, Contacts folders, Tasks folders, and Notes folders. ❍ Select the Download Public Folder Favorites check box to cache the contents
 
 of public folders that are in your Favorites folder. 7. After turning Cached Exchange Mode on or off, exit and restart Outlook to effect the change.
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 Managing Download Options for Slow Connections When you have a high-speed Internet connection, you probably give very little thought to the size of the messages, and particularly the message attachments, that other people send to you. When your computer has a slow Internet connection, however, downloading large attachments can keep Outlook busy for a long time and cause it to perform slowly. To prevent such delays, you can select the Cached Exchange Mode download option that is most appropriate for your current Internet connection. Outlook offers these Cached Exchange Mode download options: ● Download Full Items  This option downloads all your messages and their attach-
 
 ments one at a time. When your computer is online and you have a high-speed Internet connection, this is the best option because it uses the least bandwidth to download all your messages. If you have a slow connection or receive messages with large attachments, messages might be slow to appear in your Inbox when you reconnect to your server. ● Download Headers and Then Full Items  This option downloads all the message
 
 headers quickly so that you can evaluate them while downloading the message bodies and attachments. ● Download Headers  This option downloads only the message headers, and does not
 
 download the body of messages or their attachments until you preview or open the messages. This is the best option if your connection is very slow or if you are charged for the amount of bandwidth you actually use. You can evaluate a message based on its header information (sender, subject, message size, and so on) and then choose whether to download the message and any attachments. ● On Slow Connections Download Only Headers  You can select this option in
 
 addition to the Download Full Items option or the Download Headers And Then Full Items option so that when Outlook detects that its connection to Exchange is slow, it downloads only the message header, but when the connection is not slow, it uses the original option. This option is not available when the Download Headers option is selected.
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 When you’re connecting to the Internet through a local area network (LAN), broadband, or other fast connection, you probably won’t notice much difference between the first two options. You’ll notice obvious differences with the third option, and it might take some practice to determine whether to download a message based on only a few words in its header. You can manage download options from the Send/Receive tab of the ribbon in any Outlook module.
 
 General download options are in the Download Preferences list; download options for individual items are in the Server group. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 To view or change general download options, click the Download Preferences button in the Preferences group on the Send/Receive tab, and then click to select Download Full Items, Download Headers And Then Full Items, or Download Headers. (A check mark indicates the selected option.) If you usually have a fast Internet connection but might also use your computer in locations with slow Internet connections, also select On Slow Connections Download Only Headers. If you choose the Download Headers option or the On Slow Connections Download Only Headers option, you can control the download of full items by using the commands in the Server group. After your computer downloads message headers to your Inbox, you can mark specific item headers to indicate that you want to download the entire item; if you change your mind, you can unmark one or all the marked items. After marking the items you want to download, click the Process Marked Headers button to download the full items.
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 Choosing to Work Offline Even while you have an available Internet connection, you can still choose to have Outlook work offline; it might be useful, for example, when you don’t want to be interrupted by incoming e-mail messages but still want to have access to information stored in Outlook. To switch between working online and working offline in Outlook: ● On the Send/Receive tab, in the Preferences group, click the Work Offline
 
 button. When you’re working offline, your offline status is indicated by the active (orange) Work Offline button on the Send/Receive tab of the ribbon in any module and by the connection status message on the program window’s status bar.
 
 Offline status indicators.
 
 Choosing the Work Offline option in Outlook doesn’t affect the online status of your Internet connection; you can still access the Internet through your Web browser.
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 Managing an Offline Address Book When Cached Exchange Mode is enabled, as it is by default, Outlook downloads a copy of the Global Address List (GAL) along with your mailbox. This local copy of the GAL provides access to your co-workers’ contact information regardless of whether you are online. If your network connection is slow and the address book is large, this download might take a long time. If you prefer, you can disable the automatic download of the address book or reduce the amount of information transferred, and then manually update your offline address book at your convenience. To reduce the transfer of address book information during send/receive operations: 1. On the Send/Receive tab, in the Send & Receive group, click the Send/Receive Groups button and then, in the list, click Define Send/Receive Groups. The Send/Receive Groups dialog box opens.
 
 The All Accounts send/receive group is created automatically; you can define other groups with different send/receive settings.
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 2. In the Send/Receive Groups dialog box, in the Group Name list, click the group you want to change. Then click Edit. The Send/Receive Settings dialog box for the selected send/receive group opens.
 
 Downloading an offline address book makes it easy to find contact information when you’re not online. Tip  You can turn off the automatic address book update entirely by clearing the Download Offline Address Book check box. If the Download Offline Address Book option is unavailable (dimmed), it indicates that the selected account isn’t included in the scheduled send/receive operation for this group. To activate the send/receive options for the account, select the Include The Selected Account In This Group check box.
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 3. In the Send/Receive Settings dialog box, with the Download Offline Address Book check box selected, click Address Book Settings. The Offline Address Book dialog box displays the relevant download options.
 
 If your organization is large, you can choose to download only a basic version of the address book to save downloading time.
 
 4. In the Offline Address Book dialog box, click No Details, and click OK. Then click OK in the Send/Receive Settings dialog box, and click Close in the Send/Receive Groups dialog box. To manually update your offline address book: 1. On the Send/Receive tab, in the Send & Receive group, click the Send/Receive Groups button and then, in the list, click Download Address Book. The Offline Address Book dialog box displays the relevant download options. 2. In the Offline Address Book dialog box, with the Download Changes Since Last Send/Receive check box selected, select the Full Details check box, and then click OK. Tip  You can download an entirely new copy of the address book by clearing the Download Changes Since Last Send/Receive check box before clicking OK.
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 Automatically Replying to Messages If your organization is running Exchange, you can use the Automatic Replies feature (previously referred to as the Out Of Office Assistant) to inform people who send you e-mail messages of your availability. Turning on the Automatic Replies feature causes Outlook to reply automatically to messages received from other people (but only to the first message from each person). When you turn on this feature, you provide whatever textual information you want within the body of the automatic reply message (commonly referred to as an out-of-office message, or OOF message). The out-of-office functionality in Outlook is actually provided by Exchange Server, so the specific automatic reply features differ depending on what version of Exchange Server your organization is running. If your organization runs Exchange Server 2010 or Exchange Server 2007, you have more control over the content and distribution of automatic replies than you do if your organization runs Exchange Server 2003. Regardless of which Exchange Server environment you’re working in, this is a very useful feature. The purpose of the Automatic Replies feature is to provide standard information to message senders. When you’re away from your computer, an automatic reply can set expectations for when a message sender can expect a personal response from you. You don’t have to be physically out of the office to use this feature; some people use it to let other people know when responses will be delayed for other reasons, such as when they are working on a project that will prevent them from responding promptly to messages, or to inform customers who might be in different time zones of their standard working hours. In addition to having Outlook send automatic replies, you can have it process messages that arrive while you are out of the office by using rules that are in effect only when the Automatic Replies feature is on. See Also  For information about using rules to automatically forward, reply to, delete, alert you to, or otherwise process incoming messages, see “Creating Rules to Process Messages” in Chapter 11, “Manage E-Mail Settings.”
 
 The Automatic Replies feature is off until you explicitly turn it on; it does not coordinate with your free/busy information in the Calendar module. When you are using an Exchange 2010 or Exchange 2007 account, Automatic Replies include the following features: ● You can create two auto-reply messages—one that Outlook sends only to people
 
 in your organization (on the same domain) and another sent either to everyone else or only to the people in your primary address book.
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 Having separate internal and external messages allows you to distinguish the information made available to co-workers, to friends and business contacts, and to the general public (including senders of spam). For example, you might include your itinerary and mobile phone number only in an internal automatic reply, include your return date in a reply to your contacts, and not send any reply to other people. ● You can specify the font, size, and color of automatic reply message text and apply
 
 bold, italic, or underline formatting. ● You can format paragraphs as bulleted or numbered lists and control the indent level. ● You can specify start and end dates and times for your automatic reply message so
 
 that you don’t have to remember to turn off Automatic Replies. In this exercise, you’ll configure Outlook to automatically reply to incoming messages and to send one automatic reply to co-workers and another to the general public. SET UP  You don’t need any practice files to complete this exercise. Display your Inbox, and then follow the steps.
 
 
 
 1. Display the Backstage view. On the Info page of the Backstage view, click the Automatic Replies button.
 
 The Automatic Replies dialog box for your Exchange account opens. This dialog box includes two pages: Inside My Organization and Outside My Organization. The Outside My Organization page includes either (Off) or (On) to indicate either your organization’s standard setting or, if you’ve previously used this feature, your most recent setting. The content pane is currently unavailable (dimmed).
 
 
 
 2. Click Send automatic replies. The time range settings, content pane, and formatting commands become available.
 
 
 
 3. Select the Only send during this time range check box. Then set the Start time to the current time and date, and the End time to one hour from now.
 
 Tip  To set up automatic replies when you’ll be out of the office for a week, set the start time to the end of the day on the last business day preceding the week you’ll be out of the office, and the end time to the end of the day on the last business day before you return. (For example, from 5:00 P.M. Friday until 5:00 P.M. the following Friday.) By using this schedule, anyone sending mail that you won’t be able to respond to within a normal business response time period will receive an automatic reply.
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 4. On the Inside My Organization page, in the content pane, type the following sentence: I’m testing the Outlook automatic reply feature! A more typical internal automatic reply might be I’m on vacation! Call my mobile phone at (972) 555-0123 if you need to contact me. For the purpose of this exercise, though, we’ll take the safe route and not include a message that might be confusing to your co-workers.
 
 
 
 5. Select the sentence you just entered. On the toolbar at the top of the Inside My
 
 Organization page, click the Font Color button and then, in the gallery, click the Purple square. You can format the content of your automatic reply message by using the basic character and paragraph formatting commands available from the toolbar.
 
 You can have the Automatic Replies feature turn itself on and off so you don’t have to remember to.
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 6. Click the Outside My Organization tab. The Outside My Organization page includes options for sending automatic replies to all people outside of your organization, only to people with e-mail addresses that are present in your primary Outlook address book, or not at all.
 
 You can specify types of external message senders who will receive your automatic reply.
 
 A typical external automatic reply might be something like this: I am out of the office this week and will respond to your message as soon as possible. For more information about Litware, Inc. products and services, please visit our Web site at www.litwareinc.com. For the purposes of this exercise, you will not set up an external automatic reply message. Tip  If you make changes to either the internal or the external reply message, but not to both, when you close the Automatic Replies dialog box, Outlook displays a message box asking whether you want to change the other reply message. This useful reminder helps ensure that you keep both versions up to date.
 
 446    Chapter 12  Work Remotely
 
 
 
 7. Clear the Auto-reply to people outside my organization check box, if it is currently selected.
 
 
 
 8. In the lower-left corner of the Automatic Replies dialog box, click Rules. The Automatic Reply Rules dialog box opens.
 
 You can set up rules that Outlook applies specifically to messages that arrive when you are out of the office.
 
 
 
 9. In the Automatic Reply Rules dialog box, click Add Rule. The Edit Rule dialog box opens.
 
 You can create simple rules that Outlook applies only when automatic replies are turned on.
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 The process of creating rules for messages that arrive when automatic replies are turned on is much simpler than the process of creating rules that apply to all messages. See Also  For information about Outlook rules, see “Creating Rules to Process Messages” in Chapter 11, “Manage E-Mail Settings.”
 
 
 
 10. Click Cancel in the Edit Rule dialog box, and then click Cancel in the Automatic Reply Rules dialog box.
 
 The dialog boxes close without creating a rule.
 
 
 
 11. In the Automatic Replies dialog box, click OK. Then in the Outlook program window, click the File tab to close the Backstage view.
 
 The Automatic Replies information bar appears below the ribbon, and the Automatic Replies menu appears on the status bar, because you specified that Outlook should begin sending automatic replies immediately.
 
 The Automatic Replies information bar and status bar menu appear at the start time you select when setting up automatic replies.
 
 
 
 12. On the status bar, click Automatic Replies. The Automatic Replies dialog box opens.
 
 
 
 13. In the Automatic Replies dialog box, click Do not send automatic replies, and then click OK.
 
 The Automatic Replies information bar and the Automatic Replies status bar menu disappear. CLEAN UP  If you have an out-of-office time coming up soon, you can set up the automatic replies for it now, while the process is still fresh in your head, before continuing to the next exercise.
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 Working with SharePoint Site Content SharePoint products and technologies facilitate secure sharing of information within an organization. If your organization stores information on SharePoint sites, you might work with data recorded in SharePoint lists, schedules tracked on SharePoint calendars, or Office documents stored in document libraries. You can connect to SharePoint lists, calendars, and document libraries from Outlook, and work with data and documents stored on a SharePoint site from directly within Outlook.
 
 Working Offline with Document Library Content You can create a copy of a SharePoint document library as a folder in Outlook 2010. You can then preview in Outlook any document, workbook, or presentation that is stored in the document library, or you can work with a local copy of the document, workbook, or presentation on your computer. Changes that you make to a document within Outlook are synchronized with the file on the SharePoint site. To connect a document library or folder therein to Outlook, follow these steps: 1. On your organization’s SharePoint site, display the document library or subfolder you want to work with. The menu bar is at the top of the content pane. Menu bar
 
 A SharePoint document library.
 
 2. On the Actions menu, click Connect To Outlook. A Windows Internet Explorer dialog box opens, requiring that you give explicit permission for SharePoint to access Outlook.
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 3. In the Internet Explorer dialog box, click Allow and then, in the Internet Explorer Security dialog box that opens, click Allow.
 
 You must give explicit permission for SharePoint to access Outlook over the Internet.
 
 Outlook starts, if it isn’t already running. A Microsoft Outlook dialog box opens, asking you to confirm that you want to connect the SharePoint document library to Outlook.
 
 You will have more control if you configure advanced connection settings.
 
 4. In the Microsoft Outlook dialog box, click Advanced. The SharePoint List Options dialog box opens.
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 If you use Outlook on multiple computers, consider carefully whether you want to connect the document library to all of your computers.
 
 5. Select or clear the Display This List On Other Computers With The Account check box, as follows: ❍ To download a local copy of the document library to every computer on which
 
 Outlook is configured to connect to the specified account, select the check box. ❍ To download the document library only to the computer you’re currently
 
 using, clear the check box. 6. Select or clear the Update This Subscription With The Publisher’s Recommendation check box, as follows: ❍ To have the site publisher control updates, select the check box. ❍ To manually control updates, clear the check box.
 
 7. In the SharePoint List Options dialog box, click OK. Then in the Microsoft Outlook dialog box, click Yes. If a Windows Security or Connect dialog box appears, prompting you for your SharePoint site credentials, enter your user name and password, and then click OK. Outlook creates and displays a folder, named for the site and document library, as a subfolder of the SharePoint Lists folder in your mailbox, and downloads a copy of each of the items stored in the document library as an Outlook item within the folder. The icon to the left of the item name indicates the file type (for example, document, workbook, presentation, or database). Tip  Outlook creates the SharePoint Lists folder the first time you connect a document library or other SharePoint list to Outlook.
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 If the document library or subfolder you connect to contains subfolders, the content of the subfolders is also downloaded. The presence of subfolders is indicated by a transparent triangle to the left of the document library name; click the triangle to expand the folder and display the subfolders. (A black triangle indicates an expanded folder.)
 
 The local copy of the SharePoint document library, with its subfolders visible in the Outlook folder list.
 
 You now have a local copy of the document library or subfolder contents on your computer, and you can work with the files from within Outlook. You can preview any item in the Reading Pane by clicking it, or you can open a read-only version of the item by double-clicking it. When you open an item, a banner at the top informs you that you’re working in an Offline Server Document; if you want to make changes that you can later merge them with the document stored in the document library, click Edit Offline. Tip  Opening an offline file does not check out the file to you in the document library.
 
 While you work with an offline copy of a file, a local version is stored in your SharePoint Drafts folder (a subfolder of your Documents folder in Windows Explorer). To transfer changes from the offline file to the document library, save your changes and close the file. In the Edit Offline message box that appears, click Update.
 
 You can edit a document locally and update the server version when you’re ready to do so.
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 Importing SharePoint Contacts Lists Your organization’s SharePoint site might include contact information for employees, project team members, or other groups of people. You can import the information stored in a SharePoint contacts list into Outlook as an Outlook contacts folder. To connect a SharePoint contacts list to Outlook, follow these steps: 1. On your organization’s SharePoint site, display the contacts list you want to work with. The menu bar is at the top of the content pane.
 
 In its default view, a SharePoint contacts list displays only selected information fields.
 
 2. Follow steps 2 through 7 of the previous procedure for connecting a SharePoint document library to Outlook. Outlook creates a contacts folder, named for the SharePoint site and contacts list, containing contact records created from the information stored in the SharePoint contacts list. The new contacts folder is available in the Contacts module.
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 The imported SharePoint contacts list in the Outlook Contacts module.
 
 Connecting to a SharePoint Calendar If your organization maintains team calendars on a collaboration site, you might find it convenient to view the calendar in Outlook rather than on the site. By connecting a SharePoint calendar to Outlook, you can display the SharePoint calendar in the Outlook Calendar module, either by itself, next to other calendars, or overlaid on other calendars. You can work with the SharePoint calendar as you would with any other calendar in Outlook. Any changes you make to the SharePoint calendar in Outlook are immediately reflected in the calendar on the collaboration site, and vice versa. To connect a SharePoint Calendar to Outlook, follow these steps: 1. On your organization’s SharePoint site, display the contacts list you want to work with.
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 The menu bar is at the top of the content pane.
 
 A SharePoint calendar.
 
 2. Follow steps 2 through 7 of the procedure for connecting a SharePoint document library to Outlook. Outlook creates a calendar, named for the SharePoint site and calendar, filled in with calendar items matching those recorded on the SharePoint calendar. The new calendar is available in the Calendar module.
 
 The SharePoint calendar shown in Outlook’s Calendar module.
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 Key Points ● Working away from your network or without an Internet connection doesn’t
 
 mean that you can’t use Outlook. If your organization uses Exchange, you have many options for accessing your e-mail messages and other information you manage within Outlook. ● Cached Exchange Mode keeps a copy of your mailbox on your computer so you
 
 can keep working even when you are away from your network. ● Cached Exchange Mode handles connecting to and synchronizing your local
 
 mailbox for you. You can set it to cache all messages or just headers, to save bandwidth. ● When you’ll be away from your computer for a while, Outlook can send an
 
 automatic reply once to each person from whom you receive a message. This is a convenient way of letting people know when to expect a personal response from you. ● You can maintain a local copy of document library contents in Outlook, work with
 
 files, and upload your changes to the SharePoint site. ● If your team keeps a calendar in SharePoint, you can work with that calendar from
 
 within Outlook.
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 13 Customize Outlook In this chapter, you will learn how to ✔ Personalize the Outlook program window. ✔ Create and manage Quick Steps. ✔ Customize the ribbon. ✔ Customize the Quick Access Toolbar. ✔ Personalize your Office and Outlook settings.
 
 A host of configuration and customization options are available to help you take advantage of everything that Microsoft Outlook 2010 has to offer. You can change the appearance and arrangement of elements in the program window. To work more efficiently with Outlook, you can create custom Quick Steps that perform multiple actions with one click. You can specify the tabs that appear on the ribbon and the groups that appear on the ribbon tabs, and put frequently used commands at your fingertips by adding them to the Quick Access Toolbar. You can tailor many aspects of the program to suit the way you work. In this chapter, you’ll first customize the primary program window panes. Then you’ll create a custom Quick Step. You’ll change the commands that appear on the ribbon and on the Quick Access Toolbar. Finally, you’ll personalize Office and Outlook settings to meet your needs. Practice Files  You won’t need any practice files to complete the exercises in this chapter. See “Using the Practice Files” at the beginning of this book for more information.
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 Personalizing the Outlook Program Window The Outlook program window includes four primary areas in which you work with Outlook items (e-mail messages, contact records, calendar entries, tasks, and notes). Navigation Pane
 
 Content pane
 
 Reading Pane
 
 To-Do Bar
 
 The Outlook program window. Troubleshooting  The appearance of buttons and groups on the ribbon changes depending on the width of the program window or item window. For information about changing the appearance of the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the beginning of this book.
 
 You might find that the default arrangement of these areas is ideal for the way you work. But if you’re viewing the program window on a low-resolution screen, don’t need all the available tools, or would like more space for the main work area, you can easily change the appearance and layout of the workspace of each of the program window elements. ● Navigation Pane  You can tailor the Navigation Pane to suit your preferences in
 
 the following ways: ❍ You can minimize or expand the Navigation Pane by clicking the Minimize
 
 The Navigation Pane or Expand The Navigation Pane button (the left-facing or right-facing chevron, respectively) at the top of the pane. ❍ You can change the width of the Navigation Pane by dragging the vertical
 
 frame divider to the right or to the left. ❍ You can change the number and size of the module buttons.
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 To display more buttons at the bottom of the Navigation Pane, drag the handle above the module buttons up to increase the height of the button area, or click the Configure Buttons button in the lower-right corner of the Navigation Pane and then click Show More Buttons. To display buttons in a small format or allocate more space to the Navigation Pane folders and options, drag the handle down to decrease the height of the button area, or click the Configure Buttons button and then click Show Fewer Buttons. ● Module content pane  You can display and organize content in this pane in many
 
 ways. These options are discussed in the chapters that cover individual modules, such as the Mail module and the Tasks module. ● Reading Pane  You can display the pane to the right of or below the content pane,
 
 or close it entirely. ● To-Do Bar  You can hide or display the To-Do Bar, change the number of calendar
 
 months and appointments shown, and arrange the Tasks List in different ways. You can change the size of the module content pane by minimizing or maximizing the To-Do Bar—the minimized To-Do Bar displays only your next appointment and the number of active and completed tasks due today. You can display or hide any of the workspace elements (other than the menu bar, which can’t be changed) from the View menu. Your preferences are preserved from session to session. When you start Outlook, the Navigation Pane, To-Do Bar, and Calendar will appear the same way they did when you last exited the program. In this exercise, you’ll change the space allocated to the module content pane, change the content displayed on the To-Do Bar, and learn how to move the menu bar and move or hide the toolbars. SET UP  You don’t need any practice files to complete this exercise. Display your Outlook Inbox, and then follow the steps.
 
 
 
 1. At the top of the Navigation Pane, click the Minimize the Navigation Pane button. The Navigation Pane contracts to display only a vertical bar on the left side of the program window. In the Mail module, buttons on the minimized Navigation Pane give you one-click access to the folders included in your Favorite Folders list.
 
 
 
 2. Click the Folders button at the top of the minimized Navigation Pane. Outlook displays your Favorite Folders and Mail Folders in a temporary pane.
 
 
 
 3. Click away from the temporary pane to collapse it.
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 4. At the top of the To-Do Bar, if the To-Do Bar is minimized, click the Expand the To-Do Bar button.
 
 The To-Do Bar expands to display the calendars of the current and next months, your next three appointments, and your task list. Tip  To remove the To-Do Bar from the program window click the To-Do button in the Layout group on the View tab and then, in the list, click Off. To redisplay the To-Do Bar after closing it, click Normal in the list.
 
 
 
 5. On the View tab, in the Layout group, click the To-Do Bar button, and then click Options.
 
 The To-Do Bar Options dialog box opens.
 
 You can specify what is shown on the To-Do Bar.
 
 
 
 6. Change the Date Navigator setting to display 2 months, and then click OK. Tip  The number of appointments and tasks shown on the To-Do Bar depends on the vertical space allocated to each of those areas. You can change the number of appointments and tasks shown by dragging the bar that divides those two areas.
 
 
 
 7. In the Layout group, click the Reading Pane button, and then click Bottom. The Reading Pane moves from the side of the content pane to the bottom.
 
 
 
 8. In the Layout group, click the Reading Pane button, and then click Off to close the Reading Pane entirely. CLEAN UP  Using the techniques discussed in this topic, rearrange the Outlook window elements to your liking.
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 Troubleshooting  Changes you implement might make your Outlook window appear different from those shown in this book. We depict the Outlook window with the Navigation Pane and To-Do Bar maximized, and the Reading Pane displayed on the right side of the window.
 
 Creating and Managing Quick Steps Outlook 2010 includes many features designed to increase the efficiency with which you perform tasks. WIth the new Quick Steps feature available in the Mail module, you can perform multiple processes on one or more e-mail messages with only one click. For example, you can reply to an e-mail message and delete the original message, or flag a message for follow-up and move it to a specific folder. Quick Steps can include any combination of up to 12 actions that you choose. Quick Steps are available from the Quick Steps group on the Home tab of the Mail module, and from the shortcut menu that appears when you right-click a message or group of messages.
 
 Outlook provides standard Quick Steps that perform common functions, and creates custom Quick Steps based on tasks that you frequently perform. Tip  If you connect to multiple accounts, the Quick Steps in each Mail module are specific to that account.
 
 In a new installation of Outlook, the Quick Steps gallery includes five standard Quick Steps: Move To, Team E-Mail, Reply & Delete, To Manager, and Done. You can modify the actions performed by existing Quick Steps, add other common tasks to the Quick Steps menu by choosing them from the New Quick Step list, or create a custom Quick Step from scratch.
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 Choosing an action from the New menu provides a starting point for a new Quick Step. See Also  For information about using and modifying the standard Quick Steps, see “Managing Messages by Using Quick Steps” in Chapter 7, “Organize Your Inbox.”
 
 In this exercise, you’ll create a custom Quick Step that sends an e-mail message. SET UP  You don’t need any practice files to complete this exercise. Display the Inbox, and then follow the steps.
 
 
 
 1. On the Home tab, in the Quick Steps gallery, click Create New. The Edit Quick Step dialog box opens.
 
 The temporary Quick Step name is selected in the Name box.
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 2. In the Name box, replace the selected temporary name with SBS Messages. Then click the Actions arrow to expand the list.
 
 The Actions list includes 25 actions in six sections: Filing; Change Status; Categories, Tasks and Flags; Respond; Appointment; and Conversations.
 
 You can perform any of the actions in this list by using a Quick Step.
 
 
 
 3. Scroll down the Actions list to see the available actions. Then, in the Actions list, under Respond, click New Message.
 
 The selected action appears in the Actions list and the information required to perform the action appears below it.
 
 
 
 4. In the To box, enter your e-mail address. Then in the Actions list, under New Message, click Show Options.
 
 The list expands to display optional settings for the new message.
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 Required information is shown automatically; optional information is hidden until you display it.
 
 
 
 5. In the Subject box, enter SBS Quick Step Message. 6. In the Flag list, click Flag for Recipients. The Flag Message dialog box opens.
 
 You can flag an outgoing message for the recipient to follow up.
 
 
 
 7. In the Flag list, click No Response Necessary. In the By box, click the down arrow one time to set the flag time to 0 days. Then click OK.
 
 The Flag Message dialog box closes and you return to the Edit Quick Step dialog box.
 
 
 
 8. In the Text box, enter the following sentence: I did a great job learning to use Outlook 2010!
 
 
 
 9. Select the Automatically send after 1 minute delay check box. 10. Below the existing New Message action, click Add Action.
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 A second Actions list appears. You can add more actions to the Quick Step by clicking an action in the list. However, the Quick Step you have created is one that doesn’t take action on an existing message, so the other actions aren’t appropriate.
 
 
 
 11. To the right of the Actions list that currently displays Choose an Action, click the Delete button.
 
 The second Actions list disappears from the dialog box.
 
 
 
 12. In the Shortcut key list, click CTRL+SHIFT+1. 13. In the Tooltip text box, enter Send myself a message. Your Quick Step is complete.
 
 The Edit Quick Step dialog box shows the actions that the new Quick Step will perform.
 
 
 
 14. In the Edit Quick Step dialog box, click Finish. The new Quick Step appears in the Quick Steps gallery.
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 15. In the Navigation Pane, click your Outbox. 16. On the Home tab, in the Quick Steps gallery, point to SBS Messages. A ScreenTip displays Send myself a message.
 
 Adding a ScreenTip to a Quick Step helps you remember what actions it performs.
 
 
 
 17. Click the SBS Messages Quick Step. Because you chose the Automatically Send After 1 Minute Delay check box, the message appears automatically in your Outbox, and then is sent.
 
 
 
 18. Display your Inbox. The SBS Quick Step Message appears in your Inbox.
 
 
 
 19. Open the message. The follow-up flag is visible at the top of the message header.
 
 The message automatically created and sent by using a Quick Step.
 
 CLEAN UP  Close the message window before continuing to the next exercise.
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 Customizing the Ribbon Even if Outlook 2010 is the first version of the program you’ve worked with, by now you’ll be accustomed to working with commands represented as buttons on the ribbon. The ribbon was designed to make all the commonly used commands visible so that people could more easily discover the full potential of the program. But many people use Outlook to perform the same set of tasks all the time, and for them, seeing buttons (or even entire groups of buttons) that they never use is just another form of clutter. See Also  For information about minimizing and expanding the ribbon, see “Customizing the Quick Access Toolbar” later in this chapter.
 
 Would you prefer to see fewer commands, not more? Or would you prefer to see more specialized groups of commands? Well, you can customize the ribbon in both ways. Clicking Customize Ribbon in the left pane of the Outlook Options dialog box displays the Customize The Ribbon page.
 
 The ability to customize the ribbon is new in Outlook 2010.
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 Tip  The tabs that appear on the ribbon in your Outlook configuration may differ from those shown here depending on the e-mail accounts to which you’ve configured Outlook to connect.
 
 On this page, you can customize the ribbon in the following ways: ● If you rarely use a tab, you can turn it off. ● If you use the commands in only a few groups on each tab, you can remove
 
 the groups you don't use. (The group is not removed from the program, just from its tab.) ● You can move a group from one tab and to another. ● You can duplicate a group by adding it to another tab. ● You can create a custom group on any tab and then add commands to it. (You
 
 can’t add commands to a predefined group.) ● You can even create a custom tab. For example, you might want to do this if you
 
 use only a few commands from each tab and you find it inefficient to switch among multiple tabs. Don't be afraid to experiment with the ribbon to find the configuration that best suits the way you work. If at any point you find that your new ribbon is harder to work with rather than easier, you can always reset everything to the default configuration. Tip  If you upgraded from an earlier version of Outlook, as you use Outlook 2010 you might identify a few commands that no longer seem to be available. A few old features have been abandoned, but others that people used only rarely have simply been pushed off to one side. If you sorely miss one of these sidelined features, you can make it a part of your Outlook working environment by adding it to the ribbon. You can find a list of all the commands that do not appear on the ribbon but are still available in Outlook by displaying the Customize Ribbon page of the Outlook Options dialog box and then clicking Commands Not In The Ribbon in the Choose Commands From list.
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 In this exercise, you’ll turn off tabs, remove groups, create a custom group, and add a command to the new group. Then you’ll create a tab and move predefined groups of buttons to it. Finally, you’ll reset the ribbon to its default state. SET UP  You don’t need any practice files to complete this exercise. Display your Outlook Inbox, and then follow the steps.
 
 
 
 1. Open the Outlook Options dialog box, and then, in the left pane, click Customize
 
 
 
 2. In the right pane of the Customize Ribbon page, clear the check boxes of the
 
 Ribbon.
 
 Folder tab, the Add-Ins tab, and the Conferencing tab (if that tab appears in the right pane). Then click OK. The ribbon now displays only the File, Home, Send/Receive, and View tabs.
 
 You can’t turn off the File tab, which is your link to the Backstage view.
 
 
 
 3. Redisplay the Customize Ribbon page of the Outlook Options dialog box, and
 
 
 
 4. In the Choose commands from list, click Main Tabs. Then in the list of available
 
 
 
 5. In the right pane, click the IMAP group. Then between the left and right panes,
 
 in the right pane, select the Folder check box. Then click the plus sign adjacent to Folder to display the groups that currently appear on this tab. commands, click the plus sign adjacent to Folder to display the groups that are predefined for this tab. click Remove.
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 The IMAP group is removed from the list of groups that are present on the tab (the pane on the right), but it is still present in the available commands list. You can add it back to the Folder tab, or add it to a different tab, at any time. 
 
 
 
 6. If the Home (Mail) group is not expanded in the right pane, click the plus sign
 
 
 
 7. Below the right pane, click New Group.
 
 adjacent to Home (Mail) to display the groups that currently appear on the Home tab in the Mail module. Then click the tab name, Home (Mail).
 
 A group named New Group (Custom) is added to the bottom of the Home (Mail) group list.
 
 
 
 8. With the new group selected, click Rename. The Rename dialog box for groups opens.
 
 In the Rename dialog box, you can select a symbol to represent the group and change the group name.
 
 
 
 9. In the Rename dialog box, enter Housekeeping in the Display name box, and click OK. Then on the right side of the Customize Ribbon page, click the Move Up button until the Housekeeping (Custom) group is at the top of the groups list.
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 Because it is first in the list, the custom group will appear at the left end of the Home tab.
 
 You have removed a standard group from the Folder tab and created a custom group on the Home tab of the Mail module.
 
 
 
 10. In the Choose commands from list, click File Tab. The available commands list changes to include only the commands that are available in the Backstage view, which you display by clicking the File tab.
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 11. In the available commands list, click Empty Deleted Items. Then between the left and right panes, click Add. Repeat this step with the Mailbox Cleanup command. The two commands are added to the custom group.
 
 You can add commands to a custom group but not to a predefined group.
 
 
 
 12. In the right pane, remove the Respond and Tags groups from the Home
 
 
 
 13. Click the tab name, Home (Mail), and then click New Tab.
 
 (Mail) tab.
 
 A custom tab named New Tab (Custom) is added after the Home (Mail) tab. The custom tab includes one custom group named New Group (Custom).
 
 
 
 14. Remove the custom group from the custom tab. 15. Click the tab name, New Tab (Custom), and click Rename. The Rename dialog box for tabs opens.
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 You can’t assign a symbol to represent a tab.
 
 
 
 16. In the Rename dialog box, enter Follow Up in the Display name box, and then
 
 
 
 17. In the Choose commands from list, click Main Tabs and then, in the available
 
 
 
 18. With the Follow Up (Custom) tab selected in the right pane, add the Respond
 
 click OK.
 
 commands list, expand the Home (Mail) tab.
 
 and Tags groups from the available Home (Mail) groups.
 
 The right pane shows the new configuration of the Home and Follow Up tabs.
 
 You have moved groups from the Home tab of the Mail module to a new Follow Up tab.
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 19. In the Outlook Options dialog box, click OK. The new Housekeeping group is at the left end of the Home tab, and the new Follow Up tab appears on the ribbon after the Home tab.
 
 The custom Housekeeping group and Follow Up tab.
 
 
 
 20. Display the Customize Ribbon page of the Outlook Options dialog box. In the
 
 
 
 21. In the Outlook Options dialog box, click OK.
 
 lower-right corner, click Reset, and then click Reset all customizations. Then in the message box asking you to confirm that you want to delete all ribbon and Quick Access Toolbar customizations, click Yes. The default ribbon configuration is restored.
 
 CLEAN UP  Make any modifications that you want to the ribbon before continuing to the next exercise.
 
 Customizing the Quick Access Toolbar The commands you use to control Outlook are available from the ribbon located at the top of the program window and in each Outlook item window. As you use Outlook, you will become familiar with the locations of the commands you use most frequently. To save time, you can place frequently used commands on the Quick Access Toolbar which is located, by default, in the upper-left corner of the program window. To save even more time, you can move the Quick Access Toolbar from its default position above the ribbon to below the ribbon, so your mouse has less distance to travel from the content you’re working with to the command you want to invoke. In the program window, the Quick Access Toolbar displays the Send/Receive button and the Undo button. In the individual item windows, the Quick Access Toolbar displays the Save, Undo, Redo, Previous, and Next buttons. There are three ways to place the buttons and lists that represent commands onto the Quick Access Toolbar: ● From the Quick Access Toolbar ● From the ribbon ● From the Outlook Options dialog box
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 Clicking the Customize Quick Access Toolbar button at the right end of the Quick Access Toolbar displays a list of commands pertinent to the type of window you’re working in.
 
 A check mark indicates a command that is already displayed on the Quick Access Toolbar.
 
 Clicking a command that is not already preceded by a check mark adds that command to the right end of the Quick Access Toolbar, Right-clicking any button or list on the ribbon and then clicking Add To Quick Access Toolbar adds that button or list to the right end of the Quick Access Toolbar. From the Quick Access Toolbar page of the Outlook Options dialog box, you can specify which commands you want to appear on the toolbar, control the order in which commands appear, and divide commands into logical groups. Note that the settings on the Quick Access Toolbar page of the Outlook Options dialog box apply to the program or item window from which you displayed the Backstage view.
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 The Quick Access Toolbar page of the Outlook Options dialog box, opened from the program window.
 
 On this page, you can customize the Quick Access Toolbar in the following ways: ● You can define a custom Quick Access Toolbar for the Outlook program window
 
 or for a specific type of item window. ● You can add any command from any group of any tab, including contextual tabs. ● You can add commands that don’t appear on the ribbon. ● You can display a separator between different types of buttons. ● You can move buttons around on the toolbar until they are in the order you want. ● You can reset the Quick Access Toolbar to its default configuration.
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 If you never use more than a few buttons, you can add those buttons to the Quick Access Toolbar and then hide the ribbon by double-clicking the active tab or by clicking the Minimize The Ribbon button. Only the Quick Access Toolbar and ribbon tab names remain visible. You can temporarily redisplay the ribbon by clicking the tab you want to view. You can permanently redisplay the ribbon by double-clicking any tab or by clicking the Expand The Ribbon button. As you add buttons to the Quick Access Toolbar, it expands to accommodate them. If you add many buttons, it might become difficult to view the text in the title bar, or all the buttons on the Quick Access Toolbar might not be visible, defeating the purpose of adding them. To resolve this problem, you can move the Quick Access Toolbar below the ribbon by clicking the Customize Quick Access Toolbar button and then clicking Show Below The Ribbon. Tip  Even though most commands are now available on the ribbon, you can still invoke many commands by using keyboard shortcuts. For a list of the keyboard shortcuts available in Outlook 2010, see “Keyboard Shortcuts” at the end of this book.
 
 In this exercise, you’ll add and organize buttons on the Quick Access Toolbar that is shown in message composition windows. SET UP  You don’t need any practice files to complete this exercise. Display your Outlook Inbox, and then follow the steps.
 
 
 
 1. On the Home tab, in the New group, click the New E-mail button. A message composition window opens. The Quick Access Toolbar displays the Save, Undo, Redo/Repeat, Previous, and Next buttons.
 
 Only the Save button is active at this time.
 
 
 
 2. At the right end of the Quick Access Toolbar, click the Customize Quick Access Toolbar button.
 
 The Customize Quick Access Toolbar menu opens, displaying a list of frequently used commands that you can click to add to the toolbar.
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 3. Near the bottom of the menu, click More Commands. A list of available commands appears in the pane on the left, and a list of the commands currently displayed on the Quick Access Toolbar appears in the pane on the right.
 
 The Quick Access Toolbar page of the Outlook Options dialog box, opened from a message window.
 
 
 
 4. At the top of the available commands list on the left, double-click <Separator>. A separator is inserted following the default commands.
 
 
 
 5. In the Choose commands from list, click All Commands. Tip  In some cases, multiple instances of a command appear in the All Commands list— these correspond to the locations in which the command appears within the program. Pointing to a command displays the command location in a ScreenTip. Commands that appear on contextual tabs and commands that don’t appear on any tab are also available from this list.
 
 All the available commands, including those not shown on the ribbon, appear in the available commands list. Tip  You can display only those commands that aren’t shown on the ribbon by clicking Commands Not In The Ribbon in the Choose Commands From list.
 
 
 
 6. Scroll down the available commands list, click the New Appointment command, and then click Add.
 
 The command appears in the right pane following the separator.
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 7. Repeat step 6 to add the New Contact, New E-mail, and New Task commands. Then scroll to the top of the available commands list, and add another separator following the New Task command. The four commands you’ve added to the right pane are set off by separators, so they will appear on the Quick Access Toolbar as a cohesive group.
 
 You can move and group commands on the Quick Access Toolbar.
 
 
 
 8. In the right pane, click New E-mail. Then click the Move Up button two times to position this most commonly used button first in the group.
 
 
 
 9. In the Outlook Options dialog box, click OK. The Quick Access Toolbar of the open message window now includes the default buttons and the New Appointment, New Contact, New E-mail, and New Task buttons, separated by a line.
 
 You have added a group of buttons to the Quick Access Toolbar.
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 To create new Outlook items, you no longer have to open the associated module, click the Home tab, and then click the New item button. You can now create a new Outlook item with a single click, from any module, whether or not the ribbon is displayed.
 
 
 
 10. Close the message composition window. (Don’t save your changes if Outlook prompts you to do so.) Notice that there has been no change to the Quick Access Toolbar in the Outlook program window. It still displays only the Send/Receive and Undo buttons.
 
 
 
 11. Open a new message composition window. The custom Quick Access Toolbar is present in the new window.
 
 
 
 12. Click the Customize Quick Access Toolbar button and then, at the bottom of the menu, click Show Below the Ribbon.
 
 The Quick Access Toolbar moves from the title bar to the area between the ribbon and the message header, and becomes the full width of the message window.
 
 When positioned below the ribbon, the Quick Access Toolbar can host many buttons.
 
 
 
 13. From the message composition window, display the Quick Access Toolbar page
 
 
 
 14. In the Reset Customizations message box, click Yes to return the Quick Access
 
 of the Outlook Options dialog box, click Reset, and then click Reset only Quick Access Toolbar.
 
 Toolbar to its default contents. Then click OK to close the Outlook Options dialog box.
 
 The Quick Access Toolbar now displays only the default buttons for the message window, but is still located below the ribbon. CLEAN UP  Reposition the Quick Access Toolbar if you want to, by clicking Show Above The Ribbon on the Customize The Quick Access Toolbar menu.
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 Customizing the Status Bar The status bar, which is located at the bottom of the program window, displays information about the contents of the currently displayed folder, overdue reminders, send/receive status, online status, and other information. At its right end, the status bar displays a set of zoom controls with which you can control the magnification of content in the reading pane and in item windows. Almost all the available information is shown on the status bar by default; the only information not shown is quota information that helps you to track how much of your available mailbox storage space is currently being used. To change the information displayed on the status bar: 1. Right-click an empty area of the status bar. The status bar shortcut menu appears.
 
 A check mark indicates information that is currently displayed on the status bar.
 
 2. Click an item on the menu to add it to or remove it from the status bar. Many of the status bar entries are active, meaning that you can click them to display additional information. For example, when the Reminders item appears on the status bar it means that you have overdue reminders. Clicking the Reminders item opens the Reminders window in which you can see the current reminders.
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 Personalizing Your Office and Outlook Settings While you are still becoming familiar with Outlook 2010, you might be quite content to work with the default settings (and it’s good to do so until you understand the reasons they are as they are). But as you become more experienced, you might want to adjust some of the settings to better suit the way you work. You can change many of the default program settings from the Outlook Options dialog box, which you open by clicking Options in the left pane of the Backstage view. From this dialog box, you can control the settings and appearance of many Outlook features, including the following: ● E-mail accounts, functionality, and formatting ● Editorial and archive functions ● The Outlook program window panes (the Navigation Pane, the Reading Pane, and
 
 the To-Do Bar) ● Your calendar, tasks list, contact list, and notes ● The indexing and search functions ● The telephone and voice mail functions
 
 Earlier in this chapter, we experimented with modifying the ribbon and the Quick Access Toolbar to tailor the program window and item windows to your preferences. Now we’ll examine the function-specific settings that you can modify to work most efficiently. The Outlook Options dialog box is divided into 10 pages of function-specific settings, 2 pages of feature-specific settings (for the ribbon and for the Quick Access Toolbar), and 2 pages of security-related settings.
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 The default page of the Outlook Options dialog box is the General page.
 
 Click any page name in the left pane to display that page of options in the right pane.
 
 The settings on the General page apply to all Outlook modules. These settings include showing the Mini Toolbar when you select text, enabling live previews of gallery options, changing the color scheme, and setting the ScreenTip style. In addition, you can specify your user information (name and initials) on this page. The user information that you set here applies to all Office programs, not only to Outlook.
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 Mail Most of the settings you might want to change to modify the way Outlook works are available on the Mail page of the Outlook Options dialog box. These include settings for composing original messages, replies, and forwards; controlling the behavior of Outlook panes and desktop alerts; cleaning up conversations; saving, sending, and tracking messages, and default message format options. Outlook includes a selection of options so that you can manage your e-mail most effectively. To avoid losing your work, you can choose to have Outlook automatically save messages you have created but not yet sent. When new messages arrive, you can choose to have Outlook alert you by playing a sound, briefly changing the mouse pointer to an envelope icon, showing an envelope icon in the notification area, or any combination of these effects. You can also set default options for sending a message. For example, if you are concerned about privacy, you might choose to set the sensitivity of all new messages to Private. The Mail page is divided into 10 sections. Because this is where you’ll make most of your changes, we’ll take a look at each of these sections.
 
 Compose Messages The Compose Messages section of the Mail page includes options for changing the behavior of Outlook while you’re creating a new message.
 
 Message composition options.
 
 Clicking either Editor Options or Spelling And Autocorrect in the Compose Messages section of the Mail page displays the Editor Options dialog box. From this dialog box, you can set AutoCorrect options to specify how Outlook will correct and format the content of your messages as you type them, and customize the spelling and grammarchecking settings.
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 The Editor Options dialog box. See Also  For information about automatic signatures, see “Personalizing the Appearance of Message Text” in Chapter 10, “Enhance Message Content.”
 
 On the Advanced page of the Editor Options dialog box, you can control the way Outlook works with text. ● In the Editing Options area of this page, you can turn on or off advanced editing
 
 features, such as how Outlook selects and moves text, whether to track formatting changes, and whether Overtype mode is available. ● In the Cut, Copy, And Paste area, you can specify whether Outlook will apply
 
 source or destination formatting to text copied within a message, between messages, and from other programs. You can also set options for smart cut and paste (whether to automatically add and remove spaces as needed) and the Paste Options button (whether it appears after a past operation). ● In the Display area, you can set whether measurements are shown in inches,
 
 centimeters, millimeters, points, or picas; whether pixels are shown for HTML features; whether ScreenTips display keyboard shortcuts; and whether character positioning is optimized for layout rather than readability.
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 Outlook Panes The Outlook Panes section of the Mail page includes only one option, for changing the way items are marked as read when viewed in the Reading Pane.
 
 Outlook pane options.
 
 Clicking the Reading Pane button opens the Reading Pane dialog box, in which you can specify how Outlook processes messages you display in the Reading Pane.
 
 Reading Pane options. See Also  For information about the Reading Pane, see “Viewing Messages and Message Attachments” and “Configuring Reading Pane Behavior” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 Message Arrival The Message Arrival section of the Mail page includes options for controlling the way Outlook notifies you of an incoming message.
 
 Message arrival options. See Also  For information about desktop alerts, see “Working with New Mail Notifications” in Chapter 11, “Manage E-Mail Settings.”
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 Conversation Clean Up The Conversation Clean Up section of the Mail page includes options for controlling the new conversation-management features of Outlook 2010.
 
 ) Conversation clean-up options. See Also  For information about conversations, see “Working with Conversation View” in Chapter 7, “Organize Your Inbox.”
 
 Replies and Forwards The Replies And Forwards section of the Mail page includes options for the content of response messages. You can choose to close the original message window when you respond to a message, insert your name or some other identifier before text that you insert into original message text when responding, and whether and how to include original message text in a response.
 
 Options for replying to and forwarding messages.
 
 You can include original message text by attaching the original message to a blank response or by including the original message text and optionally indenting it or indenting it and inserting a vertical line to the left of the original message text block.
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 Options for including original message text in a reply message. See Also  For information about replying to and forwarding messages, see “Responding to Messages” in Chapter 3, “Send and Receive E-Mail Messages.”
 
 Save Messages The Save Messages section of the Mail page includes options for saving message drafts.
 
 Options for saving messages.
 
 By default, Outlook saves the first draft of a message three minutes after you begin composing the message, and resaves the message every three minutes thereafter. You can select a save frequency of from 1 to 99 minutes, or choose to turn off the message draft saving feature. The default location for saved message drafts is the Drafts folder, which is a top-level mailbox folder that appears in the Navigation Pane at the same level as your Inbox. You can alternatively save message drafts in your Inbox, in the Sent Messages folder, or in the Outbox. See Also  For information about message drafts, see “Creating and Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.”
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 Send Messages The Send Messages section of the Mail page includes options for composing and sending messages.
 
 ) Message sending options.
 
 An important option to note in this section is the Commas Can Be Used To Separate Multiple Message Recipients option. Until you select this check box, you must separate e-mail addresses in the To, Cc, and Bcc boxes by using semicolons. See Also  For information about importance and sensitivity level settings, see “Changing Message Settings and Delivery Options” in Chapter 10, “Enhance Message Content.”
 
 MailTips The MailTips section of the Mail page includes options for controlling the display of MailTips, which are server-generated messages that appear in the header of a message composition window to notify you of various conditions that apply to an outgoing message.
 
 ) MailTips options. Troubleshooting  The MailTips section of the Mail page is present only when your Outlook configuration includes a Microsoft Exchange Server 2010 account that supports this feature.
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 Clicking the MailTips Options button opens the MailTips Options dialog box in which you can specify the types of MailTips you want Outlook to display while you’re composing messages.
 
 You can specify the MailTips you want Outlook to display for each Exchange 2010 account.
 
 MailTip settings are specific to each Exchange account you have configured Outlook to connect to. You set your MailTip preferences for each account by selecting that account in the Apply To This Account list at the top of the dialog box.
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 Tracking The Tracking section of the Mail page includes options for requesting notifications when a message that you send is delivered to a recipient and when a message is marked by the recipient as read; and options for processing notification requests attached to messages that you receive. This section also includes options for processing responses you receive to meeting requests and voting requests that you send.
 
 Message tracking options.
 
 Delivery receipts can be a useful tool when you send an important message and need to know whether it’s reached its intended recipient. (However, not all types of e-mail accounts support all types of receipts.) When you receive a message that has a read receipt request attached, Outlook prompts you to confirm that you want to send a read receipt. You can make this choice for each individual message or select the Never Send A Read Receipt option in the Tracking section of the Mail page to refuse all read receipt requests. Tip  Be cautious when approving read receipt requests, as some mass-mailing companies utilize these to determine whether an e-mail address is active.
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 Message Format In the Message Format section of the Mail page, you can specify how Outlook displays your message content on screen and the format in which Outlook sends messages outside of your organization.
 
 Message format options.
 
 Other The Other section of the Mail page includes options for displaying the Paste Options button, allowing the use of Microsoft InfoPath forms, shading message headers, and expanding conversations when navigating through the Inbox by using the keyboard. You can also specify what occurs when you move or delete an open item. Options include opening the previous or next item in the folder, or returning to the folder without opening another item.
 
 Options in the Other section.
 
 Personalizing Your Office and Outlook Settings   493
 
 
 
 Calendar Options on the Calendar page control settings for displaying and managing Outlook calendars, and for scheduling appointments and resources.
 
 The Calendar page of the Outlook Options dialog box. See Also  For information about customizing calendar options, see Chapter 8, “Manage Your Calendar.”
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 Contacts Options on the Contacts page control settings for creating and displaying contact records.
 
 The Contacts page of the Outlook Options dialog box. See Also  For information about customizing contact options, see Chapter 4, “Store and Access Contact Information,” and Chapter 9, “Work with Your Contact List.”
 
 Tasks Options on the Tasks page control settings for creating and managing tasks.
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 The Tasks page of the Outlook Options dialog box. See Also  For information about customizing task options, see Chapter 6, “Track Tasks.”
 
 Notes and Journal Options on the Notes And Journal page control settings for creating notes and for recording activities in the Outlook journal.
 
 The Notes And Journal page of the Outlook Options dialog box. Tip  Discussion of the Outlook Journal is beyond the scope of this book.
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 Search Options on the Search page control the scope of standard searches and the way Outlook displays search results.
 
 The Search page of the Outlook Options dialog box. See Also  For information about search options, see “Quickly Locating Messages” in Chapter 7, “Organize Your Inbox.”
 
 Mobile Options on the Mobile page control settings for communications between Outlook and your mobile device.
 
 The Mobile page of the Outlook Options dialog box. Tip  The Mobile features can be used only if you configure an SMS account for text messaging. If your organization doesn’t provide SMS accounts, you can sign up for one with an online provider. Some providers allow you to experiment with free accounts for a short period of time; you can get started configuring an SMS account by clicking any of the buttons on the Mobile page of the Outlook Options dialog box.
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 Language Options on the Language page control the dictionaries used by Outlook when checking the spelling and grammar of message content as well as the language in which button labels, tab names, Help content, and ScreenTips are displayed. To use a language other than the standard Windows language, you must install a language pack. Language packs are available for download from the Microsoft Download Center at downloads.microsoft.com and might also be supplied to you through Windows Update.
 
 The Language page of the Outlook Options dialog box.
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 Advanced Options on the Advanced page control settings for customizing a wide variety of standard Outlook actions and responses.
 
 The Advanced page of the Outlook Options dialog box. Tip  Explore the settings on the Advanced page and the other pages of the Outlook Options window on your own to determine what changes you can make to truly optimize your experience while working in Outlook.
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 Using Add-Ins Add-ins are utilities that add specialized functionality to a program (but aren’t full-fledged programs themselves). Outlook includes COM add-ins, which use the Component Object Model. There are several sources of add-ins: ● You can purchase add-ins from third-party vendors, or you might install an
 
 add-in to allow it to communicate with Microsoft Office 2010 programs. ● You can download free add-ins from the Microsoft Web site or other
 
 Web sites. Important  Be careful when downloading add-ins from Web sites other than those you trust. Add-ins are executable files that can easily be used to spread viruses and otherwise wreak havoc on your computer. For this reason, default settings in the Trust Center intervene when you attempt to download or run add-ins.
 
 To use some add-ins, you must first install them on your computer and then load them into your computer’s memory, as follows: 1. At the bottom of the Add-Ins page of the Outlook Options dialog box, display the Manage list, click COM Add-ins, and then click Go. An Add-Ins dialog box opens. 2. In the dialog box, click Add. 3. In the Add Add-In dialog box, navigate to the folder where the add-in you want to install is stored, and double-click its name. In the Add-Ins dialog box, the new add-in appears in the list of those that are available for use. 4. In the list, select the check box of the new add-in, and then click OK. The add-in is now loaded and available for use in Outlook, or you may need to restart Outlook for the add-in to be installed.
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 Creating Outlook Forms Every Outlook item you create is based on a form—you create a message by entering information in a message form that is hosted in a message window; the appointment form consists of the Appointment page and the Scheduling page that you display in an appointment window; you store contact information in a five-page form (General, Details, Activities, Certificates, and All Fields) displayed in a contact window, and so on. The controls you use to interact with the form and its content are part of the item window. The Outlook 2010 Standard Forms Library includes 11 forms: Appointment, Contact, Distribution List, Journal Entry, Meeting Request, Message, Note, Post, Standard Default, Task, and Task Request. Additional forms might be installed by other programs that communicate with Outlook. To access the forms libraries, click the New Items button in the New group on the Home tab, point to More Items, and then click Choose Form. You can create your own form from scratch, or modify an existing form to fit your needs. For example, if you frequently send detailed messages that follow a standard format, want to limit or increase the fields available within a contact record, or want to control the actions a recipient can take with an e-mail message, you can create a custom form containing the specific fields or information you want to have available when you create an item based on that form. Forms can have multiple pages, and can include a variety of information including static content, fields, scripts, and macros. You can specify form properties, including the icon that represents items based on the form; actions that item recipients can perform; and the prefix added to the item subject when they perform those actions. You can save a custom form in your Personal Forms Library so that it is available to you from any Outlook folder. If your organization is running Microsoft Exchange Server, you can make a form available to anyone within your organization by publishing it to the Organizational Forms Library. Your network administrator can grant you permission to publish to this library. See Also  For a detailed explanation of Outlook forms, refer to Microsoft Outlook 2010 Inside Out by Jim Boyce (Microsoft Press, 2010).
 
 Key Points   501
 
 
 
 Key Points ● You can rearrange the Outlook window to suit your working preferences. Any of
 
 the Outlook view panes—the Navigation Pane, To-Do Bar, and Reading Pane can be displayed in any Outlook module. Outlook preserves changes to the default arrangement from session to session. ● Need one-click access to commands that are scattered in different places? Simply
 
 add a button for that command to the Quick Access Toolbar. ● You can adjust many aspects of the Outlook environment to tailor it to the
 
 way you work. ● Be sure to investigate the many options available in the Outlook Options dialog
 
 box at your leisure.
 
 Glossary address book  A storage folder within your mailbox, containing contact records and contact groups. appointment  A block of time you schedule on your calendar that has a defined start time and end time, and to which you do not invite other attendees. appointment window  The program window displaying the form in which you enter information about an appointment. arrangement  A predefined combination of grouped and sorted messages in table view. Cached Exchange Mode  A feature that lets an Outlook user who has an Exchange e-mail account work offline, either by choice or due to a connection problem. A copy of the user’s mailbox is stored on his or her computer and is frequently updated from the mail server. Any changes that are made while a connection to the server is not available are synchronized automatically when a connection becomes available. calendar item window  The program window displaying the form in which you enter information about appointments, meetings, and events. Calendar pane  The center pane that displays content in the Calendar module. client rule  Or client-side rule. A rule that Outlook applies to messages after they arrive on your computer. See also server rule. contact  A person inside or outside of a user’s organization, about whom the user can save several types of information, such as street and e-mail addresses, telephone and fax numbers, and Web page URLs.
 
 contact card  An interactive informational box that appears when you point to the presence icon of a message sender or recipient. The contact card contains contact information as well as options for contacting the person by e-mail, instant message, or telephone; for scheduling a meeting; and for working with the person’s contact record. The expanded contact card also contains information about the person’s position within the organization and distribution list memberships. contact record  A body of information you collect about a contact and store as an Outlook item. contact record window  The program window displaying the form in which you enter information about a contact to create a contact record. Contacts module  The framework providing the functionality to display and manage address books. Contacts pane  The center pane that displays content in the Contacts module. conversations  In Outlook, a means of organizing and viewing e-mail messages that have the same subject line. Date Navigator  The small calendar displayed in the Navigation Pane or To-Do Bar that provides a quick and easy way of displaying specific dates or ranges of dates in the Calendar pane. delimited text file  See separated text file. desktop alert  A notification that appears on your desktop when a new e-mail message, meeting request, or task request appears in your Inbox. dialog box launcher  On the ribbon, a button in the lower-right corner of a group that opens a dialog box or task pane containing features related to the group.
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 digital signature  Data that binds a sender’s identity to the information being sent. A digital signature may be bundled with any message, file, or other digitally encoded information, or transmitted separately. Digital signatures are used in public key environments and provide authentication and integrity services. distribution list  A group of recipients addressed as a single recipient. Administrators can create distribution lists that are available in the Address Book. Users can create distribution lists and add them to their personal address books. document workspace  A SharePoint site that is used for planning, posting, and working together on a document or a set of related documents. domain  On the Internet and other networks, the highest subdivision of a domain name in a network address, which identifies the type of entity owning the address (for example, .com for commercial users or .edu for educational institutions) or the geographical location of the address (for example, .fr for France or .sg for Singapore). draft  A temporary copy of a message that has not yet been sent, located in the Drafts folder. e-mail  Short for electronic mail. The exchange of electronic text messages and computer file attachments between computers over a communications network, such as a local area network or the Internet. e-mail message  A message that is sent over a communications network such as a local area network or the Internet. e-mail server  A computer that stores e-mail messages. e-mail trail  An e-mail message and all responses to that message. When an individual message receives multiple responses, the e-mail trail can branch into multiple trails. You can view all the branches of an e-mail trail in Conversation view.
 
 encryption  The process of disguising a message or data in such a way as to hide its substance. event  An activity that is not associated with a specific time, or an activity that occurs over a period of more than one day. event window  The program window displaying the form in which you enter information about an event. floating toolbar  A toolbar that is not attached to the edge of the program window. You can change the shape of some floating toolbars. gallery  Rich, customizable list boxes that can be used to organize items by category, display them in flexible column-based and row-based layouts, and represent them with images and text. Depending on the type of gallery, live preview is also supported. Global Address List (GAL)  The address book that contains all user, group, and distribution list e-mail addresses in your organization. The administrator creates and maintains this address book. It may also contain public folder e-mail addresses. group  An area of a ribbon tab containing buttons related to a specific document element or function. Hypertext Markup Language (HTML)  In Outlook, an e-mail message format that supports paragraph styles, character styles, and backgrounds. Most e-mail programs support the HTML format. Hypertext Transfer Protocol (HTTP)  A protocol used to access Web pages from the Internet. Information Rights Management (IRM)  A policy tool that gives authors control over how recipients use the documents and e-mail messages they send. instant messaging (IM)  The ability to see whether a person is connected to the Internet and to exchange messages. Most exchanges are textonly. However, some services allow attachments.
 
 
 
 Internet Message Access Protocol (IMAP)  A popular protocol for receiving e-mail messages. It allows an e-mail client to access and manipulate a remote e-mail file without downloading it to the local computer. It is used mainly by corporate users who want to read their e-mail from a remote location. junk e-mail  Unsolicited commercial e-mail (UCE). Also known as spam. keyboard shortcut  Any combination of keystrokes that can be used to perform a task that would otherwise require a mouse or other pointing device. Live Preview  A feature that temporarily displays the effect of applying a specific format to the selected document element. Mail pane  The center pane that displays content in the Mail module. meeting request  A message form linked to an Outlook calendar item. Meeting requests are generated by Outlook to manage meeting attendance. meeting window  The program window displaying the form in which you enter information to place a meeting on your calendar. message header  Summary information that you download to your computer to determine whether to download, copy, or delete the entire message from the server. The header includes these fields: Subject, From, Received, Importance, Attachment, and Size. message window  The program window displaying the form in which you create or respond to an e-mail message. Mobile Address Book  An address book containing contact records that include mobile phone numbers, which is automatically created if you have an Outlook Mobile Service account. Navigation Pane  The column on the left side of the Outlook window that includes panes such as Shortcuts or Mail and the shortcuts or folders within each pane. Click a folder to show the items in the folder.
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 offline address book  A copy of an address book that has been downloaded so that an Outlook user can access the information it contains while disconnected from the server. Exchange administrators can choose which address books are made available to users who work offline, and they can also configure the method by which the address books are distributed. Outlook Address Book  An address book that is automatically created from contacts in the Contacts folder. The contacts can be people inside and outside of your organization. When you update your contacts, the Outlook Address Book is updated as well. Outlook Help button  The button located at the right end of the ribbon, labeled with a question mark (?), that provides access to the Outlook Help system. Outlook Rich Text Format (RTF)  An e-mail message format that supports paragraph styles, character styles, backgrounds, borders, and shading, but is compatible with only Outlook and Exchange Server. Outlook converts RTF messages to HTML when sending them outside of your Exchange network. Outlook Today  A single-screen dashboard displaying the calendar events and scheduled tasks associated with your default e-mail account for the current day. permissions  Rules associated with a shared resource on a network, such as a file, directory, or printer. Permissions provide authorization to perform operations associated with these objects. Permissions can typically be assigned to groups, global groups, or individual users. phishing message  A technique used to trick computer users into revealing personal or financial information. A common online phishing scam starts with an e-mail message that appears to come from a trusted source but actually directs recipients to provide information to a fraudulent Web site.
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 phishing site  A Web site that prompts users to update personal information, such as bank accounts and passwords, which might be used for identity theft. Plain Text  An e-mail message format that does not support character or paragraph formatting. All e-mail programs support Plain Text. plain text messages  Messages that don’t support character or paragraph formatting in the message content. plain text files  Files that contain no formatting elements. Plain text files are sometimes referred to as the “lowest common denominator” of files. They can be opened and edited with a variety of common text editor programs, including Microsoft Notepad and Microsoft WordPad, and can be accessed on all operating systems. point to  To pause the cursor over a button or other area of the display. Post Office Protocol (POP)  A standard method that computers use to send and receive e-mail messages. POP messages are typically held on an e-mail server until you download them to your computer, and then they are deleted from the server. With other e-mail protocols, such as IMAP, e-mail messages are held on the server until you delete them. presence icon  A colored icon that indicates the online presence and status of a contact. print style  A combination of paper and page settings that determines the way items print. Outlook provides built-in print styles, and you can create your own. Quick Access Toolbar  A small, customizable toolbar that displays frequently used commands. Quick Step  A feature introduced in Outlook 2010 with which you can perform up to 13 actions with an e-mail message by invoking one quick step. recall  Instruct Outlook to delete or replace any unread copies of a message already sent.
 
 recurring item  An appointment, meeting, event, or task that occurs repeatedly on a specific schedule. For example, a weekly status meeting or a monthly haircut, can be designated as recurring. You can specify an appointment, meeting, or event as recurring, and specify the frequency of recurrence. Outlook then creates a series of items based on your specifications. reminder  A message that appears at a specified interval before an appointment, meeting, or task that announces when the activity is set to occur. Reminders appear any time Outlook is running, even if it isn’t your active program. resend  Create a new version of an original message with none of the extra information that might be attached to a forwarded message. resolving  The process of matching a user name to the information on a network server, resulting in the user name being replaced by a display name and the name underlined. ribbon  A user interface design that organizes commands into logical groups, which appear on separate tabs. Rich Text Format (RTF)  See Outlook Rich Text Format (RTF). rules  Sets of criteria defining specific actions that Outlook takes when the criteria are fulfilled. ScreenTip  A note that appears on the screen to provide information about a toolbar button, tracked change, or comment, or to display a footnote or endnote. ScreenTips also display the text that will appear if you choose to insert a date or AutoText entry. Secure Multipurpose Internet Mail Extensions (S/MIME)  A protocol that supports secure mail features such as digital signatures and message encryption. separated text file  A file containing unformatted text organized into fields and records. Records are separated by carriage returns; fields are separated by a specific character such as a comma, tab, colon, or semicolon. Separated text files may have the file name extension .txt or .csv.
 
 
 
 server rule  Or server-side rule. A rule that Exchange applies when receiving or processing a message, before delivering it. See also client rule. shared attachment  Attachment saved on a SharePoint document workspace Web site, where a group can collaborate to work on files and discuss a project. shortcut menu  A menu that shows a list of commands relevant to a particular item. Sometime referred to as a context menu. spam  Unsolicited commercial e-mail (UCE). Also known as junk e-mail. status bar  A line of information related to the current program. The status bar is usually located at the bottom of a window. Not all windows have a status bar. tab  A tabbed page on the ribbon that contains buttons organized in groups. task originator  The person who creates a task, specifically when assigning the task to someone else. task owner  The person to whom a task is currently assigned. After a task has been assigned, the task originator can no longer update the information in the task window. task window  The program window displaying the form in which you enter information to create or manage a task. Tasks List  An arrangement of the Tasks module, displaying a list of tasks associated with a specific e-mail account in the Tasks pane. See also To-Do List. Tasks pane  The center pane that displays content in the Tasks module. third-party add-ins  A software program created by one company (the “third party”) that extends the capabilities of a larger program created by another company. thread  In e-mail and Internet newsgroup conversations, a series of messages and replies that are all related to a specific topic.
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 title bar  The horizontal bar at the top of a window that contains the name of the window. On many windows, the title bar also contains the program icon, the Maximize, Minimize, and Close buttons, and the optional ? button for context-sensitive Help. To-Do Bar  The pane at the right side of the program window that displays the date navigator, upcoming appointments, and a task list. To-Do Bar Task List  The area at the bottom of the To-Do Bar that displays an interactive view of the tasks associated with your default e-mail account. To-Do List  The default arrangement of the Tasks module, displaying a list of tasks and flagged messages for your default e-mail account in the Tasks pane. See also Tasks List. Uniform Resource Locator (URL)  An address that uniquely identifies a location on the Internet. A URL is usually preceded by http://, as in http://www.microsoft.com. A URL can contain more detail, such as the name of a page of hypertext, often with the file name extension .html or .htm. View Shortcuts toolbar  A toolbar located near the right end of the status bar that displays buttons for switching between views of the current module. views  Different ways in which Outlook items can be arranged in the Outlook module window. virtual private network (VPN)  The extension of a private network that encompasses encapsulated, encrypted, and authenticated links across shared or public networks. VPN connections typically provide remote access and router-to-router connections to private networks over the Internet. Web beacon  A small, nearly undetectable graphic that links to a Web page and is embedded in a document for use as an eavesdropping device. work week  The days and times you define within Outlook as available for work-related activities.
 
 Keyboard Shortcuts The following tables list the keyboard shortcuts available in Microsoft Outlook 2010.
 
 Common Procedures Basic Navigation Action
 
 Keyboard shortcut
 
 Display the Backstage view
 
 Alt+F
 
 Display the Mail module
 
 Ctrl+1
 
 Display the Calendar module
 
 Ctrl+2
 
 Display the Contacts module
 
 Ctrl+3
 
 Display the Tasks module
 
 Ctrl+4
 
 Display the Notes module
 
 Ctrl+5
 
 Display the Folder List in the Navigation Pane
 
 Ctrl+6
 
 Display the Shortcuts list in the Navigation Pane
 
 Ctrl+7
 
 In a message window, display the next message
 
 Ctrl+Period
 
 In a message window, display the previous message
 
 Ctrl+Comma
 
 Move among the Navigation Pane, the content pane, the Reading Pane, and the To-Do Bar
 
 Ctrl+Shift+Tab or Shift+Tab
 
 Move among the content pane, the smaller panes in the Navigation Pane, the Reading Pane, and the sections on the To-Do Bar
 
 Tab
 
 Move among module elements
 
 F6
 
 Move among message header lines in the Navigation Pane or an open message
 
 Ctrl+Tab
 
 Move among the smaller panes in the Navigation Pane
 
 Arrow keys
 
 Go to a different folder
 
 Ctrl+Y
 
 Go to the Search box
 
 F3 or Ctrl+E
 
 In the Reading Pane, display the previous message
 
 Alt+Up Arrow or Ctrl+Comma or Alt+Page Up
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 Action
 
 Keyboard shortcut
 
 In the Reading Pane, display the next message
 
 Alt+Down Arrow or Ctrl+Period or Alt+Page Down
 
 In the Reading Pane, page down through text
 
 Spacebar
 
 In the Reading Pane, page up through text
 
 Shift+Spacebar
 
 Collapse a group in the message list
 
 Left Arrow
 
 Expand a group in the message list
 
 Right Arrow
 
 Display the previous view in the main Outlook window
 
 Alt+B or Alt+Left Arrow
 
 Display the next view in the main Outlook window
 
 Alt+Right Arrow
 
 Display the InfoBar menu of commands
 
 Ctrl+Shift+W
 
 Minimize, close, or expand the To-Do Bar
 
 Alt+F2
 
 Create an Item or File Action
 
 Keyboard shortcut
 
 Create a default item in any module
 
 Ctrl+N
 
 Create a message
 
 Ctrl+Shift+M
 
 Create an appointment
 
 Ctrl+Shift+A
 
 Create a meeting request
 
 Ctrl+Shift+Q
 
 Create a contact
 
 Ctrl+Shift+C
 
 Create a distribution list
 
 Ctrl+Shift+L
 
 Create a task
 
 Ctrl+Shift+K
 
 Create a task request
 
 Ctrl+Shift+U
 
 Create a note
 
 Ctrl+Shift+N
 
 Create a fax
 
 Ctrl+Shift+X
 
 Create a folder
 
 Ctrl+Shift+E
 
 Post to this folder
 
 Ctrl+Shift+S
 
 Post a reply in this folder
 
 Ctrl+T
 
 Create a Journal entry
 
 Ctrl+Shift+J
 
 Create a Microsoft Word document, Excel workbook, or PowerPoint presentation
 
 Ctrl+Shift+H
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 Procedures in All Items Action
 
 Keyboard shortcut
 
 Save (except in the Tasks module)
 
 Ctrl+S or Shift+F12
 
 Save and close (except in the Mail module)
 
 Alt+S
 
 Save as (only in the Mail module)
 
 F12
 
 Close an open item window
 
 Esc
 
 Undo the most recent action
 
 Ctrl+Z or Alt+Backspace
 
 Delete an item
 
 Ctrl+D
 
 Print an item
 
 Ctrl+P
 
 Copy an item
 
 Ctrl+Shift+Y
 
 Move an item
 
 Ctrl+Shift+V
 
 Check names
 
 Ctrl+K
 
 Check spelling
 
 F7
 
 Flag an item for follow-up
 
 Ctrl+Shift+G
 
 Forward an item
 
 Ctrl+F
 
 Send or post or invite all
 
 Alt+S
 
 Enable editing in a field (except in Mail or Icon view)
 
 F2
 
 Search Action
 
 Keyboard shortcut
 
 Clear the search results
 
 Esc
 
 Expand a search to include items from the current folder
 
 Ctrl+Alt+K
 
 Expand a search to include subfolders
 
 Ctrl+Alt+Z
 
 Expand a search to include All Mail Items, All Calendar Items, or All Contact Items, depending on the module you are in
 
 Ctrl+Alt+A
 
 Use Advanced Find
 
 Ctrl+Shift+F
 
 Create a Search Folder
 
 Ctrl+Shift+P
 
 Search for text within an open item
 
 F4
 
 In the Reading Pane or an open item, find and replace text, symbols, or formatting
 
 Ctrl+H
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 E-Mail Action
 
 Keyboard shortcut
 
 Display the Inbox
 
 Ctrl+Shift+I
 
 Display the Outbox
 
 Ctrl+Shift+O
 
 Choose the account from which to send a message
 
 Ctrl+Tab (with focus on the To box) and then Tab to the Accounts button
 
 Check names
 
 Ctrl+K
 
 Send a message
 
 Alt+S or Ctrl+Enter
 
 Reply to a message sender
 
 Ctrl+R
 
 Reply to all message recipients
 
 Ctrl+Shift+R
 
 Forward a message
 
 Ctrl+F
 
 Mark a message as not junk
 
 Ctrl+Alt+J
 
 Display blocked external content (in a message)
 
 Ctrl+Shift+I
 
 Post to a folder
 
 Ctrl+Shift+S
 
 Check for new messages
 
 Ctrl+M or F9
 
 Go to the previous message
 
 Up Arrow
 
 Go to the next message
 
 Down Arrow
 
 Open a received message
 
 Ctrl+O
 
 Open the Address Book
 
 Ctrl+Shift+B
 
 Add a Quick Flag to an unopened message
 
 Insert
 
 Display the Flag For Follow Up dialog box
 
 Ctrl+Shift+G
 
 Mark a message as read
 
 Ctrl+Q
 
 Mark a message as unread
 
 Ctrl+U
 
 In a message, open the MailTip
 
 Ctrl+Shift+W
 
 In a message, open the Find dialog box
 
 F4
 
 Find the next occurrence of the current search term
 
 Shift+F4
 
 Forward a message as an attachment
 
 Ctrl+Alt+F
 
 Show the properties for the selected item
 
 Alt+Enter
 
 Create a multimedia message
 
 Ctrl+Shift+U
 
 Mark a message for downloading
 
 Ctrl+Alt+M
 
 Unmark a message for downloading
 
 Ctrl+Alt+U
 
 Display the Send/Receive progress
 
 Ctrl+B (when Send/Receive is in progress)
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 Calendar Action
 
 Keyboard shortcut
 
 Set up recurrence for an open appointment or meeting
 
 Ctrl+G
 
 Forward an appointment or meeting request
 
 Ctrl+F
 
 In a meeting request, send a message to the organizer
 
 Ctrl+R
 
 In a meeting request, send a message to all participants Ctrl+Shift+R Show one through nine days in the calendar
 
 Alt+1 through Alt+9
 
 Show ten days in the calendar
 
 Alt+0
 
 Go to a date
 
 Ctrl+G
 
 Go to the next day
 
 Ctrl+Right Arrow
 
 Go to the next week
 
 Alt+Down Arrow
 
 Go to the next month
 
 Alt+Page Down
 
 Go to the previous day
 
 Ctrl+Left Arrow
 
 Go to the previous week
 
 Alt+Up Arrow
 
 Go to the previous month
 
 Alt+Page Up
 
 Go to the start of the week
 
 Alt+Home
 
 Go to the end of the week
 
 Alt+End
 
 Switch to Month view
 
 Alt+Equal Sign or Ctrl+Alt+4
 
 Switch to Full Week view
 
 Alt+Minus Sign or Ctrl+Alt+3
 
 Switch to Work Week view
 
 Ctrl+Alt+2
 
 Go to the previous appointment
 
 Ctrl+Comma or Ctrl+Shift+Comma
 
 Go to the next appointment
 
 Ctrl+Period or Ctrl+Shift+Period
 
 Tasks Action
 
 Keyboard shortcut
 
 Accept a task request
 
 Alt+C
 
 Decline a task request
 
 Alt+D
 
 Open the Go To Folder dialog box
 
 Ctrl+Y
 
 Open the selected item
 
 Ctrl+O
 
 Select all items
 
 Ctrl+A
 
 Switch among the Navigation Pane, Tasks list, and To-Do Bar
 
 Tab or Shift+Tab
 
 Open the selected item as a Journal item
 
 Ctrl+J
 
 Undo the last action
 
 Ctrl+Z
 
 Flag an item or mark a flagged item as complete
 
 Insert
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 Contacts Action
 
 Keyboard shortcut
 
 Dial a new call
 
 Ctrl+Shift+D
 
 Enter a name in the Search Address Books box
 
 F11
 
 In Table or List view of contacts, go to the first contact that starts with a specific letter
 
 Shift+letter
 
 Select all contacts
 
 Ctrl+A
 
 Create a message with the selected contact as the subject
 
 Ctrl+F
 
 Create a Journal entry for the selected contact
 
 Ctrl+J
 
 Open a contact form for the selected contact
 
 Ctrl+O
 
 Create a distribution list
 
 Ctrl+Shift+L
 
 Update distribution list members
 
 F5
 
 Go to a different folder
 
 Ctrl+Y
 
 Open the Address Book
 
 Ctrl+Shift+B
 
 Use Advanced Find
 
 Ctrl+Shift+F
 
 In an contact record, display the next contact
 
 Ctrl+Shift+Period
 
 Find a contact in an address book
 
 F11
 
 Send a fax to the selected contact
 
 Ctrl+Shift+X
 
 Open the Check Address dialog box
 
 Alt+D
 
 In a contact record, display the E-mail 1 address
 
 Alt+Shift+1
 
 In a contact record, display the E-mail 2 address
 
 Alt+Shift+2
 
 In a contact record, display the E-mail 3 address
 
 Alt+Shift+3
 
 Contacts: In the Edit Business Card Dialog Box Action
 
 Keyboard shortcut
 
 Open the Add list
 
 Alt+A
 
 Select the text for a field in the Label box
 
 Alt+B
 
 Open the Add Card Picture dialog box
 
 Alt+C
 
 Place the cursor at the beginning of the Edit box
 
 Alt+E
 
 Select the Fields box
 
 Alt+F
 
 Select the Image Align drop-down list
 
 Alt+G
 
 Select the color palette for the background
 
 Alt+K, then Enter
 
 Select the Layout drop-down list
 
 Alt+L
 
 Remove the selected field from the Fields box
 
 Alt+R
 
 Keyboard Shortcuts   515
 
 
 
 Color Categories Action
 
 Keyboard shortcut
 
 Delete the selected category from the list in the Color Categories dialog box
 
 Alt+D
 
 Format Text Action
 
 Keyboard shortcut
 
 Display the Format menu
 
 Alt+O
 
 Display the Font dialog box
 
 Ctrl+Shift+P
 
 Switch case (with text selected)
 
 Shift+F3
 
 Format letters as small capitals
 
 Ctrl+Shift+K
 
 Increase the font size
 
 Ctrl+] or Ctrl+Shift+>
 
 Decrease the font size
 
 Ctrl+[ or Ctrl+Shift+					    

		

            

	        	    
    		
    		    

    		    

    		

		    			
    
		
	    
		
		Microsoft Access 2010 Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Word 2010 Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Word 2010 Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Office Outlook 2003 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Office Outlook 2007 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft® Visual C#® 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Visual C# 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft SharePoint Foundation 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Visual C# 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Office Professional 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft ADO.NET 4 Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft SharePoint Foundation 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Excel 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft SharePoint Designer 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Excel 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Word 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Visual Basic 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft® Visual C#® 2010 Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft SharePoint Designer 2010 Step by Step (Step by Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft ADO.NET Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Office Home & Student 2010 Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft  Windows  Me Step by Step (EU-Step by Step)

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		XML Step by Step, Second Edition (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft® VBScript Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft VBScript: Step by Step

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		HTML5 Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		JavaScript Step by Step (Step By Step (Microsoft))

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		HTML5 Step by Step (Step By Step)

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		JavaScript Step by Step (Step By Step)

	    
	

	
	    Read more
	

    



		    			
    
		
	    
		
		Microsoft Office Home & Student 2010 Step by Step

	    
	

	
	    Read more
	

    



		        	    
 
	            

	
	    
		
	    
            
                
                    Recommend Documents

                

		
		    						    
    
	
	    
	
    

    
	
	    
		Microsoft Access 2010 Step by Step (Step By Step (Microsoft))	    
	
	
	    Microsoft Access 2010 ®

Step by Step

Joyce Cox Joan Lambert

®

 PUBLISHED BY Microsoft Press A Division of Microsoft...

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Word 2010 Step by Step (Step By Step (Microsoft))	    
	
	
	    PUBLISHED BY Microsoft Press A Division of Microsoft Corporation One Microsoft Way Redmond, Washington 98052-6399 Copyr...

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Word 2010 Step by Step (Step By Step (Microsoft))	    
	
	
	    PUBLISHED BY Microsoft Press A Division of Microsoft Corporation One Microsoft Way Redmond, Washington 98052-6399 Copyr...

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Office Outlook 2003 Step by Step	    
	
	
	    

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Office Outlook 2007 Step by Step	    
	
	
	    

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft® Visual C#® 2010 Step by Step	    
	
	
	    Microsoft Visual C# 2010 Step by Step ®

®

John Sharp

 PUBLISHED BY Microsoft Press A Division of Microsoft Corporati...

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Visual C# 2010 Step by Step	    
	
	
	    Microsoft Visual C# 2010 Step by Step ®

®

www.wowebook.com

John Sharp

 PUBLISHED BY Microsoft Press A Division of M...

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft SharePoint Foundation 2010 Step by Step	    
	
	
	    

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Visual C# 2010 Step by Step	    
	
	
	    Microsoft Visual C# 2010 Step by Step ®

®

John Sharp

 PUBLISHED BY Microsoft Press A Division of Microsoft Corporati...

	

    

    

    



						    
    
	
	    
	
    

    
	
	    
		Microsoft Office Professional 2010 Step by Step	    
	
	
	    PUBLISHED BY Microsoft Press A Division of Microsoft Corporation One Microsoft Way Redmond, Washington 98052-6399 Copyr...

	

    

    

    



					    		

            

        


    





    
	
	    
		
		    ×
		    Report "Microsoft Outlook 2010 Step by Step"

		

		
		    
			Your name
			
		    

		    
			Email
			
		    

		    
			Reason
			-Select Reason-
Pornographic
Defamatory
Illegal/Unlawful
Spam
Other Terms Of Service Violation
File a copyright complaint


		    

		    
			Description
			
		    

		    
			
			    

			

		    

		    
		

		
		    Close
		    Send
		

	    

	

    




	
	    
		Copyright © 2024 EPDF.PUB. All rights reserved.
		
		    About Us | 
		    Privacy Policy |  
		    Terms of Service |  
		    Copyright | 
		    DMCA | 
		    Contact Us | 
		    Cookie Policy 
		

	    

	    

	
	
	    
		
		    
			×
			Sign In

		    

		    
			
			    
				Email
				
			    

			    
				Password
				
			    

			    
				
				    
					
					 Remember me
				    
				    Forgot password?
				


			    

			    Sign In
			

		    

		

	    

	

	
	
	
	

	
	

	

	
	
	    Our partners will collect data and use cookies for ad personalization and measurement. Learn how we and our ad partner Google, collect and use data. Agree & close
	

	
	
    